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Send Us Your Comments

Oracle Retail Predictive Application Server User Guide for the Fusion Client, Release
15.0.1

Oracle welcomes customers' comments and suggestions on the quality and usefulness
of this document.

Your feedback is important, and helps us to best meet your needs as a user of our
products. For example:

= Are the implementation steps correct and complete?

= Did you understand the context of the procedures?

= Did you find any errors in the information?

= Does the structure of the information help you with your tasks?

= Do you need different information or graphics? If so, where, and in what format?
= Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell
us your name, the name of the company who has licensed our products, the title and
part number of the documentation and the chapter, section, and page number (if
available).

Note: Before sending us your comments, you might like to check
that you have the latest version of the document and if any concerns
are already addressed. To do this, access the Online Documentation
available on the Oracle Technology Network web site. It contains the
most current Documentation Library plus all documents revised or
released recently.

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number
(optional).

If you need assistance with Oracle software, then please contact your support
representative or Oracle Support Services.

If you require training or instruction in using Oracle software, then please contact your
Oracle local office and inquire about our Oracle University offerings. A list of Oracle
offices is available on our web site at http://www.oracle.com.
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Audience

Preface

This document describes the Oracle Retail Predictive Application Server user interface.
It provides step-by-step instructions to complete most tasks that can be performed
through the user interface.

This document is for users and administrators of Oracle Retail Predictive Application
Server. This includes merchandisers, buyers, business analysts, and administrative
personnel.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing
impaired.

Related Documents

For more information, see the following documents in the Oracle Retail Predictive
Application Server Release 15.0.1 documentation set:

»  Oracle Retail Predictive Application Server Administration Guide for the Classic Client
»  Oracle Retail Predictive Application Server Administration Guide for the Fusion Client
»  Oracle Retail Predictive Application Server Configuration Tools User Guide

»  Oracle Retail Predictive Application Server Installation Guide

»  Oracle Retail Predictive Application Server Release Notes

»  Oracle Retail Predictive Application Server Security Guide

Customer Support

To contact Oracle Customer Support, access My Oracle Support at the following URL:
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https://support.oracle.com

When contacting Customer Support, please provide the following:

s Product version and program/module name

= Functional and technical description of the problem (include business impact)
»  Detailed step-by-step instructions to re-create

= Exact error message received

= Screen shots of each step you take

Review Patch Documentation

When you install the application for the first time, you install either a base release (for
example, 15.0) or a later patch release (for example, 15.0.1). If you are installing the
base release or additional patch releases, read the documentation for all releases that
have occurred since the base release before you begin installation. Documentation for
patch releases can contain critical information related to the base release, as well as
information about code changes since the base release.

Improved Process for Oracle Retail Documentation Corrections

To more quickly address critical corrections to Oracle Retail documentation content,
Oracle Retail documentation may be republished whenever a critical correction is
needed. For critical corrections, the republication of an Oracle Retail document may at
times not be attached to a numbered software release; instead, the Oracle Retail
document will simply be replaced on the Oracle Technology Network Web site, or, in
the case of Data Models, to the applicable My Oracle Support Documentation
container where they reside.

This process will prevent delays in making critical corrections available to customers.
For the customer, it means that before you begin installation, you must verify that you
have the most recent version of the Oracle Retail documentation set. Oracle Retail
documentation is available on the Oracle Technology Network at the following URL:

http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html

An updated version of the applicable Oracle Retail document is indicated by Oracle
part number, as well as print date (month and year). An updated version uses the
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E123456-02 is an updated version of an document with part number E123456-01.

If a more recent version of the document is available, that version supersedes all
previous versions.

Oracle Retail Documentation on the Oracle Technology Network

Oracle Retail product documentation is available on the following web site:
http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html

(Data Model documents are not available through Oracle Technology Network. You
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italic Italic type indicates book titles, emphasis, or placeholder variables for
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monospace Monospace type indicates commands within a paragraph, URLs, code

in examples, text that appears on the screen, or text that you enter.
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Overview

Getting Started

Welcome to Oracle Retail RPAS Fusion Client. This chapter provides an overview that
includes information to help you get started with the application. It includes the
following sections:

Overview

Basic Concepts of RPAS

Terminology Differences Between Clients
Setting Up Your Browser

Logging into the Fusion Client
Understanding the Taskflow

Opening a Workbook

Creating a New Workbook

Deleting a Workbook

Renaming a Workbook

Understanding the Workbook Wizard Window
Extra Measures

Plug-Ins from External Applications
Reports

Locating the Commit Status

Viewing an Announcement

Locating the Version Number

Accessing Online Help

Logging Out of the Application

The RPAS Fusion Client is a web-based rich client for the Retail Predictive Application
Server (RPAS) platform developed using the latest Oracle Application Development
Framework (ADF).

Planning is one of the most important and complex processes in a retail business. It
typically involves a detailed set of activities that need to be followed as part of a
workflow. Unlike the RPAS Windows-based Classic Client, the Fusion Client includes

Getting Started  1-1



Basic Concepts of RPAS

a taskflow feature that provides a robust workflow capability to make each planning
activity easier to track and maintain.

The Fusion Client uses the same RPAS server as the RPAS Windows-based Classic
Client. In addition to the enhanced user experience, the Fusion Client provides access
to a larger number of users and a greater degree of platform independence.

The taskflow also allows you to switch between solutions and domains without
logging out and back in.

Where Does the RPAS Fusion Client Fit in a Retail Enterprise

The RPAS platform and Fusion Client form part of the Merchandising Planning and
Optimization solutions. Figure 1-1 shows an example of a retail enterprise with the
Fusion Client application implemented with the RPAS server hosting an RPAS
application. It provides a high-level overview of where the Fusion Client application
fits in a typical retail enterprise.

Figure 1-1 RPAS Fusion Client in a Retail Enterprise
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Basic Concepts of RPAS

RPAS is a configurable platform with a proven scalability for developing
multidimensional forecasting and planning based solutions. This platform provides
capabilities such as a multidimensional database structure, batch and online
processing, a configurable slice-and-dice user interface, a sophisticated configurable
calculation engine, user security and utility functions such as importing and exporting,
all on a highly scalable technical environment that can be deployed on a variety of
hardware.

This section introduces you to the following RPAS concepts:
»  Multidimensionality

s  Dimensions

= Measures

s Domains and Workbooks
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Multidimensionality

Dimensions

Measures

In RPAS, information is stored and represented based on the multidimensional
framework. In a multidimensional database system, data is presented as a
multidimensional array, where each individual data value is contained within a cell
accessible by multiple indexes.

Multidimensional database systems are a complementary technology to entity
relational systems and achieve performance levels above the relational database
systems. Applications that run on RPAS identify data through dimensional
relationships. Dimensions are qualities of an item (such as a product, location, or time)
or components of a dimension that define the structure and roll up within the
dimension.

Dimensions describe the top-to-bottom relationship between the levels or positions of
the dimensions in RPAS. They reflect the dimensions set up at your business and used
by the merchandising solutions.

RPAS supports many alternative dimensions that provide different roll ups and can
help you analyze the data from a different perspective.

Measures represent the events or measurements that are recorded, while the positions
in the dimensions provide a context for the measurement. Measures are defined based
on the business rules set in the application. The dimensionality of a measure is
configured through the definition of its base intersection, which is the collection of
levels (one per appropriate dimension) defining the lowest level at which the
information is stored for the measure.

Measure names are completely configurable and typically named using a convention
that identifies each component and the meaning of the measure.

Domains and Workbooks

RPAS stores information in a persistent multidimensional data cache that is optimized
for large volumes and dimensional or time series data access requirements, typically
required by multidimensional solutions. This central repository is called a domain.
The domain also includes central definitions of metadata for the solution and provides
a single update point.

When you use an RPAS solution, you interact with the solution through a personal
data repository called a workbook. A workbook contains the subset of the data (and
metadata) from the domain, and its scope is constrained by the access rights available
to a user. Workbooks are stored on the RPAS server and can be built using an online
wizard process or scheduled to be built in a batch process automatically.

Although the data and metadata in the workbook are copied from the domain, the
data remains independent of the domain.

With a multi-solution taskflow, you do not log into a domain. You are logged into a
solution. When you pick a particular task, you will be directed to a specific domain,
based on a few settings. First, there is a task setting that indicates whether it is
accessible via the master domain only, local domain only, or both. If the setting is local
domain only or both, the specific domain you are launched into will be based on the
position level security on the partition dimension. If you have access to only a single
local domain, you will be logged into that specific local domain. If you have access to
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more than one local domain, you will be prompted to select the positions you want to
work with, and based on that, you will be logged into a specific local domain or the
master domain.

Terminology Differences Between Clients

There are some key terminology differences between the Fusion Client and Classic
Client. Understanding these differences is useful if you are moving from the Classic
Client or if you have used the Classic Client before using the Fusion Client. The
following table describes the differences.

Table 1-1 Terminology in the Fusion Client and Classic Client

Fusion Client Classic Client
Term Term Description Term
Dimension Grouping of a particular type of information. Hierarchy

Typical dimensions are for products, locations, time,
and measures. For instance, a Product dimension
can contain information about items, item groups,
departments, and divisions.

Level A subdivision of a dimension. Levels group Dimension
information of the same type. For instance, a level
within the Product dimension can be Department.
The Department level contains all the departments
(men’s shoes, women'’s shoes, children’s shoes) that
exist.

View Multidimensional spreadsheets that are used to Worksheet
display information from the workbook. Workbooks
can include one view or multiple views, which can
present data in the form of numbers in a grid. These
numeric data values can easily be converted to a
graphical chart. Data can be viewed at a very high
level of detail, or data values can be quickly
aggregated and viewed at summary levels.

You can display the information in a view in a
variety of formats, generally by rotating, changing
the data rollup, showing and hiding measures, and
drilling up or down.

Setting Up Your Browser

The Fusion Client can be accessed using Apple Safari, Microsoft Internet Explorer,
Google Chrome, or Mozilla Firefox. A list of the supported versions of browsers is
included in the Oracle Retail Predictive Application Server Installation Guide. Before you
access the application for the first time, you should set the following browser settings
to allow seamless and error-free access:

»  Cache Settings
= Security Settings for Internet Explorer

Based on the zone where the application is installed, you may configure your browser
settings for Local intranet or as a Trusted sites zone.

Important: Do not select Internet unless you have been instructed to do so
by an administrator. In most cases, the application is available on your
company's intranet (Local intranet) or an Oracle trusted site (Trusted sites).
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Cache Settings

Before starting the Fusion Client, set up the browser’s cache so that temporary internet
files are deleted every time you visit a web page. The cache settings are typically
found in the browser’s tool menu.

Security Settings for Internet Explorer

If using Internet Explorer, you should configure the browser security settings to
improve the user experience.

To set the security settings, complete the following steps:
1. Start Internet Explorer.
2. From the Tools menu, click Internet Options.

3. On the Security tab, click Local intranet, and then click Sites.

Figure 1-2 Internet Options - Security Tab

General Security |F’ri~u'ac1,|I | Content | connections | Programs | Advanced |

Select a zone to view or change security settings.

@ € v/ O

Internet Localintranet  Trusted sites  Restricted
sites

Local intranet p—
" ites |
"‘] This zone is for all websites that are

2 found on your intranet.

4. On the Local intranet window, click Advanced.
5. In the Add this website to the zone field, enter the application URL, click Add,
and then click Close.

Figure 1-3 Local Intranet Window - Add Website to the Zone

Local intranet x|

"‘: You can add and remove websites from this zone. All websites in
i this zone will use the zone's security settings.

Add this website to the zone:
| https:/fyourcompanyname. domainname. com
Websites:

Remove |

[™ Require server verification (https:) for all sites in this zone

Close |

6. On the Local intranet window, click OK.
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7. In the Security level for this zone area, click Custom level....

Figure 1-4 Security Settings - Local Intranet Zone Window
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*Takes effect after you restart Internet Explorer

—Reset custom settings
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8. In the Security Settings - Local Intranet Zone window, select the Prompt or
Enable option for the following parameters:

Table 1-2 Parameters in the Security Settings Window

Category Parameter Name

ActiveX controls and plug-ins

Download signed ActiveX controls

Initialize and script ActiveX controls not marked as safe for
scripting

Run ActiveX controls and plug-ins

Downloads

File download

For additional security settings for exporting views, see Export
Miscellaneous

Allow websites to open without address or status bars
Scripting

Active scripting

Note: For more information on the Prompt and Enable options, see About
Prompt and Enable Options.

1-6 Oracle Retail Predictive Application Server User Guide for the Fusion Client



Logging into the Fusion Client

9. After you set up these parameters, click OK. A message appears that prompts you
for a confirmation of the changes to the settings for the zone.

10. Click Yes to accept the changes. Based on the settings you changed, you may need
to restart Internet Explorer for the changes to take effect.

About Prompt and Enable Options

The Prompt option provides a confirmation message box each time a specific action
occurs on the web browser (for example, Download signed ActiveX controls). The
browser grants access to the actions, based on your response.

The Enable setting provides direct access to the specified action without any
notification.

You may select the Prompt option for the download options because the downloads
typically occur one time. For the running and scripting actions, since they occur
frequently, you may select the Enable option. If you select the Prompt option, you may
have to respond to a message box several times in an application session.

Logging into the Fusion Client

Note: The only way to log into the Fusion Client is with external
authentication.

Before you log into the Fusion Client, ensure that your system meets the
recommended configuration requirements. For more information, see the Oracle Retail
Predictive Application Server Installation Guide.

After you check the configuration, obtain the following information:

s Uniform Resource Locator, URL — Enter the URL or the web address of the
application in the web browser to access the application. For example:

http://<fullyqualifieddomainname>:<port>/rpas
= User name and Password — Based on the tasks you want to perform, obtain a user
account (that includes user name and password) to log onto the application.

What you see when logging in depends on the type of external authentication used.
The Fusion Client login page appears only when you use LDAP for authentication. In
the case of Single Sign-On, the Single Sign-On login page will appear. If you are using
Single Sign-on (SSO), you may select a link in a portal and then see the home page.

To log into the Fusion Client:
1. Open a supported internet browser.

2. In the Address bar, enter the Fusion Client URL and press Enter. The Fusion
Client Login page appears.
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Figure 1-5 Fusion Client Login Page
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* Password
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3. On the Login page, enter the username and password.

4. Click Login. The window refreshes, and the home page of the RPAS Fusion Client
is shown.

Figure 1-6 RPAS Fusion Client Home Page

MACL € RPAS Fusion Client

ivities1
A Tests Announcement

Igregation & Spreading Home Page Message: Note the following announcements:

Aggregation & Spreading e Task flow change from tomorrow.

IgSpreadLimits e System down for 2 hours for maintenance, at 4pm

0 DynamicHier . - .
g Get more information at our corporate website.

cle Group No Elapsed Time

unt

HEE LR E
EEEEEERB

wer Uncover

Welcome to Oracle Retail Predictive Application Server (RPAS) Fusion Client.
i To get started, use the following icons next to the task you want in the Activity Taskflow pane on your left:

[} Click this icon to create a new workbook for the task.

All the activities, tasks, and steps across all the configured solutions to which you
have access are displayed. See "Understanding the Taskflow".

If a dialog appears telling you that no RPAS solutions are available or you are
missing tasks, the RPAS server could be down or there could be some other
connection issue. In this case, log out and log on later when the issue is fixed.

Logging in with Single Sign-On

If you have accessed the RPAS Fusion Client through a single sign-on environment
such as the Oracle Retail Workspace portal, you see the home page of the RPAS Fusion
Client (Figure 1-6).

Note: For more information about single sign-on (SS0O), see the
Oracle Retail Predictive Application Server Administration Guide for the
Fusion Client.
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Accessing through Guided Launch

You can also access a workbook in the RPAS Fusion Client through the guided launch
option in a web center or workspace application, such as the Oracle Retail Workspace
portal. Guided launch allows users to click a link to automatically log into the Fusion
Client and open or build a particular workbook.

If the workspace is configured to have guided launch, then a link or button is
displayed, like the one shown in Figure 1-7.

Figure 1-7 Guided Launch

,-’_:‘ Launch RPAS Client - Windows Internet Explorer

&9+ |@ o:mcpesiportalpubsic himijsunchstart himi v 4 x| £ -
: Hle Edt WVew Favorites Tools Help
U0 4% | @LaunchRPAS Cient R GTes- @

Launch RPAS Client

Click on the button to launch RPAS client and build a new workbook!

I Build A Mew Measure Analysis Workbook ||

BuildComplate - Status: code(0) messageWorkbook build was succe | 100% <

Depending upon how the guided launch is configured, the RPAS Fusion Client
appears in a new browser window or within a pane within the same browser window
with the configured workbook already open.

Concurrent Sessions

If you already have a user session of the Fusion Client running in a domain, you can
start a second or concurrent session at the same time. When logging into the Fusion
Client, if you have a concurrent session running, you see the following message:

Figure 1-8 Concurrent Session Message

ORACLE
RETAIL

You have existing session(s). What would
you like to do?

(* Terminate existing sessions and create new ones.
~ Start concurrent sessions as Necessary.

ﬁ Cancel

Select one of the following options:

= Terminate existing sessions and create new ones: This option closes any existing
connections for the user in that domain.
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= Start concurrent sessions as necessary: This option allows the user to have
multiple connections within the domain. This does not affect any prior user
connections to the domain.

Note: For information about the number of allowed concurrent
sessions, see the “System Administration” chapter of the Oracle Retail
Predictive Application Server Administration Guide for the Fusion Client.

Multiple Sessions

To have multiple sessions means that you have more than one Fusion Client session
connected to an RPAS domain, whether the connection is to the same domain or the
same username.

Note: You must not open the same workbook in more than one tab.

The supported browsers handle multiple sessions differently. Table 1-3 describes the
multiple session handling of each browser.

Table 1-3 Browser Multiple Session Handling

Browser

Multiple Session Handling

Internet Explorer

Use separate windows, rather than separate tabs.

Note: For Internet Explorer 8, a special setup is required for multiple sessions to function properly:
Option 1: From the Internet Explorer File menu, select the New Session option.

Option 2: Update the Internet Explorer shortcut to include the following command line switch:

"C:\Program Files\Internet Explorer\iexplore.exe"
-noframemerging

Use this shortcut every time.

Option 3: Create a registry string called FrameMerging:

1.  From the Start menu, click Run.

2. Inthe Run dialog box, type regedit in the Open field and click OK.

3. Navigate to

HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\Main\

Right-click the Main key and select New > String Value.

A new string value appears. Name it FrameMerging.

Right-click the FrameMerging registry string and select Modify from the right-click menu.

4
5.
6.
7.  Enter 0 in the Value data field and click OK.

Firefox

Create a program shortcut with the following target:

"C:\Program Files\Mozilla Firefox\firefox.exe"

-no-remote -p

Use this shortcut every time. The shortcut launches Firefox with a random profile. Since this profile

does not exist, the profile manager dialog appears. When invoking this shortcut for the first time, create
a profile for each concurrent session you need.

After the first use, you can select the desired profile and create the Fusion Client session. Each profile
has a different session. Ensure that you do not create a profile called random.

Chrome

Create a Fusion Client session from one Chrome window. To create another session, click the wrench
icon and then select the New incognito window menu option. This launches a new Chrome window.
In this new window, create a new Fusion Client session.

This method has a limitation: you can create only one incognito window session. Multiple incognito
windows merely share the same session.
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Understanding the Taskflow

The taskflow is displayed on the left of your screen and helps you easily navigate
through the activities in the application. It provides a pre-configured business
workflow organized into expandable and collapsible activity groups, activities, tasks,
and steps.

Note: The taskflow also appears when you log onto the application.

Each activity consists of more than one task and each task may consist of one or more
steps. In the Fusion Client, each solution (spanning across multiple workbooks) is
represented as a set of activities, tasks, and steps. The activities can also be grouped
into an activity group.

A multi-solution taskflow allows for a single point-of-access to multiple RPAS
solutions. A taskflow can contain activities from a single RPAS solution or from
multiple solutions. For multiple solutions, activity groups can be used to integrate
activities from the solutions into a unified taskflow configuration that spans those
solutions. The activity group provides an integrated workflow that represents the
business process across multiple solutions, that is, it organizes activities from multiple
solutions so the activities can be presented together under a single organizing entity.

With the multi-solution taskflow, you can log into the Fusion Client and have access to
multiple solutions and domains.

Note: The taskflow is configured for the required domains during
implementation. For more information on this configuration, see the
Oracle Retail Predictive Application Server Configuration Tools User Guide.

Figure 1-9 shows an example of a multi-solution taskflow configured with activity
groups, activities, tasks, and steps.
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Figure 1-9 lllustration of Activity Group, Activity, Task, and Step
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In the Fusion Client, the workflow illustrated in Figure 1-9 appears in the following
manner:
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Figure 1-10 Taskflow
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In the taskflow, you can click the Expand icon next to any task to view the associated
steps. When you are working with a specific step, an arrow icon appears in the
taskflow indicating the current step and your position in the workflow.

The Create New Workbook, Open Latest Workbook, and Show List of Workbooks
icons that appear next to each task or step enable you to create new workbooks or
open existing workbooks. You can find more information on creating new workbooks
and opening existing workbooks in Chapter 1, "Getting Started".

Figure 1-11 illustrates the icons that appear in the taskflow.

Getting Started 1-13



Understanding the Taskflow

Figure 1-11 Icons in the Taskflow
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Table 1-4 describes the icons that appear with all the entries in the taskflow.

Table 1-4 Description of Icons in the Taskflow

Legend | lcon Name Description

A Activity Groups | These tabs represent the grouping of activities.

B Activities These tabs represent the predefined activities of the application.

C Tasks These are individual tasks within an activity. Tasks that have a workbook

associated with it display a clipboard icon.

D Current Indicates the current step and your position in the workflow.
Position Icon

E Steps One or more steps make up each task.

F Create a New Click this icon to create a new workbook. The new workbook wizard associated
Workbook with the relevant task appears.

G Open the Latest | Click this icon to view the latest workbook (associated with the relevant
Workbook task/step) you worked on.
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Table 1-4 (Cont.) Description of Icons in the Taskflow

Legend |lcon Name Description
H Show List of Click this icon to view a list of all workbooks (associated with the relevant
Workbooks task/step) accessible to you. The Open Workbook window appears with a list of

accessible workbooks.

If you do not own any workbooks that you own, a message appears allowing
you to view all workbooks.

If no workbooks are associated with the task/step, created by you or by
someone else, a message appears that allows you to create a new workbook.

I Collapse/Resto | Click this icon to collapse or restore the taskflow. Collapsing the taskflow allows
re Icon you to view more content in the Contents area.

After you open a workbook, the state of the taskflow is maintained when
navigating between workbooks and the home page. For instance, if you are in a
workbook and the taskflow is collapsed, when you navigate to the home page
and then return to a workbook, the taskflow remains collapsed because that was
its last state.

The state of the taskflow after the first workbook is built or opened in a user
session is controlled by the rpasConfig.properties file.

For information on changing this setting, see the rpasConfig.properties section
of the Oracle Retail Predictive Application Server Administration Guide for the Fusion
Client.

J Dynamic Task | A dynamic task is one that has steps that are dynamic, based on the selection
you makes when building the associated workbook. The steps are not shown
unless you are within a workbook.

Dynamic tasks display a clipboard with a lightning bolt icon.

Access-Based Visibility

The activity and tasks that appear in the taskflow are access-based. Depending upon
the security settings, you may not have access to some tasks or activities. Access to a
task is defined by whether you have access to the workbook template that the task is
assigned to.

The access to the workbook template is maintained in the Security Administration
step. See the Oracle Retail Predictive Application Server Administration Guide for the Fusion
Client for more information about the Administration activity. If you do not have
access to a workbook template, then you cannot build the workbooks for the
associated tasks and steps.

Hiding specific tasks or activities based on user access is configurable. In the
configuration, a task can be set to either hidden or disabled. If it is hidden and the user
does not have access to it, then the task is not displayed. If it is disabled and the user
does not have access, then the task is displayed but the links to access the workbooks
are disabled. For more information, refer to the Oracle Retail Predictive Application
Server Configuration Tools User Guide.

Switching Between Multiple Tasks

When working within multiple steps or tasks, all changes you make in a specific step
are maintained when you move to a step in the same task or a different task associated
with the same workbook template. In this case, you do not need to save your work
when you switch between tasks within the same workbook template.

If you switch to a task that is associated with a different workbook template, you are
prompted to save or discard the changes before opening or building a new workbook.
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To save your changes, use the Save As dialog box. For more information on the Save
As dialog box, see Save As Option.

Opening a Workbook

After you log onto the application, a taskflow appears that you can use to navigate
through the activities and tasks associated with your user account.

To open a workbook:

1. In the taskflow, click the Show List of Workbooks icon next to the task/step you
want. For more information on the taskflow, see the Understanding the Taskflow
section.

Figure 1-12 Show List of Workbooks Icon

"Reg Price Optimization

7 [E]Business Administration
Price Ladder Management

Default Constraint Priority Setting

Batch Management

The Open Workbook window appears. When using a combined taskflow, you see
all the workbooks across all domains that you have access to.

Figure 1-13 Open Workbook Window

Open Workbook

View v | FmRename 3 Delete Find... &3
Name |Task MName |Owner Group |Owner |Mod Date W |Created Drate Arcess Cramain Mame |Domain Type
busin-admin_autosaved Business Administration Administration adm Apr 29, 2012 5:02,.. Apr 29, 2012 5:02,., User PCiE0 Master Master
busin-admin Business Administration Administration adm Apr 29, 2012 5:00,., Apr 29, 2012 4:59,,, User PCED Local 6 Local
busin-permissionattempt Administration adm Apr 29, 2012 4132,.. Apr 29, 2012 3:35.., User PCED Local 1 Local

Cpen Cancel

2. Select the workbook you want, and click Open Workbook.

Note: If the workbook DimRegistry version is different from the
domain DimRegistry version, a warning message appears:

“Workbook and Domain DimRegistry versions are not matching. May
cause performance delay while opening and processing workbooks.”

For more information about DimRegistry, see the “Reindexing
Domains” section of the Oracle Retail Predictive Application Server
Administration Guide for the Fusion Client.
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Understanding the Open Workbook Window
Figure 1-14 highlights the various components of the Open Workbook dialog.

Figure 1-14 Open Workbook Window User Interface Components
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Table 1-5 describes the screen components of the Open Workbook window:

Table 1-5 Open Workbook Window User Interface Components

Legend | Screen Area Name | Position Description

A View menu Top Left The View menu enables you to view all the workbooks that you
own. It also provides you the option to show or hide any
column in the workbooks grid. It also lets you see workbooks in
domains that you do not have position level security access to,
for example, to open a workbook saved by another user.

B Rename icon Top Left Use to rename a workbook.
Delete icon Top Left Use to delete a workbook. For more information, see Deleting a
Workbook.
D Find field, Previous | Top Center Use to identify the workbooks with the keywords you entered
and Next arrows in the Find field.

Use the Previous and Next arrows to navigate between the
workbooks matching the search pattern. The search is not
case-sensitive.

E Workbooks grid Center Displays the list of workbooks in the current profile. By default,
only the workbooks that you own appear.

To view all the workbooks, under the View menu, click All.

The grid also holds the total number of real time alerts. Move
derail can be obtained by mousing over a specific cell.

F Cancel icon Bottom Right | Use to cancel an action and exit the Open Workbook window.
G Open Workbook Bottom Right | After you select the workbook you want, click this icon to open
icon the workbook.

Note: You can open only one workbook at a time.

Creating a New Workbook

The new workbook wizard enables you to create workbooks based on the templates
set up during the implementation as well as RPAS administration templates. These
templates typically represent a high-level business activity in your organization.
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Based on the configuration, each template in the RPAS domain may include many
measures at different intersections. Each workbook template is associated with one of
the following wizards that help you filter and include the relevant information for the
workbook:

s Standard Two Tree Wizard is a set of similar looking two tree pages that help select
positions in different dimensions.

s Custom Wizard offers flexibility when configuring custom pages for choosing
positions.

The wizards are set up and associated with the workbook template using the RPAS
Configuration tool.

To create a new workbook:

1. In the taskflow, click the Create New Workbook icon next to the task/step you
want. For more information on the taskflow, see the Understanding the Taskflow
section.

Figure 1-15 Create New Workbook Icon
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2. Select the domain for the workbook. If you only have position level security for
positions within a single local domain or the task type is set to master only, this
dialog box is not displayed. There are two options within this domain selection
dialog;:

»  Select by Position: You are presented with positions for the partitioned
hierarchy, and you can select the positions that work within for the selected
task. See Figure 1-16.

When you select a position, all the other positions in the same domain are
shown on the right. Since choosing the domain is the goal, that may be
enough. If you select a position that crosses domains, it will select the master
domain if that is permitted by the task and template.

Note: This selection of positions is different than the selections made
in the wizard. You must select positions in the wizard to indicate the
specific positions that need to be included in the workbook.

= Select by domain name: To select the master domain or a specific domain,
select Select by Domain Name. See Figure 1-16. Select the master domain or a
local domain from the menu.
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Figure 1-16 Domain Selection Dialog
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3. Based on the configuration of the workbook template, an associated wizard

appears. The wizard provides you with positions that help you filter and include
the relevant information in the workbook.

Figure 1-17 Workbook Wizard
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Use Drag and Drop to add Available Items to Selected Items, use shift-dick and Add for multiple selections, or Add Al for all items.
[ synchronize Hierarchies

Cancel Previous Mext | Einish |

4. In the Available Items area, select the positions you want by holding down the
Ctrl or Shift keys and click Add. You can click Add All to select all the positions.

Or, drag and drop the positions to the Selected Items area.
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Note: In order to drag and drop multiple positions at the same time,
you must do the following:

Hold down the Shift key or the Ctrl key and, using the mouse, move
the cursor to highlight each position you want to move, keeping the
cursor in the non-text area. You must keep the mouse button
depressed after you finish highlighting and then drag your selection
to the Selected Items area.

5. Follow the instructions in the wizard, and after you have selected the positions
you want, click Finish.

Deleting a Workbook

From the list of workbooks, you can delete any workbook you have write access to. To
delete a workbook:

1. On the Open Workbook window, select the workbook you want.

To delete more than one workbook, hold the Ctrl key and select the workbooks
you want to delete. Or, you can hold Shift and select a group of workbooks.

2. Click Delete. A warning message appears.

Figure 1-18 Delete Warning Message

,_'\ Warning 2]

Deleting these workbook(s) will permanently remaove it Are you sure you want to delete?
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3. Review the warning message and then click Delete to delete the workbooks or
click Cancel to cancel this operation.

Renaming a Workbook

The open workbook dialog box enables you to rename existing workbooks without
affecting the data within the workbook or the other workbook information, such as the
created date, modified date, and formatting information.

Keep in mind these key points when renaming workbooks:

= You can only rename workbooks that you have write access to.

= Workbook names can be no more than 32 characters.

= Workbook names cannot contain double or single quotation marks.
= Workbooks cannot be named “Untitled.” This name is reserved.

To rename a workbook in the open workbook dialog box, complete the following
steps.

1. Select the workbook you want to rename from the list. When selected, it becomes
shaded, as shown in Renaming a Workbook.

2. C(Click Rename.
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Figure 1-19 Renaming a Workbook
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3. The Rename Workbook dialog box appears. Enter the new name of the workbook

and click OK.

Figure 1-20 Rename Workbook Dialog Box

Rename Workbook

*Mame | busin-admin-Version2

4. The renamed workbook appears in the workbook list.

Figure 1-21 Renamed Workbook
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You can also rename a workbook from the File menu. For more information about this
option, see Renaming Workbooks.
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Understanding the Workbook Wizard Window

Figure 1-22 highlights the various components of the workbook wizard.

Figure 1-22
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Table 1-6 describes the screen components of the workbook wizard window.

Table 1-6 Workbook Wizard Window User Interface Components

Screen Area

Legend | Name Position Description
A Available Items | Center Left Displays the positions that are available for you to select.
area
B View menu Center Left, within Provides options for viewing the available positions. You can
the Available Items adjust the column setting, detach the list to view it in a larger
area window, expand or collapse the positions, or scroll to the
beginning or end of the list.
C Dimension Center Left, within Opens the Dimension options window where you can select
menu the Available Items the levels of the dimension you want to view in the Available
area Items list. You can also select the attributes that you would
like to see and sort by in the list.
D Find field, Center Left, within Used to identify the positions with the keywords you entered
Previous and the Available Items in the Find field.
Next arrows area

Use the Previous and Next arrows to navigate between the
workbooks matching the search pattern. The search is not
case-sensitive.
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Table 1-6 (Cont.) Workbook Wizard Window User Interface Components

Screen Area

Legend | Name Position Description
E Detach Left corner of the Used to view the list of positions in a larger window.
Available Items and
Selected Items areas
F Wizard Top Center Displays the steps in the wizard process and shows you
Taskflow where you are within that process.
The wizard taskflow is configured in the RPAS Configuration
Tools. For more information, see the Oracle Retail Predictive
Application Server Configuration Tools User Guide.
G Selected Items | Center Right Displays the positions you selected. It also includes a toolbar
area that enables you to perform various functions.
H Load Favorite | Center Right, within | Used to select a previously saved group of positions to load
icon the Selected Items into the workbook.
area For more information, see Saving and Loading Favorites.
I Save Favorite Center Right, within | Used to save the positions you have selected as group. The
icon the Selected Items next time you build a new workbook, you can select and load
area that group rather than choosing the same positions
individually again.
For more information, see Saving and Loading Favorites.
J Add and Add Center Used to add positions that are selected in the Available Items
All icons area.
To add all positions in the Available Items area, click the Add
All icon.
K Remove and Center Used to remove positions in the Selected Items area.
Remove All To remove all positions in the Selected Items area, click the
icons .
Remove All icon.
L Wizard Bottom Right Used to navigate from one wizard page to another. After you
Navigation icon have made the selections for the workbook and clicked
Finish, the workbook builds with the selected positions.
M Synchronize Bottom Left When selected, the displayed levels within the Selected Items
Hierarchies area match the ones in the Available Items area. This is
check box selected by default.

Saving and Loading Favorites

After you have selected the positions that you want to appear in the workbook you are
building, you can save that collection of positions for future use by using the Save
Favorite and Load Favorite features. You can save the collection of positions for each
dimension presented in the workbook wizard.

Saving Favorites

To save the selected positions as a favorite, complete the following:

1. After you have moved the positions to the Selected Items area, click the Save
Favorite icon or select Save Favorites from the View menu. See Figure 1-23.
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Figure 1-23 Save and Load Favorites Icons

Selected Items Load Favorite
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2. The Save Favorites window appears. Enter the name of the favorite in the Label
field. In the Access field, choose one of the following:

s User: This option makes the favorite available to only the user who created it.
= World: This option makes the favorite available to all users.

Note that previously saved favorites are listed in the table.

Figure 1-24 Save Favorites Window
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Save Cancel

3. When finished, click Save. If you would like to abandon the changes, click Cancel.

Saving Calendar Positions as Favorites

When saving positions in the Calendar dimension, you have the option to use a
relative calendar rather than the predefined time periods that are shown in the wizard.
This enables you to use a range of time periods that are relative to the current date. As
time passes, the calendar favorite updates the range of time to be in relation to the new
date.
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Figure 1-25 Save Favorites — Calendar Dimension
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The length of the time periods is determined by the lowest level of the Calendar
dimension presented in the wizard. For instance, if the lowest level in the wizard is
Week, then when you select the time range in the relative calendar option, you choose
the number of weeks to include.

To use the relative calendar feature, complete the following:

1.

Editing Favorites

In the calendar step of the workbook wizard, click the Save Favorite icon. You do
not need to move a position to the Selected Items list.

In the Save Favorites window, enter the name in the Label field and select the
access level in the Access field.

At the bottom of the window, select the Use Relative Calendar option.

In the Start field, enter the number or use the arrows to choose the number of time
periods in relation to today’s date for the start period. For instance, if the
workbook’s lowest calendar level is week and you want the time period to begin 2
weeks in the past from today’s date, you would enter -2. If you wanted it to begin
2 weeks in the future, you would enter 2.

In the End field, enter the number of weeks in relation to today’s date that you
want the time period to end.

When finished, click Save.

To change or update a favorite, complete the following:

1.
2.
3.

Move the updated set of positions to the Selected Items area.
Click the Save Favorite icon or select Save Favorites from the View menu.

In the Save Favorites window, select the favorite that you want to edit from the
list.

Update the Access level if necessary.

Click Save. The favorite now includes the new set of positions.
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Loading Favorites

After you have saved a favorite, you can load it into to the workbook wizard. Loading
favorites into the wizard rather than selecting individual positions from the wizard
every time you create a workbook will save you time.

To load a favorite, complete the following:
1. In the workbook wizard, click the Load Favorite icon.

2. The Load Favorites window appears. Click the favorite you want to load. The
Load Favorites window automatically closes.

Figure 1-26 Load Favorites Window
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3. In the workbook wizard, the positions from the favorite now appear in the
Selected Items area.

Deleting Favorites
To delete a favorite, complete the following steps:
1. Click the Save Favorite icon or select Save Favorites from the View menu.
2. Select the favorite you want to delete from the list.

3. Click Delete. The favorite is deleted and no longer appears in the list.

Extra Measures

There are certain circumstances where the create workbook custom wizard results in
some extra worksheets that are not part of the Fusion Client taskflow. This can occur
when the number of worksheets being created is dependent on the number of extra
intersections that are selected by the user during the workbook creation process.

Tasks with Extra Measures

There is no way of determining from icons in the taskflow which tasks have extra
measures associated with them. This can only be determined when the workbook
wizard is in use. Both the Standard and Custom workbook wizards can have an
additional stage added to select extra measures.

1-26 Oracle Retail Predictive Application Server User Guide for the Fusion Client



Extra Measures

Figure 1-27 Workbook Wizard - Extra Measures Stage
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As there may be dozens of extra measures that could potentially be added to the
workbook, it is not possible to configure the task flow to accommodate all the
permutations. Accordingly, the views for extra measures are accessible in the views
docking area, but not in the Taskflow Area.

Figure 1-28 Extra Measures - Taskflow and Views Docking Area
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Using Extra Measures

Working with extra measures in the activity flow is similar to working with steps that
can be selected from the task flow. The sole difference being that steps associated with
extra measures can only be selected from the Views Docking Area. The following
conditions apply:
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= If the task has a single step assigned to it in the taskflow, any additional
worksheets will be assigned to that step.

s If the worksheet has a single task and multiple steps, the additional worksheets
will be accessible from each step.

= If one or more steps of a task have been configured with tabs, then all the
configured tabs will display the additional worksheets.

Plug-Ins from External Applications
RPAS has the ability to display plug-ins from other applications.

Overview of Plug-Ins From Other Applications

As well as displaying information from other RPAS domains in the Fusion Client via
the standard client/server relationship, the capability exists to integrate plug-ins from
external applications into RPAS. This allows data to be used from other sources.

For example, a plug-in can be configured to read data out of a relational database and
present it in read-only form to a user in RPAS. That user could then use the
information to update data within RPAS.

Configuring the Plug-In to Display in the Fusion Client

In order for these plug-ins to be visible in the Fusion client, a series of preparatory
actions must be carried out. A brief overview is as follows:

= Develop Package

The initial stage is to create a Ul that is RPAS compliant. This Ul must meet a set of
stringent technical requirements.

= Configure the Application Within RPAS

This requires a series of updates or edits to the files used to configure the
application. These specify the data source, selection context, and metrics to be
displayed.

Note: See the RPAS Configuration Tools User Guide for more
information.

Adding Plug-Ins to RPAS

This section specifies three ways in which plug-ins can be made available to users
within RPAS.

Launching from the RPAS Fusion Client Home Page

The first option is to make the plug-ins available to the user from the RPAS home
page. It should occupy the content area, leaving room for the alert area.
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Figure 1-29 Adding Plug-In to Home Page
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The second option is to add the plug-in to the task flow. The plug-in must be regarded
as a task or step in the task flow. The pertinent changes must be made in the
Configuration Module before it is available to standard users. The user can then select
the plug-in at the appropriate period in the business process.

Figure 1-30 Adding Non-RPAS Plug-in to Taskflow
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Launching from Within a RPAS Worksheet

The final option is to launch the plug-in from within a worksheet. This is done using
the Plug-Ins option from the right click menu. In this example, two plug-ins can be

selected.
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Figure 1-31 Plug-In Menu Option
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Reports

OBIEE reports are configured using a combination of configuration files, including
Taskflow_MultiSolution.xml, MultiSolutionBundle.properties, and reportConfig.xml.
See RPAS Configuration Tools User Guide and Oracle Retail Predictive Application
Server Administration Guide for the Fusion Client for details.

If a report or reports have been configured for a specific worksheet, you will see those
reports listed in the context menu under Plugins when you make a worksheet
selection, as shown in List of Reports. Depending on the report configuration, selected
cells are typically used to filter the report.

Figure 1-32 List of Reports
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Locating the Commit Status

When you select a report from the list of available reports to view, you see the report
displayed in a new window. Each report you select from the list is generated in a
separate window. The contents of the report depend on the selection you initially
make in the worksheet. If you change the selection and launch the report again, the
report is refreshed.

Figure 1-33 Example Report
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As with other plug-ins launched from the context of a worksheet, report windows can
be resized, repositioned, and deleted, In addition, the launch is remembered upon
workbook save. This means that when you reopen the workbook, you see the report
again without the need to relaunch it.

Locating the Commit Status

To see the commit status of a workbook without opening it, click Commit Status in the
global toolbar.

Figure 1-34 Commit Status Link
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The Commit Status dialog box appears. It lists all workbooks that have been created in
the domain. In a combined taskflow, all the workbooks across the domains to which
you have access are displayed. The workbook'’s solution, task type, domain,
submission time, owner, submitter, commit status, and completion time are displayed.
To see how the commit status appears when a workbook is open, see the Viewing
Commit Statuses section. This section also describes how to use this dialog box.

Note: Commit status has meaning only for a commit asap, not
commit now. The Fusion Client does only commit asap. To use
commit status, you use commit asap.
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Figure 1-35 Commit Status Dialog Box
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Viewing an Announcement

Site administrators can broadcast announcements to logged-in RPAS Fusion Client
users about imminent events. Up to three messages can be displayed on the user’s
login, home, or workbook screens.

To see the announcement of a workbook without opening it, click Announcement in
the global toolbar.

Figure 1-36 Announcement Link
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The Announcement dialog box appears.

Figure 1-37 Announcement Dialog Box
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Locating the Version Number

To determine the version of RPAS Fusion Client and server, click the About link in the
global header.
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Figure 1-38 About Link
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The About Oracle RPAS Fusion Client dialog box appears, displaying client and server
versions. It also lists the solutions to which you are connected. In this example, you
can see that you have access to one solution in the taskflow configuration.

Figure 1-39 About Oracle RPAS Fusion Client Dialog Box
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Accessing Online Help
To access online help, click Help in the global header.

Figure 1-40 Online Help Link
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The online help appears in a new browser window. If more than one help set is
available, you can choose which one to view by selecting it from the Book drop-down
field. If there is only one help set, the field is shaded.

Figure 1-41 Online Help Window, Book Field
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Contents
The contents of the online help set are shown in the Contents section of the navigation
bar on the left. Click the Expand icon next to the folders to drill down to the help
topics. Click the page you want to view. It appears in the content area.
Figure 1-42 Help Topic within Online Help
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Figure 1-43 Online Help: Figure List
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In the Index, you can enter keywords to find topics that contain this keyword. Click

the topic name to see the page.
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Figure 1-44 Online Help: Index
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Search

Use the Search field at the top of the online help window or the Search section within
the navigation bar to search for words or phrases.
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Figure 1-45 Online Help: Search
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Logging Out of the Application

To log out of the application, click Logout in the global toolbar.

Figure 1-46 Logout Link
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For some SSO configurations, you may see “End Session <username>" instead. This
will log you out of your RPAS session only, but not SSO. If you see Logout, it is
configured to log you out of SSO as well.

Note: You may be prompted to save and commit the workbook data
before logging out of the application.

1-36 Oracle Retail Predictive Application Server User Guide for the Fusion Client



Understanding the User Interface

This chapter introduces you to the user interface for the workbook and describes the
following screen components:

s Quick Access Toolbar
s Contents Area

Figure 2-1 highlights the various components of the workbook user interface:

Note: RPAS Fusion Client 15.0 has a new look and feel. Though
functionally the user interface is the same, users will find new styles
and skin.

Figure 2-1 Workbook User Interface
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Table 2-1 describes the user interface components in the workbook user interface:
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Table 2-1 Workbook User Interface Screen Components

Screen Component Description

Global Header Displayed at the top of the screen, this area appears across all the
business applications and custom pages. It includes the application
branding and links for the home page, About window, Online Help,
and logging out of the application.

Quick Access Toolbar Displayed below the global header, the quick access toolbar
includes the menus and icons that you use to perform various
actions in the workbook. For more information, see Quick Access
Toolbar.

Taskflow Displayed on the left of the screen, the taskflow provides a
workflow that helps you navigate through the application. It lists
each activity, associated tasks, and steps involved to complete an
activity. For more information, see Understanding the Taskflow.

Content Area Displayed on the right of the screen, the content area includes views
and tabs associated and configured for each task and step in the
application workflow.

Quick Access Toolbar

The following figure highlights the various components on the Quick Access toolbar:

Figure 2-2 Quick Access Toolbar Components
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Table 2-2 describes the quick access toolbar components highlighted in Figure 2-2:

Table 2-2 Quick Access Toolbar Components

Legend | Toolbar Component Description

A File menu The File menu provides access to the general options for the workbook, such
as Save, Commit, and so on. For more information on each option available
in the File menu, see File Menu Options.

B Edit menu The Edit menu provides access to the options associated with cell edits, such
as Cut, Undo, and so on. For more information, see Edit Menu Options.

C View menu The View menu provides options that enable you to quickly access one of
the workbooks from the taskflow using the Go To submenu. It also contains
the synchronize page edge option and tiling options. For more information,
see View Menu Options.

D Format menu The Format menu provides options that enable you to change and save the
format of the workbook.

For more information on formatting, see Format Menu Options.

E Save Icon The Save icon enables you to save the changes you make in the workbook.
You can also access this option from the File menu.

For more information on saving the workbooks, see Saving Workbooks.

F Commit and Commit The Commit icon enables you to commit the changes to the domain. You can
Status Icons also access this option from the File menu.

The Commit Status icon enables you to view the current statuses of the
current commit requests in the Commit Status dialog box.

For more information on committing the workbooks, see Committing
Workbooks.
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Table 2-2 (Cont.) Quick Access Toolbar Components

Legend

Toolbar Component

Description

G

Print Icon

The Print icon enables you to print the view by exporting it to an external
program. For more information, see Print.

H

Export Icon

The Export icon enables you to export the view to an external program. For
more information, see Export.

Refresh Workbook

The Refresh Workbook icon allows you to update a workbook with the data
that is currently stored in the domain. This allows you to work with the
most current data without having to rebuild the workbook. Workbooks can
be refreshed with a single refresh rule group or multiple ones. For more
information, see Refreshing Workbooks.

Undo Icon and
Drop-down List

The Undo icon enables you to undo actions you performed within the entire
workbook (not just the current view). You can also access this option from
the Edit menu. When more than one action has been performed, a
drop-down list of the last performed actions is available. From that list you
can select the actions to undo.

Calculate Icon

After you edit the cells within the workbook, use the Calculate icon to
calculate and update the associated cells within the workbook. You can also
access this option from the Edit menu. For more information, see
Calculating Workbooks.

Previous and Next Icons

The Previous and Next icons enable you to navigate to the previous or next
task/step in the taskflow. You can also click the down arrow (next to both
the icons) to quickly jump to a specific task or step within the workflow.

View /Manage Images

The View /Manage Images icon enables you to associate images with
specific dimension positions. Most positions have images associated with
them as part of the configuration process. You can use this feature for
positions that for some reason may be missing an image.

This feature is especially useful for the product and location dimensions. For
instance, you can associate an item with a image of what it should look like
displayed on the shelf. You can associate stores with images of the store
front or interior. For more information, see Chapter 13, "Images".

Update Attribute Values
and Level Splits Icon

After you edit user-defined attributes, you can update the attributes and
level splits with this icon. Clicking this icon recalculates all sort attributes
and dimension splits displayed in the workbook since the attribute or
dimension split was last applied to the data. This icon is enabled only when
there are attributes displayed that need to be recomputed based on user
edits. For more information, see Updating Attribute Values.

Alerts

This section of the toolbar gives information on Batch Alerts and Real Time
Alerts. These enable users to focus on information that needs their attention.
These icons will only be visible if the workbook has been configured to have
Batch Alerts and Real Time Alerts. For more information, see Overview of
Alerts.

Workbook Name

This area displays the name of the currently open workbook.

File Menu Options

The file menu includes the following options:

= Save - Allows you to save all information in the workbook. This includes
information on the current layout of views and charts. You can also click the Save
icon on the toolbar. For more information, see Saving Workbooks.

Note:

The Save option does not commit the changes to the master domain.
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Save As — Use to save the workbook with a name and the access you want. For
more information, see Save As Option.

Rename — Use to rename the workbook. For more information, see Renaming
Workbooks.

Commit — Use to commit the changes to the master domain. After the changes are
committed, all other users with access to the workbook will notice the changes as
well. For more information, see Committing Workbooks.

Commit Status — Use to view the status of committed workbooks. For more
information, see Committing Workbooks.

Page Setup — Use to change the orientation, scaling, margins, header, footer, and
page breaks for the page when printing.

Print — Use to print the view by exporting it to Microsoft Excel. For more
information, see Print.

Export — Use to export to Microsoft Excel. For more information, see Export.

Refresh — Use to update a workbook with the data that is currently stored in the
domain. This allows you to work with the most current data without having to
rebuild the workbook. Workbooks can be refreshed with a single refresh rule
group or a multiple ones.

Revert — Use to close an open workbook without saving it and reopen it. This
removes any changes made to the workbook and resets it to the last saved value.

Edit Menu Options

The Edit menu includes the following options:

Undo — Use to undo the last action you performed within the workbook (not just
the current view).

Calculate — Use to submit the edited data to the server for processing.

Cut — Use to copy and remove data from the cells of a view in order to move the
data to cells in the same view;, cells in another view, or other applications. For more
information, see Cut.

Copy — Copies selected data to the application clipboard. It keeps data in a
clipboard that you can use to transfer data within RPAS as well as to an outside
application such as Excel. For more information, see Copy.

Paste — Pastes the data that was last placed on the clipboard into the selected cells
within the RPAS Fusion Client. For more information, see Paste.

Cut Special — Cuts data at the base level or higher level intersection across page
slices. If multiple levels (product group or style) are represented in the pivot table
selections, the cut option is performed at the lowest level actually selected. For
more information, see Cut Special.

Copy Special — Copies data at the base level or higher level intersection across
page slices. You can view data at an aggregate level while copying data at a
dimensional level not currently displayed or while selecting data from the current
slice while copying data from all slices. For more information, see Copy Special.

Paste Special — Use to view data at an aggregate level while pasting it at the base
level that is not displayed in the current slices. It provides a dialog where you can
specify options for specialized paste functions. For more information, see Paste
Special.
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Copy to External — Copies data in the Fusion Client to be pasted in external
applications. This feature is useful when the browser's security restriction prevents
the Fusion Client from copying to and pasting from the clipboard. For more
information, see Copy to External.

Paste from External — Pastes data into the Fusion Client from external
applications. This feature is useful when the browser's security restriction prevents
the Fusion Client from copying to and pasting from the clipboard. For more
information, see Paste from External.

Fill — Use to quickly populate many cells of a writable measure at a time.

Clear — Use to quickly clear the contents of cells in a view and set them to their NA
value. You can clear one or more cells, a dimension level, or an entire slice.

Lock — Protects cells, measures, and positions from being edited. For more
information, see Locking and Unlocking.

Unlock - Use to remove the protection of cells, measures, and positions so that
they can be edited. For more information, see Locking and Unlocking.

Unlock All - Use to remove the protection from all cells, measures, or positions so
that they can be edited. For more information, see Locking and Unlocking.

Insert Measures — Use to add measures to an existing workbook that were not
initially included in the configuration. A measure can be inserted to a single view
and is available to all the windows for that view. For more information, see Insert
Measures.

Position Maintenance — Use to dynamically add, edit, or remove positions to a
non-calendar position while working in a workbook. These user-defined or
informal positions are updated in both the domain and workbook dimensions. For
more information, see Dynamic Position Maintenance.

Find - Use to search for phrases within the rows, column, and page axis of an
active view. The search does not include the data within the view. For more
information, see Find.

View Menu Options

The View menu includes the following options:

Go To submenu — In addition to the Previous and Next icons on the Quick Access
toolbar, the Go To submenu enables you to navigate through the workflow or to a
specific step.

Synchronize Page Edge — Use to simultaneously scroll through the page edge of
multiple views. It is useful when you want to compare multiple views containing
the same page or slice dimension. For more information, see Synchronized Page
Edge Scrolling.

Automatically Evaluate Position Queries — Allows position queries to
automatically reevaluate data after a calculate, refresh, or slice move. When
enabled, the query is updated and the view refreshes with only the positions that
meet the requirements of the position query. For more information, see Using
Position Queries with Auto Evaluate.

Resort Positions on Pagination — Reapplies the sort order when paging through
positions along the page-axis. For more information, see Sorting Across Page
Edge.
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Manage Images — Use to associate images with specific dimension positions. Most
positions have images associated with them as part of the configuration process.
You can use this feature for positions that for some reason may be missing an
image. This feature is especially useful for the product and location dimensions.
For instance, you can associate an item with a image of what it should look like
displayed on the shelf. You can associate stores with images of the store front or
interior. For more information, see Chapter 13, "Images".

Attributes submenu — Use to create and manage attributes and level splits after
you have edited user-defined attributes. The Update Attribute Values option
recalculates all sort attributes and dimension splits displayed in the workbook
since the attribute or dimension split was applied to the data. For more
information, see Updating Attribute Values.

Manage Alerts — Use to navigate to and address both batch and real time alerts.
Both forms of alert are ways of identifying circumstances where data in a
workbook or view infringes predetermined rules. For more information, see
Overview of Alerts.

In addition to the Manage Alerts option, a series of navigation controls are
available:

— Find Next Alert — Moves forward to the next alert of that type.
- Find Previous Alert - Moves back to the previous alert of that type.

—  Select Active Alert — Both Batch and Real Time Alerts come in different
sub-types. This option lets you focus on a specific sub-type.

— Allow Find Alerts to Cross Views — If multiple views are open and this option
is selected, you can use the Find Next Alert or Find Previous Alert to move to
the next or previous view, as appropriate. If this option is not active, the Next
and Previous options will be confined to the current view.

- Apply Filter by Alert — Use to show only the rows, columns or pages with
active alerts.

- Remove Filter By Alert — Removes any filtering that confines the displayed
information to rows, columns od pages containing active alerts.

Tile Vertically — Arranges all non-minimized views from left to right as columns.
This layout is useful for comparing two or more views side by side.

Tile Horizontally — Arranges all non-minimized views from top to bottom as
rows.

Tile — Arranges all non-minimized views on multiple rows or columns as a grid.

Note that for all the tile options above, the views are arranged in order such that the
last selected view is placed first. If multiple views are selected prior to the tile action,
the views will be arranged in reverse order of selections, starting with last selected
view first.

Format Menu Options

The Format menu includes the following options:

2-6

Measure Styles — Opens the Format dialog box. In the Format dialog box, you can
set and clear formats that apply to measures or dimensions. You can make changes
to single or multiple measures and dimensions and apply those changes across
one, many, or all views in the workbook. For more information, see Formatting.
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s Number — Modifies the number formatting for measures. For more information,
see Modifying Number Formatting.

= Date/Time — Configures the date and time display for measures. For more
information, see Modifying Date/Time.

s Exceptions — Exception formatting is used for numeric measure types. Exception
formatting defines the styles to be applied to a cell’s value when it falls outside a
defined range. For more information, see Modifying Exceptions.

= Alert Styles — Configures the appearance of alerts. For more information see
Customizing Alert Appearance.

=  Dimension Styles — Specifies header styles for dimensions. For more information,
see Modifying Dimension Styles.

= Save Format — Saves the workbook format to be used in the future. Formats can be
saved at one of the following levels: For Just Me, For [My Group], or For
Everyone. For more information, see Saving Formats.

s Delete Format — Deletes a workbook format. It can be deleted at one of the
following levels: For Just Me, For [My Group], or For Everyone. For more
information, see Deleting Formats.

Contents Area

The contents area appears on the center of your screen and includes the views
associated with each step within the business workflow. It provides spreadsheet-like
views that display multidimensional data. Each view includes a set of measures
relevant to the step that help you view, analyze information, and make decisions.

Figure 2-3 shows the various components in the contents area.
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Figure 2-3 Content Area Components

A ~| ITtem Lewvel L A
B HE] Scenario| Location| YT E] Merchandis
[1 Max Revenue |« Price Zone 1= Bf Measure
cHE@w & e -3 @ B Ecm@ i |
Cranberry Sauce Jelied 15 oz | Cranberry Sauce Whale Berry 15 oz |
MNote ~
Active Ttem?
Price Ladder
i| |[Price Hald ] ] -
Criginal Price $1.09 %1.49 r
D H Apply Min/Max Price | |
Min Price
Max Price
Default Price Constraint Priority Priority 3 Priority 3
Price Constraint Priority Default Default
Apply Min/Max Margin [l [l
Original Cost £0.00 S0.00 [v
£ ] [#]
E H F Item Group Level Item Level

Table 2-3 describes the components highlighted in Figure 2-3.

Table 2-3 Components in the Contents Area

Legend | Area Name Description

A View Title Bar Displays the name of the view and also includes view-level features such as
Minimize, Maximize, Restore, and other View Options. See View Title Bar for more
information.

B Page Edge and Enables you to move or swap individual dimensions to view the information in a

Dimension Tiles
Area

more effective manner. See Page Edge and Dimension Tiles Area for more
information.

C View Toolbar Provides quick access to view-level formatting, exporting, and charting options. See
View Toolbar for more information.
D View Area Displays a Pivot Table/Grid with the multidimensional data organized based on the
dimension position set up in the Page Edge and Dimension Tiles area. See View
Area for more information.
E Views Docking Displays the views available in the current step and helps you manage any
Area additional copies of the existing views that you may create. See Views Docking Area

for more information.

View Title Bar

The View Title bar appears on the top of each view and displays the view name. It
enables you to perform the following view-level actions:

»  Maximizing or Restoring a View

s Minimizing a View
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= Moving a View
= Renaming a View
= Making a Copy of a View

s Deleting a View

Maximizing or Restoring a View
To maximize a view:

= On the View Title bar, click the Maximize icon. This icon is the arrow that points
towards the top-right. See Figure 2—4.

Figure 2-4 Maximize Icon on the View Title Bar
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To restore a maximized view to its original size:

s On the View Title bar, click the Restore icon. This icon is the arrow with a box that
points towards the bottom-left. See Figure 2-5.

Figure 2-5 Restore Icon on the View Title Bar
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Minimizing a View
To minimize a view:

s On the View Title bar, click the Minimize icon. This icon is the arrow with an
underline that point towards the bottom-left. See Figure 2-6.

Figure 2-6 Minimize Icon on the View Title Bar
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A minimized view is shown with a restore icon to the left of the view name. To restore
the view, you must click the view in the Views Docking Area.

Moving a View
To move a view:

1. On the View Title bar, click the Move icon on the view you want to move. This
icon is the cross hair that appears to the left of the Minimize icon. See Figure 2-7.

Figure 2-7 Move Icon on the View Title Bar

| Ttem Level - g A

2. Drag and drop the view to the location you want. You can move this view only
within the Contents area. When you try to move a view to a location out of the
Contents area, the view auto fits to the nearest valid space.
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Renaming a View

To rename a view:

1. On the View Title bar, click the View Options icon. The View Options menu
appears.

2. In the View Options menu, click Rename view.

Figure 2-8 Rename View Option in the View Options Menu

~| Item Level E +oe
B Scenario| Location %3 Copy view... rchandise
[ Max Revenve | » [ Price Zone 1= | Rename view... [pasure

==

Bla i | & | [ TR

A Rename View dialog box appears.

3. Inthe Rename View dialog box, enter the new view name and click OK.

Making a Copy of a View

To make a copy of a view:

1. On the View Title bar, click the View Options icon. The View Options menu
appears.

2. In the View Options menu, click Copy view.

Figure 2-9 Copy View Option in the View Options Menu

v | Item Level oy A
Bl Scenario| Location S Copy view... rchandise
|1 Max Revenue 'l%l' Rename view. .. asUre

|
Bl i | & | [Frd. R

A Copy View dialog box appears.

3. In the Copy View dialog box, enter or accept the new view name and click OK.

Deleting a View
To delete a view:

1. On the View Title bar, click the View Options icon. The View Option menu
appears.

2. In the View Options menu, click Delete view.

Figure 2-10 Delete View Option in the View Options Menu

| Item Level2 El X
A Scenario| Location %3 Copy view... rchandise
| 1 Max Revenus -m- Rename view. .. SSLre

]

Bau b m  =ee bgss

A warning message appears.
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3. Review the warning message and click Delete to remove the view.

Note: Deleting a view removes the view from the user interface
permanently.

Page Edge and Dimension Tiles Area

The Page Edge area appears on top of the View area and displays the dimensions on
the page edge axis according to its current position in the dimension. The Dimension
Tiles area displays the dimensions as tiles that appear in the row and column axes.

On the Page Edge, the current position appears below the dimension name,
horizontally with the highest visible level on the left and the lowest visible level on the
right. You can mouse over the position to view the name of the level (displayed as a
tool tip).

Figure 2-11 Page Edge Displaying the Current Position

Merchandise Location
Dimension Dimension

Tile Tile
v Iterl\ Level v oy o
sz |Merd‘uandise| |Lc-catic-n | PR B3 Scenario
Cranberry | Cranberry | Granberry Ssuce Jellied 15 oz |} | Price Zone 1 i j@ Measure
-

Highest Visible Lowest Visible Only Visible
Level of Merchandise Level of Merchandise | evel of Location

When you open the workbook for the first time, the first position in each visible level
is visible. In an existing workbook, the positions retain the last saved values.

You can collapse or restore the Page Edge and Dimension Tiles area to fit more view
content. You can also drag these icons to resize this area. Figure 2-12 shows the
Collapse Pane icon that you use to resize or collapse the Page Edge and Dimension
Tiles area.

Figure 2-12 Collapse and Restore Icons in the Page Edge and Dimension Tiles Area

~| Ttem Level v b oy A
FR | Merchandise| Location | o Scenario

[ Cranberry | [ Cranbemy || Cranbermy Sauce Jellied 15 oz | =[ Price Zone 1= M Measure
—

When a workbook is saved or a newly built workbook is formatted, the
collapse/expand state of the dimension tile area is saved. This includes information
for collapsing just the row and column as well as the entire dimension tile area. This
information is saved on a view-by-view basis.

Understanding Paging/Position Navigation

On the Page Edge area, you can select any position displayed and page through or
navigate to the positions using the navigation icons (First, Previous, Next, Last)
available next to the dimension tiles. In the view, data relevant to each position is
displayed when you navigate to a new position in a level.
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Figure 2-13 Paging Navigation Icons

«|Ttem Level First Previous Next Last - 4 A

ER  Merchandise | Loluﬁm-l—mljirl;l j@ Scenario

[ Cranbermy | [ Cranbesry |[ Cranbemy Sauce Whale Bamy 15 oz |=| Price Zone 2 |= Bl Measure
|

The First icon enables you to navigate to the first visible position within the level that
is selected. When you are at the first position, the First and Previous icons are disabled
and appear greyed out.

The Last icon enables you to navigate to the last visible position within the level that is
selected. When you are at the last position, the Next and Last icons are disabled and
appear greyed out.

The Previous and Next icons enable you to navigate to the previous and next position
in the level that is selected. The position to which you navigate depends on the current
position. When you navigate to a new position, all associated positions at the higher
and lower visible levels of the same dimension are updated recursively.

Note: You can also pivot or rotate the dimensions between the Page
Edge, Tiles, and View areas to rearrange the orientation. For more
information, see Rotating or Pivoting Dimensions.

View Toolbar

The View Toolbar appears within the View area, above the grid. It displays several
tools that you can use to manipulate the view.

Figure 2-14 View Toolbar
A B C D E
Ela | &

lFGHIJ K
¢ & EWEcam A oW

Y
Find...

Table 2—4 describes the components highlighted in Figure 2-14.

Table 2-4 Components in the View Toolbar

Legend | Area Name Description

A Switch to Pivot Table When in the chart view, use this icon to switch to the pivot table view. For
View icon more information, see Viewing Charts.

B Switch to Split View Use to see the pivot table and chart in two vertical panels simultaneously in
icon the same view. For more information, see Viewing Charts.

C Switch to Chart View When in the pivot table view, use this icon to switch to the chart view. For
icon more information, see Viewing Charts.

D Select Chart Type icon | Use to select which type of chart you want to view the data in. For more

information, see Viewing Charts.

E Find field, Find Use to search for words, partial words, or phrases within the rows, column,
Options, Previous and and page axis of an active view. The search does not include the data within
Next Arrows the view. For more information, see Find Using the View Toolbar.
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Table 2-4 (Cont.) Components in the View Toolbar

Legend | Area Name Description

F Selection Options icon | Use to select the data that is shown in the chart. You can choose Select All or

any other option it presents. Select All finds the full extent of the pivot table
edges (in slices) and sets a new selection range to encompass the entire pivot
table. This action triggers a refresh of the pivot table.

G Measure Profile icon Use to select, save, or delete measure profiles. See Measure Profiles for more
information.
H Level Splitting icon Use to group dimension data based on position characteristics defined by

attribute values. For more information, see Level Splitting.

I Attributes icon Use to create dynamic attributes that describe a particular dimension and

level, based on a measure’s value at specified levels of other dimensions. For
more information, see Dynamic Attributes.

J Lock icon Protects cells, measures, and positions from being edited. For more

information, see Locking and Unlocking.

K Sort Ascending and Use to sort positions in a dimension based on the values of a measure's slice
Sort Descending icons | for that dimension. For more information, see Simple Sort.

View Area

The view area includes the multidimensional pivot table that displays information for
the relevant task. Each task may include more than one view, and each view can
appear in the contents area. The information in the view is organized based on the
dimension positions set up at the Page Edge, row, and column axes.

The Fusion Client is designed to help you to work with the data within the view. You
can manage the way the information is presented in a view. You can arrange and
present the information in a layout you want by rotating or pivoting dimensions
across the axes, changing the data roll ups, or showing or hiding measures. You can
view the information at a low level of detail or aggregate to view the information at
summary levels. You can also choose to present the information in many types of
charts using the charting functionality.

Block View vs. Outline View
You can view the data within the view in one of two ways:

= Block View enables you to display the data one dimensional level at a time (with
the lowest level expanded in the grid). Figure 2-15 illustrates the block view.

Figure 2-15 lllustration of the Block View

Active Item? | Original Price

W Tomatoes |V Ketchup Private Label Ketchup 14 oz £1.09
Private Label Ketchup 32 oz $1.69

Hunts Kethcup Squeeze Bottle 28 oz $2.39

Hunts Ketchup 14 oz $1.59

Hunts Ketchup 32 oz $2.39

W Sauce, Paste |Private Label Tomato Sauce 8 oz £0.69

Private Label Tomato Sauce 15.5 0z %0.89

Private Label Tomato Paste 5 oz $0.69

Hunts Tomato Paste 5 oz $0.79

= Use the Outline View to view the data at multiple dimensional levels at the same
time, so that you do not need to collapse lower-level dimensions in order to see
aggregate totals for higher levels. Figure 2-16 illustrates the outline view.
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Figure 2—-16 lllustration of the Outline View

Merchandise | Active Ttem? | Original Price

7/ Tomatoes $1.41
W Ketchup $1.83
Frivate Label Ketchup 14 oz %1.09
Private Label Ketchup 32 oz %$1.69
Hunts Kethcup Squeeze Bottle 28 oz $2.39
Hunts Ketchup 14 oz %$1.59
Hunts Ketchup 32 oz $2.39

W Sauce, Paste %0.82
Private Label Tomato Sauce 8 oz %0.69
Private Label Tomato Sauce 15.5 oz 50.89
Private Label Tomato Paste 5 oz %0.69
Hunts Tomato Paste 5 oz %$0.79

To switch between the outline and block views, right click the header of the axis whose
view you want to change and select the relevant view option.

Images

If image-enabled attributes or measures have been configured via Config Tools, you
can see the images displayed in the UL See Chapter 13 for more information about
images in the Ul Images may be displayed as follows:

= Pivot table header. A thumbnail image as an attribute value is displayed for a
specific position in a pivot table. The label can be displayed in addition to the
image or instead of the image. You can hover over the image to see the label
details. See Chapter 11 for details about showing and hiding attributes.

= Pivot table cells. A thumbnail image is displayed as a pivot table cell for measure
cell values. The cell display rules apply to the displayed images. These cells cannot
be edited.

In addition, additional images, displayed in a larger size, can be viewed via a detail
pop-up that has been configured to display a series of images and associated
information. See Chapter 14 for a description of this functionality.

Rotating or Pivoting Dimensions

In the View area, you can rotate or pivot the dimensions across the axes to display data
in different orientations. In the Fusion Client, you can pivot the dimensions (in both
outline and block views) between the view, tiles, and page edge in the two ways:

= Pivot Move — Moves a dimensional layer to another position on an axis.

= Pivot Swap — Swaps a dimension with another dimension on the axis.

Note: When a dimension is swapped or moved to the page edge for
the first time, the first position within the dimension is displayed in
the page edge and the data for that position is shown in the view.
When a dimension that has already been on the page edge during the
current session is returned to the page edge, the position that was last
displayed in the page edge during previous time is shown.

To perform a pivot move in the page edge:
1. In the page edge, click and hold the dimension tile you want to move.

2. Drag the tile next to the area you want and release the mouse.
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Figure 2-17 Pivot Move in the Page Edge

~/| Ttem Level - b o A
EH Scenario |H| ‘ﬁ@\m‘hﬁsi“ﬂ

1 Max Rewvenue |= B |Loca

Bla m | & | [Frd.. ~ 3 @ HmEsm»

To perform a pivot move in the pivot table:
1. From the row or column edge, click and hold the dimension you want to move.

2. Drag the dimension to the location you want and release the mouse.

Figure 2-18 Pivot Move in the Pivot Table

~| Item Level v F g A
[l Scenario 3 EH  Measure
[ Max Revenue|- BA Location| Merchandise |
Y
Bl i | & | [Frd. ¢ ¢ mMEcom A W
Ttem [ Label ] Maote | Active Them? Price | adder

Price Zone 1 | Cranberry Sauce Jelied
Cranberry Sauce Whole
Cut Yams 15 oz

Ttem [Label ]
Cranberr\;'ﬁuce Jellied

Del Monte Diced Peached| prick

Del Monte Diced Peacheq
Del Monte Diced Tomatog

To perform a pivot swap in the page edge:
1. In the page edge, click and hold the dimension tile you want to move.

2. Drag the dimension tile over the one you want to swap it with. Release the mouse.

Figure 2-19 Pivot Swap in the Page Edge

~| Ttem Lewvel v b oy A

B Scenario P E] Measure

= |
rY

To perform a pivot swap in the pivot table:

1. From the row or column edge, click and hold down the dimension you want to
swap.

2. Drag the dimension over the other dimension and release the mouse.
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Figure 2-20 Example of a Pivot Swap Action

~| Tkem Level A
Bl Scenario P B Measure
[T Max Revanue |= BA Merchandise| Location |
e |
_— - e
Bl | b | [Find... ~ & & mMAEcom A 4 W
Price Zone [|] Mote | Active Item? Price Ladder
Price Zone 1
Price Zone [1 Price Zone 2
CranbarapEaiee ihple E| Price Zone 1
Price Zone 2 Price Zone 2
Cut Yahpjmg8n, || Price Zone 1
Price Zon Price Zone 2
Del Mopiz Dired Feadhes Min Max
. Price Zone 1| Price Price Ladder with 0.2 step frci
Price Zone 2 = =
Y rice Zone .
Del Mogte Diced Peaghes MinMax
Price Zome 2 Pr!ce Zone 1) Price Price Ladder with 0.2 step frci
. Price Zone 2
Price Zogne 1 :
Del Mogite Diced Tomftoe| Price Zone 1
Price Zone 2| |Price Zane 2
Del Mogie Piced Jomftoe| Price Zone 1
- - - —
Price Zone 2 ﬂ
Price Zone 1

Note: You can also perform similar actions to switch dimensions
between the Views, Page Edge, and Dimension Tiles areas.

Views Docking Area

The Views Docking Area displays all the views configured within the tab. It enables
you to easily navigate to a view that is not currently visible. When a view is behind
other views, you can click the specific view name in the Views Docking Area to bring
that view back to the front.

When you minimize a view, the view is minimized to the Views Docking Area. A
minimized view can be displayed using the Restore icon to the left of the view name.
To restore a minimized view, you must click the view in the Views Docking Area.

The following figure shows a Views Docking Area of a tab with three views:

Figure 2-21 Example of a Views Docking Area with Three Views

Item Group Level Item Linkage Override 0 Select Constraint Items

In Figure 2-21, the Item Group Level is the current view that is visible. It is the active
view that is highlighted in light blue in the Views Docking Area. The Item Linkage
Override view is hidden behind Item Group Level. The Select Constraint Items view is
minimized and has a Restore icon next to its name in the Views Docking Area.

Resizing Pivot Table Row and Column

You can resize column width and row height along an axis to fit the data into the pivot
table:

= Resizing Single Row and Column

= Resizing Multiple Rows and Columns
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Note that when images are displayed, they will be scaled down proportionally if they
are too large for the available space, but will not be scaled up if they are too small.

Note: When using zoom in the Google Chrome browser on scrollable
components such as Pivot Table, the user must refresh the page to
avoid alignment issues.

Resizing Single Row and Column

You can select a single column and adjust the width. In Figure 2-22, the width of the
DAmR column is adjusted by dragging it to right.

Figure 2-22 Resize the Width of a Single Column

BAR | BOR |TextMea DAmR | DminR | DmaxR  RAmP ||

10000010 Leather Loater | [J  [J : 0.00 -
10000011 Leather Loafer-| (1 [ § 0.00
10000012 Leather Loafer ] ] : [% 0.00
10000013 Leather Loafer | (1 [ 0.00

The width of the DAmR column is increased, as shown in Figure 2-23.

Figure 2-23 Width Increased for a Single Column

BAR BOR |TextMea DAmMR DminR | DmaxR | R

10000010 Leather Loater | L1 [ i
10000011 Leather Loafer - D D |
10000012 Leather Loafer D D E’E f

10000013 Leather Loafer L] O |

You can select a single row and adjust the height. In Figure 2-24, the height of the
10000010 Leather Loafer row is adjusted by pulling it down.

Figure 2-24 Resize the Height of a Single Row

BAR BOR | TextMea DAmMR DminR | DmaxR | RAmP

10000010 Leather Loafer | [ [J 0.00
10000011 Leatier Uoater=1 T3 --=-£ SRRk
10000012 Leather Loafer | [] 0 2 000
1A0NAN12 | aathar | nafar |_| ﬂ n.n0

The height of the 10000010 Leather Loafer row is increased, as shown in Figure 2-25.
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Figure 2-25 Height Increased for a Single Row

. BAR BOR | TextMea DAmR DminR | DmaxR | RAmP RAmpP_
10000010 Leather Loafer

-Black6 B o o 0.00 4334658

10000011 Leather Loafer-| (]  [J 0.00 323435

10000012 Leather Loafer O O & o.00 0.00
=Lo = =

The row height and column width changes are persisted by saving the workbook.
These changes can also be saved as formatting settings. For more information, see
"Saving Formats" in Chapter 5.

Note: If there are no members on the X or Y axis, the row height or
column width adjustments are not persisted.

Resizing Multiple Rows and Columns

You can select multiple columns and adjust the width. The columns can be contiguous
or non-contiguous. In Figure 2-26, the RminD and RminE columns are selected.

Figure 2-26 Select Multiple Columns

B & " Find... - $ @ 5?3@%@1@:30@@

[ BOR RTRoocooooc  RTE RminD RminE | SHS_CLND_W  String | SHS_LOC_CHI
10000010 Leather Loafer D 10.00 abcdefg0.000t XYZ0.00123 XYZ0.00123 .
10000011 Leather Loafer - O 40.00 abcdefg0.000t X¥Z0.00123 X¥Z20.00123 *
10000012 Leather Loafer O 0.00 abcdefgD.000t XYZ0.00123 XYZ0.00123 *
100000132 Leather Loafer D 80.00 abcdefgD.OO0N XYZ0.00123 X¥Z0.00123 .
10000014 Leather Loafer O 60.00 abcdefg0.000t X¥Z0.00123 X¥Z0.00123 *
10000015 Leather Loafer O 0.00 abcdefg0.000t XYZ0.00123 X¥Z0.00123 .
10000016 Leather Loafer D 30.00 abcdefgD.0O0r X¥Z0.00123 X¥Z0.00123 .
10000017 Leather Loafer O 70.00 abcdefg0.000t X¥Z0.00123 X¥Z0.00123 *
10000018 Leather Loafer D 90.00 abcdefg0.000t XYZ0.00123 X¥Z0.00123 L]
10000019 Leather Loafer O 0.00 abcdefg0.000t XYZ0.00123 X¥Z0.00123 -
10000020 Leather Loafer O 0.00 abcdefg0.000t X¥Z0.00123 X¥Z0.00123 *
AMARANT | sathar | nafar M AN ahedafall DONE XYZNAR123 XWZ0 IN123 *

In Figure 2-27, the widths of the RminD and RminE columns are adjusted by dragging
one of the columns to the right. In this figure, the RminE column is dragged to the
right to adjust the width of both columns.
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Figure 2-27 Resize the Width of Multiple Columns

BEm | & Find... -3 @ ﬁmaﬁi@@&ﬂw

BOR  RTRcooocooe  RIE RminD RmnE | SHE_CLND_W  Sting | SHS_LOC_CHI
10000010 Leather Loafer O 10.00 [abedefgd 00 XYZ0.00123  XYZ0.00123 .
10000011 Leather Loafer - O 4000 abcdefgd 000N XYZ0.00123  XYZ0.00123 .
10000012 Leather Loafer O 0.00 abcdefgd 000 XYZ0.00123  XYZ0.00123 .
10000013 Leather Loafer O 80.00 abcdefg0. 0001 XYZ0.00123  XYZ0.00123 .
10000014 Leather Loafer O 60.00 abedefg0. 000t XYZ0.00123  XYZ0.00123 .
10000015 Leather Loafer O 0.00 abcdefgd 000t XYZ0.00123  XYZ0.00123 .
10000016 Leather Loafer O 30.00 abcdefg0d.000h XYZ0.00123  XYZ0.00123 .
10000017 Leather Loafer O 70,00 abcdefgd 000 XYZ0.00123  X¥Z0.00123 .
10000018 Leather Loafer O 90.00 sbodefg0. 000 XYZ0.00123 X¥Z0.00123 ! .
10000019 Leather Loafer O 0.00 abcdefgd 000 XYZ0.00123  XYZ0.00123 *
10000020 Leather Loafer O 0.00 abedefg0. 000t XYZ0.00123  XYZ0.00123 .
10000021 Leather Loafer O 0.00 abcdefg0. 000 XYZ0.00123  XYZ0.00123 .
10000022 Leather Loafer D 0.00 abcdefgd 000 X¥Z0.00123  X¥Z0.00123 *

The widths of the selected columns are increased, as shown in Figure 2-28.

Figure 2-28 Width Increased for Multiple Columns

B a u i Find... * 3 @ oD Ecam 6 W

BOR RTRoo0ooooos RTE RminD RminE SHS_CLND_W String SHS_L(C
10000010 Leather Loafer | [ 10.00 [abcdefg0.00 X¥Z0.00123 X¥Z0.00123 .
10000011 Leather Loafer - O 40.00 abcdefg.000 XYZ0.00123 X¥Z0.00123 .
10000012 Leather Loafer O 0.00 abedefg0.000t XYZ0.00123 XYZ0.00123 .
10000013 Leather Loafer | O 80.00 abcdefg0.000t X¥Z20.00123 XYZ0.00123 :
10000014 Leather Loafer O 60.00 abcdefgd.000 X¥Z0.00123 XYZ0.00123 .
10000015 Leather Loafer ' O 0.00 abcdefg0d.000t XYZ0,00123 XYZ0.00123 .
10000016 Leather Loafer |:| 30.00 abcdefg0.000t XYZ0.00123 XYZ0.00123 L]
10000017 Leather Loafer | O 70.00 abcdefg0.000t XYZ0.00123 XYZ0.00123 *
10000018 Leather Loafer O 80.00 abcdefg0.000t XYZ0.00123 X¥Z0.00123 .

i -am A —— -

If you change the width for a single column that is not part of the selection, the
behavior is same as a single column width change. In Figure 2-29, the RminE column,
which is not part of the selection, is dragged to the left.

Figure 2-29 Resize the Width of a Single Column with Multiple Columns Selected

BOR RTRX00000000C RTE RminD RminEx\/ | SHS_CLI String | SHS_PF
10000010 Leather Loafer | ] 10.00 abcdefgd.0... XYZ.. XYZ0.00123 .
10000011 Leather Loafer ] 4000 abcdefg.0... XYZ... XYZP.00123 *
10000012 Leather Loafer | O 0.00 abcdefg0.0... XYZ.. XYZD.00123 .
10000013 Leather Loafer | O 80.00 abcdefgd.0... XYZ.. Xvz.00123 .
10000014 Leather Loafer O 60.00 abedefg0.0... XYZ... XYZ0.00123 *

Only the RminE column is adjusted, as shown in Figure 2-30.
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Figure 2-30 Width Decreased for a Single Column with Multiple Columns Selected

| BOR RT Roaaaoo: RTE RminD | Rmin SHS_CLI String | SHS_PF
10000010 Leather Loafer | ] 10.00 abecdefgd.0... XYZ... X. *
10000011 Leather Loafer | ] 40.00 abcdefgd0... XYZ... X *
10000012 Leather Loafer | 0 0.00 abcdefg0.0... XYZ.. X. *
10000013 Leather Loafer | ] 80.00 abcdefg0.0... XYZ... X. B
10000014 Leather Loafer | ] 60.00 abcdefgd.0... XYZ... X .

Similarly, you can change the row height for multiple rows. The rows can be
contiguous or non-contiguous. In Figure 2-31, the 10000021 Leather Loafer and
10000023 Leather Loafer rows with the same heights are selected. The 10000023
Leather Loafer row is pulled down to adjust the row height.

Figure 2-31 Resize the Height of Multiple Rows

e m e i e —m e e S

0.00 abcdefg0.000t X¥Z0.00123 XYZ0.00123 a

10000020 Leather Loafer O

10000021 Leather Loafer ] 0.00 abcdefg0.000t X¥Z0.00123 XY¥Z0.00123 =
10000022 Leather Loafer | O 0.00 abcdefg0.000t X¥Z0.00123 XYZ0.00123 &
10000023 Leather Loafer ] 0.00 abcdefg0.000f XYZ0.00123 XYZ0.00123 *
..10000024 Leather. Loafer.......... | I S 0.00.. abcdefg0.000k XX Z0.00323 .. XY Z0.00123. ... Percoreor o
10000025 Leather Loafer D 0.00 abcdefg0.000t XYZ0.00123 X¥Z0.00123 *

The new height is applied to both the selected rows, as shown in Figure 2-32.

Figure 2-32 Height Increased for Multiple Rows

10000019 Leather Loafer O 0.00 abcdefg0.000t X¥Z0.00123 XYZ0.00123 E
10000020 Leather Loafer O 0.00 abcdefg0.000t X¥Z0.00123 X¥Z0.00123 -
10000021 Leather Loafer

-Brown 7B D 0.00 abcdefg0.000t XYZ0.00123 XYZ0.00123 =
10000022 Leather Loafer | D 0.00 abcdefg0.000t XYZ0.00123 XYZ0.00123 *
10000023 Leather Loafer

-Brown 8B [l 0.00 abcdefg0.000t XYZ0.00123 XYZ0.00123 -
10000024 Leather Loafer D 0.00 abcdefg0.000t X¥Z0.00123 XvZ0.00123 -

If you change the height for a single row that is not part of the selection, the behavior
is the same as a single row height change. In Figure 2-33, multiple rows 10000011
Leather Loafer, 10000012 Leather Loafer, and 10000013 Leather Loafer are selected. The
10000016 Leather Loafer row, which is not part of the selection, is pulled down to
adjust the row height.
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Figure 2-33 Resize the Height of a Single Row with Multiple Rows Selected

BOR RTRoooooocod  RTE RminD | Rmin SHS_CLI String | SHS_PRI
10000010 Leather Loafer O 10.00 abcdefg0.000hi X¥Z0.00 XYZ *
10000011 Leather Loafer - O 40.00 abcdefg0.000hi XYZ0.00 XYZ -
10000012 Leather Loafer L 0.00 abcdefg0.000hi XYZ0.00 XYZ -
10000013 Leather Loafer O] 80.00 abcdefg0.000hi XYZ0.00 XYZ -
10000014 Leather Loafer | O 60.00 abcdefg0.000hi XYZ0.00 XYZ *
10000015 Leather Loafer | O 0.00 abcdefg0.000hi XYZ0.00 XYZ :
10000016 Loather Loafer | O 30.00 abcdefg0.000hi XYZ0.00 XYZ *
...10000017. Leather Loafer.......... 10 [ B— 70.08-* abede fg0:008hi XYZ0.00 XY Zr+++wwseeeees P veeetennnes
e el O 90.00 abcdefg0.000hi XYZ0.00 XYZ .

.

Only the 10000016 Leather Loafer row is adjusted, as shown in Figure 2-34.

Figure 2-34 Height Increased for a Single Row with Multiple Rows Selected

Sku [ Label]

|

10000010 Leather Loafer
10000011 Leather Loafer -
10000012 Leather Loafer
10000013 Leather Loafer

10000014 Leather Loafer |

10000015 Leather Loafer II
10000016 Leather Loafer |

-Black9B

10000017 Leather Loafer |
10DANN1R | eather | nafar |

BOR

| Rm
10.00
40.00
0.00
80.00
60.00
0.00

30.00
70.00

100 O00O0OOogo

RTE
abcdefg0.000hi XYZ0.00 XYZ
abcdefg0.000hi XYZ0.00 XYZ
abcdefg0.000hi XYZ0.00 XYZ
abcdefg0.000hi XYZ0.00 XYZ
abcdefg0.000hi XYZ0.00 XYZ
abcdefg0.000hi XYZ0.00 XYZ

abcdefg0.000hi XYZ0.00 XYZ
abcdefg0.000hi XYZ0.00 XYZ

®

| RminD | Rmin SHS_CLI String | SHS_PR

The row height and column width changes are persisted by saving the workbook.
These changes can also be saved as formatting settings. For more information, see
"Saving Formats" in Chapter 5.

Note:

If there are no members on the X or Y axis, the row height or

column width adjustments are not persisted.

Understanding the User Interface 2-21



Contents Area

2-22 Oracle Retail Predictive Application Server User Guide for the Fusion Client



3

Workbooks

When you use an RPAS solution, you interact with the solution through a personal
data repository called a workbook. A workbook contains the subset of the data (and
metadata) from the domain, and its scope is constrained by the access rights available
to a user. Workbooks are stored on the RPAS server and can be built using an online
wizard process or via an automatic batch process.

This chapter describes the various tasks you can perform with the data in the
workbooks. It includes the following sections:

= Saving Workbooks

= Renaming Workbooks

= Calculating Workbooks

= Refreshing Workbooks

s Committing Workbooks

= Synchronized Page Edge Scrolling

Loading Data to Workbooks

When a workbook is opened, the pivot table loads with a block of data from the server.
If, during workbook use, you scroll to a cell outside the limits of that block of data, a
new block of data is loaded from the server. The size of the block of data loaded is
controlled by settings in the rpasConfigure.properties file. (This file is only accessible
to users with permissions to configure settings governing operation of the
application). See the RPAS Administration Guide for the Fusion Client for more
information.

The size of the block of data loaded affects the performance of the application.

= If alarge block of data is loaded, the workbook is slower to open but once loaded,
you can scroll further before reaching cells where another block of data needs to be
loaded.

= If a smaller block of data is loaded, the workbook will open more quickly, but you
will not be able to scroll as far before another block of data needs to be loaded.

This affects the performance of the RPAS solutions. The optimum settings depends on
the amount of data that you need to access when completing workbook tasks. These
settings can vary from retailer to retailer and should be discussed when the application
is being configured. This will ensure the best day-to-day experience.
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Saving Workbooks

Saving Workbooks

On the workbook screen, you can edit the cells in the pivot table, change the layout of
views, and so on. The Save and Save As options enable you to save such workbook
changes.

The Save option is available in the File menu and also as an icon on the toolbar. The
Save As option is available only in the File menu.

Each time you save the workbook, the workbook is first automatically calculated
before the changes are saved. If the calculate or save operation fails, an error message
appears.

To save a workbook:

= After you complete the changes you want, click the Save icon on the toolbar.

Figure 3—1 Save Icon on the Toolbar

File ~ Edit~ View - Format~ | &

> Commit status: Never Committed !-B

or

s From the File menu, click Save.

Figure 3—-2 Save Option in the File Menu

Save

Save As...

Repame...

t
fq‘!# Commit

@Commit Status... ¥ Setting
Page Setup...

Eyprint...

. @ Export...

| f‘e‘g Refresh

Revert

Ctrl4R

Permissible File Names

When saving a workbook (or saving a copy using the Save As command), there are
restrictions on the length of the file name and the characters that can be used.

»  The file name can be a maximum of 32 characters.

s The filename can contain the following standard characters:
- a-z
- A-Z
- 0-9

s The filename can contain the following special characters:
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Saving Workbooks

- §
- &

- spaces

Any file name not meeting these conditions results in an error message.

Save As Option

The File menu also includes a Save As option that enables you to save a copy of the
workbook. It also enables you to set the access privileges for the workbook.

To save a copy of the workbook:

1. With the workbook open, click Save As in the File menu. The Save As dialog box

appears.

Figure 3-3 Save As Dialog Box

Save As
View v | FmRename 3 Delete Find... &3
MName |Task Name |Owner Group |Owner|Mod Date W |Created Date Access  |Domain Mame |Domain Type
untitled Administration adm  Dec 22, 2010 4:56:00 PM Dec 22, 2010 4:56:00 PM USER PCGD Masker IMaster
price-permissionattempt Administration adm  Dec 22, 2010 4:37:09 PM Dec 22, 2010 4:33:39 PM USER PCGED Local & Local
price-analysis 3. Price Analysis Administration adm  Jan 1, 2005 2:20:46 PM  Jan 1, 2005 1:37:19 PM  USER PCGD Local 1 Local
price-analysis_autosaved 3. Price Analysis Administration adm  Jan 1, 2005 11:46:25 AM Jan 1, 2005 11:46:25 AM USER PCGED Local 1 Local
*Name | CannedGoods
* Access | USER
USER
WORLD
Administration

Sawve Cancel

2. In the Save As dialog box, enter appropriate details in the following fields:

s Name - The name of the workbook.

= Access — The access privilege to be set for the workbook. Select one of the
following options:

- User: This is the default option. Select this option if this workbook should
only be accessible to you.

- [Group Name]: Select a group if you want to allow access to all users in
that group who have access to this workbook template.

These other users may have to use View/All or View /Other Domain to
see the workbooks that they do not own and that may be in a domain the
users do not normally work in.

- World: Select this option if you want to allow access to all the users who
use the application who have access to this workbook template.

3. Click Save.
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By default, the Name and Access fields retain the values set for the workbook that
were saved previously. You can also select a different workbook from the list and then
update it to make it a unique name.

Auto-Save

The RPAS Fusion Client has an Auto-Save workbook feature that saves a copy of an
open workbook automatically. Auto-saved workbooks contain all the changes up to
the last Calculate and Custom menu actions.

Note: Cell edits that have not been calculated and formatting
changes made in the previous session are not saved in the auto-saved
workbooks.

The auto-save workbook feature enables you to quickly resume your work in case one
of the following events occur:

= The web browser window is closed before you log out from the RPAS Fusion
Client.

s The web browser window stops responding and closes abruptly.
s The network is disconnected or the web server stops responding.

When one of these events occurs, an auto-save takes place and a copy of the existing
workbook is made. This copy has the same name of the workbook with _autosaved
appended.

After one of these events occurs, you should first notify your administrator. After the
issue is fixed and the servers are restored, you can open a new web browser window,
log onto your domain again, and start using the auto-saved workbook or your last
saved revision of the workbook.

Note: If your implementation uses a clustered configuration and the
web server stops responding, you will be redirected to the RPAS
Fusion Client login page on another managed server that acts as a
fail-over server. You can then log onto your domain and resume work
using the auto-saved workbook.

Renaming Workbooks

When you have a workbook open, you can rename it at any time without affecting the
data within the workbook or the other workbook information, such as the created
date, modified date, formatting information, and so on.

Note the following about renaming workbooks:

= You can only rename workbooks to which you have write access.

= Workbook names can be no longer than 32 characters.

= Workbook names cannot contain double or single quotation marks.
= Workbooks cannot be named “Untitled.” This name is reserved.

To rename a workbook, complete the following steps:

1. With the workbook open that you want to rename, select Rename in the File
menu.
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Figure 3-4 Rename Option in the File Menu

E Save

Save As...

Rename...

@ Commit

2. The Rename Workbook dialog box appears. Enter the new name and click OK.

Figure 3-5 Rename Workbook Dialog Box

Rename Workbook B8

*Mame | CannedGoods

oK Cancel

3. The workbook refreshes and the new name appears in the top right corner.

Figure 3-6 Renamed Workbook

Change password  Logout adm -

Workbook : CannedGoods

onstraint Violat. .. Optimize Prices

You can also rename a workbook from the Open Workbook window or the Save As
window. For more information about this option, see Renaming a Workbook.

Calculating Workbooks

When you edit any cell value within a view, you must calculate the workbook to
review the cells that are updated based on your action. The Calculate icon on the
Quick Access toolbar and the Calculate option in the Edit menu enable you to
calculate the workbook after you edit any cell value in a workbook.

The Calculate option may also affect the number of Real Time Alerts and their
appearance. For example, some real time alerts may completely clear. Other real time
alerts (where there are multiple alerts for a cell) may have one or more alerts cleared,
leaving a different alert visible.

Figure 3-7 Calculate Option on the Quick Access Toolbar and Edit Menu

view ~ Format~ | J&

Reg Pi 55 undo
W B'] Caleulate culeT BBl v 1tem Group Level
Ccut Ctrl+X =l @ e F—
Pr C cotac 3 5 ocation CENario »u T
=0py _ [Price Zone 1 =1 Max Revenus|=
Dt paste coivv HEDE
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When you calculate a workbook, the updated cell value is sent to the server and the
associated cells are recalculated based on the calculation rules already configured.

The formatting for edited cells are removed.

Note: The Calculate option is disabled on the Quick Access toolbar
and Edit menu when there are no changes in the workbook.

To calculate a workbook:

1. In the workbook, edit the cells you want. You can edit the unprotected cells only.
There are some protected measures that you may not be able to edit. When you
edit a cell, the formatting on the edited cell is removed.

Alternately, because of protection processing, some cells are protected while you
are editing other cells.

2. Click the Calculate icon on the Quick Access toolbar.
or

In the Edit menu, click Calculate.

Note: You can also calculate the workbook using the keyboard
shortcut Ctrl + T.

All associated cells are calculated and the updated workbook appears. As a result of
the calculate operation, protected cells may become unprotected if they were protected
as a result of a previous cell edit.

Refreshing Workbooks

When you are working with a workbook, you can update it with the data that is
currently stored in the domain. In this way, you can work with the most current data
without having to rebuild the workbook. However, configured refresh rule expressions
control which measures are updated during the refresh. See the Oracle Retail Predictive
Application Server Configuration Tools User Guide for more information on setting up
refresh rules.

Workbooks can be configured to have a single refresh rule group or multiple refresh
rule groups.

Note: If a refresh rule group does not exist for a workbook, the
Refresh option is disabled.

= Single refresh rule group — These contain refresh rules in a single rule group. This
means that only one rule group is assigned as a refresh rule group in the
configuration of the workbook.
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Figure 3-8 Single Refresh

ﬁ = | Edit + View ~ Format~ | = % Commit status: Never Committed i‘

E Save
Save As... =
5 ~| Item Group Level
Repame...
: t 50 |EH Location| Scenario T
fq‘!# Commit =
) D = [ Price Zone 1]+[1 Max Revenue |-
(G Commit Status... Setting 5
Page Setup... 5 Em | Find... - ¢
5 print. Mote | Apply Constraint | LHS Multiplier
I E - E5 [ | coo001 | Peaches 100.00%
Expaort...
= EXp & €00002 1 100.00%
| B refresh Cirl+R 00003 O 100.00%
3 4 = 100.00%
S | |coooos O
Revert .B 00005 ml 100.00%

= Multiple refresh rule groups — Multiple refresh rule groups are set up and
assigned to a workbook. When there are multiple refresh rule groups, the refresh
options in the Edit menu and in the toolbar have a down arrow that shows a list of
available refresh rule groups. You can choose the specific group to refresh the data
in the workbook. Only one rule group can be selected or applied at a time.

Figure 3-9 Multiple Refresh

h Edit » Wiew v Format « | E B Commit status: Never Committed f-ﬂ £=h 9 ﬁg g ﬂ|—' &

[ zave | AggSpreadLimits AggSpdRefreshol
Save As... ding [ Calendar| Location 5 AgaSpdRefresh0z2
Rename... | - = /122005 «[D102 STRASECURG |«

. tding i) i

| ke Commit , = - n
SO G| Baw o f. -3 9 @0
- E RTRI00000000
Page Setup... | N 10000359 Private Label Chicken Noodle Soup
I IEI Erint... 10000350 Private Label Cream of Mushroom 12/26 oz
| m = 10000351 Private Label Tomato Soup
| o) £d Time ¥ EE
7 Export [} 10000449 Campbell Chicken Noodle Soup 48/10.75 oz.
| fﬁ} Refresh » AggSpdRefresh01 10000450 Campbell Cream of Mushroom 1226 oz,
| Revert AggSpdRefreshn2 10000451 Campbell Tomato Soup 48;10:5 oz,
10000452 Campbell Yegatable Soup 48/10.5 oz,

The refresh rule groups available for use in the Fusion Client are set up in the RPAS
Configuration Tools. To learn how to create these rule groups, see the Oracle Retail
Predictive Application Server Configuration Tools User Guide.

When the refresh option is used, the following occurs:

= When the refresh option is invoked, the Fusion Client runs the calculation before
running the refresh operation.

s The uncommitted data is lost for measures that are refreshed or calculated as a
result of the refresh. If the measure is not affected by the refresh process, then the
uncommitted data is not affected.

= Ifalocked cell has updated data in the domain, the value in the cell changes to the
domain value.

= In general, all locks are ignored and the data is updated with new values from the
domain.

= Itis possible that elapsed time is updated as part of the refresh. When you refresh,
the elapsed setting can be updated; therefore, data for certain periods may become
read-only.
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Committing Workbooks

When you perform a save operation, the changes are saved to the workbook. Unless
these changes are committed to the master domain, the updated information may be
lost if the workbook is deleted or corrupted. You can use the Commit option to merge
the changes you performed in the workbook to the master domain.

You can find the Commit option in the File menu and also as an icon on the toolbar. A
Commit Status option is also available next to the Commit option. Use this to review
the status of the commit requests.

To commit a workbook:

= After you make the changes you want, click the Commit icon on the toolbar.

Figure 3-10 Commit Icon on the Toolbar

File ~ Edit~ Yiew ~ Format~ | B | % Commit status: Never Committed Ty

or

s From the File menu, click Commit.
Figure 3—-11 Commit Option in the File Menu

File Edit v View v Format » | B
Save
Save As...

Rename...

|@ Commit
(i) Commit Status... Setting

Page Setup...
Ebprint...
l @ Export...
R Refresh Ctrl+R
Bge

| i) [ [ [ [ L

When you commit a workbook, a copy of the workbook is added to the commit queue
and the commit status changes to Pending. This status is updated at a set time interval
(which is configurable and defaults to 30 seconds) until the status changes to
Committed. When the system resources are available, the changes are committed to the
master domain. You can continue working on the workbook while the commit
operation is in progress. If any changes made subsequent to the last commit operation
need to be committed to the domain, then another commit operation is required.

Note: The Commit operation is similar to the Commit ASAP option
in the RPAS Classic Client.

The following Commit statuses are available:

s Committed - Indicates that the changes have been committed successfully and no
additional changes have been made.

= Modified - Indicates that the changes have been made (saved or unsaved) since
the last commit.
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= Pending - Indicates that the changes have been submitted to the queue and are
waiting to be processed.

s  In Progress — Indicates that the changes in the workbook are in the process of
being committed.

s Failed - Indicates that the changes were not successfully committed. You may
need to fix any errors in the workbook and try committing again.

Note: If you commit an untitled workbook that has never been
saved, the data is committed; however, the commit status in the
toolbar is not updated until the workbook is saved for the first time.

An information icon is available to the right of the Commit Status. You must mouse
over the Commit Status icon to view the current commit status.

Viewing Commit Statuses

Use the Commit Status dialog box to view the commit statuses for all the workbooks.
In a combined taskflow, all the workbooks across all the domains to which you have
access are displayed.

To view the commit statuses:

= On the Quick Access toolbar, click the information icon located to the right of the
current Commit Status.

Figure 3-12 Commit Status Information Icon

File v Edit~ View~ Format~ | B& | % Commit status: Never Committed figy

s Or, from the File menu, click Commit Status.

Figure 3-13 Commit Status Icon on the File Menu

E Save
Save As...
Rename...

@ Commit

|!?gr:ommi; Status... y Settir

Page Setup...
B print...

@ Export... L

The Commit Status dialog box appears, as shown in Figure 3-14.
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Figure 3-14 Commit Status Dialog Box

Commit Status

view = | Submitter | userl | salution | Task | status Al =l @ (5}
Namne Solution |Task Domnain |Submission Tirne: Owner |Submitter ‘Status |Comp\etion Tirmne: |
Aggregation MFP Agaregation & Spr... PCGD Master May 7, 2012 2:43:... userl userl Committed May 7, 2012 2:43:...
Aggregation MFP Aggregation & Spr... PCGD Local 1 Apr 29, 2012 4:32... userl userl Committed Apr 29, 2012 4:32...

|

Close

By default, the Commit Status dialog box lists the statuses of the current commit
operations. It also enables you to filter the list by the users, solutions, tasks, or status.

To view the commit status based on specific criteria:

1. In the Commit Status dialog box, select the relevant values in the Submitter,
Solution, Task, or Status drop-down lists.

2. After the specific criteria is selected, click the Refresh icon located to the right of
the Status drop-down list.

Showing or Hiding Columns

By default, the Commit Status dialog box displays all the columns. To show or hide the
columns, complete the following steps:

1. On the Commit Status dialog box, click View.

Figure 3—15 View Menu in the Commit Status Dialog Box

=

Commit Status
m Submitter | adm
Columns 4
Detach

t

Reorder Columns. ..
i 20T 2T )
item-mgt-2011 2. Item
price-analysis 3. Price

Show All
+ Name
+ Task
+ Submission Time
" Owner
+ Submitter
+ Status
+ Completion Time

En'ﬁme
05 3:...
2011 ...
2011 ..
2011 ..

2011 ...
2011 ..

2, On the View menu, select the column you want in the Columns submenu.

Reordering Columns

The Reorder Columns option in the View menu enables you to reorder the columns
that appear in the Commit Status dialog box.
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Note: You can also reorder the columns visible in the dialog box by
dragging and dropping them to the position you want.

To reorder the columns:
1. In the Commit Status dialog box, click View.

2. In the View menu, click Reorder Columns. The Reorder Columns window
appears.

Figure 3-16 Reorder Columns Window

Reorder Columns L]

Visibl I

Task

Submission Time
Owner
Submitter
Status
Completion Time

L

K 4

M Cancel

3. In the Reorder Columns window, select the columns you want and click the up or
down arrows to reorder the columns. Click the top (first) and bottom (last) arrows
to move your selection to the top or bottom of the list.

4. Click OK.

Synchronized Page Edge Scrolling

Synchronized page edge scrolling lets you simultaneously scroll through the page
edge of multiple views. When synchronized page edge scrolling is enabled, all views
that contain the same slice dimension scroll to the new slice position when one of
those views is scrolled to a new position. When scrolling disabled, scrolling through
slice positions in one view does not affect the slice position display of other views.

Synchronized page edge scrolling works for all views within a single workbook, and it
remains enabled as you move through the tasks and steps within that workbook.
Synchronized page edge scrolling is useful when you want to compare multiple views
containing the same page or slice dimension.

To enable synchronized page edge scrolling, click Synchronize Page Edge in the View
menu, as shown in Figure 3-17.

Figure 3—17 Synchronize Page Edge Option in the View Menu

Wm = | % Commitstatu

GoTo 3

| Synchronize Page Edge

Automatically Evaluate Position Queries

Resort Positions on Pagination
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When synchronized page edge scrolling is enabled, a check mark appears by this
option in the View menu. In addition, workbooks that are set at the same dimension

levels are refreshed to show the same data within those levels.

Figure 3—-18 Synchronized Views

| Like Ttem Level * ¢ ¢ 7 | v ItemLevel > 4oy A
EA Scenario| Location | E Measure| FA  Scenario|  Location | EH Measure
| 1 Max Revenue =| Price Zone 1 lI B Merchandise | |1 Mazx Revenue = Price Zone 1 '| @ Merchandise
| e |

Bla | & | [Fd - 3 e i | & | [Fnd... ~ 3 & »

Active Ttem? | Price Hold || Active Item? [
Cranberry Sauce Jellied 15 oz ] | | Cranberry Sauce Jelied 15 oz ~
Cranberry Sauce Whole Berry O = ||| Cranberry Sauce Whole Berry =
Cut Yams 15 oz [ Cut Yams 15 oz
Del Monte Diced Peaches 8.5 [ Del Monte Diced Peaches 8.5 o Frice Ladder
Del Monte Diced Peaches 14.9 [wl 1 [v Del Monte Diced Peaches 14.5 Price Ladder ¥
<] il | [>I<]""| [’] {] 1l | [>I<]||||| [)]

In Figure 3-18, the two views, Item Level and Like Item Level, have been
synchronized to show the same data: 1 Max Revenue scenario and the Price Zone 1
location.

Note: The views in Figure 3-18 have been tiled vertically. For more
about the tiling options, see View Menu Options.

After you have enabled synchronized page edge scrolling, you can use the navigation
arrows (Figure 3-19) to view other positions within that level. As you use the
navigation arrows on one view to move to a different position, the other views that
have the same level displayed move to the same position.

Figure 3—19 Navigation Arrows

«| Ttem Lewel  First PrEviOusl, :‘Iext Last - + o A
| | -
El  Merchandise | LDJBHUH'|—| K"(l )I E8 Scenario
| Cranbermy | Cranbemy || Cranbemy Sauce Whole Bery 15 0z |-| Price Zone 2 = B Measure
-

Note: When views do not share the same lowest level of a
dimension, the views do not scroll together.

If you save the workbook with the synchronized page edge option turned on, it is
saved with the workbook. Therefore, when you open the workbook again, the
synchronized option is still enabled.
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Cells

Your ability to edit multiple workbook cells at once and to move chunks of data in and
out of the workbook is essential to using RPAS efficiently and effectively. This chapter
describes how to select and edit cells as well as how to cut, copy, and paste
information into cells. It also provides details about the various tasks you can perform
with the data in cells. It includes the following sections:

= Select and Manipulate Cells

= Navigation Shortcuts for Editing Cells
= Enter or Change Values in a Cell

»  Modify Data with Cell Formulas

»  Clear and Fill Cells in a View

= Modifying Cell Data

s Cut, Copy, and Paste

s Cut, Copy, and Paste Special

= Copy to External and Paste from External
s Read-Only Measures

= Locking and Unlocking

Select and Manipulate Cells

Cells or groups of cells must be selected in the pivot table before certain operations can
be performed on them. Operations such as cutting and copying data, filling or clearing
data cells, and displaying data in chart form are typically performed on a subset of
cells that you must select before invoking the menu command.

Note: Certain cells are read only to prevent them being edited. By
default, read-only cells are indicated by a gray background. Cells are
specified as read only during configuration. This cannot be changed
by the user. For more information, see Read-Only Measures.

There are several ways to select cells in the pivot table. Generally, you should make
your selections in the view axes (where the column and row headers appear) and not
in the cells themselves.
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Navigation Shortcuts for Editing Cells

Note: You cannot select multiple cells for copying or cutting when an
edit is in progress. While an edit is in progress, only the current edited
text is copied. To copy multiple selected cells, click Escape to exit and
then select the multiple cells again.

Select a Single Cell

Click inside the cell. When selected, the cell is shaded. Alternatively, press the F2 key
when the focus is on the cell. This is typically used when the user has used the cursor
keys to navigate from a read only cell into an editable one.

Select all Cells in a Row
Click the row header for that row of cells.

Select all Cells in a Column
Click the column header for that column of cells.

Select a Group of Contiguous Cells in the Same Row
1. Click the first cell in the row of cells you want to select.

2. Hold the Shift key and click the last cell in the group. The cells become shaded.

Select a Group of Contiguous Cells in the Same Column
1. Click the first cell in the column of cells you want to select.

2. Hold the Shift key and click the last cell in the group. The cells become shaded.

Select a Block of Contiguous Cells
1. Click the top-most, left-most cell in the block you want to select.

2. Hold down the mouse and drag the cursor to the bottom-most, right-most cell in
the block that you want to select.

Select a Group of Non-Contiguous Cells
1. Click the first cell you want to select. The selected cell becomes shaded.

2. Hold down the Ctrl key and click the other cells you want to select. All selected
cells become shaded.

Figure 4-1 Non-Contiguous Cells

Wp Sales R F28000.01Y 171575.93 I0MEGLS4 93461.534 135576.9
Wp Sales Reg R 643600.01 DIS6192.31 92153.85 86153.85 1201923
Wp Sales Prome R 70000.00 13461.54 | 10769.23 | 10759.23 13461.5
Wp Sales CIr R 10000.00 1923.08 1538.46 1538.46 1923.0

See the Paste section for information about copying and pasting non-contiguous cells.

Navigation Shortcuts for Editing Cells

When you are editing cells in a pivot view, a number of navigation options are
available that you can use to move to the next cell. Table 4-1 lists these navigation
options.

4-2 Oracle Retail Predictive Application Server User Guide for the Fusion Client



Enter or Change Values in a Cell

Table 4-1 Navigation Options

Action Effect

Tab Move to next editable cell to right
Shift + Tab Move to next editable cell to left
Enter Move to next editable cell below
Shift + Enter Move to next editable cell above

When you use these options, the cell you navigate opens in editable mode (unless the
cell is read-only). To exit editable mode, use the Escape key.

Note: You can also use the Ctrl-Up, Ctrl-Down, Ctrl-Right, and
Ctrl-Left arrow keys to move between cells when editing.

When you navigate to read-only cells or move to cells that are not in editable mode,
you can use the cursor keys.

Note: Use the Escape key to exit Editable mode. Use the Escape
sequence ('#) to revert an edited value and exit Editable mode.

Enter or Change Values in a Cell

The following are descriptions of actions you can take to change individual values in
the pivot table.

Note: The type of data that cells can accept is predefined. If you try
to enter another type of data into the cell, you will see an error
message.

Numbers: Enter or overwrite a numeric value. Some cells may have constraints on the
maximum values that can be entered. If you exceeding this limit, you will see an error
message.

Alphanumeric Values or Plain Text: Enter or overwrite an alphanumeric value. Text
may be entered up to a maximum value of 4096 characters. Any text string that
exceeds this length will be truncated to this value.

Drop-Down List Items: Select the desired option from the drop-down list. Click the
arrow and select an item from the drop-down list. For information about selecting
dimension values in drop-down lists, see Single Hierarchy Select.

Check Box (Toggle) Items: Click the check box to change the status of the item (yes or
no, on or off).

Math Operations: For information about incrementing the value in a cell using a
mathematical formula, see Modify Data with Cell Formulas.

Date and Time Items: Select the desired date and time. (Some measures may be
formatted to display only the date. You can only set the time when the date measure is
formatted to display time.)

Click within the cell to display the Select Date and Time dialog box. Click the
appropriate arrow keys to change the year, month, day, hour, minute, second, and
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AM/PM. (The AM/PM option buttons are available only if the measure has been
configured to use the 12-hour format.)

You cannot enter dates or times outside of the lower and upper bounds for the
measure.

Figure 4-2 Select Date and Time Dialog Box

Sebect Date and Tinee L]
A by v 2011 5 b
SM MON TUE WED THU FRI  SAT
1 2
3 4 a 6 7 i ?
10 11 12 13 14 1% 16
17 18 19 20 21 2 23
24 5 26 27 28 Eli]
I
I = = == =
[1°] ¥ : 0= ~H 9 = ®am Opm

O Cancel
—_—

Modify Data with Cell Formulas

You can use cell formulas to modify the value of a data cell in the pivot table by
applying an operator (+, -, *, or /) to that value. With this functionality, you can make
changes to data values without having to manually calculate the result. To perform
this function, click the data cell and type the operator that you want to add, subtract,
multiply, or divide by.

For example, suppose that a particular data cell contains the value 10.
= Add: If you enter +10 in the cell, the value becomes 20.

= Subtract: If you enter + -10 in the cell, the value becomes 0.

s Multiply: If you enter *10 in the cell, the value becomes 100.

s Divide: If you enter /10 in the cell, the value becomes 1.

= Percentages: If you want to increase the value of a cell by 10 percent, multiply the
value by 1.1 (enter *1.1)

Cell formulas have many applications for modifying data. Cell formulas can only be
applied to one cell at a time, but changes made to aggregate level cells are spread
down to lower-level cells along dimension lines. Similarly, any changes made to lower
level cells are reflected in the aggregates of that data.

Using Math Formulas

In addition to the basic math operations, you can also extend the math operations and
enter formulae in the cells. For example, entering +30/2 in a cell with a value 70 will
add 30 to the existing value, and then divide the result by 2. Entering 10+30/2 in a cell
will update the cell with a value 20.

Overriding Spread Methods

By default, making an edit in the aggregate level cell and calculating spreads the data
based on the spread method of the measure.
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However, you can override the default spread method of a measure and spread the
aggregate data into individual cells using a different spread method. The override
spread methods available are Replicate, Evenly, Proportionally, and Delta. Using this
feature, you can spread data at an aggregate level down to the lower levels in a
dimension.

For example, entering 40r in a cell replicates 40 in the child dimension cells when the
next calculate is performed. The calculation of the spread is done by the RPAS Server.

To override the default spread method, add one of the following letters as a suffix to
the cell value:

Replicate: [value] r A value entered into a cell at an aggregate level is replicated (copied)
into every cell at the aggregate cell's base level. This results in a higher aggregate cell
total (the value entered multiplied by the number of base-level cells).

Evenly: [value]e A value entered into a cell at an aggregate level is evenly distributed
among all cells at the aggregate cell's base level.

Proportionally: [value] p A value entered into a cell at an aggregate level is distributed
proportionally among all cells at the aggregate cell's base level (proportional to the
original values in the base-level cells).

Delta: [value] d The difference between a value entered into a cell at an aggregate level
and the original value of that cell is distributed evenly among all cells at the aggregate
cell's base level.

The spread action is performed after you click Calculate. For more information on
Calculating, see Calculating Workbooks.

Enter Measure Data Using a Scaling Factor

Use the scaling factor feature to enter measure data that will be scaled or factored to an
internal value that is recognized by the server in data calculations. When you enter a
value for a measure that has a scaling factor, the value that you enter is multiplied by
the scaling factor to arrive at this internal value. The display of the data and the ease of
data entry can be greatly enhanced by use of a scaling factor.

For example, suppose that you want to enter data in thousands of units. You might
find it tedious to enter 1000, 2000, 6000, and so on. A more sensible approach is to
enter the values 1, 2, and 6, and have the system apply a scaling factor (in this case
1000) to the entered data. The internal values of the three affected cells are 1000, 2000,
and 6000, and these internal values are used in required data calculations. Removing
the zeros from the display results in a cleaner, less cumbersome view appearance.

Scaling factors can be set in the RPAS Configuration Tools or through the formatting
options in the RPAS Fusion Client. For more information about setting scaling factors
in the Configuration Tools, see the Oracle Retail Predictive Application Server
Configuration Tools User Guide.

To set scaling factors in the Fusion Client, complete the following steps:

1. Right-click a measure. The right-click context menu appears.
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Figure 4-3 Number Formats Option in the Right-Click Context Menu

Akkributes Brand Dernand Lova
Cash Generating 0.0 % 0.0 % 0.0 % r
Exciternent Creating 0.0 % 0.0 % 0.0 % C
Image Enhancing 0.0 % 0.0 % 0.0 % [
Profit Contribution 0.0 % 0.0 % 0.0 % L
Traffic Building 0.0 % 0.0 % 0.0 % L
D T 0.0 % [
Turf Defending Lewels ' 0.0 % [

[T3 3election Cptions r

® EBlock View
Qutling Wiew

Hide Selected Member(s)
Show and Hide ..

Cut Chrl

Copy Chrl4C

Paste Chrl+y Hegders and Cells
Lack Headers

Cells

2] Attributes b Murnber
E%ﬁ Lewvel splitting b Date/Time

Find... Exceplions |

o (RSN (FRETE Dimension Skyles
Format 3

2. Select Format and then select Number. The Format dialog box appears.
3. Select the measure and views for which you want to change the scaling.

4. Enter a value in the Scale option, as shown in Figure 4—4.

Figure 4-4 Setting the Scale Option in the Number Formatting Tab

Format <]

Measure Styles Number Date/Time Exceptions Dimension Styles

~| Filter measures

MName contains Type | Al >| wishlein | Plan Sales and Markdowns | @

~| Apply number formatting

Measure | Wp Sales R | Prefix Show separator [
Suffix Precizion | mived
View | Al x| 1758
— Scale | 1000
- .
format o

Clear Apply

Close

a

For example, if you enter 1000 as the scale factor, then all values in the view are
displayed in thousands, meaning that a value of 35 actually represents 35,000.

5. When finished, click Apply and then Close.

You can use the scale factor for percentages as well. Enter a scale of 0.01 if you want to
see values displayed as percentages, so that you see 19% rather than 0.19.
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Figure 4-5 Using the Scale Option for Percentages

Format [ ]

Measure Styles Number Date/Time Exceptions Dimension Styles

~| Filter measures

Mame contains Type | Al »| vishlein | Plan Sales and Markdowns x| @

~| Apply number formatting

Measure | Wp Sales R | Prefix Show separator |:|
Suffi Predision | mixed
view | Al = v e
— Scale | 0.01
Qs -
format T

Clear Apply
Close

Clear and Fill Cells in a View

Your ability to edit multiple workbook cells and to easily move data in and out of the
workbooks is essential to using RPAS to its fullest extent You can accomplish this by
using the fill and clear functions. These are found in the Edit menu.

Figure 4-6 Fill and Clear in the Edit Menu

WI

Caleulate Cirl+T
Cut Cirl+x
Copy Ctrl+C
Paste Crl+v
Cut Spedial. ..

Copy Special...
Fill...
Clear...

Lock
Find... Cirl+F

Clear

Use the clear feature to quickly clear the contents of cells in a view and set them to
their NA value. With the clear function, you can clear one or more cells, a dimension
level, or an entire slice.

Clear Cells

1. Select the cells you want to clear. In Figure 4-7, the Wp Sales R cells for three
months have been selected.
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Figure 4-7 Cells Selected to be Cleared

~| Plan Sales and Markdowns

R Location| Product P
[Eick & Morar | = [150 Candy |-
Bl i | e | [Frd. -3 mEsmA Y
W FY2027

Feb FY2027 | Mar FY2027 | Apr FY2027 | May FY2027
Wp Sales R 728600.01 | 171576.93 | 104461.54 | 58401.54) 135576.92
Wp Sales Reg R 648600.01 156192.31 92153.85 B86153.85 120192.31
Wp Sales Promo R 70000.00 13461.54 10759.23 10759.23 13461.54
Wp Sales CIr R 10000.00 1923.08 1533.45 1533.45 1923.08

2. Select the Clear option in the Edit menu.

3. The selected cells are returned to their NA value, as shown in Figure 4-8.

Figure 4-8 Cleared Cells

~| Plan Sales and Markdowns

B Llocation| Product P
[ Brick & Mortar | «[ 150 Candy =
Ele i | & | [Fro.. ~$ ¢ mMBEcorm A W
W FY2027

Feb FY2027 | Mar FY2027 | Apr FY2027 | May FY2027
Wp Sales R 728600.01 a2.00 o2.00 0.00)  135576.92
Wp Sales Reg R 548600.01 156192.31 92153.85 86153.85 120192.31
Wp Sales Promo R 70000.00 13461.54 10759.23 10759.23 13451.54
Wp Sales Clr R 10000.00 1923.08 1538.46 1538.46 1923.08

Clear a Dimension Level

The steps for clearing a dimension level vary depending upon which view you are in,
outline or block. In block view, you can click Clear in the Edit menu just as you do
when clearing cells. However, clearing a dimension level in outline view works
differently if more than one level is in the selection.

To clear a dimension level in outline view, complete the following steps:

1. Select the cells you want to clear. In Figure 4-9, the entire Weekly Sales - Regular
measure has been selected and two product dimension levels are selected, Fiscal
Quarter and Fiscal Month.

Figure 4-9 Clearing Dimension Levels

~| Plan Sales and Markdowns > + v 7
Bl Locaton| Product P E Measure
[ Brick & ortar |[ 150 Candy|» B calendar
.|
Ba | & | [Fod. -3 ¢ mEcom A »
Measure [ Label ] | Wip Sales R & & Wp Sales Reg R | Wp Sales Promo R | Wp Sales Cir R
W FY2007 728600.01 ©543600.01 F0000.00 10000.00
Apr FY2007 98451.54 86153.85 10759.23 1538.46
Mar FY2007 104461.54 92153.85 10759.23 1538.496
Jul FY 2007 108461.54 96153.85 10759,23 1538.46
Jun FY2007 110061.54 97753.85 10769.23 1533.46
May FY2007 135576.92 120192.31 13461.54 1923.08
Feb FY2007 171576.93 156192.31 13451.54 1923.08
<] I | [*]
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2. Select Clear in the Edit menu or click Delete. The Clear dialog box appears.

Figure 4-10 Clear Dialog Box

Clear <]

Calendar | Manth

Year
oK Cancel

Manth

3. Select the dimension level you want to clear and click OK. That dimension level
clears in the background.

4. If you want to clear another dimension level, select it from the list and click OK.
When you are finished clearing, close the Clear dialog box.

Clear a Slice
You can clear an entire slice, that is, all data shown in the view.

1. When you open the view, do not select any cell.

If cells are selected, you can deselect them by clicking a dimension tile, opening
the Dimension dialog box, and then clicking OK to close it.

2. With no cells selected in the view, click Clear in the Edit menu.

3. A message appears, stating "Entire slice will be cleared because nothing is
selected.” Click OK.

Figure 4-11 Clear Entire Slice Message
Clear >

Entire slice will be deared because nothing is selected.
QK Cancel

The entire slice is cleared. If any read-only cells exist in the slice, you see a message
informing you that the read-only cells have not been cleared.

Figure 4-12 Fill/Clear Message: Ignored Read-Only Cells
r,ﬁ Fill/Clear Message m1

Some of the selected read-only cell(s) have been ignored in this operation.

oK |

If all selected cells are read-only, an error message appears, stating that none of the
selected cells were editable and therefore the clear did not occur.

Undo Clear

To undo any type of clear, click Undo in either the Edit menu or the quick access
toolbar. However, after the Calculate function is invoked, the Undo option cannot
reverse the clear.
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Fill

4-10

Use the fill feature to quickly populate many cells of a writable measure at a time.
Depending on which view you are using, outline or block, one of the following dialog
boxes appears.

Note: The fill feature cannot be used for hyper-dynamic pick lists
because the list of available selections may vary from cell to cell.

Figure 4-13
Fill
* Measure
*Fill Value

Spread Method

Figure 4-14
Fill
* Measure
*Fill value
Location

Spread Method

Fill Dialog Box in the Block View

-]
Wp Shrink R v
1250.00)
Replicate
Even
Proportional
Delta

Do not spread to NA value

ﬁ Cancel

Fill Dialog Box in the Outline View
<]
Wp Shrink R ™
1250.00
Channel [+
Replicate
Even
Proportional
Delta

Do not spread to NA value

ok | gl

As shown in Figure 4-14, the outline view has additional dimension level fields. These
are available whenever multiple dimensions are displayed in the outline view. You
must choose which dimension level you want to fill with data.

To use the fill feature, complete the following steps.

1. Select what you want to fill. In Figure 4-15, the Wp Sales R measure for 100
Non-food Consumer Goods is selected. Its lower level has four positions within it.
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Figure 4-15 Selecting a Cell to Fill

~| Plan Receipts [ Inventory - G o A
@ Location| Calendar 3 EH  Measure
[[Brick & Mortar |=[1/27/2007 |» j@ Product
|
Bl i | & | [Fro. >4 ¢ @BMAEEcamA M >
Wp Sales R Ly Sales R. | Wp Markdown R wg |
W 100 Mon-food Consumer Goods 0.00 0.00 0.00 [
450 Home Theater 0.00 0.00 0.00 =
700 Electronics 0.00 0.00 0.00
750 Books Reference 0.00 0.00 0.00
900 Personal Care 0.00 0,00 0.00 .
T 200 Dumsar — L) o 8 V
< 1l >

2. With a cell selected, click Fill in the Edit menu.The Fill dialog box appears.

Note: If no cells were selected before the fill feature was invoked, all
cells within the measure that is selected in the Fill dialog box are filled.
The fill applies to the current slice only.

If only a few cells were selected in the grid, only those selected cells
are filled.

Figure 4-16 Fill Dialog Box

Fill <]
*Measure | Wp Sales R [
*Fill Value 152400.00
Product | Group [+

Spread Method &) Replicate

@ Ewven
&) Propaortional

iy Delta

[] Do not spread to NA value

ﬁ Cancel

3. Choose the measure you want to fill in the Measure field. If you select only one
measure, as in the previous example, only one option appears.

4. Enter a value in the Fill Value field. The measure you select determines the type of
data you can input as the fill value. For instance, if you choose a Boolean type
measure, only true or false are available options for the fill value.

5. In the next field, select the level of the dimension that you want the fill to apply to.
The name of this field varies according to the dimension you select.

6. Select the spread method to use to distribute that fill value among the lower levels
that belong to the dimension level you select. For the spread method, choose
among the following:

= Replicate: Any value filled into an aggregate level cell is replicated exactly to
every base level cell that comprises the aggregate total.
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= Even: Any value filled into an aggregate level cell is spread evenly among that
cell's lower level constituents.

= Proportional: Any value filled into an aggregate level cell is spread
proportionally among all lower level constituent cells. This is based on the
content of the cells before the fill.

= Delta: The difference between the value pasted in the aggregated cell level and
the original value of the aggregate cell level is spread evenly among all
lower-level constituent cells.

Note: The Spread Method options are disabled when the base or
lowest level of a dimension is selected. They are disabled because it is
not possible to spread a fill value to lower levels if the lowest level is
already selected.

7. Decide whether you want the fill value to be spread to cells that currently have an
NA value. If you select Do not spread to NA Value, the fill value data is not
spread to lower level cells that contained an NA value before the fill. The NA
values are left intact, and the aggregate data is spread to the remaining lower level
cells.

Note: The Do not spread to NA value option is only enabled if the
spread method option is enabled.

8. Click OK when finished. The Fill dialog box disappears.

Note: If some of the selected cells are editable and some are
read-only, a message appears stating that the read-only cells have been
ignored.

In the view, the new fill value appears in the cell. It is shown in italics because it
has not been calculated or saved yet.

9. Click Calculate. The view refreshes and the fill value is now distributed
throughout the lower levels. In Figure 4-17, the fill value is distributed evenly
among the lower levels.

Figure 4-17 Fill Value Distributed Among Lower Levels

~| Plan Receipts [ Inventory - G o A
[FH Location| Calendar 3 EH  Measure
[[Brick & Morzar |=[1/27/2007 |» j@ Product
|
Bl i | & | [Fro. ~ ¢ ¢ @mMAEcamA M >
Wp Sales R Ly Sales R. | Wp Markdown R wg |
% 100 Mon-food Consumer Goods 152400.00 0.00 0.00 [
450 Home Theater 38100.00 0.00 0.00
700 Electronics 38100.00 0.00 0.00
750 Books Reference 38100.00 0.00 0.00
900 Personal Care 38100.00 0.00 0.00 i
T 0N Dmsar | noan n onan non [-]
< ¥
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Fill from Pivot Table Toolbar (Quick Fill)

Use Quick Fill to replicate a value from one cell into other cells directly in the pivot
table. To use Quick Fill, click the Quick Fill icon in the toolbar. The icon is shown in the
following figure:

Figure 4-18 Quick Fill Toolbar Icon

v| Aggregation & Spreading

.E Calendar | Location P

- P R a Quick-fill toolbar button
Blaw | Fo. -0 G |BmismaWa
[ [ ramp rampp ravgd ravge rav

Quick Fill works in a similar way to copy and paste, except it copies the fill value from
the top left cell of your selection and pastes it to the other selected cells. Your selection
can include cells of the same measure or cells of different measures, as long as they are
of a compatible type. Quick Fill is slightly different from Fill using the edit menu.
Quick Fill can be used in outline or block mode.

Note: After using Quick Fill, you can do a calculation using the
quick access toolbar or the calculate edit menu option. The updated
cell value is sent to the server, and the associated cells are recalculated
based on the calculation rules already configured.

To use Quick Fill:

1. Make a selection in the pivot table where the upper left cell is the value you want
to copy into the other selected cells. If you want to fill a different value to the
selected cells, change the top left cell value.

In the example shown in the following figure, some of the cells are selected.

Figure 4-19 Quick Fill Selected Cells

v| Aggregation & Spreading

.ﬂ Calendar| Location P

e -(SueERsRorRa - Quick-fill toolbar button
Baw bl . -~ ¢ [Floiseaas e
| ramp T rampp ra‘t'gd ravge ravgp ravgpe ravgpp rITlII'Id
10000008 Z*Test - To be deleted 0.00 0,00 0.00 1,00 0.00 0.00 0.00 0.00
10000010 Leather Loafer - Black 6 B 0.00 45.00 0.00 1.00 0.00 0.00 0.00 0.00
10000011 Leather Loafer - Black 6.5B | 0.00 0.00 0.00 1.00 0.00 0.00 0.00 0.00
10000012 Leather Loafer - Black 78 0.00 0.00 0.00 1.00 0.00 0.00 0.00 0.00
10000013 Leather Loafer - Elack 7.5B 0.00 0.00 0.00 1.00 0.00 0.00 0.00 0.00
10000014 Leather Loafer - Black 8 B 0.00 0.00 0.00 1.00 0.00 0.00 0.00 0.00

2. Click the Quick Fill icon, as shown in Figure 4-19.
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Figure 4-20 Quick Fill Updated Cells

~| Aggregation & Spreading

B} Calendar| Location >

[171672010 ~ [ 0102 STRASBOURG | *
= -3 ¢ [Blmicsmaad
ramp ampp ravgd ravge ravgp ravgpe ravgpp rmind
10000008 Z*Test - To be deleted 0.00 .00 0.00 1.00 0.00 0.00 0.00 0.00
10000010 Leather Loafer - Black 6 B 0.00 top-leftg oo 1.00 0.00 0.00 0.00 0.00
10000011 Leather Loafer - Black 6.5 B . 0.00 0.00 0.00 0.00
10000012 Leather Loafer - Black 78 0.00 0.00 4500 4500 4500 4500 0.00 0.00
10000013 Leather Loafer -Black 7.5B 0.00 0.00 0.00 1,00 0,00 0.00 0.00 0.00
10000014 Leather Loafer -Black 8 8 0.00 0.00 0.00 1.00 0.00 0.00 0.00 0.00

The system fills the data (top left cell's value) into the selected cells. If some of the
selected cells do not match the data type of the fill value (data type of top left cell
from the selections), or some of the selected cells are in read-only mode, the
system ignores those cells and fills the rest of the cells.

A warning message is displayed if some or all of the selected cells are ignored.
Here are examples of a few of the warnings that may be displayed:

s When the selection contains all editable cells, but some of them are a different
data type.

Figure 4-21 Quick Fill Warning Message Example 1

~| Aggregation & Spreading v 4+ v 2
B Calendar| Location| >3 J@ Measure |
[2/1272505 - [OT07 STRASBOURG] M product
. & Warning ﬂ ]
Ela | & | [F. -
| ramp Some of the selected cell(s) could not be filled because they have an incompatible type. rava

10000008 Z*Test - To be deleted 0.00 @ 0.0C
100000 10 Leather Loafer - Black 6 0.00 L 0.00
100000 11 Leather Loafer - Black 0.00 0.00 0.00 0.0C
10000012 Leather Loafer - Black 7 000 | 2400 0.00 0.00 0.0C
10000013 Leather Loafer - Black 000 | 2400 0.00 0.00 0.0¢
100000 14 Leather Loafer - Black 8 0.00 0.00 0.00 0.00 0.0C

= When the selection contains editable, read-only, incompatible data type cells.

Figure 4-22 Quick Fill Warning Message Example 2

v| Aggregation & Spreading

B8 Calendar| Location| &\ warning m

2/12/2005 |« [ 0102 STRASECU
Some of the selected cell(s) could not be filled because they are read-only or have an incompatible type.
Baw & F

10000008 Z*Test - To be deleted
10000010 Leather Loafer - Black &
10000011 Leather Loafer - Black
10000012 Leather Loafer - Black 7
10000013 Leather Loafer - Black

INNNNN1A | asthar | Asfar - Rl 2

;EEEEE

s When the Quick Fill icon is clicked and one cell or no cell is selected in the
view.
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Figure 4-23 Quick Fill Warning Message Example 3

~| Aggregation & Spreading - 4+ v 2
B2 calendar| Location| > 3 B8 Measure
[2/12/2005 =[0102 STRASECURG | jm Product
.
Bl il | & | [Frd. >~ @ BPmEcom @ 4w
ramp rampp ravgd ravge damr [
10000008 Z*Test - To be deleted 0.00 0.00 0.00 1.00
10000010 Leather Loafer - Black 6 0.00 0.00 0.00 1.00
100000111 , , -
10000012 | & Warning
10000013L MNothing is selected. Please make a selection to be filled with its first cell value.
10000014 L
10000015 L OK I
100000 16 Leaws= . e
10000017 Leather Loafer - Black 0.00 0.00 0.00 1.00

10000018 Leather Loafer - Black 0.00 0.00 0.00 1.00

After you use Quick Fill, as with any other edit, values that have not been
calculated or saved yet are shown in italics. If the top left cell has an undefined or
ambiguous value, the fill operation is not completed and the following warning
message is displayed: "Cannot Fill using a value that is ambiguous or undefined."

If you are in outline view with multiple levels selected, you can still use Quick Fill,
but when a calculation is completed, the system may only honor the edit at one of
the levels.

Spread Method Quick Fill applies the fill value to the selected cells using the cells’
default spread method, even when the value originally entered in the top left cell has a
different spread method. For example, if you enter a value into the top left cell with a
spread char, such as 101, and quick fill that value to a selection, the filled cells do not
use a spread method of r, unless that is their default spread method.

When you click the Quick Fill icon, the system fills the value to the selected cells that
have same data type.

When you click Calculate, the view refreshes and the fill value is distributed
throughout the lower levels. The spread method replicate (r) applies to the top left
cell's measure only and values for rest of the edited measures use the measure's
default spread method.

The following example illustrates how the spread method works. The example uses
two measures, rampp and ravgd.

Measure Default Spread Method
rampp RATIO
ravgd delta (d)

Figure 4-24 shows the initial cell values.
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Figure 4-24 Quick Fill Initial Values

rampp ravgd
V 60 Soup* [ 0.00 000
10000358 Private 0.00 0.00
10000360 Private 0.00 0.00
10000361 Private 0.00 0.00
10000443 Campbell 0.00 0.00
10000450 Campbell 0.00 0.00
10000451 Campbell 0.00 0.00
10000452 Campbell 0.00 0.00
10000453 Campbell
Black Bean Soup 0.00 0.00

Figure 4-25 shows the 25r (replicate spread method) entered into the top left cell.

Figure 4-25 Quick Fill with Value Entered in Top Left Cell

rampp ravgd

V 60 Soup*® | 251) 0.00

10000359 Private 0.00 0.00

10000360 Private 0.00 0.00

10000361 Private 0.00 0.00

10000449 Campbell 0.00 0.00

10000450 Campbell 0.00 0.00

10000451 Campbell 0.00 0.00

10000452 Campbell 0.00 0.00
10000453 Campbell

Black Bean Soup 0.00 0.00

7 M Damar® N AN nnn

Figure 4-26 shows the results after you click the Quick Fill icon.

Figure 4-26 Quick Fill Updated Cells

V 60 Soup™
10000359 Private
10000360 Private
10000361 Private
10000443 Campbell
10000450 Campbell
10000451 Campbell
10000452 Campbell

10000453 Campbell
Black Bean Soup

T .- -

Figure 4-27 shows the cells after a calculate.
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Figure 4-27 Quick Fill Cells After Calculate

rampp ravgd
¥ 60 Soup™ 25.00 313
10000359 Private 25.00 313
10000360 Private 25.00 313
10000361 Private 25.00 313
10000445 Campbell 25.00 313
10000450 Campbell 25.00 313
10000451 Campbell 25.00 313
10000452 Campbell 25.00 313
10000453 Campbell
Black Bean Soup 25.00 3.13

After you use Quick Fill, when the system fills the value to the selected cell and when
you calculate, the replicate spread method is applied to the rampp measure and the
measure's default spread method (ratio) is applied to the ravgd measure. The final
results are shown in Figure 4-27.

Undo Fill

To undo a fill, click Undo in either the Edit menu or the quick access toolbar. Note that
once the Calculate function is invoked, the Undo option cannot revert the fill.

Modifying Cell Data

Revert Cell

In the view, you can make changes to the data cells. You can make the edits by directly
typing or updating a value in the cell, copying and pasting, or by importing changes
from a file. You can also lock a cell value by clicking the Lock icon on the View toolbar.
This ensures that any calculation performed during the cell edits do not affect the
locked cell values.

In the Fusion Client, you can modify workbook data in the following manner:

1. Click on the cell that you want to edit. Alternatively, navigate to the cell using the
cursor keys and press F2.

2. After you enter or change the value in the cell, you can navigate to any other cell
by double-clicking on that cell or using the following keyboard keys to navigate:

= Enter to scroll down.

= Shift + Enter to scroll up.
= Tab to scroll right.

= Shift + Tab to scroll left.

To learn how to modify data with math formulas, see Modify Data with Cell Formulas.

After you complete an edit action, you can revert the cell to the last calculated value
using the Revert Cell option in the right-click context menu. The Revert Cell feature
works on a cell-by-cell basis. When you click Revert Cell, the edited cell reverts to the
last saved or calculated value. Changes up to the last saved or calculated value are
available in the Undo list.
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Protection Processing

Protection processing is the process that makes some cells within a workbook
read-only to ensure that during edits no conflicts occur within the RPAS engine in a
Calculation Cycle. There are two types of protection processing:

= Measure Protection Processing — Locks cells in all the displayed views based on
the measures that have been edited.

= Dimension Protection Processing — Locks cells based on the dimension
intersections that have been edited.

Protection processing runs each time when a workbook with any locked cell or
measure is opened, a cell is edited, a cell or measure is locked, and after each cell
revert action. It runs only once when a group of cells is updated in one action.
Protected cells or measures appear highlighted in a different color in the view. This is a
configurable feature.

Measure Protection Processing

In measure protection processing, cells become read-only when you make changes to
enough measures. This ensures that there are no more possible changes that may cause
conflicts.

For example, consider six measures (A, B, C, D, and E) set up with the following two
rules:

" Rulel1-A=B+C
" Rule2-B=D+E

In this scenario, both A and B are read-only before any edits are applied. Although B
appears to be editable, since there are no reciprocal expressions for B's relation to D
and E, it is not editable. Measures C, D, and E, however, are editable.

Typically, rule definitions are set up to include all equivalent derivations of any
expression. This ensures that you can edit all of the measures contained in any
expression in the rule.

Considering the previous example, Rules 1 and 2 will be configured as:
= Rule1 A=B+C, B=A-C,C=A-B
= Rule 2 B=D+E, D=B-E, E=B-D

In this case, all measures are editable before you make any changes and the measures
remain editable based on the edits you make.

Measure protection processing locks all instances of a measure when any position of
the other measures in the rule are edited.

For example, consider the Rule 1 in a typical Product, Location, Calendar dimension.

When you edit the measure B for product 1, location 1, and week 1 and measure C for
product 1, location 1, and week 2, the measure A becomes read-only for all products at
all locations in every week.

Dimension Protection Processing

Changes to cells at the aggregated levels occur during a spread action that changes
values down to the base intersection of a measure. Dimension protection processing
protects the intersections (combination of levels) to ensure that all changes made
during the spread do not affect such a spreading path.
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Considering the typical retail dimensions, the process applies at
product:color-location:store-calendar:week and product:style-location:region-calendar:month.
These two intersections are on the same path from the root to leaf. If the location
dimension has roots for both region/state and Store Volume, any edit to a cell in the
Volume Group dimension causes all cells included in an intersection with a
company /region/state/city to become read-only.

Figure 4-28 Location Dimension Example for Dimension Protection Processing

Region

Dimension protection processing changes to the intersection of dimension and level
are processed, and edits are allowed to cells as long as the edits are on one path from
the root to the leaf level.

Single Hierarchy Select

If a measure has been set up to have dimension values as inputs, the measure cell
displays a drop-down list of positions, as shown in Figure 4-29.
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Figure 4-29 Single Hierarchy Select

~| Set Initial COE Parameters - 4 oy A

B Product > 3 B Measure|
[A-28 PARKS DIVISION/RED SIERRA |« ER Location

]
B E il | & | [Find... ~ ¢ & @WMBE »

COE Initial EQL Exit Week | COE Initial EOL Sell Thru % | COE Initial EOL 54

PZ1 = 0.0%
pz2| 10/8/2011 [] 0.0 %

Pz 3| 10/15/2011 0.0 %
pz 4| 10/22/2011 0.0 %
10/29/2011
11/5/2011
11/12{2011
11/19/2011
11/26/2011
12/3/2011
12/10{2011
12/17/2011
12/24/2011
12/31/2011
1/7/2012
1/142012
1/21/2012
1/28/2012
Seardh. ..

£ ] it [ >

For example, a Week Mapping measure can be configured to have the week position of
the Calendar dimension as an input. The selection of the dimension is configured in
the domain configuration for a measure.

You can either select a value from the list or click Search at the bottom of the panel, as
shown in Figure 4-30.

Figure 4-30 Single Hierarchy Search

1/14/2012
1/21f2012
128017

Search. ..

< |

< ] M

The Search link launches the Search dialog box, where you can search for specific
values. The search dialog box automatically opens on the Advanced search option
(Figure 4-31).
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Figure 4-31 Single Hierarchy Search Dialog Box, Advanced

Search [ ]

~|Search Basic
*Required Operators for Week

*Week | Contains v |
Starts With

Does not Contain Search | Reset

Equals

Week | Mot Equals
Contains (|
1292 DLEnds With
2/5/2000
2/12/2000
2/19/2000
2262000
3/4/2000
3/11/2000
3/18/2000
3/25/2000
4/1/2000
4/8/2000
4/15/2000
4/22/2000
4/29/2000
5/6/2000
5/13/2000

[ Tl T Tt

o
ﬂ Cancel

To use the basic search, click Basic. The Search dialog box refreshes with the basic
search tools (Figure 4-32).

Figure 4-32 Single Hierarchy Search Dialog Box, Basic

Search B
~|Search Advanced
* Required
*\Week |Starts with [+

Search | Reset

Cut, Copy, and Paste

The cut, copy, and paste features provide flexibility to edit the workbook according to
the business needs and transfer data from external applications (such as Microsoft
Excel) to the system as well as from RPAS to those external applications.

To apply the operation, select data from the view. After selecting the appropriate cells,
you can cut, copy, and paste. For more information, see the Cut, Copy, and Paste
sections or Cut, Copy, and Paste Special and Copy to External and Paste from External.
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Cut

Note: The maximum number of cells that can be copied, cut, or
pasted is limited by memory. These operations should not be used to
export entire workbooks. For more information, see Export.

You cannot cut or copy multiple cells when an edit is in progress.
While an edit is in progress, only the current edited text is copied. To
copy multiple selected cells, click Escape to exit and then select the
multiple cells again.

Date and Time Data Handling in Cut/Copy/Paste Operations

Since date and time measures can be formatted to display no time, 12-hour formatted
time, or 24-hour formatted time, date and time data is handled differently when it is
cut, copied, or pasted.

When date and time data is cut, copied, or pasted internally, the full date and time
data is captured, regardless of whether the measure is formatted to display the full
date and time. If the measure is formatted to display no time and no time is entered in
the cell, RPAS stores the time as 00:00:00 and is displayed as 12:00:00AM in 12 hour
format and 00:00:00 in 24-hour format.

When date and time data is cut, copied, or pasted externally, you have two options:
= The As displayed option copies the data with its formatting
= The Raw value option copies the data without its formatting

If time data is stored in a cell but is not displayed due to the measure’s formatting,
when that data is pasted to a 12-hour or 24-hour formatted cell, the time data is
reformatted to match the destination cell’s formatting. Similarly, when time data is
copied from a 12- or 24-hour formatted cell to a cell with no time formatting, the data
is pasted but the time is not displayed. If a time is copied from a 12-hour formatted cell
and pasted to a 24-hour one (or 24-hour to a 12-hour), the data is converted
automatically during the copy/paste operation.

For more information about time formatting, see Modifying Date/Time.

Use this procedure to copy and remove data from the cells of a view in order to move
the data to another view or other applications. Note that data created from deferred
calculations can be cut.

Notes: You cannot cut data from non-editable or read-only
measures.

To cut data, complete the following steps:
1. Select all data cells in the pivot table that you want to cut.
2. To cut the data and copy it to the clipboard, use one of these three methods:

s From the Edit menu, click Cut.
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Figure 4-33 Edit Menu - Cut

i Caloulate Ctrl+T
Cut Ctrl+¥
Copy Ctrl+C
Faste Cirl+v

= Right-click and select Cut from the right-click menu.

Figure 4-34 Right-click Menu - Cut

[E3 selection Options k
Cut Ctrl+x
Copy Ctrl+C
Paste Ctrl+v

Lock

If>::‘:| Level splitting k
Find...

Format L4

s Use the shortcut command Ctrl + X.

3. Data from the selected cells is copied to the clipboard. The selected cells now
contain NA values.

4. To paste the data to other cells or to another application, see the Paste section.

Note: To remove the last deferred entries after using the cut option,
right-click and select Revert Cell from the right-click menu. Or, use
the shortcut option Ctrl + Z. You can also select the Undo option.

Copy

Use this procedure to copy selected data to the application clipboard. Unlike the cut
function, the copy function does not clear the data from the view cells. It keeps data in
a clipboard that you can use to transfer data within RPAS as well as to an external
application such as Excel. It also helps you to transfer large amount of data easily.
When cells are copied, only the unformatted textual content is transferred.

When data is copied from a cell to the clipboard, the string representation of the cells is
copied to the clipboard so that it can be pasted into either other cells in the pivot table
or to external applications. Data containing deferred calculations can also be copied.
There is no need to invoke Calculate before copying.

Table 4-2 shows what is actually copied to the clipboard, based on cell (measure) type.
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Table 4-2 Copied Data

Cell (Measure) Type

Behavior

Boolean True, or checked, values are copied as 1. False, or unchecked, values are copied as 0.

Date/Time The formatted date is copied and visible in the cell. If the measure is configured to
contain the time, the time is copied as well.

Integer The formatted number as displayed in the cell is copied. Prefixes and suffixes, such
as $ or %, are copied as well separators.

Picklist The value displayed in the cell is copied.

Real The number as displayed in the cell is copied. The format, such as $ and %, is

copied as well.

Single dimension

The value as displayed in the cell is copied.

String

The value as displayed in the cell is copied.

To copy data, complete the following steps:

1.
2.

Select all data cells in the pivot table that you want to copy.
To copy the data to the clipboard, use one of these three methods:
= From the Edit menu, click Copy.

Figure 4-35 Edit Menu — Copy

Caleulate CHrl4T
Cut Cirl+x
Copy Ctrl+C
Paste Cirl+v
Cut Special. ..

Copy Special...

= Right-click and select Copy from the right-click menu.

Figure 4-36 Right-Click Menu — Copy

[T selection Options C

Lock

E}:fﬂ Level splitting 2

Cut Cirl+x
Copy Ctrl+C
Paste Cirl+v

Find...

Format L

s Use the shortcut command Ctrl + C.
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Paste

Note:

If no cells are selected, the Edit menu and right-click options
are grayed out. If no cells are selected when the Ctrl +C method is
used, a warning message appears that states, “No positions have been
selected for this operation.”

The selected cells are copied to the clipboard.

After you have copied or cut data from a view, you can paste the data to other cells
within the RPAS Fusion Client or you can paste it to an application such as Excel. The
Paste option pastes the data that was last placed on the clipboard into the selected

cells.

Note:

Although non-contiguous data cells can be copied, they cannot
be pasted as non-contiguous cells. Data copied from non-contiguous
cells does not maintain the pattern in which it was copied. For
information about selecting non-contiguous cells, see Select a Group
of Non-Contiguous Cells.

To paste data, complete the following steps after you have copied or cut data from
another location:

1. Select the cells into which you want to paste the data.

2. To paste the data into the cells, use one of these three methods:

s From the Edit menu, click Paste.

Figure 4-37 Edit Menu — Paste

Calculate
Cut

Copy
Paste

Crl+T
Ctrl4¥
Ctrl+C
Ctrl4v

= Right-click and select Paste from the right-click menu.

Figure 4-38 Right-Click Menu — Paste

[ selection Options
Cut
Copy
Paste

Lock

If>:'E| Level splitting
Eind...

Format

Cirl+x
Ctrl+C
Ctrl+v

[ 3

s Use the shortcut command Ctrl + V.
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Note:

If protection processing does not allow data to be pasted into

the selected cell, the paste operation is aborted.

Cut, Copy, and Paste Special

The following sections describe the cut, copy, and paste special features.

Cut Special

You can also cut data at the base level or higher level intersection across page slices. If
multiple levels (such as product group or style) are represented in the pivot table
selections, the cut option is performed at the lowest level actually selected. After data
is cut from the selected cells, it can be pasted into other selected cells in the pivot table.
To cut data, complete the following steps:

1. Select all data cells in the pivot table that you want to cut.

2. From the Edit menu, click Cut Special.

Figure 4-39 Edit Menu — Cut Special

i Caloulate
Cut
Copy
Paste
Cut Special. ..
Copy Spedial...

Cirl+T
Cirl+x
Cirl+C
Ctrl+v

3. The Cut Special menu appears.

Figure 4-40 Cut Special Menu

Cut Special

Cut all slices

(=) Cut selected level (Price Zone, Style/Color, {2})

() Cut at base level (Price Zone, Style/Color, {2})

ﬂ Cancel

Select from the following options:

= Cut all slices: This option is enabled only if the current workbook view
contains more than one page slice. Otherwise, this option is disabled. When
this option is selected, the cut operation behaves as if all positions in the slice
dimension’s levels were selected prior to the cut. If the box is left unchecked,
only the data from the current slice position is cleared and copied.

n  Cut selected level: This option cuts only the selected level of data.

= Cut at base level: This option allows you to cut the data at the measure’s
lowest intersection. Although the cut function is performed at the base level, it
seems that the aggregated level data has been cut since the data is rolled up.
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Copy Special

You can also copy data at the base level or higher level intersection across page slices.
After data is copied from the selected cells, you can paste data to other selected cells in
the pivot table. This feature allows you to view data at an aggregate level while
copying data at a dimensional level not currently displayed or while selecting data
from the current slice while copying data from all slices. You can copy data at the base
level only or copy from all slices without selecting the base level data or without
selecting data from entire slices.

Note: Data copied using the Copy Special option is not copied to the
clipboard. It is copied to the RPAS server.

To copy data, complete the following steps:
1. Select all data cells in the pivot table that you want to copy.
2. From the Edit menu, click Copy Special.

Figure 4-41 Edit Menu — Copy Special

Calculate Cirl+T
Cut Cirl+x
Copy Ctrl+C
Paste Cirl+v
Cut Special. ..

Copy Spedial...

Copy to External...
Paste from External...

Fill...

Clear...
Lock

Insert Measures...

ind... Ctrl+F
3. The Copy Special menu appears.

Figure 4-42 Copy Special Menu

Copy Special L]
[ copy all slices
(%) Copy selected level {Price Zone, Style(Color, {2})

(") Copy at base level (Price Zone, Style/Color, {2})

M Cancel

Select from the following options:
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= Copy all slices: This option is enabled only if the current workbook view
contains more than one page slice. Otherwise, this options is disabled. When
this option is selected, the copy operation behaves as if all positions in the slice
dimension’s levels were selected prior to the copy. If the box is left unchecked,
only the data from the current slice position is copied.

s Copy selected level: This option allows you to copy the level of data shown in
the pivot table. The base level data from which the displayed data is created is
not copied.

= Copy at base level: This option allows you to copy the base level data (the
measure’s lowest intersection), which may not be displayed in the pivot table.
If this option is not selected, the data is copied for the selected dimension level
only.

4. The selected data is copied to the RPAS server. It is not copied to the clipboard.
You can paste the copied data to other selected cells in the workbook multiple
times. The copied data is available to the RPAS server until the workbook is
closed.

Paste Special

Use Paste Special to view data at an aggregate level while pasting it at the base level,
which is not displayed in the current slices. It provides a dialog in which you can
specify options for specialized paste functions.

If the levels of multiple dimensions are represented in the pivot table selections, the
default paste option is performed at the lowest level.

To use special paste, complete the following steps:

1. Before using paste, you have placed data in clipboard using Cut Special or Copy
Special from the Edit menu.

2, Select Paste Special from the Edit menu.

Figure 4-43 Edit Menu — Paste Special
Bt ver - rorat- | |
| Calculate Cirl+T
Cut Cirl+x
Copy Ctrl+C
Paste Cirl+v
Cut Special. ..
Copy Spedial...
Paste Special. ..
Copy to External...
Paste from External...
Fill...

Clear...

3. The Paste Special menu appears.
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Figure 4-44 Paste Special Menu

Paste Special >4

[Iraste all slices
[]Do not paste MNA value.

(&) Paste selected level (Price Zone, Style/Color, {2})

() Paste at base level (Price Zone, Style/Color, {2})

M Cancel

Select from the following options:

»  Paste all slices: This option pastes data to all slices. If this option is not
selected, data is only pasted to the currently displayed slice position.

= Do not paste NA values: If this option is selected, NA data that has been cut
or copied is not pasted into the current selection. Whenever the system
encounters an NA value in the copied data, that value is ignored and the data
cell being pasted keeps its original value. In other words, when this option is
selected, the current pivot table data is not overwritten by NA values.

»  Paste selected level: This option only pastes data at the level of data shown in
the pivot table.

»  Paste at base level: This option is enabled only if none of the base level
measures are selected before the paste. Use this option to paste data at the base
level, which may not be currently displayed in the workbook. You can view
data at an aggregate level while pasting it at the base level.

4. Click OK. The selected data is pasted.

Copy to External and Paste from External

Use the Copy to External and Paste from External options to copy and paste data from
the system clipboard when the browser's security restriction prevents the Fusion
Client from copying to and pasting from the clipboard. These options are necessary for
Mozilla Firefox and Google Chrome.

The following shortcut keys are available for this functionality:
s Use Ctrl-Shift-c to copy to external.
»  Use Ctrl-Shift-v to paste to external.

These shortcuts can be used to activate the menu items, shown in Figure 4-47 and
Figure 4-49. The shortcuts are also available on the right-click menu.
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Figure 4-45 Right-Click Menu - Copy and Paste From External

H3 Selection Options »
Cut Cirl+X
Copy Cirl+C
Paste Ctrl+V
Copy to External... Ctrl+Shift+C

Paste from External... Cirl+Shift+y

B Lock
£ Level splitting »
Position Filtering b
Find...
Format »
Copy to External

Use the Copy to External feature when data from the pivot table must be copied to an
application other than RPAS Fusion Client, such as Microsoft Excel or Notepad. To use
the Copy to External feature, complete the following steps:

1. Select the cells to be copied in the pivot table.

Figure 4-46 Selecting Cells for Copy to External

~| Review Consumer Data > b w2
BB Product| Calendar s 3 (EH Customer Segment
[#01 Shart Sleeve Basic| [ 1/5/2008] - Ef Measure
L]

Blau & . -3 & 005>

Consumer Consumer Consumer |
AMg Wp 1250.00 1900.00 3300.00 -~
AMg Wp | Working Empty Soccor Mom
AMg Wp 90.00 875.00 7800.00
AMg Wp 45,00 175.00 650,00 L
AMg Wp 2,00 5.00 12,00 1
AMa Wp 8000,00 15000.00 45000.00
AMg Wp | 720000.00 13125000,00 351000000,00
AMg Wp i

2. Click the Copy to External option in the Edit menu.
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Figure 4-47 Edit Menu — Copy to External

View ~ Format ~ = | =

Calculatg Cirl+T
cut Ctrl+X
Copy Ctrl+C
Paste Ctrl+v
Cut Special...
Copy Special...
Copy to External.. Ctrl+Shift+C

Paste from External.. Ciri+Shift+V
Fill...

Clear.. Del

Lock

Insert Measures...

Position Maintenance » '

Eind... Ctrl+F

A dialog box appears, containing the copied data from the pivot table. The data is
formatted correctly and is selected in a text field.

Figure 4-48 Copy to External Source Dialog Box

Copy to External Source B

Data to Copy | 45,00 17500 650.00
2.005.00 12.00
8000.00 15000.00 45000.00

-
Press Ctrl+C or select the browser's Copy command to copy the selection to the dipboard.

Close

3. To execute the browser's copy command, select the copy option from the browser
menu or click CTRL+C. This copies the selected text from the text field to the
system clipboard. Click Close.

The data can then be pasted into another application. It can also be pasted into the
Fusion Client using the Paste from External option.
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Paste from External

Use the Paste from External feature when you need to paste data into the Fusion Client
from the system clipboard.

To use the Paste from External feature, complete the following steps:
1. Copy the data in the correct format from another application.

2. Select the area to paste in the pivot table by selecting the upper left hand corner of
the paste area or the exact cells to be pasted into.

3. Click the Paste from External option in the Edit menu.

Figure 4-49 Edit Menu — Paste to External

View ~ Format = = =

Calculate Ctrl+T
Cut Ctrl+X
Copy Ctrl+C
Paste Cirl+V
Cut Special...
Copy Special ..
Copy to External... Cirl+Shift+C

Paste from External... Ctrl+Shift+V

Fill...

Clear.. Del

Lock

Insert Measures...

Position Maintenance 4 '

Eind... Cirl+F

A dialog box appears, containing an empty text field.
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Figure 4-50 Paste from External Source Dialog Box

Paste from External Source -]

*Data to Paste

-
Press Ctrl+V or select the browser's Paste command to paste from the dipboard.

Paste Cancel

4. o paste the clipboard data into the text field, use the browser's paste command
from the browser menu or click CTRL+V.

5. Click Paste in the dialog box to paste the data in the selected pivot table.

Read-Only Measures

Read-only measures are defined during the domain configuration process. The
read-only status can be set at both the base intersection and aggregate levels.
Read-only measures are indicated as non-editable cells based on measure information
retrieved when the workbook is opened.

Read-only cells by default have a gray cell background color. This same default color is
used to indicate protection processing protected cells and elapsed cells. If the visual
indicator for read only is changed to be different than the visual indicator for protected
cells and the cell is both read-only and protected, then the cell will display the visual
indicator for protected cells. These cells are not editable from the RPAS Fusion Client.

Figure 4-51 Read-Only and Writable Measures

~| Global Goals and Constraints * 4 oy A
B EH Scenario
j@ Measure
|
Bl i | & | [Fd. ~ & & mEcam & 4l
1 Max Revenue | 2 Max Sale uints | 3 Max Margin |
Min Volume (% of Original) 80,00 Jad
CPI (Absolute)
CPI (% of Original) writable — 75.00
Max # Price Changes (Absolute)
Max # Price Changes (%% of Total Prices) 20
Price Drift Low Unrestricted Unrestricted
Criginal Gross Marain 137404 137409 1374.0% | l
Qriginal Gross Margin %a 100.00 100.00 100,00 | =
Original Revenue read-only — 1374.04 1374.04 1374.04
Criginal Volume 1086.00 1086.00 1086.00 §__|
Criginal CPI 29.71 29.71 29.71 |™|
4 1l F3
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Locking and Unlocking

In addition to read-only workbooks and measures, the RPAS Fusion Client also
provides a locking function in order to protect information. The locking function can
be used on cells, measures, and positions.

Cell locking is available for any editable cell and invokes protection processing.
Measure locking is available for any measure and invokes protection processing.

Position locking is available for non-calendar dimensions and does not invoke
protection processing.

Note: Locks are not recognized by operations such as custom menus
and refresh. Locks are only recognized when a workbook calculation.
is done.

Cell Locking

Use the cell locking feature to lock one or more editable cells in the pivot table. When a
table cell is locked, calculations performed as a result of data manipulations do not
affect the locked data values. This functionality allows you examine various what-if
scenarios to determine the best course of action for planning or forecasting.

The RPAS Fusion Client iterates through the selected cells by measure, then by
column, then by row. Locked cell information is immediately transferred to the RPAS
server. The locked cell information is saved with the workbook and locked cells
continue to be locked when the workbook is reopened.

The locked status of a cell is indicated by the presence of a picture of a lock on the left
side of the cell. After an eligible cell is locked, the system determines whether the
remaining table cells are eligible or ineligible for locking. For instance, if all the child
cells of any parent cell are locked, the parent cell cannot be locked. Instead, any edits
to the parent cell are spread to the child cells based on the ratio of the values locked
into the cells. If a cell becomes ineligible for locking, the right-click menu associated
with that cell does not contain the Lock option. Furthermore, any read /write cells that
become ineligible for locking are made read-only.

You may choose to lock a data cell at any time to protect that cell from forced
recalculations as a result of data manipulation elsewhere in the workbook. For
example, you may want to see the effect of a change to sales value on inventory levels
without forcing a change to receipts. Or, you may want to change sales value at an
aggregate level (such as month) and spread the result to only three of the four weeks
that comprise that month. In this case, you can effectively hold the second week's sales
value constant while spreading the aggregate-level increase among the remaining
three weeks.

Protection processing executes against locked cells as if they were edited to their
current value. Cell locks do not appear in the Undo list, which appears next to the
Undo icon in the toolbar when more than one edit has been made. In addition, cell
locks are not affected by the Undo option from the menus. Only cell value edit
changes appear in the Undo list. Cell lock or unlock actions do not force a calculation
cycle to execute.

Measure Locking

Use the measure locking feature to simultaneously lock all of the cells that are
associated with a given measure in a view. A measure can be locked or unlocked when
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the header cell of the measure dimension is selected. As with individual cell locking,
the locked status of each cell in the measure is indicated by the lock picture on the left
side of each cell.

Locked measure information is immediately transferred to the RPAS server. The
locked measure information is saved with the workbook, so locking measures enables
the save features of the workbook. The locked measure information is saved with the
workbook and locked measures continue to be locked when the workbook is
reopened.

Protection processing executes against a locked measure as if the measure has been
edited to the same value.

If multiple measures are selected, they are locked or unlocked in row or column order.
A measure may be locked even if it is already protected by protection processing.

Note: You can only make a selection at one level in the headers of a
multidimensional header. Lock and unlock apply to the selected
measure only. Locked measures are designated by a lock icon in the
header text of the measure and in its cells.

Position Locking

Use position locking to lock all measures in all displayed views along one or more
positions of non-calendar dimensions. Cells along unlocked positions are still editable
and can also change as a result of calculations. Locked positions are designated by a
lock icon in front of the position name. The cells of the locked position are shaded as
read-only.

Figure 4-52 Locked Positions
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Protection processing does not run against cells locked by a position lock. Unlike cell
locks, a parent position becomes locked if all its children are locked. A parent position
becomes unlocked if any of its children are unlocked. Hidden children are considered
when deciding if a parent position becomes locked. Unlocking or locking the parent
unlocks or locks all the children. Hidden child positions are treated in the same way as
visible children. Unlike a measure lock, the lock indicators do not show up in each of
the cells, only in the header cells, even though the cells are displayed as read-only.

Locked position information is immediately transferred to the RPAS server. The locked
position information is saved with the workbook, so locking positions enable the save
features of the workbook. The locked position information is saved with the workbook
and locked positions continue to be locked when the workbook is reopened.

A position cannot be locked when locking it affects an edited or locked cell. A warning
modal dialog is displayed and asks you to revert the affected edits and calculate the
workbook or cancel the position locks. You are warned if a cell lock is affected and
given the choice of canceling the position lock or unlocking the affected cell locks and
continuing. If both edits and cell locks are affected, then you see both dialogs, with the
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edit dialog appearing first. If you cancel the position lock from either dialog, then no
action is taken against either locked or edited cells.

Locking and Unlocking Methods

You can initiate locks by selecting a cell, measure, or position within the pivot table
and then selecting one of three options to initiate a lock or unlock action. Locking and
unlocking can be done through the following:

s Locking Using the Right-Click Context Menu
s Locking Using the Edit Menu
= Locking Using the Lock Icon

Locking Using the Right-Click Context Menu

One way that you can lock or unlock a cell, measure, or position is by using the
right-click context menu. Depending upon what is selected, the context menu
determines whether the Lock or Unlock option is shown.

Figure 4-53 Locking: Right-Click Context Menu
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To lock using the context menu, complete the following:
1. Select a cell, measure, or position. After it is selected, it is shaded.

2. Right-click the mouse. The context menu appears. If the cell, measure, or position
is not already locked, the Lock option appears in the menu.

3. Select the Lock option.

4. The selected item or items show a lock symbol.

Figure 4-54 Lock Symbol Shown in a Locked Measure
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Locking Using the Edit Menu

You can lock a cell, measure, or position by using the Edit menu. The Edit menu
contains several locking options:

= Lock

= Unlock

= Unlock All Cells

= Unlock All Measures
= Unlock All Positions

Figure 4-55 Locking Options Using the Edit Menu
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To lock using the Edit menu method, complete the following:
1. Select a cell, measure, or position. After it is selected, it is shaded.

2. From the Edit menu, click the Lock option.
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Figure 4-56 Locking Using the Edit Menu
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The selected item or items show a lock symbol.

To unlock using the Edit menu method, complete the following:
1. Select the cell, measure, or position that is locked.

2. From the Edit menu, click Unlock.

Or, if you want to unlock all cells, measures, or positions, select Unlock All and
choose the type you want to unlock.

Figure 4-57 Locking Options in the Edit Menu
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Locking Using the Lock Icon

You can lock a cell, measure, or position using the Lock icon in the toolbar. If some
selected cells are already locked, they are ignored. If all selected cells are already
locked, then the selected cells are unlocked instead of locked. If an error occurs when
any of the selected cells measures or positions are locked, then an error message will
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be displayed and all of the applied locks will be reset. Cells that were already locked
when the lock action started will remain locked.

To lock using this method, complete the following:
1. Select a cell, measure, or position. After it is selected, it is shaded.

2. Click the Lock icon in the toolbar.

Figure 4-58 Locking with the Lock Icon
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The selected item or items show a lock symbol.
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Formatting

You can configure formatting settings of workbooks and save those settings for future
use in RPAS. You can configure some formatting within the Fusion Client as well as
through the RPAS Configuration Tools. For more information about configuring
formatting with the Configuration Tools, see the Oracle Retail Predictive Application
Server Configuration Tools User Guide.

Formatting settings are created in the Format dialog box. In the Format dialog box,
you can set and clear formats that apply to measures or dimensions. You can make
changes to single or multiple measures and dimensions and apply those changes
across one, many, or all views in the workbook.

Note:

The following formatting choices do not apply in the Fusion

Client: Text Font, Text Size, Border Style, and Border Color.

Default Cell Formats

Some formatting cannot be altered in the Fusion Client. Read-only and protected cells
as well as edited cells have default formats that are configured in a property file for the
entire solution. The default formats are shown in Table 5-1.

Table 5-1 Default Formats

Cell State Configurable Style Default Style

Read-only cells Cell Style Light grey background color

Protected cells Cell Style Light grey background color

Invalid cells Cell Style Dark grey background color

Editable Cells Cell Style None (white background color)

Edited Cells Text Style Italic font, white background color
Note: These default styles can be changed by editing the

PivotTableStyles.properties file. For instructions on editing this file,
see the “PivotTableStyles.properties File” section in the Oracle Retail
Predictive Application Server Administration Guide for the Fusion Client.

Read-only cells are those that cannot be edited for any reason. In Figure 5-1, the cells
of the Ly Sales R measure are read-only since the data is from last year and cannot be

changed because it occurred in the past.
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Protected cells are read-only in order to protect them from editing. In Figure 5-1, the
cells of the Wp Sales AUR measure are protected because that measure is based on the
data from Wp Sales U, which has been edited. For more information, see Protection
Processing.

Invalid cells are at a level in the view below the base intersection of the measure. In
Figure 5-1, the Wp BOS R measure has a base time level of Half, and so it is invalid at
the week level. Therefore, the cell in the Sprg Fy2010 is editable, but the cells in the
week columns are invalid.

Editable cells can be edited. In Figure 5-1, the cells of the Wp Sales R and Wp Sales U
measures are editable and therefore have white cell backgrounds.

After a cell has been edited, it retains its white cell background, but its font becomes
italic. In Figure 5-1, the 2/13/2010 cell in the Wp Sales U measure has been edited.

Figure 5-1 Default Cell Formats
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Modify Formatting

To access the Format dialog box, select an option in the Format menu.

Figure 5-2 Format Menu

Format - E @ C
Measzure Styles...
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Exceptions...

Alert Styles...
Dimension Styles...
Save Format b
Lelete Format 2

Or, right-click a dimension position in the page edge, column axis, or row axis.
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Figure 5-3 Format Option in the Right-Click Context Menu
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The Format dialog box appears. From the Format dialog box, you can modify measure
styles, number formatting, exceptions, and dimension styles.

Figure 5-4 Format Dialog Box
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Using the Filter to Find Measures

You can use the filter to find measures that share a common name, type, or location. To
use the filter, complete the following steps:

1. Enter data in at least one of the following fields:

= Name contains: Enter the word or phrase you want to find. The word or
phrase is searched for in the entire label string, including any displayed
attributes. This field is not case sensitive.

= Type: Select the type of measure you are searching for. The options are integer,
real, date, text, Boolean, or all types.

= Visible in: Select the view that you want to search in. You can select one,
several, or all.

In Figure 5-5, the string "Ly" is searched for in all types of measures within the
Alert Sheet 1 view.
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Figure 5-5 Filtering Measures
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2. After you have entered the search criteria, click the blue arrow to the right of the
Filter measures area. The measures that fit your search criteria are shown in the
Measure field within the Apply measure format area.

Figure 5-6 Filter Results
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Extended Measures

Extended measures also appear in the Measure field. Some extended measures have
the same label as the measure from which they were created. As a result, when
displaying measure labels in the Measure field, use a series of attributes to describe the
measure. The attributes are separated by a delimiter character.

The order of attributes is usually displayed as [Label] | [%] | [Aggregation]
For example:

= Wp Gross Margin | | TOTAL

= Wp Sales contrb Prod R% | % Product | TOTAL

= Wp Sales contrb Time R% | % Calendar | TOTAL

Modifying Measure Styles

From the Measure Styles tab of the Format dialog box, you can locate measures with
the filter feature and then modify the measure style for those measures. Measures can
be modified by altering the appearance of the headers cells.
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When the filter feature is not in use, the measures that appear in the Measure field
within the Apply measure format section shows the measures that are contained in the
current view.

Figure 5-7 Measure Styles Tab of the Format Dialog Box
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Applying Measure Formats

After you have found the measures you want to change, you can edit or clear the
existing formats for those measures and add new ones. To alter the measure format,
complete the following steps:

1. Use the filter to find the measures you want to alter. See Using the Filter to Find
Measures.

2. Select the measures from the Measure field. You can select one, several, or all.

Figure 5-8 Select Measures
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3. In the View field, select the views in which the measures you want to change
appear.

4. Inthe Applies to field, select the part of the measure formatting that you would
like to alter.

5. In the Text color, Background color, Cell alignment, and Font style fields, choose
the settings you want to apply.

Note: The cell background for read-only measures cannot be altered.

6. When finished, click Apply and Close.

The Format dialog box closes. In the view, the new formatting is visible.
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Note: Mixed appears as a formatting option when two positions
have different formatting settings. For instance, if a user has selected
bold as the font style for one measure and italics for another, when the
user selects both measures at once, the font style drop-down displays
mixed. The mixed option occurs only when there are multiple
selections on the left side and the properties on the right side contain a
drop-down list.

Figure 5-9 Formatted Measures
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Modifying Number Formatting

From the Number tab of the Format dialog box, you can locate measures with the filter
feature and then modify the number formatting for those measures. When the filter
feature is not in use, the measures that appear in the Measure field within the Apply
measure format section shows the measures that are contained in the current view.
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Figure 5-10 Number Tab of the Format Dialog Box
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Applying Number Formats

After you have found the measures you want to change, you can edit or clear the
existing number formats for those measures and add new ones. To alter the number
format, complete the following steps:

1. Use the filter to find the measures you want to alter. See Using the Filter to Find
Measures.

2. Select the measures you want to alter from the Measure field. You can select one,
several, or all.

Figure 5-11 Select Measures
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3. In the View field, select the views in which the measures that you want to alter
appear.

The Quick format field contains four preconfigured number formats: currency,
percentage, thousands, and millions. If one of these formats suits your needs,
select it. The values in the Prefix, Suffix, and Scale fields adjust accordingly. If the
quick formats do not suit your needs, continue to the next steps to adjust the
remaining fields.

Table 5-2 Quick Format Options

Quick Format Description

Currency The currency format as a scale factor of 1 and a prefix of $. It has a
precision of 2. For example, $1223.45.
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Table 5-2 (Cont.) Quick Format Options

Quick Format Description

Percentage The percentage format has a scale factor of 0.01 and a suffix of %. It has a

precision of 0. For example, 16%.

Thousands The thousands format has a scale factor of 1000 and a suffix of k. It has a

precision of 0. For example, 1,235k.

Millions The millions format has a scale factor of 1000000 and a suffix of M. It has a

precision of 0. For example, 1,235M.

In the Prefix field, enter a string up to seven characters that you want to appear
before number. Prefixes are often used for a currency symbol.

In the Suffix field, enter a string up to seven characters that you want to appear
after the number. Suffixes are often used to denote scaling factors (k, m) or
percentages (%).

In the Scale field, enter the factor to be applied to displayed values to produce an
internal value. For instance, you can use this to display a fractional value as a
percentage with a scale factor of 0.01.

Select the Show separator option to use the thousands separator in the view. The
thousands separator depends upon the regional setting. Often though, itis a
comma.

In the Precision field, enter the number of places to the right of the decimal to be
displayed. The precision value for integers is 0.

Note: Below the Precision field is an example of how the formatted
number appears.

When finished, click Apply and Close. The number formatting is applied to the
selected measures in the view.

Modifying Date/Time

From the Date/Time tab of the Format dialog box, you can locate date measures with
the filter feature and then modify the date/time formatting for those measures. When
the filter feature is not in use, the measures that appear in the Measure field within the
Apply DateTime format section shows only date measures that are visible in the
current view.
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Figure 5-12 Date/Time Tab of the Format Dialog Box
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Applying Date/Time Formatting
1. Use the filter to find the measures you want to alter. See Using the Filter to Find
Measures.

2. Select the measures you want to alter from the Measure field. Only date/time
measures are displayed in this list. You can select one, several, or all.

Figure 5-13 Select Date Measures
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3. Inthe View field, select the views in which the measures appear that you want to
alter appear.

4. Use the Time field to configure how the time is displayed.
s Choose No Time if you do not want the time data to be displayed with the

date.

»  Choose 12 Hour Format to display the time in 12-hour format. Example:
10:58PM.

s Choose 24 Hour Format to display the time in 24-hour format. Example:
22:58PM.

An example of the time format you have chosen appears below the time field.

5. When finished, click Apply and Close. The date/time formatting is applied to the
selected measures in the selected views.
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Modifying Exceptions
Exception formatting is used for numeric measure types. Exception formatting defines
the styles to be applied to a cell’s value when it falls outside a defined range.

From the Exceptions tab of the Format dialog box, you can locate measures with the
filter feature and then modify the exception formatting for those measures. When the
filter feature is not in use, the measures that appear in the Measure field within the
Apply measure format section shows the numeric measures that are contained in the

current view.

Figure 5-14 Exceptions Tab of the Format Dialog Box
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Applying Exception Formatting
1. Use the filter to find the measures you want to alter. See Using the Filter to Find
Measures.

2. Select the measures you want to alter from the Measure field. You can select one,
several, or all.

Figure 5-15 Select Measures
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3. Inthe View field, select the views in which the measures that you want to alter

appear.
4. Use the Condition and Value fields to set the parameters of the exception.

= In the Condition field, select one of three options:
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— < =: Use this to select values that are less than or equal to Value 1.
— > =: Use this to select values that are greater than or equal to Value 1.

— Not between: Use this option to select values that do not fall between
Value 1 and Value 2. This is a way to set both the <= and >= conditions to
have the same formatting styles.

= In the Value fields, enter the following:

- If you chose <= or >= as the Condition, enter the value in Value 1 that the
exception needs to be greater or less than.

— If you chose Not between as the Condition, enter the values that the
exception should not fall between in Value 1 and Value 2.

Note:

» If entering a value that has a scale factor, such as a percentage,
enter the raw value. For example, if you want to enter 10%, you
should enter .1.

= Exceptions applied to integer measures must have integer values
for Value 1 and Value 2. Otherwise an error occurs.

5. In the Text color, Background color, and Font style fields, choose the settings you
want to apply.

Note: An example of a formatted exception is displayed below the
Font Style field.

6. When finished, click Apply and Close. The exception formatting is applied to the
selected measures in the view.

Modifying Alert Styles

The alert styles can be modified for Real Time Alerts. This enables users to customize
their visual appearance. This option will only be available if Real Time Alerts are
present in the workbook. The changes apply to the specific workbook the alert is in.
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Figure 5-16 Alert Styles Tab of the Format Dialog Box
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Applying Alert Formatting

1. Select the alerts you want to alter from the Real Time Alert field. You can select
one, several or all.

2. Inthe Condition field, select the alert conditions you want to modify.

3. Use the Text color, Background color, and Font style options to configure the
appearance of the alert. The visual appearance is then updated in the provided
example.

4. When you are finished, click Apply and Close. The modified formatting is applied
to the selected Real Time Alerts in the selected views.

Modifying Dimension Styles

From the Dimension Styles tab of the Format dialog box, you can specify header styles
for one, a few, or all dimensions. The filter measure feature is not available on this tab
because dimension formatting applies only to dimensions, not measures.
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Figure 5-17 Dimension Styles Tab of the Format Dialog Box
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Applying Dimension Styles

1. In the Dimension field, select the dimension that you want to alter. You can select
one, a few, or all.

Note: Measure appears as an option in the Dimension field. If you
choose Measure as the dimension, you can set a default header style
for measures, but not a default cell style.

2. In the View field, select the views in which these dimension styles should be used.

3. In the Text color, Background color, and Font style fields, choose the settings you
want to apply.

Note: An example of a formatted dimension header is displayed
below the Font Style field.

4. When you are finished, click Apply and Close.

The Format dialog box closes. In the view, the new dimension styles are visible.

Saving Formats

RPAS lets you to configure the formatting settings of workbooks and views and save
those settings for future use. You can configure the appearance of measures, grids,
axes, and exceptions; set the type-specific parameters of measures; and enable
synchronized page scrolling.

The following settings are saved in the formatting database:
= Dimension and measure tile locations
= Visible dimension levels (aggregate roll-ups)

s Measure order and format
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s Format menu settings
= Slice selection

s Block view vs. outline view

Note: Split level/dimension settings and the sort order without
attributes setting are not saved in the formatting database.

Format Levels

The formatting settings you create are stored along with the workbook in the domain.
Because workbook formats are saved just as workbooks are, they can be made
available to other users. Saved formats are used when being new workbooks.

A workbook format can be saved at three availability levels:
»  For Just Me: The workbook format is available only to the user who created it.

s For My Group: The workbook format is available to all members of the user’s
group. Users who belong to more than one group can choose which group to make
the workbook available to.

s For Everyone: The workbook format is available to all users in the organization.

Figure 5-18 Save Format
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When a new workbook is created, the most specific set of workbook formats that
apply are taken as the new workbook format. When a workbook formatting set exists
for an availability level (user, group, world), the entire set is taken from that level and
applied to the new workbook. For example, if there are user settings for the current
user, all workbook formatting from those user settings are applied.

Note: When a new workbook is created, the user’s default group is
used for the group availability level check.

Saving Options
When saving formatting settings, you can save all formatting, using Save All, or just
save the changes you have made, using Save Changes Only.
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Figure 5-19 Save Format Options
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Save Changes Only

The Save Changes Only option allows you to save only what you have changed so that
a subset of the workbook's formatting is merged into the existing saved format. This
subset consists of changes made since the workbook was first constructed. You can
also include changes inherited from any of the saved styles. During the merge, any
conflicting settings in the existing saved format are overwritten, and non-conflicting
settings are left alone. This allows multiple users to manage group and template styles.
Users can write to the same files without necessarily writing over the changes of
others.

Since formatting is saved incrementally, non-conflicting changes to formatting can be
propagated throughout different levels. When a workbook is created, a superset of all
changes in the applicable user, group, and template level styles is made, with all
conflicting changes resolved by the lowest level, user. Therefore, if a change is made to
the group formatting, each group member sees it in every new workbook, as long as a
conflicting formatting setting does not exist at the user level.

Note: The saved formats you inherit may have changed since you
built your workbook. You should have a strategy in place for
managing multiple users who save to the group and template formats.

Save All

The Save All option can be used if you do not want to inherit any changes made to a
higher level. Selecting Save All writes an entry for each formatting setting, whether or
not you changed it from the group or template format. Essentially, this blocks any
changes that were made at a higher level from the level at which you are saving.

After Save All is applied to the user format, that user is not able to see changes made
to the group or template level formatting again. Accordingly, if Save All is applied to a
group format, then no member of the group can see the changes made to the template
level. However, each group member maintains access to any user level overrides that
he or she saved. Since Save All overrides all formatting, the only way to revert to Save
Changes Only is to delete the formatting at that level.

Inheritance Formatting

You can select the check boxes on the Save Format dialog box to inherit the formatting
information from other levels.

For example, for any setting at the group level that needs to be propagated to the
template level, select View and then Save Format for All. The Save Format dialog box
appears. Click Save Changes Only and then select Include Inherited Group
Formatting.
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For any setting at the template level that needs to be propagated to the user level,
select View and then Save Format for User. The Save Format dialog box appears.
Click Save Changes Only and then select Include Inherited Template Formatting.

Note: Chart format data is not merged into the existing saved format
as other data is. It is saved as Save All (overwriting existing
formatting), even if Save Changes Only is selected.

Deleting Formats

You can delete formats that you created. To delete a format, complete the following
steps.

1. Open the workbook that has the formatting you want to delete.
2. From the View menu, click Delete Format.
3. Choose the level you want to delete it from.
»  For Just Me: The workbook format is deleted only for the user who created it.

s For My Group: The workbook format is deleted for all members of the user’s
group.

»  For Everyone: The workbook format is deleted for all users in the
organization. Only administrators can save for everyone.
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Dimensions, Levels, and Positions

Dimensions describe the top-to-bottom relationship between the levels or positions of
the dimensions in RPAS. They reflect the dimensions set up at your business and being
used by the merchandising solutions.

RPAS supports many alternative dimensions that provide different roll ups and help
you analyze the data from a different perspective.

Levels are subdivisions of a dimension. Levels group information of the same type.
For instance, a level within the Product dimension could be Department. The
Department level would contain all the departments that exist.

Positions are the individual members of the level.

This chapter describes the various tasks you can perform with dimensions, levels, and
positions. It includes the following sections:

»  Showing/Hiding Levels

»  Expanding and Collapsing Levels
s Level Splitting

»  Showing and Hiding Positions

Showing/Hiding Levels

Dimension levels that appear in the view are based on the configuration. Only levels
configured for a view are visible in the view. In the Fusion Client, you can show or
hide the levels using;:

= Right-click menu

= Levels tab in the Dimension dialog box

Using the Right-Click Menu

To show or hide levels using the right-click menu:
1. In the view, right-click anywhere in the area that displays the dimension.

2. Select the level you want to show or hide.
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Figure 6-1 Right-Click Menu
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The view updates to display or hide the relevant level.

Note: You can perform the same action by accessing the right-click
context menu in the page edge.

Using the Dimension Dialog Box
To show or hide levels and select the display type using the Dimension dialog box,
complete the following steps:

1. In the page edge, click the dimension tile you want. The Dimension dialog box
appears.
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Figure 6—2 Dimensions Dialog Box, Levels Tab
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2. Click the Levels tab. The Levels tab shows all the levels and alternate roll-ups and
enables you to select one or more levels within a single dimension.

3. Select the levels you want to show or hide using the check boxes to the left of the
level name.

4. Select Block View or Outline View as the display type.
5. Click OK to apply the changes and close the dialog box.
Or, click Apply to apply the changes and continue working on the other tabs.

Expanding and Collapsing Levels

Although you can click the Expand/Collapse buttons next to each level displayed in
the view, it can be time consuming if there are many levels. The Fusion Client includes
the following options to help you expand or collapse levels easily:

= Right-click menu

s Levels Tab in the Dimension pop-up

Using the Right-Click Menu

To expand or collapse levels using the right-click menu:
1. Select the levels you want to expand or collapse, and right-click.

2. On the right-click menu, select Expand Level(s) or Collapse Level(s).
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Figure 6-3 Expand Level and Collapse Level Options in the Right-Click Menu
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Using the Dimension Dialog Box
To expand or collapse levels using the Dimension dialog box:

1. In the page edge, click the dimension tile of the dimension you want to collapse or
expand. The Dimension dialog box appears.

Figure 6—4 Dimensions Dialog Box, Levels Tab
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2. On the Levels tab, select the relevant check box to expand or collapse all the
positions at the level. To expand or collapse all positions at all the visible levels,
click the Expand/Collapse shortcut menu on the top.

Figure 6-5 Expand/Collapse Shortcut Menu
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Note: The expand and collapse check boxes are enabled only for the
levels selected.

3. Click OK to apply the changes and go back to the view.

You can also click Apply to apply the changes and continue working on the other
tabs.

Level Splitting

Level splitting allows you to group dimension data based on position characteristics
defined by attribute values.This enables users working with large sets of data to group
together subsets of data to make the information easier to work with. These attributes
can be either predefined (set up during the configuration process) or dynamic (defined
by a user and made available globally).

For example, for an attribute that describes the climate of a store location, you can
group those store locations by climate using a level split. This lets a planner working
on the winter season to first work with stores in cold weather regions and then work
with stores in more temperate regions.

Level splitting is applied to the entire workbook, although when the split was defined
it may have been specified that the split should only be shown in some of the views in
the workbook. As each dimension in the workbook can only have one split applied to
it at any one time, applying a split to a view without any apparent grouping may still
result in a message saying that a split already exists. Users then have the option of
continuing with the existing split or clearing it and applying the new split to the entire
workbook.
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Figure 6-6 Level Splitting Example
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As shown in Figure 6-6, the attribute values (cold, moderate, hot) act as positions
within the level split. Each level split contains only the positions that have that
attribute: only the cold locations appear in the cold split, only the hot locations appear
in the hot split, and so on.

The level split has its own dimension tile. You can move this tile just as you would a
dimension tile because level splits behave like independent dimensions. See Creating a
New Split for more information.

Behind the scenes, a hierarchy is built based on attribute values at the level that is split,
allowing the aggregations to be correctly calculated and providing a spreading for
values edited at aggregated levels. Other capabilities, such as locking and protection
processing, are fully functional on the positions of the split.

Creating a New Split

Before you can create a level split, you must have an attribute, dynamic or static, to
base the split on. Static attributes are defined in the Configuration Tool and can only
be changed by users with access to the tool. Dynamic attributes can be created by any
user. To learn how to create a dynamic attribute, see Creating Dynamic Attributes.

You can define multiple splits for a specific dimension but only one of those splits can
be applied to the dimension at any one time. If there are multiple dimensions in use
for the pivot table, each of these dimensions can have a split applied to it.
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1. Click the Level Splitting icon in the toolbar. In the Level Splitting menu, select
New Split.

Figure 6—7 Level Splitting Icon
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Or, right-click a position. The right-click context menu appears. Select Level
Splitting. In the Level Splitting menu, select New Split.

Figure 6-8 Level Splitting Option in the Right-Click Context Menu
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2. The New Split dialog box appears (Figure 6-9). Select the following options:
= Dimension: Select the dimension that you want to split.
s Level: Select the level that you want to split into groups.

= Attributes: Check the attribute that you want to use to group the levels into
and use the Move icon to move it to the right side. More than one attribute can
be selected.

If multiple attributes are selected for a split, the order they are selected will
determine the order they are applied. The first attribute in the list will be used
to group the dimension into bands. The second attribute in the list will then be
used to subdivide within the initial bands, and so on. The order can be
modified by using the up or down arrows in the New split dialog box.

If you want to create a new attribute, use the New Attribute icon.

= Apply To: Select the views that the split should apply to. You can choose one
view, some views, or all views.

= Split Name: To save the split for later use, enter a name and click Save Split.
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Figure 6-9 New Split Dialog Box
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3. When finished, click OK. The dialog box closes, and the levels are split, as shown
in Figure 6-10.

Figure 6—-10 New Level Split
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You can move the split dimension to a different axis, as shown in Figure 6-11. Moving
the split dimension to a different axis can be helpful when you have aggregate levels
of the base dimension. In Figure 6-11, the base dimension is Location. When
aggregating that dimension, you can see the total Weekly Sales for regions by climate.
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Figure 6-11 Split Dimension on Different Axis
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You can also move the split dimension to the page edge, as shown in Figure 6-12.

Figure 6-12 Split Dimension on Page Edge
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You can use more than one attribute to define a split for a dimension. In Figure 6-13,
two attributes were used to define the split.

s Climate (Hot, Moderate, Cold)
= Sales (Low, Medium, High)

These are used in the priority order used to select them when the split was defined.
Because Climate was the first attribute selected, the stores are first grouped by the
climate bands. Within a specific climate band, the stores are then grouped by sales.
These splits can be moved to different axes or the page edge.
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Figure 6-13 A Split with Two Attributes
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Clearing a Split
To clear or remove a split from the view, complete the following steps:

»  Click the Level Splitting icon in the toolbar. Then select Clear Split.

Figure 6-14 Clearing a Split with the Level Splitting Icon
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s Or, right-click a position. In the right-click context menu, select Level Splitting.
Then, select Clear Split.
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Figure 6-15 Clearing a Split with the Right-Click Context Menu
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The split is removed from the view.

Selecting a Split
To apply a saved split to a view, complete the following steps:

1. Click the Level Split icon in the toolbar and then click Select Split.

Figure 6-16 Select Split: Level Splitting Icon
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Or, right-click a position. In the right-click context menu, select Level Splitting
and then Select Split.
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Figure 6-17 Select Split: Right-Click Context Menu
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2. The Select Split dialog box appears. Select the split you want to apply to the view.

Figure 6—18 Select Split Dialog Box
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M New 7 Edit Copy (= Rename 3§ Delete o Detach
Filter By Dimension | Al x| Level [al | Attribute(s) | Al = ®
Name |Dimensi0n |Leve| |At’ibute(s)
Climate Location Store Climate
Apply To | Sales Total x|
oK Cancel

3. Click OK. The split is applied to the view.

= If no existing split exists for the dimension the split is being applied to, the
split will be immediately applied.

= If an existing split exists for the dimension the split is being applied to, a
warning dialog box will appear.

Figure 6—19 EXxisting Split Warning

New Split [ %]

This workbook already containg a split for Calendar that is displayed in ane or more
wiews, This previous splitwill be removed and the new split applied.

OK  cancel

As only one split can be applied to a specific dimension at one time, users
have the option of continuing with the existing split or removing it and
applying the new one.
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Editing a Split
To edit an existing split, complete the following steps:
1. Ensure that a split appears in the view.
2. Right-click the level split or click the Level Split icon.
3. From the Level Split menu, select Edit Split.

Figure 6-20 Editing a Level Split
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4. The Edit Split dialog box appears.
5. Edit the split as necessary and click OK.

Note: A split cannot be edited if it is in use in a worksheet. To edit
the split, first clear the split from the workbook.

Showing and Hiding Positions

Positions that appear in the view are based on the configuration. Only positions
configured for a view are visible in the view. In the Fusion Client, you can show or
hide the positions using the Dimension dialog box.

To show or hide positions:

1. In the Page Edge and Tiles area, click the dimension tile you want. The Dimension
dialog box appears.

2. In the Dimension dialog box, click the Show and Hide tab.
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Figure 6-21 Dimension Dialog Box, Show and Hide Tab
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Hold down the CTRL or SHIFT key and dick to select multiple items. Drag and Drop the items or use the Add/Remove buttons to move the items.

Apply M Cancel

3. Select the positions you want by holding down the CTRL or SHIFT key.

4. Click the Add and Remove arrows to move positions between the Visible
Positions and Hidden Positions areas.

Or

Drag and drop the positions between these areas.

5. Click OK to apply the changes and go back to the view.

You can also click Apply to apply the changes and continue working on the other

tabs.

Use the Add All and Remove All arrows to move all the positions between the
Visible Positions and Hidden Positions area.
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Measures

Measures represent the events or measurements that are recorded, while the positions
in the dimensions provide a context for the measurement. Measures are defined based
on the business rules set in the application. The dimensionality of a measure is
configured through the definition of its base intersection, which is the collection of
levels (one per appropriate dimension) defining the lowest level at which the
information is stored for the measure.

Measure names are completely configurable and typically named using a convention
that identifies each component and the meaning of the measure.

This chapter describes the various tasks pertaining to measures. It includes the
following sections:

= Showing/Hiding/Reordering Measures

s Insert Measures

Showing/Hiding/Reordering Measures

Measures that appear in the view are based on the configuration, and only measures
configured for a view are visible in the view. In the Fusion Client, you can show, hide,
or reorder the measures using the dimension dialog box.

To show or hide measures:

1. In the page edge, click the Measure tile.

Figure 7-1 Measure Tile
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The Measure Dimension dialog box appears.
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Figure 7-2 Measure Dimension Dialog Box, Show and Hide Tab

Item Level - Measure

Show Attributes and Sort

Hidden Measures

Show and Hide

Visible Measures

view » Find... - G G E. ;:j' Detach View v Find... - {} {} Default [+] 3 »

Label -~ ‘Aggregahe |Defau|t |% Label |Aggregate |Defau\t |%
Treat Min/Max Pric... AMBG Mote AMBG

Active ITtem? E_CR

Price Ladder AMBG

Price Hold AMBG

Original Price AVG

Apply Min/Max Price  AMBG

[Min Price AMBG

52| |max price AMBG

Default Price Cons... AMBG

Frice Constraint Pr... AMBG

Apply Min/Max Ma.. AMBG

ﬂ (Criginal Cost AVG

Min Margin AMBG

Max Margin AMBG

Default Margin Co... AMBG

Margin Constraint ... AMBG
[=] i e [#] Ll | [l
Hold down the CTRL or SHIFT key and dick to select multiple items. Drag and Drop the items or use the Add/Remove buttons to move the items.

Enable User Defined Sort Order Frofile Name Save Profile

Apply g Cancel

2.

On the Show and Hide tab, select the measures you want by holding down the
Ctrl or Shift key.

Click the Add and Remove arrows to move measures between the Visible
Measures and Hidden Measures areas.

Or, drag and drop the measures between these areas.
Click OK to apply the changes and go back to the view.

You can also click Apply to apply the changes and continue working on the other
tabs. Use the Add All and Remove All arrows to move all the measures between
the Visible Measures and Hidden Measures area.

To reorder measures:

On the Show and Hide tab, select the measures you want to reorder and click the
First, Up, Down, or Last arrows until you get the order you want.
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Figure 7-3 Measure Dimension Pop-Up > Show/Hide Tab
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Note: Sorting the measures in the Visible Measures area does not
reorder the measures in the view. To reorder the measures, use the
First, Up, Down, and Last arrows.

Insert Measures

When you want to see a measure that is not part of the current workbook, but you do
not want to build a new workbook to include that measure, you can use the Insert
Measures feature. To use this feature, there must be an active view that defines the
view where the measures will be inserted. You do not have to calculate the workbook
to insert measures. The measures available for insertion depend upon the following
criteria:

= Measure is configured to be insertable (the Insertable attribute is true).

= Measure security grants read /write or read-only access rights to the user.

= Measure has a storage database.

= Measure is not a recalc measure.

=  Its base intersection is compatible with the base intersection of the workbook.

= Measure is not already present in this workbook.
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Note: The visibility and editability of the inserted measure and any
dependent measures varies, based on the permissions granted to the
user for the inserted or dependent measures.

For more information about measure permissions, see the “Measure
Rights View” section of the Oracle Retail Predictive Application Server
Administration Guide for the Fusion Client.

Insert Measures Dialog Box

The Insert Measures dialog lists the labels of the measures available to be inserted.
This list is initially sorted in ascending alphabetical order, but you can click the
heading to change the sorting. You can also use the find option to locate a measure.
Only measures that can be inserted in the current view appear in the list.

This dialog launches only if there is at least one insertable measure for the workbook.
If not, an error dialog appears, stating “There are no measures to insert.”

Figure 7-4 Insert Measures Dialog Box Menu

Insert Measures ®

View - Find... =Uv i}
MName Fray
Active Ttem A
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Copy Base Demand
Ending Digit 4

Cmdirmm Diimid T

0K Cancel

Accessing the Insert Measures Dialog Box

There are three ways to access the Insert Measure dialog box: the Edit Menu, the
Context Menu, and the Show and Hide tab in the Measure Dimension dialog box.

From the Edit Menu
In the Edit menu, click Insert Measures.

7-4 Oracle Retail Predictive Application Server User Guide for the Fusion Client



Insert Measures

Figure 7-5 Insert Measures Option in Edit Menu
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From the Right-Click Context Menu

Right-click a measure in the pivot table. The right-click context menu appears. Click

Insert Measures.

Figure 7-6 Insert Measures Option in Right-Click Context Menu
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From the Show and Hide Tab
Click the Measures tile.

Figure 7-7 Measure Tile
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The Measure Dimension dialog box appears. On the Show and Hide tab, click the

Insert Measures icon.
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Figure 7-8 Insert Measures Option on Show/Hide Tab
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Inserting a Measure

To insert a measure, complete the following steps:

1. Open the Insert Measures dialog box from the Edit menu, Context menu, or Show
and Hide tab, as described in Accessing the Insert Measures Dialog Box.

2. In the Insert Measures dialog box, select the measure you want to insert.

To select more than one measure, hold the Ctrl key and click the measures. As the
measures are selected, they become shaded.

3. C(lick OK.

The dialog box closes, and the selected measures are inserted in the workbook for the
current view.

When inserting measures from the Show and Hide tab, you have the additional option
of specifying where you want the measures to be inserted.

1. Click the Measure dimension tile. The Measure Dimension dialog box appears.
Figure 7-9 Measure Dimension Tile

> b ¢ A

:I B} Location
Measure
|

2. On the Show and Hide tab, in the Visible Measures section, select the measure that
you want the inserted measure to appear under.

Figure 7-10 Selected Measure in the Show and Hide Tab
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3. Click the Insert Measures icon.
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Figure 7-11 Insert Measures Option on Show/Hide Tab
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4. The Insert Measure dialog box appears. Select the measures you want to insert and

click OK. The dialog box closes.

5. The inserted measure appears below the measure selected in Step 2.

Figure 7-12 Inserted Measure
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About Inserted Measures

Here are a few things you should know about inserted measures.

= After measures are added to a particular view, they cannot be added to other
views in the workbook. They do not appear in subsequent Insert Measures
dialogs.

= After a measure is added to a workbook, it cannot be deleted. The only way to
revert the workbook is to close it without saving and open a previously saved
version.

s Each measure selected for insertion is added to the view and made visible.

»  If the inserted measure has dependent measures, those are inserted as well.

Dependent measures are measures configured to act as upper or lower bounds of

the inserted measure. If the dependent measures have dependent measures
themselves, those measures are also inserted.

Dependent measures are inserted in the view but are not automatically made

visible in the views. You can make them visible by moving them from the Hidden
Measures section to the Visible Measures section in the Show and Hide tab of the
Measure Dimension dialog box.

Inserted measures have only a load rule. Inserted measures with writable access
can be edited within the workbook, but because they have no commit rule, the
edits cannot be committed to the domain.

Inserted measures can be formatted, and that formatting can be saved to a
template. However, the inserted measures are not added to the template and are
not present when new workbooks are built. If measures are inserted later, they can
still use the formatting saved in the template.
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Measure Profiles

Measure profiles are customized groups of measures that you can create and use in
views. Instead of adding or removing measures from the default measure list each
time you work with a particular view, you can save that customized group of
measures as a measure profile and load it into the view. By creating a measure profile
for each set of measures that you frequently use, you reduce the amount of time it
takes to set up a view.

Measure profiles are created at the view level and are available in all views and copies
of that view. Measure profiles are saved as part of the formatting. Depending on how
you save the formatting, you can make your measure profiles available to other users.
For more information, see Formatting.

Creating a Measure Profile

To create a measure profile, you first need to select the visible measures for the view.
After you have selected the measures that you want to appear in the measure profile,
you can create the measure profile.

1. Open the view that you want to create a measure profile for.

2. Click the Measure dimension tile.

Figure 8—1 Measure Dimension Tile
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3. The Measure Dimension dialog box appears. On the Show and Hide tab, use the
arrows to move the measures to and from the Visible Measures box. Place only the
measures that you want to appear in the measure profile in the Visible Measures
box.
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Figure 8-2 Moving Measures to the Visible Measures Box
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Enable User Defined Sort Order Profile Name Save Profile

Apply oK Cancel

4. Adjust the order of the measures in the Visible Measure box by using the First, Up,
Down, and Last arrows located to the right of the Visible Measure box. This step is
optional.

5. After all of the measures that you want to appear in the measure profile are in the
Visible Measures box, you can save the measure profile using one of two methods:

Method 1:

a. In the Profile Name field below to the Visible Measures box, enter the name of
the measure profile.

b. Click Save Profile.

Figure 8-3 Measure Profile Name Field

Max % Price Chan... AMBG

Message AMBGP
<] I | []
Rows Selected 1
i ; 2 the jtem:

Profile Mame | Sales and Markdown Save Profile |

Method 2:

a. Click OK. The Measure Dimension dialog box closes and the view is visible
again. The measures that you selected to be visible are shown in the view.

b. Click the Measure Profile icon in the View toolbar.
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Figure 8—4 Measure Profile Icon
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c. The Measure Profile menu appears. Click Save.

Figure 8-5 Measure Profile Menu: Save
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6. The Save Profile dialog box appears. Enter the name of the measure profile and
click Save.

Note: Existing measure profiles are visible in the Save Profile dialog
box.

Figure 8-6 Save Profile Dialog Box

Save Profile [ ]
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Save Cancel

Regardless of the method you use, you cannot create a measure profile that contains
the same measures and order of an existing profile. If you do create a measure profile
that is identical to an existing one, a warning message appears and asks if you would
like to rename the existing measure profile. Click OK to save it with the name you
entered in the Profile Name field. Click Cancel to leave it as the existing name.
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Figure 8—-7 Measure Profile Warning Message
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Similarly, you cannot save a measure profile with the same name as an existing
measure profile.

Applying Measure Profiles
To apply an existing measure profile to a view, complete the following steps:

1. Click the Measure Profile icon in the view tool bar.

Figure 8-8 Measure Profile Icon
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2. The Measure Profile menu appears. Click Select.

3. Alist of existing measure profiles appears next to the menu. The measure profile
in use is designated by a blue dot. Select the measure profile you want to apply.

Figure 8-9 Measure Profile Menu: Select
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The view refreshes and the measures of the measure profile appear.

Updating Measure Profiles

To update an existing measure profile, complete the following steps:

1. Click the Measure tile.
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Figure 8-10 Measure Tile
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2. The Measure Dimension dialog box appears. On the Show and Hide tab in the
Visible Measures section, select the profile you want to update from the list.

Figure 8—-11 Measure Profile List
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The Hidden Measures and Visible Measures lists are updated based on the profile
selected.

3. Update the profile by adding or removing measures from the Visible Measures list.
4. When finished updating the profile, click Save Profile.

5. A warning message appears and asks if you want to overwrite the content of the
measure profile. Click OK.

Figure 8—12 Update Measure Profile Warning Message
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6. Click OK at the bottom of the Measure Dimension dialog box to return to the view.

The measure profile is updated.

Deleting Measure Profiles

You can delete measure profiles that you have created. However, you cannot delete the
default profile. To delete an existing measure profile, use one of the following
methods:

Deleting a Measure Profile: Method 1

1. Click the Measure Profile icon in the View toolbar.
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Figure 8-13 Measure Profile Icon
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2. The Measure Profile menu appears. Click Delete.
3.

A list of existing measure profiles appears next to the menu. Click the measure
profile you want to delete.

Figure 8—-14 Measure Profile Menu: Delete
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4. A warning message appears, asking if you want to delete the profile. Click OK.

Figure 8-15 Measure Profile Warning Message: Deleting Profile
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The measure profile is deleted.

Deleting a Measure Profile: Method 2

You can also delete a measure profile from the Save Profile dialog box:

1. From the Save Profile dialog box, select the measure profile you want to delete.

2. C(lick Delete.
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Figure 8-16 Deleting from the Save Profile Dialog Box
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3. A warning message appears, asking if you are sure you want to delete the profile.

Click OK.

The measure profile is removed from the list.
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Dynamic Position Maintenance

Dynamic Position Maintenance (DPM) enables users to dynamically add, edit, or
remove positions to a non-calendar position while working in a workbook. These
user-defined or informal positions are updated in both the domain and workbook
dimensions. Positions added by the user are referred to as informal positions.
Positions added during the load process are referred to as formal positions.

When an informal position is to be made formal, the position's name (a label is not
necessary for the update to occur) must first be updated to reflect the correct position
name that will be loaded during the load process. Prior to the load, an administrative
utility is run against the environment to change the status of a position from informal
to formal (see the Oracle Retail Predictive Application Server Administration Guide for the
Fusion Client for more information on the updateDpmPositionStatus utility). This
process enables the loading and purging of that position through the hierarchy load
process and disables further DPM activities on the position.

Note: Access to the DPM menus and dimensions that DPM
functionality can be applied is determined in the solution and
workbook configuration (see the Oracle Retail Predictive Application
Server Configuration Tools User Guide for more information on enabling
DPM functionality).

DPM Restrictions

The following limitations for DPM exist:

= You cannot add a dynamic position to the calendar dimension. Due to the rolling
nature of calculations for measures, were you to add a position to the calendar
dimension, data for those measures and other measures that depend on them
would be inconsistent.

= Ina global domain environment, the DPM process cannot be used for maintaining
positions at or above the partition level. For example, if a global domain is
partitioned by department that rolls up to division, you cannot use DPM
functionality to add informal departments or divisions.

» Ina global domain environment, the DPM process cannot be initiated from
workbooks in the master domain.

When you creating a workbook for this purpose, pay attention to the “master
domain” warning in the Select Domain dialog. When opening, look at the
“Domain Type” column in the open dialog. This can steer you clear of master
domains.
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= Positions from alternate dimensions that are not already in the workbook cannot
be imported into the workbook to be used as parents for new DPM positions.

= DPM cannot be performed in a master domain.

Add New Positions to a Dimension
To add new positions to a dimension, complete the following steps:

1. From the Edit menu, select Position Maintenance and then the dimension to
which you want to add a dynamic position.

Figure 9—1 Position Maintenance Option in Edit Menu
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Or, right-click the position level to which you want to add a new position. The
right-click context menu appears. Select Position Maintenance and then select

Add Position.
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Figure 9-2 Adding a Dynamic Position
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2. The Add Dynamic Position window appears. The dimension levels outlined in a
thick blue line are informal positions. Click the Edit Position link in the dimension
level to which you want to add a position.

Figure 9-3 Add Dynamic Position Window
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Note: The aggregate information (district, region, company, and so
on) is populated only if the Add Dynamic Position window is
accessed from the right-click menu. If you accessed this window from
the Edit menu, these positions are empty.

If DPM is enabled in the configuration and domain, you can create
informal positions for workbooks that are based above the domain's
base intersection. For these positions, RPAS populates the position's
children with dummy positions. For example, you can create informal
subclasses in a workbook that only goes to the subclass level while the
domain goes to the style-color level. All lower level positions between
subclass and style-color will be dummy positions.

If there are alternate branches off those child positions that are not in
the workbook, and if they are DPM-enabled, RPAS generates dummy
positions for those as well. If they are not DPM-enabled, the first
existing formal position is selected. The position that is selected is
non-deterministic.

3. The Add [Position] dialog box appears.

»  If you selected the lowest dimension level, the Add Position dialog box looks
like Figure 9—4.

Figure 9-4 Add Position Dialog Box, Lowest Level

Add Ttem o

Positions to add 3 il
Label | New Leather Loafer
Mame | NwLeathLoaf

m Cancel

Enter information in the following fields:

- Positions to add: Enter the number of positions that you want to add at
this level. All of the positions will have the same attributes.

- Label: Enter the name that you want to appear in the pivot table. If you
are adding more than one position, this label is suffixed with a number.

For instance, if you enter 3 in the Positions to add field and new Leather
Loafer in the Label field, three labels appear in the pivot table:

New Leather Loafer0000001
New Leather Loafer0000002
New Leather Loafer0000003

— Name: Enter the name of the position or use the system-generated one
provided. When multiple positions are created, the name is concatenated
with a sequence number. This name is used in the RPAS server.

Click OK.

= If you selected a dimension level other than the lowest dimension level, the
Add Position dialog box looks like Figure 9-5.
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Figure 9-5 Add Position Dialog Box, Higher Levels
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Enter information in the following fields:

- Positions to add: Enter the number of positions that you want to add at
this level. All of the positions will have the same attributes.

- Label Prefix: Enter the name that you want to appear in the pivot table. If
you are adding more than one position, this label is suffixed with a
number.

For instance, if you enter 3 in the Positions to add field and Leather Loafer
Grandparent in the Label field, three labels appear in the pivot table:

Leather Loafer Grandparent0000001
Leather Loafer Grandparent0000002
Leather Loafer Grandparent0000003

— Name Prefix: Enter the name of the position or use the system-generated
one provided. When multiple positions are created, the name is
concatenated with a sequence number. This name is used in the RPAS
server.

In addition to the fields for the selected level, there are additional fields for the
levels below the level being added. In Figure 9-5, the selected level is
Grandparent and the lower levels are Parent and Item. If needed, enter
information for those fields as well.

Click OK.

Notes: If there are alternate hierarchies, the value can either be
selected or added as new if the alternate hierarchy supports dynamic
positions.

After multiple positions are added for a level in the position tree, the
levels above that level can only support single position add or edit.
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4. The Add Dynamic Position window refreshes with the new positions shown in the
selected dimension level.

Figure 9-6 Added Dynamic Position
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5. Modify the parent levels of the new positions. You can select an existing parent
level or create a new (dynamic) one. To do either, click the link in a level above the
new position.

Figure 9-7 Modifying the Parent Level
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6. Perform one of the two options:

= To select an existing position as the parent of the dynamic position, select one
from the drop-down list or search for one using the search link. For more
information about the search feature, see Using the DPM Search Feature.

Figure 9-8 Selecting an Existing Parent Level
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= To create a new (dynamic position) parent level, type the name of the new
parent in the Label field and select the Create New Position option.
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The Name field is enabled. Enter the name of the new parent. When finished,

click OK.

Figure 9-9 Creating a New Dynamic Parent
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7. Repeat step 6 for other parent levels.

8. When finished, click Save and Close. Or, if you want to add another position, click

Save and Next.

The Add Dynamic Position window closes. The view refreshes and the new position is

shown in blue text.

Figure 9-10 New Dynamic Position in View
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1000001 1L eather Loafer - Black 6.5
% 10000012 eather Loafer - Black 7B
100000 12L eather Loafer - Black 7B
% 100000 13Leather Loafer - Black 7.5 B
100000 13Leather Loafer - Black 7.5

Weekly | Weekly | Weekly | Boolean | Store
0.00 0,00  0.00
0.00 o.00  o.00 [
0.00 0,00  0.00
0.00 0.00  0.00
0.00 o.00 o.00 [
0.00 0.00  0.00
0.00 o.00  o.00 [
0.00 0,00  0.00
0.00 o.00  o.00 [
0.00 o.00 o.00 [
0.00 0.00  0.00
0.00 o.00 o0 D

Note:

If the active view has a PQD and the Automatically Evaluate

Position Queries option is enabled, the newly created position may
not appear in the view if its default value is set to false.

Modify an Informal Position

After dynamic positions are added to the hierarchy, the DPM process allows you to:

s Change the parent of a dynamic position to a different formal or dynamic parent.

= Update the position name and position label.
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Note: Only dynamic positions can be modified using the DPM
feature. The Modify menu is not visible if there are no dynamic

positions in the workbook.

1. Right-click the dynamic position you want to modify.

2. From the right-click menu, select Position Maintenance, then Modify Position.

Figure 9-11 Modifying a Dynamic Position

Copy Ctrl+C
~| Sales by Type
Paste Ctrl+v

b

's

A

EH calendar| 1 [ B
11/17/200& |=| Barcel :D

E “ﬂ Iﬁ@;ewmage m E E\%S:‘ g

EH Measure
i

Product

@ 4

|

[#3) Attributes v

5 pocket capri - Blas 4 L evel splitti R
5 pocket capri - Blas o' “P1ing

5 pocket capri - Blas | Position Maintenance

-

Add Position...

5 packet capri - Den
5 pocket capri - Den

Eind... Modify Position...

5 pocket capri-Den  Format 3 Delete Position

5 pocket capri - Lightweight A 0.00

1] E

X]

3. The Modify Dynamic Position window appears. Select the existing dynamic
position and modify the position label or position name. Or, select any parent of
the dynamic position to change the parent assignment.

Figure 9-12 Modify Dynamic Position Window

Medify Dynamic Position <]
Parent Grandparent Subclass Class
5 pocket capri - Khaki 5 pocket capei 111Fashion 1141Jeans®
IR
| Parent Diff1 GrandlrFf'arent . Subclass Diff1 . Class Diff1
Diff1

5 pocket capri - Antique ..,
. L | 5 pocket capri Medium

Item

5 pocket capr - Khaki 8

111Fashion Medum

1141Jeans™ Medim

Save and Close | Close

4. When finished, click Save and Close.

Delete an Informal Position

After a dynamic position is added, you can delete it and all child positions to which it

is a parent.
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Delete an Informal Position

Note:

Only dynamic positions can be deleted using the DPM feature.

The delete option is not be visible if there are no dynamic positions in

the workbook.

When a workbook contains only one dynamic position (no other
regular position or dynamic position), that position cannot be deleted.
In such cases, the "Delete Position" menu is disabled. When a
workbook contains more than one position (either regular and
dynamic or more than one dynamic position), the "Delete Position"

menu is enabled.

1. Right-click the dynamic position you want to delete.

2. From the right-click menu, select Position Maintenance and then Delete Position.

Figure 9-13 Deleting a Dynamic Position

Copy
Paste

|LE| Lock

~| Sales by Type

E Calendar
11/17/2006 |=| Barcel

E Lﬂi |_ EI'I.I'IEW Image
[ Attributes

5 packet capri - Blas If;'EL | solitt
5 pocket capri - Elas EVE spiting

Ctrl+C
Cirl+v

o

=
S
G

m A =

Measure
Product

|

5 pocket capri - Elas Position Maintenance

L2

Add Position...

5 pocket capri - Den
5 pocket capri - Den
5 pocket capri - Den

Eind...

Format

k

Modify Position...

| Delete Position |

5 packet capri - Lightweight A

0.00
0.00

E3)

3. The Delete Dynamic Position dialog box appears to indicate the dynamic position
that will be deleted and any child positions associated with it that will be deleted

as well. Click OK.

Figure 9—-14 Delete Dynamic Position Dialog Box

Delete Dynamic Position

‘You are are about to delete the following positions:

Item:5 pocket capri - khaki 8

This dynamic position maintenance operation will implicitly delete the following positions:

Parent:5 pocket capri - Khaki

Press Delete to continue or Cancel to abort.

Delets Cancel

The dialog box closes, and the dynamic position is removed from the view.
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Using the DPM Search Feature

When selecting the parent level that a new dynamic position belongs to, you can use
the search feature to find the desired level.

1. Click a level above the dynamic position you are creating, as shown in
Figure 9-15.

Figure 9—-15 Using the DPM Search Feature

Parent Diff1

5 pocket capel - Antigue ...

2. The Add/Select [Level] dialog box appears. Click the Label field to access the
Search link.

3. C(lick the Search link.

Figure 9-16 Search Link for DPM Search

Add/Select Parent [}

Label 5 pocket capri - Khaki |
5 pocket capri - Stonewashed &

5 pocket capri - Stonewashed &

5 pocket capri - Stonewashed 1

5 pocket capri - Stonewashed 1

5 pocket capri - Antique 10 An

5 packet capri - Black 10 Ankl
Baske i~ Stonewashed &

4. The Search and Result dialog box appears (Figure 9-17). Use the search features to
search for a position. You can search with the following options:

m Starts With

Mame

s Does Not Contain
= Not Equals
s Equals

s Contains

9-10 Oracle Retail Predictive Application Server User Guide for the Fusion Client



Using the DPM Search Feature

s Ends With

Enter a value in the search field and click Search.

Figure 9—17 Search and Result Dialog Box

Search and Result Dialog ]

~|Search Basic

*Reguired Operators for Parent |
T I

*Parent | Contains [i] Black
Starts With

Dioes not Contain Search | Reset

Not Equals

Parent |Equals

5 pocket Contains
P [Ends With

S

Enncket
5 pocket capri - Stonewashed 1
5 pocket capri - Stonewashed 1
5 pocket capri - Antique 10 An
5 pocket capri - Black 10 Ankl

5 pocket capri - Black 12 Ankl

5 pocket capri - Black 8 Ankle

5 pocket capri - White 10 Ankd |
5 pocket capri - White 12 Ankl

5 pocket capri - White 8 Ankle

5 pocket capri - Denim 10 Ankl

5 pocket capri - Denim 12 Ankl

5 pocket capri - Denim 8 Ankle

5 pocket capri - Stonewashed 1

5 pocket capri - Stonewashed 1 M

S TR S MUY PR S I

[il i | [l]
ﬂ Cancel

5. The dialog box refreshes with the positions that match the search. Select the
position you want and click OK.
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Figure 9-18 DPM Search Results

Search and Result Dialog )
~|Search Basic
*Required
*Parent | Contains [+] | Black
Search | Reset
|Parent

5 pocket capri - Black 10 Ankl
5 pocket capri - Black 12 Ankl
5 pocket capri - Black 8 Ankle

[( ] 1l [ )]
ﬂ Cancel

The Search and Result dialog box closes, and the selected position is filled in the
Add/Select [Level] dialog box.

Master Detail

Master Detail provides a named, pre-configured way to transition to another view,
filtered using your initial selection. Both the Transition and the Worksheet are

configured to support your specific application's needs. This appears as a View Detail
menu when one or more transitions are applicable.
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Dynamic Attributes

Dynamic attributes are attributes you can create in the RPAS Fusion Client. Dynamic
attributes describe a particular dimension and level based on a measure’s value at
specified levels of other dimensions. The dynamic dimension attributes can be used
for level splitting, sorting, and displaying in the workbook. For instance, you can
create an attribute based on the weekly sales that describes stores in terms of their
weekly sales rate: low, average, or high.

After you have created a dynamic attribute, it is saved to the domain. It is added to the
workbook during workbook build process if the dimension is present and if the
following conditions are met:

»  The attribute is accessible by the user.

= The source measure exists in the workbook.

= The other positions of this attribute fit into the workbook context.
The attribute data is only updated when the attribute is used.

This chapter describes the various tasks you can perform with dynamic attributes. It
includes the following sections:

»  Accessing the Define New Attribute Dialog Box
s Creating Dynamic Attributes

s Managing Dynamic Attributes

= Updating Attribute Values

Accessing the Define New Attribute Dialog Box

Dynamic attributes are created in the Define New Attribute dialog box. You can access
this dialog box in three ways: with the attributes icon in the toolbar, from the
right-click context menu, or from the dimension dialog box.

Attributes Icon in the Toolbar
Figure 10-1 Attributes Icon

|
BEla | e | [Frd e EEF R

From the Right-Click Context Menu
1. Right-click a dimension level. The right-click context menu appears.

2. Select Create New Attribute.
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Figure 10-2 Create New Attribute: From the Right-Click Context Menu

J PULKEL Lapil = AL IE

5 pocket capri - An (= view Image

z p'x:‘ £apri - An| [ Attributes Y| Create new Attribute...

5 pocket capri - Bar - —

LA Level splittin 3 ;

5 pocket capri - Bar plitting Manage Attributes. ..

5 pocket capri -Bar Position Maintenance ’ Show Attributes and Sort...

5 pocket capri - Blac Find...

5 pocket capri - Blac

5 pocket capri -Blac ~ Format ’
0.00 =

From the Dimension Dialog Box
1. Click a dimension tile. The dimension dialog box appears.

2. C(Click the Show Attributes and Sort tab.
3. C(lick the New Attribute icon in the Available Attributes section.

Figure 10-3 Create New Attribute: From the Dimension Dialog Box

Sales by Type - Product

Levels Show Attributes and Sort Show and Hide

Available Attributes

view + | [Find... + & @ | | Hpetach
> T 211 |

Creating Dynamic Attributes
To create a dynamic attribute, complete the following steps:

1. Access the Define New Attribute dialog box using the icon, right-click context
menu, or the dimension dialog box, as described in the Accessing the Define New
Attribute Dialog Box section.
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Figure 10-4 Define New Attribute Dialog Box

Define New Attribute L]

Attribute Name Weekly Sales

Dimension Location ||

Level | Store [w]

Calendar all [Calendar] v all [Calendar] |
Product all [Product] v all [Product] x|
Measure | Weekly Sales v

Is Displayed

Clustering (") No Clustering

(=) Clustering
Mumber of dusters 3 §| Auto Fill
Group 1label | 1-Low Infinity - 200.0 )
Group 2 Label | 2 - Average =200.0 - 500.0
Group 3 Label | 3 - Highl = 500.0

:v:
M Cancel

Enter the following information:

Attribute Name: Enter a name for the attribute. The name must be unique
across a level for a selected dimension and fewer than 80 characters.

Dimension: Select the dimension that the attribute should apply to.

Level: Select the level of the dimension chosen in the Dimension field. This is
the level that the attribute should apply to.

[Dimension1] and [Dimension2]: These fields display the dimensions that
were not chosen in the Dimension field. Select the dimension levels and
positions that the attribute should be applied to for each.

Measure: Select the measure that the attribute should be based on.

Is Displayed: Check the check box if you want the created attribute to be
displayed in the view after it is created. If this was not selected, the attribute is
created but not visible. To make the attribute visible at a later time, select it for
display in the Dimension window as described in Select Attributes for
Display.

Clustering: Select No Clustering if you want the data from the measure to be
replicated in the attribute. Select Clustering if you want to group the
dimension by the values of the measure data.

Number of clusters: Choose the number of groups that you want the attribute
to create. This option is visible only if clustering is selected.

Group Label: Enter the label of the attribute that you want to apply to that
cluster of data. Specify how the clusters should be defined by entering a range.

Auto Fill: Click this button to automatically create the range for each cluster.

Note: The cluster options are only available for real and integer
measures.

Click OK.
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The attribute is added to the pivot table.

After you have created the attribute, you can sort the positions by attribute. For more
about sorting, see Attribute Sorting.

Figure 10-5 Dynamic Attribute: Clustering Example

~| Sales Total * J v A
BER calendar| Product EB Measure
[ 2l [Calendar] | = [ 2l [Product] | - Ef Location
e |
Bl | & | [Fnd. ~ % & BEcoa»
Weekly Sales
W all [Location] | Barcelona 3 - High 1148.00
Berlin 2 - Average 400,00
Chicago 1-Low 50.00
Dusseldorf 1-Low 50.00
London-Oxford Streef ' 3 - High 620.00
Madrid 3 - High 1440.00
Minneapolis 1-Low 100.00
Montreal 1-Low 75.00
New York City 1-Low 75.00
Paris 2 - Average 300.00

Another way to use dynamic attributes is to duplicate measure data in the attribute.
For instance, if you had a Climate measure that describes the climate of a location, you
could create an attribute based on that measure and select No Clustering, as shown in
Figure 10-6 and Figure 10-7.

Figure 10-6 Define New Attribute: No Clustering

Define New Attribute L]

Attribute Name | Store Climate
Dimension Location [v]
Level Store [v]
Calendar all [Calendar] [v] all [Calendar] hd
Product | all [Product] [v] all [Product] |
Measure | Store Climate Attribute [v]
Is Displayed

Clustering () No Clustering |

Clustering

Mumber of dusters = Auto Fill

M Cancel
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Figure 10-7 Dynamic Attribute: Non-Clustering Example

~| Sales Total * b v A
B Calendar| Product E] Measure
|E|| [Calendar] =] all [Product] |= ﬁ Location
|
Bl | & | [And.. ~$ & BEcamE >
eekly Sales | Store Climate Attribute
%W all Location] | Barcelona Hot 1148.00 Hot
Berlin Mild 400.00 Mild
Chicago Cold 50.00 Cold
Duszeldarf Cold 50.00 Cold
London-Oxford Stregt « Mild 620.00 Mild
Madrid Hat 1440.00 Hot
Minneapolis Cold 100.00 Cold
Montreal Cold 75.00 Cold
MNew York City Cold 75.00 Cold
Paris Mild 300.00 Mild

Managing Dynamic Attributes

After you have created a dynamic dimension attribute, you can edit, copy, rename, or
delete it using the Manage Dynamic Attributes dialog box.

The Manage Dynamic Attributes dialog box displays all attributes for the selected
dimension and level. You can search for attributes by using the attribute filter. You can
search all dimensions and levels by selecting All in the Dimension drop-down list. Or,
you can search by a particular dimension, level, and measure.

Figure 10-8 Filtering Attributes

Manage Dynamic Attributes B
View » New  # Edit Copy mRename 3¢ Delete i Detach

Filter By Dimension |Location [w|Level [Store [ Measure |all [»] @

Name LAtl:!mﬁon |Level |Measure Location |calendar |Product |Mum of Clusters

Weekly Sales Calendar Store Weekly Sales all [Calendar]:all [... all [Product]:all [Pr... 3

Weekly 5ales2 Product Store Weekly Sales all [Calendar]:all [... all [Product]:all [Pr... 3

Store Climate Location Store Store Climate Attri... all [Calendar]:all [... all [Product]:all [Pr...

A I | [2]

Close

By default, attributes for the innermost layer of the selection on the pivot table are
listed. If there are no attributes for the selected level, attributes for all visible levels of
the selected dimension are displayed.

If there are no attributes for the selection dimension, all attributes across all
dimensions are shown. If there are no attributes across any dimension, a message
states that there are none.
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Accessing the Manage Dynamic Attributes Dialog Box

To access the Manage Dynamic Attributes dialog box, complete the following steps:

1. Right-click in the content area.

2. The right-click context menu appears. Select the Manage Dynamic Attributes

option.

Figure 10-9 Manage Dynamic Attributes

~| Sales Total |IEI Aftributes v Create New Attribute. ..
ER calendar| Produ: CHLevel splitting ¢ Manage Attributes. ..
all [Calendar] || zll [Produc Position Maintenance L4 Show Attributes and Sort...
& Lﬂi |_ Find... Hide Selected Attribute(s)
Format ' Fe Climate Attribute
% all [Location] Hot 1143.00 Hot
Berlin Mild 400,00 Mild
Chicago Cold 50.00 Cold
Dusseldorf Cold 50.00 Cold
London-Oxford Street « Mild 620,00 Mild

3. The Manage Dynamic Attributes dialog box appears.

Figure 10-10 Manage Dynamic Attributes Dialog Box

Manage Dynamic Attributes L]
View - Mew A Edit Copy  J=mRename 3¢ Delete & Detach

Filter By Dimension | Location [v] Level |Store [v] Measure | Al [v] @

Narne |Dimension |Level |Measure |Location |Calendar |Product |Mum of Clusters
Weekly Sales  Location  Store Weekly Sales all [Calendar]:all [Calend... all [Product]:all [Pro... 3

Weekly Sales2 Location  Store Weekly Sales all [Calendar]:all [Calend... all [Product]:all [Pro... 3

Store Climate  Location  Store Store Climate Attribute all [Calendar]:all [Calend... all [Product]:all [Pro...

[( ] i | [)]

Close

From the Manage Dynamic Attributes dialog box, you can edit, copy, rename, delete,

or create attributes.

Editing Dynamic Attributes

To edit a dynamic attribute, complete the following steps:

1. Access the Manage Dynamic Attributes dialog box as described in Accessing the

Manage Dynamic Attributes Dialog Box.
2. Select the attribute you want to edit and click the Edit icon.
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Figure 10-11 Editing a Dynamic Attribute

Manage Dynamic Attributes

View - MNew Copy Ij:EI Rename

Filter By Dimension |Location |w|Level [Store  [s] Meast

Mame |Dimensi0n |Level |Measure |L0cat’t
Weekly Sales  Location  Store Weekly Sales

Weekly Sales? Location  Store Weekly Sales

Store Climate  Location  Store Store Climate Attribute

3. The Edit Attribute dialog box appears. Make changes to the attribute information.
For details about the fields, see Step 2 of the Creating Dynamic Attributes section.

Figure 10-12 Edit Attribute Dialog Box

Edit Attribute <)

Attribute Mame | Store Climate
Dimension Location [v]

Level | Store [w]

Calendar Fiscal Quarter [v] all [Calendar] x|
all [Calendar]
Product Fiscal Year all [Product] x|
Fiscal Half
Measure Dute |w
Is Displayed | Fiscal Month
Wesk
Clustering (&) No Clustering
Clustering
Mumber of dusters = Auta Fill

ﬂ Cancel

4. When finished, click OK.

Copying Dynamic Attributes

To copy a dynamic attribute, complete the following steps:

1. Access the Manage Dynamic Attributes dialog box as described in Accessing the
Manage Dynamic Attributes Dialog Box.

2. Select the attribute you want to copy and click the Copy icon.

Figure 10-13 Copying a Dynamic Attribute

Manage Dynamic Attributes

View - MNew / Edit Copyl Ij:EI Rename

Filter By Dimension |Location |[w|Level [Store  [s] Meast

Mame |Dimensi0n |Level |Measure |L0cat’t
Weekly Sales  Location  Store Weekly Sales

Weekly Sales? Location  Store Weekly Sales

Store Climate  Location  Store Store Climate Attribute
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3. The Copy Attribute dialog box appears. Enter the name of the new attribute. The

name must be unique across the level for a selected dimension and fewer than 80
characters.

Figure 10-14 Copy Attribute Dialog Box

Copy Attribute B

*MNew Attribute Name | Copy of Store Climate

M Cancel

4. C(lick OK.

Renaming Dynamic Attributes

To rename a dynamic attribute, complete the following steps:
1. Access the Manage Dynamic Attributes dialog box as described in Accessing the
Manage Dynamic Attributes Dialog Box.

2. Select the attribute you want to rename and click the Rename icon.

Figure 10-15 Renaming a Dynamic Attribute

Manage Dynamic Attributes

view v | [FNew AEdit [ Copy

Filter By Dimension |Location [w] Level [Store

| % | Meast
MName

|Dimensi0n |Level |Measure

Weekly Sales  Location  Store Weekly Sales

Weekly Sales? Location  Store Weekly Sales

Store Climate  Location  Store Store Climate Attribute

|L0cat’t

3. The Rename Attribute dialog box appears. Enter the new name. The name must be

unique across the level for the selected dimension and fewer than 80 characters.

Figure 10-16 Rename Attribute Dialog Box

Rename Attribute o

* Attribute Mame | Store Climate

E Cancel

4. Click OK.

Deleting Dynamic Attributes

To delete a dynamic attribute, complete the following steps:

1. Access the Manage Dynamic Attributes dialog box as described in Accessing the

Manage Dynamic Attributes Dialog Box.

2. Select the attribute you want to delete and click the Delete icon.
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Figure 10-17 Deleting a Dynamic Attribute

Manage Dynamic Attributes

View - MNew / Edit Copy Ij:EI Rename

Filter By Dimension |Location [v] Level | Store [v] Measure | All

Name |Dimensi0n |Level |Measure |L0cat’0n |Calendar

Weekly Sales  Location  Store Weekly Sales all [Calendar]:all [Caler
Weekly Sales? Location  Store Weekly Sales all [Calendar]:all [Caler

3. A warning message appears. Ensure that you have selected the correct attribute
and click Delete.

Figure 10-18 Delete Attribute Dialog Box

(A Warning L)

Deleting this attribute will permanently remove it. Are you sure you want to delete?

Delete Cancel

The attribute is deleted from the list.

Updating Attribute Values

If data in the base measure of the attribute has changed, you may need to recalculate
the attributes to see the updated data. To do this, use the Update Attribute Values
option in the View menu or the Update Attribute Values and Level Splits icon in the
toolbar.

Figure 10-19 Update Attribute Values Option

¥ Commit status: Never Committed iﬂ g

Go To 3
r Synchronize Page Edge
Automatically Evaluate Position Queries

Resort Positions on Pagination

)
@ Manage [mages...

| Attributes ¥ | Create New Attribute...
D[j‘ﬁle Wertically Manage Attributes. ..
== Tile Horizontally Update Attribute Values
EETe

Figure 10-20 Update Attribute Values Icon

Home About Help Change pagsword Logout gain -

- B & |- .|_. = & Workbook : level

The values of the user-defined attributes must be recalculated based on the user edits.
The update icon and menu are enabled only when attributes are displayed that need to
be recomputed based on user edits. Clicking the update option or icon recalculates all
sort attributes and level splits displayed in the workbook based on the user edits since
the attribute or dimension split was applied to the data.
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Sort

Simple Sort

Sort, Find, and Position Queries

Easily sorting and finding data is essential when working with workbooks that contain
thousands of items, hundreds of locations, and an endless number of dates. Being able
to put this data in a logical order or find a specific piece of information is what makes
planning possible.

This chapter describes the ways you can sort, find, and query data:
= Sort
- Simple Sort
— Attribute-Based Sort
= Find
»  Position Query
= Position Filtering

= Working with Position Filters

There are two kinds of sort: simple sort and attribute sort. Both can be used to put the
data in a meaningful order.

You can sort positions in a level by using the sort icons on the toolbar or the arrows
that appear on column headers. The positions are sorted based on the values of a
measure's slice for that level. This sorting can be done without defining additional
attributes.

The sort occurs along a single measure, using only a single level in the sort. The
sorting is limited to the current view, providing the user an ability to see the same data
sorted differently in different views. Sorting is only available in the pivot table or split
view. It is not available in the graph view.
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Note: A slice is valid if it involves only one measure and if it has a
unique value for each position along the level being sorted (meaning
that one position along all other dimensions in the measure's
intersection has been selected).

A simple sort cannot be applied to positions in a dimension along the
page axis. However, you can pivot the desired dimension to either
row or column axes, execute the sort along the desired slice, and then
pivot the sorted dimension back to the page axis.

After you have selected the desired valid slice of measure data that you want to sort,
the sorting arrows are enabled on the toolbar and in the columns, as shown in
Figure 11-1.

Figure 11-1 Sort Arrows

Sort Sort
Ascending Descending

Bau & f. - § Ei%éﬂ@ltﬁ

| Measure [ Label ] Ftore Climate Attribute

% all [Location] |Barcelona Hot ]
Berlin Mild 400.p0 Mild

Chicago Cold 50.p0 Cold

Column Sorting Arrows

After you click one of the sort arrows, the selected positions are sorted according to the
measure's values in the selected slice.

The Sort Ascending icons in the toolbar and columns order the data so that the lowest
number appears at the top of the list and the highest at the bottom. After the data is
sorted, the column header is shaded gray and the Sort Ascending arrow is shaded
dark gray, as shown in Figure 11-2.

Figure 11-2 Sort Ascending

~| Sales Total >~ 4+ v A
B Calendar| Product] B3 Measure|
|a|| [Calendar] | =| all [Product] |= m Location
A |
Bl il | & | [Fnd.. ~ & & B EcamE 4
Store Climate Attribute
% all Location] | Chicage Cold 50,00 Cold
Dusseldorf Cold 50,00 Cold
Mew York City Cold 75.00 Cold
Maontreal Cold 75.00 Cold
Minneapolis Cold 100,00 Cold
Paris Mild 300.00° Mild
Berlin Mild 400.00 Mild
London-Oxford Street « Mild 620,00 Mid
Barcelona Hot 1148.00 Hot
Madrid Hot | WF  1440.00 Hot

The Sort Descending arrows order the data so that the largest number is at the top.
Again, after the data is sorted, the column header is shaded gray and the Sort
Descending arrow is shaded dark gray (Figure 11-3).
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Figure 11-3 Sort Descending

~| sales Total > b A
B Calendar| Product] j@ Measure |
[l [Cslendar] | = [l [Produa] |- B Location
.|
Bl | & | (A -9 & DA @A MM
Store Climate Atiribute
* all [Location] | Madrid Hot | g4 18400001 Hot
Barcelona Hot 1148.00 Hot
London-Oxford Street  Mild 620,00 Mild
Berlin Mild 400.00 Mild
Paris Mild 300.00 Mild
Minneapolis Cold 100,00 Cold
Montreal Cold 75.00 Cold
Mew Yark City Cold 75.00 Cold
Dusseldorf Cold 50,00 Cold
Chicago Cold 50.00 Cold

Sorting should be reapplied after operations that do not change the data. If you show

or hide positions, change the rollup, or switch the mode from outline to block view or
vice-versa, you should reapply the sort. Since a pivot operation resets the selected sort
slice, you must reselect a valid slice and sort again.

If you use the View Attributes and Sort tab to perform a attribute sort, the simple sort
is overridden. Previous sorts (either attribute-based or simple sort-based) are not
maintained after a new simple sort.

Data editing operations like calculate, update, or refresh do not reapply the sort, and
the positions remain in the last sorted order.

If you edit a cell and attempt to sort using the toolbar icon, a message appears that
states that the edited cells need to be calculated before the sort operation can take
place.

Figure 11-4 Uncalculated Cells Warning Message

,fﬂ Warning L]
This operation requires the cells to be calculated. Would you like to calculate the workbook, revert ar cancel the sort?

Calculate | Revert | Cancel |

You can choose to calculate, revert, or cancel:

= Calculate: The positions are sorted after the calculate operation is performed.
= Revert: The edits are reverted and the sort is performed.

= Cancel: The sort operation is canceled.

If you have edited the cells and attempt to sort using the column header icon, the page
refreshes without applying the sort and the header no longer displays the icon to sort.
If you perform other operations such as show and hide after the edits that have caused
the page to refresh, the sort icon does not appear in the column header until the edited
cells are calculated.

Sorting By Column Headers

You can sort data by mousing over the pivot table column headers to make the
ascending and descending sort icon appear.

Sort, Find, and Position Queries 11-3



Sort

Figure 11-5 Sort Icons in Column Header

Weekly Salesl_\vl

1148.00
400.00
50.00
50,00
620.00

Click the icons to sort the positions along the row-edge based on the vales of a
measure's slice for that dimension. The column is highlighted and the column header
displays a selected sort icon (ascending or descending) based on the sort direction.

Figure 11-6 Sort Icons in Column Header After Sort

Weekly Sales =W
1440.00

1148.00

©20.00

400.00

300.00

The sort icons do not appear on the column headers if the slice (with the selected
column) is invalid. For example, when the measures are on the row edge, the sort
icons do not appear on the column headers. Also, when there is more than one
dimension on the column axis, the sort icons appear only on the inner layer.

Sorting with the Toolbar Icons

The sort icons in the toolbar are enabled if there is a valid slice involving a single
measure being selected. Select either a column or row and click the one of the sort
icons. The toolbar icons are more useful for sorting the rows.

Figure 11-7 Sort Icons in Toolbar

Blau & . -~ & ¢ DmEs@A @[l
% all [Location]

Madrid | Barcelona | London-Oxford Street | Berlin | Paris | Minneapolis

Hot Hat Cold Milde Mild Cold
Weekly Sales 1440.00 _1143.00 620.00 400.00 300.00 100.00
Store Climate Attribute | Hot 10t Cold Mild Mild Cold

The selected position is sorted according to the measure's values in the selected slice. If
the rows were sorted, only the row appears selected. If a column was selected, a sort
icon appears in the column header.

If you select an invalid slice, for instance, multiple rows or columns, the sort icons are
enabled but clicking them results in an error message that states the selected slice is
not a valid slice for sorting.

Sorting in Outline Mode and Block Mode

You can sort in either the outline or block mode. Sorting in the outline mode sorts all
the positions as well as the positions within those positions. Sorting in block mode,
however, only sorts the highest aggregate position.

Outline Mode If the pivot table is in outline mode, that is, it displays aggregate levels of
the dimension in separate rows or columns in the same grid, the aggregate positions as
well as the positions within the aggregate positions are sorted.
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In Figure 11-8, note how the 5 Pocket Capri position is listed first because it is larger
than both the 5 Pocket Frayed Jeans and Bohemian 5 Pocket Jeans groups. Then,
within the 5 Pocket Capri group, the style/sizes are listed in order of greatest to least,
the "Antique 10 An" being the largest of all the departments.

Figure 11-8 Sorting in Outline Mode

Weekly Sales - Regular

W 5 pocket capri 36759.00
5 pocket capri - Antique 10 An 7859.00

5 pocket capri - Denim 10 Ankl 65356.00

5 pocket capri - Antique 12 An 6253.00

5 packet capri - Denim 12 Ankl 5739.00

5 pocket capri - Antique 8 Ank 5607.00

5 pocket capri - Denim 8 Ankle 4395.00

7 5 Pocket Frayed Jeans 65295.00
5 Pocket Frayed Jeans - Stonew 2756.00

5 Pocket Frayed Jeans - Antiqu 2035.00

5 Pocket Frayed Jeans - Lightw 1503.00

W 1000005 1Bohemian 5 Pocket Jeans 2369.00
10000054Bchemian 5 Pocket Jeans - Ston 785.00

Block Mode If the pivot table is in block mode, that is, it displays the dimension levels
in separate rows or columns but not the aggregate levels, the simple sort still orders
the aggregrate levels as well as the dimension levels within them.

In Figure 11-9, note how the 5 Pocket Capri, 5 Pocket Frayed Jeans, and Bohemian 5
Pocket Jeans groups do not have an aggregated number in the column. Nevertheless,
the groups are still ordered greatest to least, as are the style/sizes within those groups.

Figure 11-9 Sorting in Block Mode

W 5 pocket capri

% 5 Pocket Frayed Jeans

5 pocket capri - Antique 10 An

5 pocket capri - Denim 10 Ankl

5 pocket capri - Antique 12 An

5 pocket capri - Denim 12 Ankl

5 pocket capri - Antique 8 Ank

5 pocket capri - Denim & Ankle

5 Pocket Frayed Jeans - Stonew
5 Pocket Frayed Jeans - Antiqu
5 Pocket Frayed Jeans - Lightw

% 10000051Bohemian 5 Podket Jeans | 10000054Bohemian 5 Pocket Jeans - Ston

Sorting Across Page Edge

When the positions are sorted on a specific slice, by default the positions stay in the
previously sorted order as you page through the positions along the page-axis. In
other words, the positions are not resorted based on the new selections in the
page-axis. If you want to reapply the sort when paging through positions along the
page-axis, you must enable the Resort Positions on Pagination option in the View

menu.

Weekly Salec e
7859.00
£356.00
6253.00
578,00
5e07.00
4895.00
2756.00
2036.00
1503.00

7585.00

For example, there are two slices that display the sales of five stores: one slice displays
data for the denim 5 pocket capri, the other displays data for the antique capri. Before
sorting, the five stores are listed in alphabetical order, as shown in Figure 11-10. When
the user scrolls from one slice to the other, the stores stay in alphabetical order.
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Figure 11-10 Two Unsorted Slices

~| Sales by Type ~| Sales by Type
ER calendar| Product| K ¢3!y T B Celendar| Product| K¢ 3 M7
[T1/17/2006 | = [ pocket capr - Denim = [ 117172006 | =[5 pocket capri - Antique |-
Bla i | & | [Frd. - Bl |l | [Fnd -
Weekly Sales - Regular Weekly Sales - Regular
Barcelona 300,00 Barcelona 200.00
Berlin 500.00 Berlin 400,00
Boston 100,00 Boston 100,00
Catalog Store 400.00 Catalog Store 300.00
Chicago 200.00 Chicaga 500.00
Denim Antique

When a user sorts the denim slice by descending order, the stores are reordered so that
the store with the highest sales, Berlin, is at the top. If the user scrolls to the antique
slice, Berlin is still at the top even though the Chicago store has the highest sales. This
is because the positions stay in the same order by default. They are not resorted
according to the data. This is shown in Figure 11-11.

Figure 11-11 Sorted Slices, Default Setting

~| Sales by Type ~| sales by Type
FR Calendar| Product| i ¢ » »w |EB Calendar| Product| i ¢/3lM ¥
[11/17/2006 | = [ 5 pocket capri - Denim = [11/17/2006 | [ 5 pocket capri - Antique |«
Find... -
Berlin 500.00 Berlin 400,00
Catalog Store 400.000 |Catalog Store 300.00
Barcelona 300,00/ |Barcelona 200.00
Chicago 200.00 Chicago 500.00
Boston 100.00 Boston 100.00
Denim Antique

On the other hand, if the Resort Positions on Pagination feature is turned on, the
positions are resorted according to the data. The Resort Positions on Pagination option
is located in the View menu.

Figure 11-12 Resort Positions on Pagination

= # Commit statu

w = | Format

GoTo 3

Synchronize Page Edge

Automatically Evaluate Position Queries

| Resort Positions on Pagination

@ Manage Images...
Attributes 2
Dlj'ﬁle Vertically
g'ﬁle Harizontally
E5Tile

When the Resort Positions on Pagination feature is turned on and the first slice is
sorted by descending order, when the user scrolls to the next slice, it too is sorted, as
shown in Figure 11-12.
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Figure 11-13 Sorted Slices with Resort Pagination

~| Sales by Type ~| Sales by Type
A calendar| Product| k¢ M7 A calendar| Product| ¢ M7
[11/17/2006 | = [ 5 pocket capri - Denim = [11/17/2006 | = [ 5 pocket capri - Antique =
Em Y Find... - Em Y Find... -
Weekly Sales - Regufur
Berlin 500,00 Chicago
Catalog Store 400.00 Berlin
Barcelona 300.00 Catalog Store
Chicago 200.00 Barcelona
Boston 100.00 Boston
Denim Antigue

Note: Simple sort cannot be applied to positions in a dimension
along the page axis. However, you can pivot the desired dimension to
either row or column axes, execute the sort along the desired slice, and
then pivot the sorted dimension back to the page axis.

The Resort Positions on Pagination option is saved with the workbook
formatting. For more information about formatting and how
formatting is saved, see Saving Formats.

Undo Sort Using the Context Menu
If you want to undo a sort, right-click and select Undo Sort from the right-click context
menu.

Figure 11-14 Undo Sort in Context Menu

«| Sales by Type Paste Ctrl+¥ k

Bl Calendar| Product [ @' Lock

[11/17/2006 | = [ 5 pocket capri - Antique 12 An]=

[ Attributes P B
@ Find... o -
C E,%Z! Level splitting 3

Weekly Sales - Reg:
Chicage 500 Find... "y
Berin 00 Format NE
Catalog Store 300
Barcelona app|  Undo Sort
Boston 100.00 [v

You do not need to select the exact slice; any slice on the sorted dimension renders the
Undo Sort option. After you select the Undo Sort option, the simple sort is no longer
applied and the positions appear in the original sort order that was shown when the
view was first opened.

Attribute Sorting

An attribute is a piece of information that further describes a position at a given level.
For example, the SKU level of the product dimension could have three attributes
associated with it: label, color, and price. This means, any SKU in this product
dimension could have attribute values of:

s LABEL:SKU00012 - Cashmere Sweater
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s COLOR: Pale Blue
s PRICE: $62

Label is the only attribute that is required, but positions in a level can be described
with any number of attributes. After they are established, attributes can be displayed
in the view if desired. The dimension's attributes can also be used to decide display
sort order for positions within that level.

But before you can sort by attributes, you need to select the desired attributes to
appear in the view.

Select Attributes for Display

To see the available attributes that you can sort by, complete the following steps:

Note: You use the Show Attributes and Sort tab to determine which
image attributes are visible in the UI. For more information about
images, see Chapter 2, Chapter 13, and Chapter 14.

1. In an open view, click the dimension tile of the dimension that you want to sort by
an attribute. In Figure 11-15, the Location dimension has been selected.

Figure 11-15 Dimension Tiles

~| Sales by Type * 4 oo A

El Calendar Productl RE»NT :Iﬁ Measure

[11/17/2006 | =[ & pocket capri - Antigue 12 An|= EAl| Location

2. The Dimension window appears. Click the Show Attributes and Sort tab.

3. In the Show Attributes and Sort tab, the available attributes for the dimension are
listed in both the Available Attributes and Sort Attributes sections on the left. The
attributes currently shown in the view are listed on the right. These attributes have
a check mark beside them.
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Figure 11-16 Show Attributes and Sort Tab

Sales by Type - Location

Levels Show Attributes and Sort

Available Attributes

view v | [Find... - & ¢ i Detach » View v
¥ Store ¥ Store
v Label Label
Climate
Weeldy Sales
>
Weekly Sales2 J
Store Climate
Store Climate Attribute
<l
Sort Attributes
Available Attributes Sort Attributes
View ~ Find... - & ¢ i Detach View ~
¥  Store ¥  Store
v Label Label [
Climate
Weekly Sales .
>
Weekly Sales2 d
Store Climate
Store Climate Attribute
E

Hold down the CTRL or SHIFT key and dick to select multiple items. Drag and Drop the items or use the Add/Remove buttons to move the items.

Show and Hide

Visible Attributes

Apply E Cancel

a. Select the attributes that you want to appear in the view from the Available
Attributes section at the top.

b. Either click the right arrow to move the attribute to the Visible Attributes box
on the right side or drag the attribute to the right side.

c. Repeat the same process for the attributes you want to sort by moving them to
the Sort Attributes section at the bottom.

d. When you are finished, click OK. This saves your changes and closes the

window.

If you want to make additional changes on other tabs in the Dimension
window, click Apply instead. This saves your changes but leaves the
Dimension window open so you can go to other tabs.

The attributes now appear in the workbook as shown in Figure 11-17.

Figure 11-17 Attributes Shown in a View

~| Sales by Type

>~ F g A

Measure

] Calendar| Product| w ¢ » w7 jﬁ
[11/17/2008 | =[ 5 pocket capri - Antique 12 An = Ef Location
rY
Bl i | & | [Frd- - EEE
Weekly Sales - Regular
|Store
W Brazi 0.00 i
Rio de Janeiro Cold 0.00 =
Sao Paulo Cold 0.00
W Canada 0.00
Montreal Cold 0.00
Toronto Cold 0.00 [

If you have selected image attributes to appear, they will be displayed as well. You can
hover over the image in order to see the position and image label.
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Displaying Attributes in Views

In the Fusion Client, you can display attributes in both the outline and block views.

Outline View

In the outline view, you can view the attributes in either the row edge or the column
edge. In outline view, for each dimension, the first layer displays attributes with
display order 1 merged across levels. This layer also features the expand and collapse
icons. By default, after the first layer, each displayed attribute is rendered as a separate
layer.

Views You can view attributes in two places in the outline view: the row edge and the
column edge.

Figure 11-18 Outline View: Attributes in Row Edge

~| Sales by Type - 4oy A
] Calendar| Product| w ¢ >N 7 jﬁ Measure
[11/17/200 | =[ 5 pocket capri - Antique 12 An = ER Location

S

Bl | 1& | [Frd -3 @ mAE >

Weekly Sales - Regular
Attribute Level —
7 Erazi 0.00 )
Rio de Janeiro Cold 0.00
Sao Paulo Cold ) 0.00
7 Canada Attributes 0.00
Montreal Cold 0.00 ]
Toronto Cold 0.00 hd

Figure 11-19 Outline View: Attributes in Column Edge

~| Sales by Type > + ¢ 7
[l Calendar| Product] w<¢ %7 B8 Location
[11/17/2006 | s[5 pocket capri - Antique 12 An |= j@ Measure
|
Bla | & | [Fod. -3 ¢ ma »
Attribute Label | */ Braazil " Canada
Rio de Janeiro | Sao Paulo Maont]
[ store [ Climate ] | Cold Cold C
Weekly Sales - Regular 0.00 oo T T
Attributes
£ >

In the outline view, the default ordering of displayed attributes across levels is from
higher to lower levels. For example, the attribute from the higher district level is
displayed, first followed by the lower store level.

For each dimension, the first layer always features the expand/collapse icons. In
addition, the label itself is an attribute, and you can choose to display it in any order or
hide it altogether (as long as there is at least one attribute displayed for each level). For
example, you can choose the label attribute for both the store and district levels as
second in display order, with SKU Label reordered before District Label.
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Attribute labels can be combined with levels and shown as Level Label (Attribute
Label) format. For example, the Store (Fmt) shown in Figure 11-19. The attribute label
hovers above the layer. However, hovering over the first layer just displays the
dimension label.

Merge and Split You can choose to display multiple attributes as a single layer by using
the merge option in the right-click context menu. After you have merged two
attributes together, you can split them using the split option in the context menu
option.

Note: The Merge and Split feature is only available in the outline
view, not the block view.

To merge two attributes, complete the following:
1. Right-click one of the attributes you want to merge.

2. In the context menu that appears, select Merge and then select the other attribute
from within the Merge menu. See Figure 11-20 for an example.

Figure 11-20 Merging Attributes

~| Sales by Type Revert Cell | - 4oy A
BH calendar| Product | [ Attributes ’ | Create Mew Attribute. .. |
[12/17/2006 | =[S pocket capri - An L Level splitting 2 Manage Attributes. ..
L |
Fiy  Posifion Maintenance ’ Show Attributes and Sort...
Eind... Hide Selected Attribute(s)
Format | Store (Climate) I |E'Merge k
% Continental Europe _ X L
Barcelona Hot 200.00
Berlin Mild 400,00 L
Dusseldorf Cold 0,00
Lille Mild 0.00
Madrid Hot 0.00
Paris Mild 0.00
W Morth America 14000 600.00
Boston Mild 100.00
bei =l Lo On [v

The attributes are merged together and appear in the same row or column. Note how
the Store Count and Store Format attributes are now in the same column in
Figure 11-21.

Figure 11-21 Merged Attributes

Weekly Sales - Regular
% Continental Europe 10500 600,00
Barcelona Haot 200.00
Berlin Mild 400,00
Dusseldorf Cold 0.00
Lille Mild 0.00
Madrid Hot 0.00
Paris Mild 0.00
W North America 14000 600,00
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Only attributes belonging to different levels can be merged. You cannot perform
Merge and Split actions on the first layer in the outline view because this layer
displays the first attribute across the merged levels.

To split two attributes that have been merged, complete the following:
1. Right-click a merged row or column.

2. In the context menu, select Split and then select one of the merged attributes from
within the Split menu.

Figure 11-22 Splitting Attributes

~| Sales by Type Revert Cell [ v o A
ER Calendar| Product |4 2] attributes ¢ l_ Create New Attribute... pasure |
[ 1171772006 | » 5 pocket capri - Antigu ﬁé}f:‘ Level splitting e Manage Attributes. .. cation
@ & | e Frg.  Psition Maintenance b Show Attributes and Sart... ==
Find... Hide Selected Attribute(s)
Formd  Store (Climate) | $iE spiit ’
7 ContnentzlEcrope [NOGOGMMM|  Region (Store Count) N
Barcelona Hot EALAL
Berlin Mild 400,00
Dusseldorf Cold 0.00
Lille Mild 0.00
Madrid Hat 0.00
Paris Mild 0.00
% Morth America 14000 600,00 -

In the outline view, you can merge or split attributes across levels using the right-click
context menu. However, the first layer would always display attributes with display
order one merged across levels. In addition, you cannot merge attributes that belong to
the same level.

Note: The merge and split feature is session-only and is lost after
you close the session.

Block View

In the block view, each layer renders one attribute and all the displayed attributes for a
level are shown consecutively in the user-selected display order, as shown in
Figure 11-23. The first layer in each dimension features the expand and collapse icons.
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Figure 11-23 Block View: Attributes in Row Edge

v| Sales by Type by A
Bl calendar| Product| k< » w7 E  Measure
[11/17/2006 | [ & pocket capri - Antigue 12 An|= Ef Location
|
EN G il | & | [Find... ~ ¢ ¢ @mMAEcam@
) Weekly Sales - Regular
Region Store
Attribute Attripute
% Continental Europe 10500 Barcelona Hot 200,00 |~
Dusseldorf Cold 0.00 |
Lille Mild 0.00 | =
Madrid Haot 0.00
Paris Mild 0.00
% Morth America 14000 Boston Mild 100.00
Chicago Cold 500.00 [+
< ] 1l |[ >]
Figure 11-24 Block View: Attributes in Column Edge
~| Sales by Type > + ¢ 7
B Calendar| Product] k¢ M7 E8 Location
[11/17/2006 | «[5 pocket capri - Antigue 12 An |« ER Measure
s
Gl | & | [Find. ~ & & BEcam @ 4
% Continental Europe
10500
Barcelona | Dusseldorf | Lille | Madrid | Paris | Boston | Chicago | Minneapolis | M
| Store [ Climate ] Hot Cold Mild | Hot | Mid | Mid Cold Cold
Weekly Sales - Regular 200,00 0.00 0.00 0.00 0.00 100,00 500.00 0.00
<] I | [»

In the block view, the attribute ordering always follows the display order you select.
You can reorder using drag-drop, but that is the same as using the View Attributes and
Sort tab to change the attribute display order.

You can also right-click an attribute and hide the block view. This completely removes
the associated layer from view.

As in outline view, the expand and collapse icons are on first layer for each dimension.
You can display the label attribute in any order or even hide it altogether (as long as
there is at least one attribute displayed for each level).

Page Edge
You can also see the attributes of a dimension that is in the page edge. The attributes

are displayed on the page edge and are separated by a bar separator. The attribute
labels are added to the level display when you mouse over.

Figure 11-25 Attributes on the Page Edge

~| Sales by Type >~ 4+ ¢ A
Bl calendar| Location PRy EE Product
[11/17/2006 -|Continenta|E..'\:|pe| 10500 IBE'\:EbnEI Hotl' B Measure

Reordering Attributes In both the outline and block views, you can reorder attributes
across levels by dragging an attribute row or column to a different location.
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Note: The reordering feature is persisted in the session only. After
you close the session, the new order is lost.

To change the order of attributes, complete the following:
1. Mouse over the area above the row until the attribute label appears.

2. (Click and drag the attribute label. As you move the attribute row or column, the
available locations where you can drop the attribute are shaded gray.

Figure 11-26 Reordering Attributes

~| Sales by Type

Ef Calendar| Measure

[11/17/2008 = [Weskly Sskes - Regular|-

Ela i | & | [Frd -8 @ @B

Store||5 pocket cap
% Continental Europe 10500 Barcefd ey, Hot
Dussd IdHElft Cald
Lille Cold Mild
Madrifl i Hot
Paris | [ 4ot Mild

% Morth America 14000 Bostor| | Mild
Chical Jchi d Cald
Minng a@i@ Caold

Mantfegt ol | <old
New oe‘tﬂt Caold
San Frepgerp| Cold
Seattle - 14l | Sold
Tororfig-q4 Caold

W South America 3500 Rio df Tapa <old
Sao PaL&%H Caold
Cold

3. When the location where you want to move the attribute is shaded gray, drop the
attribute.

Figure 11-27 Reordered Attributes

~| Ssales by Type

Bl calendar| Measure
[11/17/2006 | =[Weskly Ssles - Regular|=

B E ol | & Find... -

W Continent 10500 Hot ' Barcelona
Cold ' Dusseldorf
Mild - Lille
Hot ' Madrid
Mild ' Paris

Hiding Attributes You can hide an attribute in a view by right-clicking a cell within that
attribute’s row or column. In the context menu, select Attributes and then select Hide
Selected Attribute(s).

Note: The hiding feature is session-only and is lost after you close
the session.
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Figure 11-28 Hiding Attributes

| Sales by Type |IEI Attributes v | Create New Attribute, ..
EQ cCalendar| Measurs CALevel splitting ¢ Manage Attributes. ..
[11/17/2006 [ Weskhy Sales - Position Maintenance s Show Attributes and Sort...
E 8 il | & Find... | Hide Selected Attribute(s)
Format 2 ﬁMerge LT
7 Continent 10500 | HGEM Barcelona 5607.00 7859,
Cold ' Dusseldorf 0.00 0.
Mild :Lille 0.00 a.
Hot Madrid 0.00 a.
Mild  Paris 0.00 a.
% Morth Am¢ 14000 Mild Boston 0.00 0.
Cold ' Chicago 0.00 0.
Cold : Minneapolis 0.00 Q.
< 3
Attribute-Based Sort

Find

You can sort positions in a level using any of the level's attributes. Use the View
Attributes and Sort tab to choose the attributes used for sorting. You can also define
sort direction (ascending or descending) and the order that the attributes you select are
to be applied during the sorting process. For example, the SKUs in the product
dimension can be sorted primarily by price, and then within those prices by label.

The sort is applied dimensionally across multiple levels. For example, if the product
dimension contains the levels company, division, class, style-color, and SKU, the
positions within the company level are sorted first by the selected sort attributes for
company, and then positions within each division, applying the division’s selected sort
attributes, and so on.

As with display, if an attribute is the default sort attribute for a level, the default sort is
always applied if you have no other selection. The attribute-based sort order does not
override any current simple sort selection, unless you:

= navigate to the View Attributes and Sort tab and click OK or Apply. This reapplies
the attribute-based sort even if you do not make any changes on this tab.

= select Undo Sort in the right-click context menu.

For measure dimensions, the sort order you define is applied by default. You can
choose the Disable User defined Sort Order option on the Show/Hide tab to disable
the default behavior.

Note: The RPAS Fusion Client displays a warning that when all sort
attributes are removed from the Show Attributes and Sort table of the
dimension pop-up, the values are displayed in default sort order. For
the RPAS Fusion Client, the default sort order is Label. It is not the
order returned from the RPAS Server. To get a guaranteed sort order,
create a sorting attribute and populate it with values.

Use the find feature to search for words, partial words, or phrases within the rows,
column, and page axis of an active view. The search does not include the data within
the view.
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The find feature locates the phrase you looking for and shades it gray. If the matched
position is not visible because it is hidden under a scroll bar, the view is automatically
scrolled to reveal it. The search is performed through collapsed or hidden positions.
When a matched position is found, the parent is expanded and the matched position is
shaded gray.

The find feature can be accessible four ways:

s The Find option in the right-click context menu
s The Find option in the Edit menu

s The shortcut Ctrl + F

s The Find field in the view toolbar

Find Using the Right-Click Context Menu

To use the find feature from the right-click context menu, complete the following:

1. Right-click a measure, position, or attribute label to see the right-click context
menu. Note that right-clicking on a data cell does not activate the find feature in
the right-click context menu.

2. C(Click Find.

Figure 11-29 Find in the Right-Click Context Menu

Levels »
[ selection Options »
@& EBlock View

Qutline View

Hide Selected Member (=)

Show and Hide...

Cut Cirl43

Copy Ctrl+C

Paste Cirl+v
Lock

[¥2) Attributes v
If>::‘:| Level splitting k
Position Maintenance b

| Eind... |

Format 3

3. The Find window appears.
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Figure 11-30 Find Window

Find

*Search | Sales Match Case
Far Options B

*Dimension | Measure |w |

*Levels | Info =l

[ whole word Cnly

o

Find Previous | Find Mext | Cancel |

Enter the following:

Search For: Enter the text you want to find.

Match Case: Select this option if you want the search to locate text that use the
same case as the text you entered. Leave it unchecked if you want the search to
find all text that match yours, regardless of case.

Whole word Only: Select this option if you want the search to find the text in
a whole word rather than a partial one.

For example, if you are searching for the letter U and you select the Whole
word Only option, then the search will find the Wp BOS U measure, but it
will not find the letter U within the Wp BOS AUR measure.

Only within...: Select this option to search in a variety of ways:

- Search for the text only within one or more measures, positions, or
attributes that you right-clicked in Step 1. When this option is selected, the
search ignores all matches outside of those measures, positions, or
attributes.

-  Search within multiple positions by selecting more than one member to
search through.

- Find the text within a specific member and within its own dimension.

-  Find the text within a specific member and within another dimension.

- In outline mode, use this option to find positions within different levels
(style, SKU).

- Inblock mode, use this option to find positions within the same level

(either style or SKU).

Dimension: Specify what dimension you want to search within. This is a
required step.

Levels: Specify which level of the dimension you want to search within. You
can choose a specific level or you can choose All to search all levels. The
search is performed level by level, not through parent and child. For example,
when there are two levels, style and SKU, the search is performed in the style
level first and then the SKU.

4. When finished, click Find Next. The view refreshes. If a match is found, it is
shaded gray.

Sort, Find, and Position Queries 11-17



Find

Figure 11-31 Match Shaded Gray by Find Feature

Wp Fcst Pre-Season R
Wp Sales R

Ly Sales R

Wp Sales var Ly R%%

Wp Markdown R

5. Click Find Next to see the next match. You can click Find Previous at any time to
see matches you have already seen.

If a match is not found, the following message appears:

Figure 11-32 No Matches Found Message

,ﬁ Warning m

Mo matches found.

Note: A similar message appears when you reach the end of the
search and asks if you would like to start the search again.

Find Using Edit Menu or Ctrl + F

Using the Find feature from the Edit menu or Ctrl + F works in the same way as the
right-click context menu.

1. After you have opened a workbook, click Find in the Edit menu or enter Ctrl + F.
It is not necessary to select anything in the view.

2. The Find window appears. Enter the information as described in Step 2 of the Find
Using the Right-Click Context Menu section.

Note: If no position was selected in the workbook, the Dimension
field will not have a dimension automatically selected. You must
select a dimension from the list to perform the search.

3. When finished, click Find Next. The view refreshes behind the Find window.

Find Using the View Toolbar

The Find field within the View toolbar is a quick alternative to using the Edit or
Context menus.
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Figure 11-33 Find Field in the View Toolbar

Find Find Previous
Field Options and Next

BHaw b [ |[-][& &) mExma i
Feb FY| . Dimension | ALL = FY2011 | Jun FY2011
Wp Fest Pre-Season R o 0.00 0.00
[ mMatch Case 0.00 0.00
Wp Sales R [ whole ward Only 0.00 0.00
Ly Sales R o.o0 o.00 o.00 0.00 0.00

To use the find option in the workbook toolbar, complete the following;:
1. Enter a phrase in the Find field.

2, Click the Find Options arrow to manage the search parameters. This is an optional
step. If you skip this step, the search is performed on all dimensions.

= Dimension: Select the dimension you want to search in or select All to search
all dimensions.

= Match Case: Check this option if you want the matches to have the same case
that you entered.

= Whole word Only: Check this option if you want to find the text in a whole
word rather than a partial one.

3. Click either the Previous or Next arrows to begin your search.

Position Query

Position queries are preconfigured rules that filter data so that only positions that
fulfill the requirements of the query are shown in the view. Position queries are
configured in RPAS Configuration Tools by an administrator. For instance, if an
administrator has configured a position query to filter for the stores with sales greater
than $3500, you can turn on that position query to display only those stores.

The dimension that the query is based on must be in the page edge (Z axis). This is
known as the driving dimension. The dimensions in the X and Y axes are known as the
query dimensions. The data in the query dimensions is based on the current position
of the driving dimension.

When a position query is applied to a view, the positions in the query dimensions
(X'and Y axes) that fulfill the requirements of the query for the particular position of
the driving dimension (Z axis) are the only ones shown in the view. All other positions
are automatically hidden.

When more than one driving dimension is present, all of the driving dimensions have
to be in the Z-axis for the position query to execute. If one or more driving dimensions
are taken out of the Z-axis and placed in the X or Y axes, associated position queries
are not executed. A given view can have more than one position query, driven by one
or more dimensions in the Z-axis and driving different dimensions in the X and Y
axes.

You can configure a worksheet with the Lock PQD dimensions. With these worksheets,
you cannot move a driving dimension off the Z-axis. If the PQD's driving dimension is
not on the page edge, or the driving level is not visible on the page edge, the PQD will
not be visible until that is true, at which point the Lock will take effect.
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Figure 11-34 Position Query Icon
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When the position query filter is turned off, the icon appears flat. When you mouse
over the icon, the roll-over text says “Filter [Rule].”

When a position query filter is turned on, the position query icon is depressed. When
you mouse over the icon, the roll-over text says “Remove filter for [Rule].”

Figure 11-35 Position Query Rollover Status
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Using Position Queries

If you have a workbook that is configured to have a position query, you can filter to
view only the positions that fulfill the requirements of that query.

For this example, a Sales Total workbook has been configured to include a position
query to filter locations with the Store measure selected. As shown Figure 11-36, the
Sales view contains several items; some have Store selected and some do not.

Figure 11-36 Position Query Example, Filter Off
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When you click the Position Query icon, the view refreshes and only the items with
the Store measure selected are visible.
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Figure 11-37 Position Query Example, Filter On
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Position Query Filtering Without Calculating

If you edit the measure data and attempt to apply the position query filter without
calculating first, a warning appears.

Figure 11-38 Position Query Warning for Edited Cells

(A Warning L]

There are edited cells in the workbook. Would you like to calculate the workbook before continuing?

Yes | Mo | Cancel |

To calculate the data and then apply the position query filter, click Yes. To apply the
filter without considering the edited data, click No. To cancel the action, click Cancel.

Updating Measure Data in Position Queries

After you have applied a position query filter to the data, if you edit the data and
calculate, the position query filter does not automatically refilter according to the new
values. When this happens, the filter icon changes to a warning icon. The warning icon
means that the position query may have stale data in it.

For example, if you deselect the Store measure for the Still Water product and click
Calculate while the filter is on, Still Water remains visible in the view and the filter
icon changes to a warning icon.
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Figure 11-39 Updating Measure Data in a Position Query
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If you want the position query to automatically refilter the edited data, use the Auto
Evaluate feature. For more information about this feature, see Using Position Queries
with Auto Evaluate.

Scrolling in Position Queries

After you have filtered the slice, if you scroll to the next position, the position query
filter is not reapplied to the new position and only the positions that were shown in
the previous slice are shown in the current slice.

For example, click the Next icon to scroll to the next location.

Figure 11-40 Scrolling with Position Queries
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The view refreshes and the next location, Berlin, is shown (Figure 11-41). Note that the
position query icon is no longer depressed. The same stores in the position query for
Barcelona (Figure 11-40) are shown, even though two of the stores, Liverpool and
Oslo, do not have sales greater than $3,500. This is because the position query has been
turned off.

11-22 Oracle Retail Predictive Application Server User Guide for the Fusion Client



Position Query

Figure 11-41 Position Query Scrolled to New Slice

~| Sales Total

Bl Calendar| Location| K ¢ » M 7
=]

Bla | &

Find...

* F ¢y A

:| EH Measure
BR Product
|

-% @ | mOEsmmE>

5 pocket capri
5 pocket capri
5 pocket capri
5 pocket capri
5 pocket capri

5 packet capri

4% aX% 1L still water

- Bandblasted 1
- Bandblasted 1
- Bandblasted 8
- Black 8 Ankle
- Black 10 Ankl

-Raw 12 Anlde

5

=3
i

5 oo

If you wanted to reapply the position query, click the Position Query icon. The view
refreshes, and only the stores that meet the requirements of the position query are
shown in this slice.

Figure 11-42 Position Query Reapplied to a New Slice

~| Sales Total

[ calendar| Location| 1 ¢ » ){F B Measure
=l [Calendzr] | s Barlin |» j

Blau &

Find...

* v A

5 pocket capri - Bandblasted 1
5 packet capri - Bandblasted 1
5 pocket capri - Bandblasted &

B Product
|
-~ % ¢ '@ »
Store

If you want the position query to automatically update when you scroll to a new slice,
use the Auto Evaluate feature. For more information, see Using Position Queries with
Auto Evaluate.

Using Position Queries with Auto Evaluate

If you want position queries to automatically reevaluate data after a calculate, refresh,
or slice move, use the auto evaluate feature.

The auto evaluate feature is located in the View menu. When enabled, the query is
updated and the view refreshes with only the positions that meet the requirements of
the position query. For performance reasons, this option is disabled by default.

To turn auto evaluate on, click Automatically Evaluate Position Queries option in the
View menu.

Sort, Find, and Position Queries 11-23



Position Query

Figure 11-43 Automatically Evaluate Position Queries
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Note: The setting of the Automatically Evaluate Position Queries
option is saved with the workbook formatting. For more information
on how formatting is saved, see Saving Formats.

Note: Some worksheets can be configured with Auto PQD enabled
for the worksheet. In such cases, PQDs are automatically evaluated for
that worksheet, regardless of this workbook setting.

Updating Measure Data with Auto Evaluate

After you have filtered the data using the position query feature with auto evaluate
turned on, if you edit the data and calculate, the position query filter automatically
refilters according to the new values.

For example, change the Sales total for Luxembourg to zero and click Calculate.

Figure 11-44 Updating Measure Data with Auto Evaluate

~| Sales Total + J v A

@ Calendar| Location » ){ j@ Measure
Bl Product
|

~$ & @ »
Store |
4X 6 1L 5til Water ] &
5 pocket capri - Black 10 Ankl =
5 pocket capri - Black 8 Ankle
5 pocket capri - Raw 12 Ankle [v
[ i Depmedbleeied 4 (il

The view refreshes and Luxembourg is no longer shown in the filter results.
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Figure 11-45 Measure Data Updated with Auto Evaluate
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Scrolling with Auto Evaluate

After the slice is filtered, if auto evaluate is enabled and you scroll to the next position,
the position query filter is reapplied to the new position. As a result, only the positions
that meet the requirements of the position query are shown in the current slice.

For example, click the Next icon to scroll to the next location.

Figure 11-46 Scrolling with Auto Evaluate
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The view refreshes and the next location, Berlin, is shown (Figure 11-47). Note how the
position query icon remains depressed and how different stores are shown compared
to the previous slice (Figure 11-46). Because auto evaluate is enabled, the position
query remains on and only the stores that meet the position query requirements are
shown.

Figure 11-47 Position Query Scrolled to New Slice with Auto Evaluate
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No Position Query Matches

If you scroll to a new slice where no position meets the requirements of the position
query, all positions in the view are displayed and a warning appears.

Figure 11-48 Scrolling with No Position Query Matches
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Position Filtering

Use position filtering to use the set of selected data cells in one worksheet view to filter
another worksheet view. For example, you can select one or more cells in a pivot table
that are associated with a group of items, locations, and measures. The intersection of
selected cells can be used to filter another worksheet view.

Note: Position Filtering can be turned on or off using Config Tools.

This provides you with a convenient way of filtering a large worksheet with one or
more views down to the subset of data you are interested on working with.

Figure 11-49 Position Filtering in a Single View
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Location and Measure!
Dates

Products
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In the example above a set of positions is selected in a single view. When position

filtering is applied, the cells visible in the view are reduced to those specified by the
selected positions.
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Figure 11-50 Position Filtering in Two Views

Location and Measures Products
Dates Measures
E F u
8 Filter o
° 5]
& o
o
View 1 View 2

In the above example, a set of positions is selected in the first view. When the position
filter is applied, a second view is selected. The positions in the second view are filtered
to match those selected in the position filter in the first view.

Position filtering can be applied to multiple views. For example (providing the
workbook has been configured to contain those views) position filters can
progressively be applied to a sequence of four views.

Position filtering can also be regressive. A set of position filters can be selected in a
view and then applied to a second view. This results in a subset of the data being
displayed in the second view. The second view can then be have a set of positions
selected and used to set a position filter for the first view.

Figure 11-51 Regressive Position Filters
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Working with Position Filters

This section describes the basics of working with position filters.

Initiating Position Filtering
The position filtering option is available from the right click menu when you right

click on a position from the page edge, selected rows or columns, or a specified set of
cells.
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Selecting from Page Edge Position

If you select a page edge position where position maintenance is available (most
dimensions excluding the calendar dimension), the Position Filtering option will
appear below the position maintenance option when you selected one or more rows or
columns. Otherwise, the position filtering option will appear under the Level Splitting
option.

Position filtering can then be applied to the current view or other views in the
worksheet. The available views can be selected from the right click menu.

Figure 11-52 Right Click Menu - Position Filtering from Page Edge
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Selecting from Rows or Columns

Position filtering can also be initiated by selecting from one or more rows or columns.
Again, the right click menu can be used to initiate position filtering. It can be applied
to the current view or to other views in the worksheet.

Figure 11-53 Right-Click Menu - Position Filtering from Row or Column
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Selecting from Cells

The final way of initiating position filtering is to select one or more cells. Again, the
right click menu can be used to initiate position filtering. It can be applied to the
current view or to other views in the worksheet.

Figure 11-54 Right-Click Menu - Selecting Position Filtering from Cells
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Using Position Filters

Position filters can be applied to all views in the current workbook.

= You can filter the current view. The current view will be filtered to show only those
rows and columns selected in the filter. This is equivalent to using the Show and
Hide options in the Dimensions dialog box to access any dimension tile in the
page edge. An alternative is to access the Show and Hide options via the right
click menu for any rows and columns.

= You can filter another view in the workbook. For this to be effective, the workbook
template must be configured with two or more views. There must also be one
dimension hierarchy in common with both the views or a filter cannot be applied.

If the worksheet template is only configured to show a single view, only the Current
View option will be available in the right click menu.

Figure 11-55 Right-Click Menu - Example of Available Views
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In the above example, a worksheet has been opened for the Cover step task. The
available views are the Current View, Cover Case 2, and Cover Case 3. The next task
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(Uncover) also has three views available from the right click menu: (Uncover Case 1,
Uncover Case 2 and Uncover Case 3).

= If you select one of the other views in the current task (Cover Case 2 or Cover Case
3), the selected view will be filtered to show only the specified data.

= If you select a view in the Uncover task, the views will switch to the Uncover task
views and the specified view will be filtered to show only the specified data.

Once the filter has been applied, the view to which the filters have been applied
becomes the current view.

Tiling Views

One way of working with position filters is to tile the views. This can be done from the
View menu on the global toolbar. In this way, two or more views can be shown
simultaneously. The filter can then be applied to one of the views, leaving the filtered
data showing in another view.

Figure 11-56 Example of Tiling
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Basic Example of Applying Position Filters

In this example, two views are open. A set of positions are selected in the left hand
view and the second (right hand) view selected from the Position Filtering option on
the Right Click menu.

11-30 Oracle Retail Predictive Application Server User Guide for the Fusion Client



Working with Position Filters

Figure 11-57 Basic Example of Position Filtering - Stage 1
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The positions selected for position filtering are highlighted during the selection

process. They stay highlighted after the position filtering operation, enabling the user
to see which rows are in use for position filtering.
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Figure 11-58 Basic Example of Position Filtering - Stage 2
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When the position filter is applied, the right hand view is restricted to those positions
selected with the position filter in the left hand view. Filtering is based on all
dimensions found on the row, column, and page (X, y and z) axis. If the row and
column have nothing in common, the page edge (for example the calendar dimension)
may still be used to apply the filter.

In the above example, the position filter has been used in the left hand view to select a
subset of dates from the total range available. The right hand view now only contains
data restricted to this range of dates.

For example, you may want to isolate data restricted to a range of dates covering a
promotional campaign for a product. As the promotional campaign may raise the
quantities sold over the duration of the promotion, position filtering makes it easier for
you to focus on the data pertinent to an advertising campaign.

Note: This can work equally well in reverse, with the positions
selected and the filter applied in the right hand view. This results in
the left hand view being filtered.

Additional Example of Applying Position Filtering

Position filtering can be applied to multiple views. In this example, three views are
available. Position filtering starts in the lower right view, where a set of positions has
been selected. Filtering is applied to the upper right view.
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Figure 11-59 Additional Example of Position Filtering - Stage 1
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After position filtering has been applied, the upper right view displays a subset of
data.
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Figure 11-60 Additional Example of Position Filtering - Second Stage
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Another set of position filters can now be applied to the upper right hand view. As
before, the positions selected for filtering remain highlighted.
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Figure 11-61 Additional Example of Position Filtering - Third Stage

= e Lage 3 T b & F o Cower Cased i U
&3 Piodecl|  Leewien » ¥ B vesmne  |BY Produd Locaicn [ dewam
B0 0 L i L atht Birchm @ |3 K 0 s DRy 18 caemnn TOOCAEH] LeathrLadnss B2 b o[ D00 &1 ResanLa |« TR Ak
MW | ~ S ¢ mAGRA&s @@ [ Find. ~F f | WA @EE
i ] B Tl T (3 EL Wl Do
e [T om [T} T (T3 am [T
ks UL Ll L] - g LY oo g
FEEENS s o [ 5 LRk loam am was
T i1 ool oAl S| T S ek Cptiars ' a0 L7 [ TH
TS L g il I Miarichicw LEs 3 pd il
T E] aso oo L1 # azc LT o3
s gk 0o 03 3 nevies e o s
A us L1:] waa o Hhbe Seleted Mnaad] 0w LT [TH
AR LT om n1 5 GhwandHie nse om nm
4B nae am nn1 i - 0L a0 na
Anmns 0 ge o i | i
AN (1 {151} 0 Capr G
] a0 aca [F] Bk [y
AT ek L] Lbid) ¢ o
E A LE om LT
SIS [T o s L e '
j_ R nen L] wn b La sl apikig LS
Lalb el o oo l;!l: Pt Filaima ¥ Curratl Vs
EnEN LB o nal =
| memoms nae [T an E- Bind T Eaoni
TEING e fiTi] Wi Cowerdme s
T 02K oo a1 Ui CEie 1 ER AT =
TS L 0o L Urcover Caza 2
BRI [ om w1
et b 6 i Unewves Case 3
| RS U L] ] Ammpae Fller
& W LT oo 15
| s UL oo L)
| SIS LEL LLe] LR
EWENS nee i waa
| Ennems asp om a1
AT LS 0og Lhi
P ugp am i
TN nin oo oz
Lo L) L] b
MU asp oo L15
PGS L ooy A
HIGRNE [T o i & =

Coan Casr | G Casn 2 Cower Dase 2

When the position filter is applied, the third (left hand) view is filtered.
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Figure 11-62 Additional Example of Position Filtering - Final Result
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This is a complex example of what can be achieved with position filtering. If the
position filtering is applied to the location dimension with the region, district, and
store levels available, you can use the first view to filter stores down to a specific
region (say France) and the second view to filter stores in France down to a specific
district (say Northern France). As a result, the third view contains a list of stores in
cities such as Calais, Cherbourg, and Dieppe.

This is an effective way to open a workbook with a large amount of data and then use
position filters to swiftly isolate subsets of data to edit.

Page Edge Synchronization

When a position filter is applied, the information in the page edge is also filtered. If the
Synchronize Page Edge option has been selected from the View menu, synchronized
page edge navigation may not always be possible if a position filter has been applied.

Figure 11-63 Position Filtering - Page Edge Synchronization Example
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In the above example, a position filter has been applied to View 2. This results in a
single position, 33 France. If you now goes to View 1 and uses the page edge controls
to scroll through the available locations, view 2 cannot synchronize because it only has
a single location dimension. This situation will persist until more locations are made
visible when another position filter is applied (or the show and hide option is used).

Position Filtering and Charts

Position filtering also updates charts. Where positions are hidden by the position filter,
the graph is updated to reflect the changed data. In the example below, the pie chart is
currently showing data for all stores in the district of France.

Figure 11-64 Chart Before Position Filter is Applied
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A position filter is then applied. As a result, the district of France is filtered so that only
three stores are visible. The pie chart is updated accordingly.

Figure 11-65 Chart After Position Filter is Applied.
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If a different position filter is applied, the chart will update accordingly. In the final
example, the position filter has been reapplied, and as a result, the data from the Spain
district is visible. The chart now shows the pertinent stores from Spain.
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Figure 11-66 Chart After Position Filter is Reapplied
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Position Filtering and Chart Drilling

Position filtering is not supported for chart drilling. See the section on chart drilling for
more information.

Factors Affecting the Use of Position Filters

Other RPAS functionality can affect the use of position filters.

Position Filtering and Hidden Positions

Position filtering only operates on visible measures. In addition, if the measures are
hidden when the filter is applied, they will remain hidden after the filter has been
applied. In order to see which measures are hidden, double click any dimension tile in
the page edge. This brings up the Dimension dialog box. The Show and Hide tab
shows which measures are visible and which are hidden.

Figure 11-67 Dimensions Dialog Box - Show and Hide Tab
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If you hides positions with the position filter applied, the position filter will remain in
effect. If you show additional positions, the position filter will be overridden.
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Show Members by Batch Alert Option

If you opt to view batch alerts, the current position filter will be removed. Batch alerts
can be selected for viewing from the opening page or from the View menu if a
workbook is currently open.

Once a workbook has been opened to show batch alerts, the alerts can be filtered using
position filtering.

Figure 11-68 View Menu - Manage Alerts Option
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After the batch alerts have been displayed, you can reapply the position filter.

Removing Position Filters

Once applied, position filters can be removed using an option available on the right
click menu. This option is not available until a position filter has been applied.

Figure 11-69 Right-Click Menu - Remove Filter Option Enabled.
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Copying and Saving with Position Filtering

When workbooks are copied or saved with position filtering applied, the following
applies:
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Copying Workbooks

If a workbook view is copied, any position filters are copied as well. This means that
the copied view will be identical to the original. you can remove the position filter in
the copied view to show all positions.

Saving Workbooks

When a workbook is saved, the currently applied position filter are saved as well.
When the workbook is closed and reopened, it will open with the position filter
applied.
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Working With Charts

You can use the charting feature to generate a visual representation of the data in the
form of charts. This section describes the available chart types and provides
instructions on the various tasks you can perform with charts. It includes the following
sections:

= Viewing Charts

n  Charts View User Interface

» Editing Data Through a Chart
s Customizing a Chart

= Saving a Chart as an Image

= Available Chart Types

s Charting and Drilling

Note: Due to some limitations of Flash, chart axes and labels may not
be visible at times and chart sizes may not adjust as expected.

Viewing Charts
You can view charts using the following views:
»  Chart View — In this view, the chart displays in the complete view area.

= Split View — In this view, the chart and data display together in two vertical
panels.

To view a chart:
1. Select the data you want for the chart.

2. From the View toolbar, click the Select Chart Type icon, and then select the chart
type.
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Figure 12-1 Select Chart Type Icon on the View Toolbar
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3. After you select the chart type, click one of the following icons:

s Switch to Chart View — Select this icon to switch the view to charts.

Figure 12-2 Switch to Chart View Icon on the View Toolbar
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= Switch to Split View — Select this icon to see the pivot table and chart split in
two vertical panels.

Figure 12-3 Switch to Split View Icon on the View Toolbar
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To switch back to the pivot table, click the Switch to Pivot Table View icon.

Figure 12-4 Switch to Pivot Table View Icon on the View Toolbar
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Cell Selection Considerations

When you choose to view a chart, only the cells that you select are represented in a
chart. Each available graph type requires that a specific amount of data or number of
cells are selected for a graph to appear. Although you may select a subset, the cells
must contain enough data to support the desired graph for the graph to be displayed.
For more information on the information required for each graph type, see Available
Chart Types.
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Squaring the Selection

When the chart is rendered on screen, the cell selections in the view are automatically
squared. In this operation, additional cells are added to your selection to represent a
squared selection area. This ensures that the data is analyzed in a consistent manner.

For example, if you choose to select some cells before viewing a chart, as shown in
Figure 12-5:

Figure 12-5 Example of Cells Selected Before Viewing a Chart
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After the chart appears, your selection in the view is squared, as shown in Figure 12-6:

Figure 12-6 Example of Squared Selection After the Chart Appears
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Working with Charts

The following sections describe the charting functions.
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Charts View User Interface

When you switch to the Chart View or Split View, the View toolbar appears with icons
relevant to charts.

Figure 12-7 Charting Icons in the View Toolbar
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In the Chart View, the following charting icons appear:

Table 12-1 Charting Icons in the View Toolbar

Legend |lcon Name Description
A Chart Formatting Use to customize the format of the charts. For more
information, see Customizing a Chart.
B Save Chart to Image | Use to save the chart as an image (PNG format) file.
Flip Chart Axis Click to swap the contents represented on the X and Y axes

without manually performing a pivot operation.

Editing Data Through a Chart

After the chart appears on screen, you can update the value of a specific series.

Editing Data Without the Drilling Operation Enabled

If no drilling operations have been carried out, data can be edited simply by clicking
the series in the chart. To edit a chart:

1. In the chart, select the value for the specific series represented in the chart using
the following steps:

a. Mouse over the series or the legend. The specific series is highlighted
automatically, and the other series are dimmed. See Figure 12-8.
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Figure 12-8 Example of a Series Highlighted in Area Chart
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Note: This is a configurable setting and can be toggled on or off in
the properties file. For more information, refer to the Oracle Retail
Predictive Application Server Administration Guide for the Fusion Client.

b. After the series is highlighted, locate the value you want to edit on the chart
and select the relevant area based on the following;:

Chart Type Area to Select

Area Chart Right-click on the specific point and select Edit... in the context menu.
The point is indicated by a tool tip pop-up when you point at it.

Bar Chart Right-click the bar area and select Edit...

Bubble Chart Right-click the bubble. and select Edit...

Column Chart Right-click the column area and select Edit...

Combination Chart

Right-click on the relevant area based on chart type. Refer to the area
for Area, Column, and Line Charts.

Line Chart Right-click the specific point on the line and select Edit... (indicated by
line marker).

Pareto Chart Right-click on the column or the pareto line marker and select Edit...

Pie Chart Right-click the slice and select Edit...

Radar Chart Right-click the line marker point and select Edit...

Ring Chart Right-click the slice and select Edit...

Scatter Chart Right-click on the scatter marker (shape) and select Edit...

Treemap Chart Right-click the node and select Edit...
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Figure 12-9 Example of Value to be Selected in the Area Chart
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The Chart Editor window appears.

Figure 12-10 Chart Editor Window

li] chart Editor B
Boston | #968.00
oK Cancel

2. Enter the new value or values and click OK. The chart and the view data are
updated with the new values entered.

Note: The cell-editing and protection processing rules also apply to
the editing of chart values. Read-only values are not editable.

Customizing a Chart

In Chart View, the View toolbar includes the Chart Formatting icon that you can use to
format and customize the chart.

Note: The Chart Formatting Window for the Treemap Chart is
described separately in Understanding the Treemap Chart Formatting
Window.

To customize the chart:

1. In the Chart View, click the Chart Formatting icon in the View toolbar.

Figure 12-11 Chart Formatting Icon in the View Toolbar

pall & [@kl- e
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The Chart Formatting window appears.

Figure 12-12 Chart Formatting Window
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Title
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2. In the Chart Formatting window, make the relevant changes. For more
information on the Chart Formatting window, see Understanding the Chart
Formatting Window.

3. Click the Apply icon to apply the changes and continue customizing your chart.
When you click the Apply icon, the changes take effect immediately in the
background.

4. After you have completed making changes, click OK. The changes are applied to
the chart and the Chart Formatting window closes.

Note: The Chart Formatting Window for the Treemap Chart is
described separately in Understanding the Treemap Chart Formatting
Window.

Understanding the Chart Formatting Window

The Chart Formatting window can include the following tabs. Some tabs are only
displayed for certain chart types.

s General Tab
s Axis Tab
m Series Tab

s Quadrants Tab
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General Tab
Use the General tab

to customize the general settings for the chart.

Figure 12-13 General Tab on the Chart Formatting Window
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The General tab includes the following fields:

Table 12-2 Fields on the General Tab

Field

Description

Title

Use to set a title to the chart.

Subtype and Layouts

Subtype Selection includes the following options:
Absolute (applies to Area, Bar, and Line Chart)
Stacked (applies to Bar and Line Chart)

.
.
= Percentage (applies to Area, Bar, and Line Chart)
= Is Horizontal (Bar only)

Layout Selection includes the following options

Single Y (applies to the Bubble, Scatter, and all
Absolutes/Stacked types)

Dual Y (applies to the Bubble, Scatter, and all
Absolutes/Stacked types)

Split Y (applies to all Absolutes and Stacked types)

Show Legend

Select this check box to display a legend on the chart.

3D Effect

Select this check box to display the chart in 3-D.

Background Color

Use to select a background color for the chart.
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Axis Tab

Use the Axis tab to customize the axes settings.

Figure 12-14 Axis Tab on the Chart Formatting Window

Chart Formatting

General Axis Series
Select Axis | X-Axis [+
Title

Axis Type

Axis Settings:

Axis Tick (&) Auto

Is Logarithmic

() Grid
(") None

Apply | oK | Cancel |

The Axis tab includes the following fields:

Table 12-3 Fields on the Axis Tab

Field

Description

Select Axis

Based on the type of chart, displays the axes for the chart. You
can select each axes and set the parameters in the Axis Settings
section.

Title

Use to set a title for the axis.

Axis Type

These options are available only for bubble and scatter charts.
Use to set the data type for the axis. You can choose from the
following options:

= Number (does not apply for percentage type graphs).
s Currency (does not apply for percentage type graphs).

= Percentage (automatic on percentage type graphs).

Axis Tick

Use to show or hide grid lines within the chart. Select from the
following options:

u Auto
n Grid

= None
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Table 12-3 (Cont.) Fields on the Axis Tab

Field

Description

Is Logarithmic

Changes the axis to use a logarithmic scale when plotting data.
This is useful to display data with large range differences. For
example, you may have the values 99999, 5002, and 250.
Normally, the value 250 does not appear, due to its small value.
If the Is Logarithmic box is checked, that value will be displayed
properly in the bar chart.

Series Tab

Use the Series tab to set the series color and Y-Axis assignment.

Figure 12-15 Series Tab on the Chart Formatting Window
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The Series tab includes the following fields:

Table 12-4 Fields on the Series Tab

Field

Description

Select Series

Displays the series that appear in the chart.

Series Color

Use to set a color for the series selected in the Select Series
section.

Series Y-Axis Assignment

Use to Move/Move All/Remove/Remove All icons and assign
series to the Y1 and Y2 axes.

Quadrants Tab

Use the Quadrant tab to configure quadrants in the bubble charts. The tab only
appears if the chart type is set to bubble. It does not appear for other chart types.
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You can configure the chart to have more than four quadrants or sections. You can
configure the chart to have up to 16 sections.

As you enter the desired number of X and Y axes divisions, the graph icon in the
Quadrant Labels section refreshes to show a new representation of the chart. If you
enter quadrant labels for the sections, you can adjust the placement of these labels
with the Alignment feature.

Figure 12-16 Quadrant Tab on the Chart Formatting Window

Chart Formatting <)
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X
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Quadrant & label | Under Utilized

Apply | oK | Cancel |

The Quadrant tab includes the following fields:

Table 12-5 Fields on the Quadrant Tab

Field Description

Display quadrants | Select this check box if you want to display the quadrant lines.

X-axis divisions Use this drop-down box to select the number of quadrants or sections
you want along the X axis. As you adjust this number, the graph icon
refreshes to display your selection.

Y-axis divisions Use this drop-down box to select the number of quadrants or sections
you want along the Y axis. As you adjust this number, the graph icon
refreshes to display your selection.

Alignment Use this drop-down box to adjust the placement of quadrant labels
within the quadrant. Options are Center, Top, and Bottom.

Quadrant Labels Use these fields to enter names for each quadrant. This is optional.

Understanding the Treemap Chart Formatting Window

The Treemap chart formatting window is similar to the General Tab of other charts, but
with the addition of Subtypes that are used to configure how node color is displayed.
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Once you have made updates, you can click OK to refresh the display of the Treemap
chart.

Figure 12-17 Treemap Chart Formatting Window

Chart Formatting [x]
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Table 12-6 Fields for Treemap Chart Formatting

Field Description
Title Use to set a title to the chart.
Subtype Subtype Selection includes the following options:

s Continuous allows one color to be used in different shades
for a node. The color shades transition from a minimum to
a maximum value.

= Grouped allows specific colors to be assigned to defined

groups.
Show Legend Select this check box to display a legend on the chart.
Background Color Use to select a background color for the chart.

Continuous Subtype

When you select the continuous subtype, you must manage the options for Auto Fill,
Minimum Value, Maximum Value, and Color. The Number of groups value is disabled
here as it only applies to the grouped subtype. See Treemap Chart Formatting
Window.
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Table 12-7 Continuous Subtype Options

Option

Description

Auto Fill

Select this check box if you want Values or On drill to be
auto-calculated. These two options are both selected by default.

Values. Select this option if you want the minimum and
maximum values to be auto-calculated based on the chart data.
The minimum value is set to the lowest chart data value, and the
maximum value is set to the highest chart data value. You can
override these auto-calculated values by entering a number for
either value yourself. In this case, the Value check box becomes
de-selected.

On drill. Select this option so that after drilling down, the
minimum and maximum values are re-calculated based on the
new highest and lowest values instead of on the existing
parent-level values. You may not need the On drill option when
the data that drives color is aggregated as average, mean,
median, or percent. This option is more relevant when color data
aggregates as total, min, max, and so on.

Minimum Value/Maximum

Value

Define the starting and ending values for the color transition.
Treemap chart nodes that have values less than or equal to the
minimum are shaded with the color associated with the
minimum value, and nodes with values greater than or equal to
the maximum are shaded with that associated color. Nodes with
values in between are reflected by color shades according to
their specific values. These values are auto-calculated if you
select the Auto Fill check box.

Color

Associates a specific color with the minimum value and a
specific color with the maximum value. The default values are
selected from the chart color series.

Grouped Subtype

When you select the grouped subtype, you must manage the options for Number of
groups, Auto Fill, Labels, Range cut-off values, and Color.

Figure 12-18 Grouped Subtype Option

Chart Formatting

Title
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Show Legend
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Apply  OK  Cancel
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Table 12-8 Grouped Subtype Options

Option Description

Number of groups Defines the number of discrete groups that the nodes are
grouped into. Each group is associated with a label. range cut-off
value, and color. The default is 2.

Auto Fill Values. Select this option if you want the range of cutoff values
to be auto-calculated based on Number of groups and chart
data. You can override these auto-calculated values by entering a
range cutoff value yourself. In this case, the Value check box
becomes de-selected.

On drill. Select this option so that after drilling down, you want
the range cutoff values to be proportional. The new cutoffs are
based on the new color data and proportioned using the
parent-level cutoffs. You may not need the On drill option when
the data that drives color is aggregated as average, mean,
median, or percent. This option is more relevant when color data
aggregates as total, min, max, and so on.

Label The name for each group. The default names are Group 1 and
Group 2. You can change these names as appropriate. If you add
a group (by changing the value in Number of groups), the new
group will initially be assigned a default name, regardless of any
changes you may have made.

Range cut-off value Defines the cut-off value for the range associated with the group.
All the nodes that have a color data value greater than the lower
cutoff and lower than or equal to the upper cutoff are shaded
with the associated color.

Color Defines the color associated with each group. A node is assigned
a color based on the range into which the value falls. The default
color is assigned to each group using the chart color series.

Saving a Chart as an Image

In Chart View, the View toolbar includes the Save Chart to Image icon that you use to
save the chart as an image (in PNG format).

Figure 12-19 Save Chart to Image Icon on the View Toolbar

Bl e &k

To save the chart as an image:

1. In the Chart View, click the drop-down arrow on the Save Chart to Image icon
and select the image resolution.

Figure 12-20 Drop-Down Menu on the Save Chart to Image Icon

Bl & (& §- e

® Current Size

5.000

B G080
|
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1024x 768
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i Custom Size

=

2. Click the Save Chart to Image icon to save the image.
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3. The File Download dialog box appears. Click Open or Save, as shown in
Figure 12-21.

Clicking Open opens the chart as a PNG file. Clicking Save allows you to select a
location to save the file.

Figure 12-21 File Download Dialog Box

X]

File Download
Do you want to open or save this file?

Name: Chart.
ﬂ png
Type: PNG Image

From: localhost

Open l[ Save l| Cancel |

ham your computer. i you do not trust the source, do not open or

lal While files from the Intemet can be useful, some files can potertially
A save this file. What's the risk?

Elapsed and Unelapsed Time

Line Charts and Area Charts can be displayed with a line that represents the division
between elapsed time and unelapsed time.

This line is displayed if, for a given chart for a selection of data cells, the calendar
dimension is selected and the time period selected includes the elapsed time. The line
will only be displayed if the calendar dimension is on the X-axis and the calendar’s
positions are in sorted order. If the X-axis contains multiple dimensions that include
the calendar dimension, then the line will not be displayed.

You can format this line using the General tab of the Chart Formatting window in
order to select the color for the line or to hide/un-hide the line.

To configure the color for the line, select the color you want from the drop-down list
and click Apply.

To hide a line that is currently displayed, un-check the Show Today check box and
click Apply. To display the line, check the Show today check box and click Apply.

Boolean Flags

Line charts can be configured to display a Boolean flag.

To display a Boolean flag:

1. Select a group of measures that include Boolean measures.

2. Select Line Chart.

3. The Line Chart display a graph with the Y2-axis as the Boolean axis.

The Y axis is the default axis for the Boolean flag. You can change the default using the
Edit Chart dialog box.

The default scale for the Boolean axis is 1. You can change this using the Formatting
dialog box.

Working With Charts 12-15



Working with Charts

If you select more than one Boolean measure, all the measures you select will be
displayed on the chart.

Available Chart Types

The following chart types are available with the charting feature:
s Area Chart

»  Bar Chart

»  Bubble Chart

s Column Chart

s  Combination Chart
s Line Chart

» Pareto Chart

» DPie Chart

= Ring Chart

= Radar Chart

m  Scatter Chart

s Treemap Chart

Area Chart

In a Area chart, the data is represented as a filled-in area. An area chart can be used to
show trends over time, such as sales for the past 12 months. Area charts require at least
two groups of data along an axis.

Area charts are available in the following types:

= Absolute Area Chart — Each area marker connects two data values. This type of
chart has the following variations:

s Absolute Area Chart with a Single Y-Axis
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Figure 12-22 Absolute Area Chart with a Single Y-Axis
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Absolute Area Chart with a Split Dual Y-Axis

Figure 12-23 Absolute Area Chart with a Split Dual Y-Axis
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are added to the values of previous sets. The size of the

Stacked Area Chart — Area markers are stacked, and the values of each set of data

stack represents a

cumulative total. This type of chart has the following variations:

Stacked Area Chart with a Single Y-Axis
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Figure 12-24 Stacked Area Chart with a Single Y-Axis
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= Stacked Area Chart with a Split Dual Y-Axis

Figure 12-25 Stacked Area Chart with a Split Dual Y-Axis
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»  Percentage Area Chart — Area markers show the percentage of the cumulative total
of all sets of data.
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Figure 12-26 Percentage Area Chart
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Bar Chart

A Bar Chart is similar to the Column Chart, except that the data is represented as
series of horizontal columns.

Bubble Chart

In a Bubble Chart the data is represented by the location and size of round data
markers (bubbles). Bubble charts show correlations among three types of values. They
can be used when there are a number of data items present and you want see the
general relationships. Bubble Charts require at least two data values. If two data
values are used, the size of the bubbles will be the same.

Data is represented by the location and size of round data markers (bubbles). Each
data marker in a bubble graph represents three group values:

»  The first data value is the X value. It determines the marker's location along the
X-axis.

»  The second data value is the Y value. It determines the marker's location along the
Y-axis.

»  The third data value is the Z value. It determines the size of the marker. A negative
values in Z coordinate is treated as an absolute (meaning that it has the equivalent
size of a positive number in that position) in respect to the visual size. Once the
bubble graph is plotted with two measures, you cannot edit the z-value (bubble
volume), which is a constant for all the plotted bubbles.

For more than one group of data, bubble graphs require that the data must be in
multiples of three. For example, in a specific bubble graph, you might need three
values for Paris, three for Tokyo, and so on. An example of these three values might
be: X value is average life expectancy, Y value is average income, and Z value is
population.

For the X and Y axes in bubble charts, only the minimum and maximum values are
programmatically set to correspond to the minimum and maximum values of the data
set on each axis. Otherwise, ADF auto scaling would start the axes at 0, and if all the
values were relatively high, the bubbles would all be in the upper left area. Therefore,
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if you were using quadrants, the quadrants would not be meaningful. For more about
quadrants, see Quadrants Tab.

Bubble Charts are available in the following types:
= Bubble Chart with a Single Y-Axis

Figure 12-27 Bubble Chart with a Single Y-Axis
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Figure 12-28 Bubble Chart with a Dual Y-Axis
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Column Chart

In a Column Chart, the data is represented as a series of vertical bars. A Column Chart
can be used to examine trends over time or compare items at the same time (for
example, sales for different product divisions in several groups).

Column Charts are available in the following types:

»  Clustered Column Chart — Each cluster of columns represent a group of data. This
type of chart has the following variations:

»  Clustered Column Chart with Single Y-Axis

Figure 12-29 Clustered Column Chart with Single Y-Axis
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s Clustered Column Chart with Dual Y-Axis
Figure 12-30 Clustered Column Chart with Dual Y-Axis
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s Clustered Column Chart with Split Dual Y-Axis

Figure 12-31 Clustered Column Chart with Split Dual Y-Axis
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= Stacked Column Chart — Bars of each set of data are appended to the previous sets
of data. The size of the stack represents a cumulative data total. This type of chart
has the following variations:

= Stacked Column Chart with a Single Y-Axis

Figure 12-32 Stacked Column Chart with a Single Y-Axis
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s Stacked Column Chart with a Dual Y-Axis

12-22 Oracle Retail Predictive Application Server User Guide for the Fusion Client



Working with Charts

Figure 12-33 Stacked Column Chart with a Dual Y-Axis
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Figure 12-34 Stacked Column Chart with a Split Dual Y-Axis
~| Sales by Type - by A
EH Measure| Product P EH calendar
[Wizekty Seles - Regulr | «[4 36X 1L Srll Water |= Bl Location
p— A
Ball .« | (&a- e
16.000
12.000
8,000
4,000
M Boston
Ju] 8.000 Berlin
M Barcelona
5,000
4,000
2,000
10/62006 10132006 102002006 102702006 11/3/2006

Percentage Column Chart — Bars are stacked and display the percentage of a given

set of data relative to the cumulative total of all sets of data. Percentage Column

Charts are arranged only with a single Y-Axis.
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Figure 12-35 Percentage Column Chart
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Combination Chart

The Combination Chart uses three different types of data markers to display different
kinds of data items. The Combination Chart can be used to compare bars and lines,
bars and areas, lines and areas, or all three combinations. Combination charts require
at least two groups of data for the chart to render an area marker or a line marker.

Combination Charts are available in the following types:

= Combination Chart with Single Y-Axis

Figure 12-36 Combination Chart with Single Y-Axis
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s Combination Chart with Dual Y-Axis
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Figure 12-37 Combination Chart with Dual Y-Axis
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Line Chart

In a Line Chart, the data is represented as a line, series of data points, or data points
connected by a line. Line Charts require data for at least two points for each member in
a group.

Line Charts are available in the following types:

= Absolute Line Chart — Each line segment connects two data points. This type of
chart has the following variations:

= Absolute Line Chart Single Y-Axis

Figure 12-38 Absolute Line Chart Single Y-Axis
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s Absolute Line Chart Dual Y-Axis
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Figure 12-39 Absolute Line Chart Dual Y-Axis
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Figure 12-40 Absolute Line Chart Split Dual Y-Axis
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s Stacked Line Chart — Each set of data is appended to previous sets of data. The
size of the stack represents a cumulative data total. This type of chart has the
following variations:

s Stacked Line Chart Single Y-Axis
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Figure 12-41 Stacked Line Chart Single Y-Axis
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s Stacked Line Chart Dual Y-Axis
Figure 12-42 Stacked Line Chart Dual Y-Axis
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Figure 12-43 Stacked Line Chart Split Dual Y-Axis
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»  Percentage Line Chart — The lines are stacked, and each line shows the percentage
of the given set of data relative to the cumulative total of all sets of data.
Percentage Line Charts are arranged only with a single Y-Axis.

Figure 12-44 Percentage Line Chart
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Pareto Chart

In a Pareto Chart, the data is represented by bars and a percentage line that indicates
the cumulative percentage of bars. Bars are arranged by value from left to right, from
the largest to the lowest. A Pareto Chart is always a Dual Y-Axis chart. The first Y-Axis
corresponds to values that the bars represent and the second Y-Axis runs from 0-100
percent and represents the cumulative percentage values.
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Figure 12-45 Pareto Chart
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Pie Chart

In a Pie Chart, the data is represented as sections of a circle. Pie charts can be used to
show the relationship of parts to a whole.

Figure 12-46 Pie Chart
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Ring Chart

Ring Charts are similar to the Pie Chart, except that the center of each circle displays
the total pie value.
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Figure 12-47 Ring Chart
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Radar Chart

In a Radar Chart, the data is represented in a polygon layout. Radar Charts are used to
show patterns that occur in cycles, such as monthly sales for last three years.

The data structure of a Radar Chart is:

= Number of sides on the polygon is equal to the number of groups of data. Each
corner of the polygon represents a group.

= A series or set of data is represented by a line, markers of the same color, or both
(labeled by legend text).

Figure 12-48 Radar Chart
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Scatter Chart

In a Scatter Chart, the data is represented by the location of data markers. Scatter
Charts can be used to show the correlation between two different kinds of data values.

Scatter Charts are available in the following types:

»  Scatter Chart with a Single Y-Axis

Figure 12-49 Scatter Chart with a Single Y-Axis

~| sales by Type - 4 oy A
Bl Measure| Product ¥ T EE calendar
[Weskhy Sales - Regulzr | [@ X 6X 1L Sall Water |» BR Location
A
salll L & ®-e
5,000
|
7.500 u
6,000
M Barcelona
4,500 * Berfin
* # Boston
3,000
1,500
[i]
a 1.500 3,000 4.500 6,000 7.500 5,000
»  Scatter Chart with a Dual Y-Axis
Figure 12-50 Scatter Chart with a Dual Y-Axis
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Treemap Chart

In a Treemap chart, the data is represented by the size and color of the rectangular area
markers (nodes). A Treemap chart shows correlations between two types of data
values and is used to examine relative performance between a number of data items.

The first data value determines the area size. A zero or negative value will be ignored
and no node will be shown on the chart. The second data value determines the area
color. You can reverse this via the Flip size/color option that is available on the
right-click context menu. Selecting it refreshes the chart so that it displays the new
orientation of the data.

For example, a Treemap chart can be used to show the correlation between yearly sales
vs. average percent markdown for different regions. The sales data for each region
determines the node size, and the average percent markdown determines its color. See
Figure 12-51.

Treemap charts are available in the following types:

»  Treemap chart with continuous colors. The node colors in this Treemap chart
transition between a range of shades between two colors. The color shade is
determined based on the node data value that determines color.

You can pick the two colors on the chart formatting dialog. See Understanding the
Treemap Chart Formatting Window.

Figure 12-51 Treemap Chart with Continuous Colors
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» Treemap chart with grouped colors. The nodes in this Treemap chart use discrete
colors based on the pre-defined range that the node data value falls into. Each
range is associated with a group label and a color.

You can define the groups with a start value and a cutoff value with the chart
formatting dialog. See Grouped Subtype.
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Figure 12-52 Treemap Chart with Grouped Colors
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Drilling Down

You can double click on any node with visible children in order to drill down in a
Treemap Chart. It is recommended that you do not select the On drill option when
drilling down in cases where the data is aggregated (for example, mean, median,
percent). Minimum and maximum color values are adjust to reflect new data when
you select Auto fill and On drill prior to drilling down. You can de-select the Auto fill
option after you have drilled down if you decide you want to use the original parent
values instead of the adjusted values.

Showing Images

Show images functionality is supported with Treemap Charts. If the pivot table you
make your data selection from displays images, then the Treemap Chart you render
will display those images as well. (Note that if there are multiple images associated
with a position, only one image will be shown. The image shown will be the one that is
the closest on the screen to the measure data.) While the user is viewing the Treemap
chart, images can be hidden (if shown) or shown (if hidden) from a context menu. For
more information about showing images, see Chapter 13, "Images".

To display images, you must have a visible media attribute on the pivot table. If the
pivot table displays images during the initial rendering of the treemap, then the
images will also be shown on the treemap. When more than one media attribute is
visible on a pivot table, the innermost media attribute will be shown on the treemap.

The treemap uses the same image.id and size.id that has been configured for the pivot
table. That is, they are chosen from pivottable.default.header.image.id and
pivottable.default.header.size.id. The height and width of the treemap images can be
configured using the following two properties in rpasConfig.properties, which both
default to a value of 50.

»  chart.default.image.width=50
»  chart.default.image.height=50
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Note that if either the configured aspect ratio does not match the image aspect ratio or
the actual image is smaller that the configured sizes, then the image may not display
clearly because of stretching.

In order to hide an image, you must select the Hide Images context menu option. This
menu option is only enabled when there are visible attributes on the pivot-table.

Charting and Drilling

This section describes how to drill into graphs to get more detail.

Note: With Treemap Charts, unlike other charts, you must
double-click in order to drill down.

Introduction

When taking decisions or reviewing data, you may find it useful to see the information
presented graphically. RPAS lets you drill down into the child positions in the graph to
see a greater level of detail. You can also return to the original graph. In the example
below, the first pie chart shows data at quarterly level.

Figure 12-53 Drill Down Example Before
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Figure 12-53 shows the data for the 1st Quarter segment of the pie chart at a monthly
level.

Figure 12-54 Drill Down Example After
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You can return to the previous level in the drill down by clicking on the provided link
in the legend. If you drill down more than one level, you can select any prior level
from a drop-down list. [Not shown in above screen shot].

You can drill down to the lowest level in the hierarchy and then drill back (go back) to
the original chart. To see data at a higher level than that originally selected for the
chart, you must make a fresh selection in the pivot table view.

Unless you make a fresh selection, the data selected in the pivot table remains
unaffected by the drilling operation.

Restrictions on Drilling
The drilling functionality has some restrictions:

Types of Chart
The following chart types cannot be drilled into:

s Pareto Chart

= Radar Chart
Drilling into Groups is not supported for the following types of charts:

s Bubble Chart
s  Scatter Chart

Disabling Chart Legend

When configuring charts, you can hide the legend. If the legend is not visible, you
cannot use it for drilling down nor for returning to the previous level. You can still
drill down by clicking any chart segment or return by selecting previous levels in the
drop-down list.

Dimensions

You can drill into any dimension other than measures. This is because a measure
consists of a fact (numerical value of some item of information) plus a formula used to
manipulate that information. Since this formula may vary at different points along a
dimension, drilling down into a measure is not meaningful.

When you select data for the pivot table, you can select a subset of dimensions from
those available. Only dimensions selected for the pivot table can be drilled into. In the
example below, data has been selected for March and April.
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Figure 12-55 Selecting Dimensions
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To drill into Y axis positions (Row edge in the pivot table), you can either click on chart
area or the legend. To drill into the X axis (Column edge in pivot table) positions, click
on labels displayed on the X axis of chart.

Saving and Reopening

If you save the workbook and reopen it while a chart is open and drilled into, the state
of the chart will not be saved. Instead, when you reopen the workbook, the chart that
is displayed will be based on the data that was selected in the pivot table view.

Drilling Down

Drilling down lets you see more detail associated with a specific part of a chart.
Drilling down is only possible if the selected dimension has one or more levels
selected below the level at which data has been selected for the chart. For example, if
you starts to drill into the product dimension at Class level, you must have previously
selected other dimensions like Sub-Class and SKU to drill into.

Plotting the Chart

You create charts by selecting the required data in the pivot view window and then
selecting Select Chart Type from the View toolbar. Once you select the chart type,you
can display it by choosing the Switch to Chart View or Switch to Split View options.
Once the chart is available, you can drill down into the chart.

Note: Some restrictions exist on the drill-down functionality. For
example, you cannot drill into specific chart types. Nor can you drill
into specific levels of a particular dimension if those levels have not
been selected when creating the pivot table view.

Methods for Drilling Down

One way to drill down is to click on the required part of the legend. Another is to click
in the appropriate section of the chart. If no further levels are available, the chart
legend is no longer clickable.

To drill into Y axis positions (row edge in the pivot table), you can either click on chart
area or the legend. To drill into the X axis (Column edge in pivot table) positions, you
must click on labels displayed on the X axis of chart.
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Figure 12-56 Drill-Down Methods
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Once you click the legend or chart section, the chart is redrawn to show the
information at the lower level.

Reaching Lowest Level

When you reach the lowest available level for drilling down, clicking on the legend or
chart area will have no further effect.

Drilling Back (Reversing Drilling Operation)
Once you drill down at least one level into the chart, you can revert to previous levels.
Two options are available:

Figure 12-57 Drilling Back Methods
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s Clicking on the link in the legend

The link you use to drill down is highlighted in the legend. This link shows the
immediate parent position level. Click this to go back one level. If you have drilled
through multiple levels, each click on the legend will take you back one level.

s Using the drop-down list

You can also got back to previous levels using the drop-down list. If you have
drilled down through multiple levels, you can select any previous level.

Page Edge Navigation

You can select alternative positions on the page edge.
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Figure 12-58 Page Edge Position
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If you select another position, for example, another product or another location, the
chart will be refreshed with the information at the currently selected level. For
example, if you select another store and you have drilled down two levels from the

information selected in the pivot table, the chart will refresh and show information for

the new store two levels down from the one you selected in the pivot table.

Formatting Options
The standard chart formatting options work in the drilled state:

= Refreshing Chart
The chart can be refreshed with pivot table selections while in the drilled state.

s Changing Chart Type

Chart types can be changed while in the drilled state. The new chart type is drawn

with the same positions and data values as the one it is replacing.
s Toggling Between Views

Toggling between pivot table view to graph view or toggling between graph view
to pivot table view retains the same positions and data values as the current
drilled state.

s Copying Views

Using the Copy View option when the chart is in the drilled state also copies the
state of the drilled graph.

s Drilling into Split Levels
If you have drilled into split levels:

— The drilled state of the charts is preserved when the workbook is recalculated.

— The drilled state of the chart is preserved when the workbook is saved and
refreshed. However, the drilled state will be lost if you close and reopen the
workbook.

»  Flipping Charts

If the axes of the chart are reversed, the drilled state of the chart will be preserved
and it will remain at the current drilled level.

= Pivot Swap from Row or Column to Axis

If a pivot swap from row to column axis (or vice versa) is carried out, either by
using tiles or directly in the pivot table, the chart will revert to its original,
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un-drilled state. This initial state is determined by the selected data in the pivot
table.

= Pivot Swap between Page Edge to Column or Row

If a pivot swap occurs between column edge to column or row (or vice versa), then
the chart revert back to its original state.

Editing Data Values

In both normal and drilled chart view, data can be edited by right clicking in the chart
area and opening the Right Click menu.

Figure 12-59 Editing Data - Right-Click Menu
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If you select the Edit option, a pop-up window opens that you can use to edit the data.

Figure 12-60 Pop-Up Menu for Editing Data
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Refreshing the Chart

Use the refresh button to update the chart with the current data in pivot view.

Figure 12-61 Toolbar - Refresh Option
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»  If the data selected in the pivot table is unchanged, the chart will be restored to its
undrilled state.

»  If the data selected in the pivot table changes, the chart will be redrawn to an
undrilled state and display the new data.
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Overview

Images

The ability to view images associated with positions on a dimension is useful in many
aspects of the retail world such as assortment planning, item planning, and story
boarding.

Note: See Chapter 14, "View Details", for information about
additional functionality for displaying images in the UL

For example, you can associate an item with a image of what it should look like
displayed on the shelf. You can associate stores with images of the store front or
interior. You can use images to storyboard themes by creating a collection of looks and
colors for a particular buying period, floor set, or flow. Some retailers choose to
associate multiple types images with multiple levels of the Product dimension. For
instance, you could associate images for the following Product levels:

s Department: Image of a generic sweater
= Class: Image of a wool sweater
= Subclass: Image of a L/S V-Neck Solid sweater

= Style: Image of Chunky Shrunken Style, Washable Wool, L/S V-Neck Solid
sweater

= Style/Color: Image of Chunky Shrunken Style, Color Pumpkin, Washable Wool,
L/S V-Neck Solid sweater

With the Fusion Client, you can associate an image for any dimension with a
configured media attribute, including calendar levels. These images can be stored on a
website or in a repository located in the same network as the application server.

After images are associated with a position, you can view and compare them within
the Fusion Client.

Images can be included in a domain by configuring media dimension attributes and
measures, loading them with media bundle values referring to images, and making
them visible in worksheets. A number of images may be included in each bundle
value; one of those is designated as the primary image that can be seen in the pivot
table. All the images, not just the primary, can be seen via the detail pop-up.

Pivot table headers display images for visible media dimension attributes. Attributes
can be made visible by selecting them for display in the worksheet view, as discussed
in Select Attributes for Display, or as configured for the worksheet in Config Tools.
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Pivot table cells display images for visible media measures. Measures can be made
visible in the view using measure lists or measure profiles in the worksheet

definitions.

In addition, these attribute and measure values can be viewed in a detail pop-up, as
described in Chapter 14, "View Details", provided they have been configured
appropriately using Config Tools.

A detail pop-up is a pop-up that has been configured to display a group of images and
associated information. A detail pop-up differs from view image in that former is used
to browse all the images associated with a position or cell and the latter is used to
browse positions using images. A detail pop-up can also show non-media attribute
and measure values for the position or cell.

Worksheet formats applied via the Format dialog box are also applied to format the
styles for the content that appears in the Information section of the detail pop-up. See
Chapter 5, "Formatting" for details.

Media measures and media attributes do not display as images outside of the detail
pop-up and the pivot table. The use of media items in other contexts within the Fusion
Client is subject to the following constraints:

Table 13-1 Measure and Dimension Behavior in the Ul

Ul Element Behavior

Show /Hide The position label for the image is displayed in lieu of the media
image.

Level Split Media attributes are not available.

Quick Fill Media values can be copied to other media cells in one or more
measures but cannot be copied into string, text, or other non-media
types.

Fill For media measures, the fill dialog expects a media bundle value in it
XML fragment string representation. This value is parsed and
validated. Parsing errors or validation errors are reported and logged.

Chart Legends Position labels are displayed if only media attributes are visible.

Copy/Paste Media measure behave in the same way as other measures. Type
checking occurs, so media cannot be pasted into a float or integer cell.
Media can be pasted into a string measure cell. If a string measure
contains a media XML fragment, it can be pasted into a media measure
and the image will be displayed.

Cut Removes media data from media measure.

Copy External/Paste  Same as Fill behavior.

External

Workbook Wizard Media measures are not available for selection.

Dimension Options

Print/Export

The display of images is not supported. The export settings As Seen
and Formatted display different content than the export setting Raw
Data. In all cases, some fragment of text such as the label, the media
url, or the media xml will be displayed.

Viewing Image from a View

To view the image associated with a position, use one of the following methods. Note
that the image you see is the primary image of the image attributes available for a
given level. It is either the innermost visible image attribute (if present) or the first
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image attribute. If no image attributes are available but old-style single images are,
then those images are used (via the Config Tools Enable Images check box on a Level).

Viewing Images - Method 1
1. Right-click the position within the view or page edge.

2. The right-click context menu appears. Select View Image.

Figure 13—-1 View Image Option in the Right-Click Context Menu
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The View/Manage Images dialog box appears. The image for the position you selected
is shown in the center of the image carousel.

Viewing Images - Method 2

1. Click the Manage Images icon in the toolbar or select Manage Images from the
View menu.

2. The View/Manage Images dialog box appears. Use the Find image for drop-down
box or the image carousel to locate and view the image.

Associating Images with a Position

To associate an image with a position, complete the following steps. Note that this is
for associating a single image to a position on an ad-hoc basis. Populating multiple
images for a position is a back-end process.

1. Click the Manage Images icon in the toolbar or select Manage Images from the
View menu.

Figure 13-2 Manage Images Icon
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Figure 13-3 Manage Images Option
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2. The View/Manage Images dialog box appears. Enter the following information:

Dimension and Level: Select the dimension and level into which you want to
load the image. In Figure 13-4, the Product dimension and Item level have
been chosen.

Find image for: Select the position for which you want to load the image. You
can select the position from the drop-down list, or you can scroll through the
positions in the carousel view.

Show Children: This option appears when you have selected a dimension
level other than the lowest dimension level. Select this option to display
images of the children instead of the parent.

If Show Children is not set, then Find Image for and the carousel both navigate
to the same positions and stay in synch. If Show Children is set, then Find
Image for navigates to the parent position and the carousel navigates to the
child positions. Because of this, if you change the parent position, you will see
a new set of child positions; however, if you use the carousel, the position does
not change.

At Level: This option is enabled when the Show Children option is selected.
Use this field to select which child level to display images for.

Attribute: Select the attribute that contains the images that you want to
display or manage. If the selected level is not configured for media attributes,
then this control is disabled.

The Attribute list is disabled when no media attributes are configured for the
selected level. However, the level is still displayed because old-style Enable
Images is set (via the Config Tools Enable Images check box on a Level). You
can view and manage these images here for compatibility with configurations
that do not use media attributes.

Image Source: Select either URL or Repository as the location of the image.
Select URL if the image is located on the internet. Select Repository if the
image has already been loaded into the repository on a shared network
location.

Note: The repository is configured during the installation process.
The levels having attributes that represent images are also configured.
In addition, rules must be configured if the image attribute changes
are to be committed to the domain. Contact your administrator for
assistance. See the Oracle Retail Predictive Application Server Installation
Guide for more information.
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=  File path: Enter the file path for the image. You can type or paste the file path
for either a Repository or URL image source. For Repository images, you can

also use Browse to locate the file within the repository. After you have entered
the file path, click Go.

Figure 13-4 Loading Images
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The image appears in the image carousel and is now associated with the
position.

Comparing Images

You can drag images from the images carousel to the Compare area of the
View /Manage Images dialog box in order to compare images side by side.

To compare images, complete the following steps:

1. Click and drag an image from the image carousel to the Compare area. When the

background of the Compare area changes to blue, release the image. The image
appears in the Compare area.
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Figure 13-5 Dragging an Image to the Compare Area
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2. Click and drag other images to the Compare area. The images appear as
thumbnails.
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Figure 13-6 Images as Thumbnails in the Compare Area
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3. To expand the Compare area in order to view the selected items as larger images,
click the Expand icon in the top, right corner of the Compare area. To collapse the
Compare area after expanded, click the Collapse icon in the top, right corner.

Deleting Images

You can disassociate an image with a position by using Delete in the View /Manage
Images dialog box. This clears out the images from the value for a position.

Note: Using the Delete function does not delete an image from the
repository. It only disassociates the image with the position.

To delete an image, complete the following steps:

1. Click the Manage Images icon in the toolbar or select Manage Images from the
View menu.

Or, right-click the position within the view and select View Image from the
right-click context menu.
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Figure 13-7 View Image Option in the Right-Click Context Menu
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2. The View/Manage Images dialog box appears. Select the position for which you
want to delete the image. You can select the position from the Find image for
drop-down box or from the image carousel.

3. After you have selected the position, click Delete located to the right of the File
Path field.

Figure 13-8 Delete Button
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The image disappears from the image carousel.
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View Details

You can view visual data in the form of images that are displayed in pivot table
position headers as attribute values, pivot tables cells for measure cell values, or as
detailed pop-ups for specific positions or cells. The availability of these images for a
particular worksheet depends on both the configuration of the worksheet and what
you select within the UL

Note: This functionality is distinct from the view images
functionality that is described in Chapter 13, "Images." The view
images functionality described there is used to display primary
images in positions, and can be changed or updated.

This chapter contains the following sections:
= Pivot Table Headers

= Pivot Table Cells

ns  The Detail Pop-Up

s Accessing a Detail Pop-Up

»  Detail Pop-Up Features

Pivot Table Headers

Images can appear as pivot table headers for positions. This functionality can be
configured in Config Tools or can be specified in the Fusion Client, as described in
Select Attributes for Display. Only a single thumbnail image can appear as an attribute
value in a pivot table header cell. This attribute functions as do all attributes within the
Fusion Client (for example, whether or not the attribute is shown or not).
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Figure 14-1 Image as Pivot Table Header
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The image may be displayed instead of the label or in addition to the label. You can
hover over the image in order to see the label. You can also specify which attributes are
displayed using the Dimension pop-up functionality.

Pivot Table Cells

Images can appear as pivot table cells for measure cell values. This functionality can be
configured in Config Tools. Only a single thumbnail image can appear as a cell value.

Such measures can be included in the measure profile for the worksheet definition
during configuration. You can also make changes using the Dimension pop-up
functionality. These cells cannot be edited in-line. They can be configured to be
read-only, but they are not automatically read-only. They are subject to the same
display behavior as any other cells.

The Detail Pop-Up

A detail pop-up is a dialog box that provides additional information related to a
specified position or cell. These details consist of attribute and measure values,
including images, for a single position or cell. All information is read-only and must be
available in the current workbook.
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The Detail Pop-Up itself is configured as a worksheet. The pop-up can potentially be
accessed from more than one position or cell, depending on the configuration. If no
pop-up has been configured, then nothing appears in the menu.

In order to be available, the detail pop-up must first be configured using the
Workbook Transition tab of Config Tools. This configuration creates the transition or
link to the detail pop-up within the UI and determines what is displayed within the

pop-up.

Accessing a Detail Pop-Up

You can access a detail pop-up by right-clicking on a position or cell that has been
configured as a transition. If a detail pop-up has been configured for that position or
cell, you will see a cascading menu that lists the pop-up or pop-ups that are available.

Figure 14-2 Detail Pop-up Menu
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The transitions you can select include:

= Dimension level. A position at this level can provide access to the pop-up. This can
only be accessed when a specific position at a specific level is selected.

= Worksheet. A worksheet cell selection can provide access to the pop-up. This can
be accessed anywhere in the worksheet.

= Measure. A measure cell selection can provide access to the pop-up. This can be
accessed anywhere in the measure.

Detail Pop-Up Features

The detail pop-up is divided into three sections, as shown in Figure 14-3. The title of
the detail pop-up is taken from the worksheet label.
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Figure 14-3 Detail Pop-Up Example
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Selected Media Item section. This section contains one full size image with a
caption based on the image label. You can change the image that is displayed by
clicking one of the thumbnails selected from the Media Browsing section.

Media Browsing section. This section contains thumbnails of all the available
images. Click one of the thumbnails in order to display it in the Selected Item
section. You can hover over each image to see the label information for that image
as well as the attribute or measure the image comes from.

Information section. This section provides details about the cell or position
selected in the worksheet. Labels include attributes, which are displayed in their
configured order, and then measures in their configured order. Next to each label
is either the attribute value or the data cell value. Since space is limited, you may
need to hover in order to see a more complete value.

The Information section is divided into three subsections: selection context of the
cell selected on the source worksheet; attribute values from the selection; and
measure values for the selection.

Formatting from the underlying pivot table is mostly reflected in the data
presented in the Information section. The following do not carry over directly:
real-time alert filtering, read-only formatting, and formatting specified in the
formatting dialog for either attribute labels or values.

When an image has enough detail to allow a zoomed-in view, the information
section is temporarily replaced with the zoom detail (see below).

Use the Close button to dismiss the dialog box.
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Note: If no images have been configured for the pop-up, then only
the information section is displayed.

Zooming In on an Image

The Fusion Client scales images to fit into the upper left hand side of the detail popup.
The details of larger images can be viewed by rolling the mouse over the selected
image. The zoomed-in details of that image will be displayed in the upper right side of
the detail popup.

Figure 14-4 Example of a Image Zoom
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Figure 14—4 shows some of the features of the detail view related to zooming in on an
image.

When an image is larger than the selected item display size, the following message
appears under the selected image: "Roll over image to zoom in." If you move the
mouse cursor over the selected image, the zoom feature is automatically triggered.

A Zoom Context Rectangle is shown in the selected image in the upper right. The
portion of the image covered by the zoom context rectangle is what is displayed in the
upper right of the Detail Pop-up. The mouse cursor automatically changes to the zoom
context rectangle (with the cursor at the center of the rectangle) when you move the
mouse over a zoomable image. It changes back when you move the mouse away from
the image.

The high-resolution image shows a cropped, scrolling subset of the selected image.
Moving the cursor around the selected image changes what portion of the
high-resolution image is shown. When you move the cursor off of the selected image,
the high-resolution image reverts back to the tabular Information section.
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Overview

Tiled View with Drag and Drop

Drag and drop is enabled in workbook wizards, where it is used to add or remove
products, time periods, and other entities from a workbook. It is used in the

Show /Hide measure dialog box to add or remove measures from a worksheet or to
re-order them. It is also enabled in the planning workspace via a worksheet type called
a "tiled view."

The tiled view is ideal for adding or removing one or more styles or style-colors from a
cluster's assortment, a promotion, and so on. More generally, it can be used in any
situation where dragging a tile from one worksheet to another represents a business
operation. This capability is fully configurable.

The results of the drag and drop action are stored by RPAS, and these results can be
used to filter which tiles are visible in the tiled view.

Figure 15-1 illustrates how the tiled view can be used. The business operation in the
example shows how a planner can graphically build an assortment by dragging styles
from a pool into the assortment.

The Available Styles view (left) contains the pool of all available styles. The Assorted
Styles view (right) contains the assortment of styles that are to be offered in specific
store clusters. In order to modify the assortment, the planner selects one or more styles
from Available Styles, then drags and drops them onto Assorted Styles. The items are
added to the appropriate row in the Assorted Styles, updating that assortment or
cluster. Similarly, the planner can drag and drop a style from Assorted Styles back to
the Available Styles in order to remove that style from that assortment. The results can
be saved, committed, and further operated on as usual.
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Tiled View

Figure 15-1 Tiled View
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The tiled view is a worksheet type that can be configured in ConfigTools. The tiled
view has both similarities and differences from the Pivot Table/Chart worksheet.

Like the Pivot Table/Chart worksheet, the tiled view can have multiple dimensions on
the page or z-axis. The dimensions in the Page Edge can be used for the driving
positions in a Position Query Definition (PQD). The dimensions in the Page Edge can
be synchronized as usual. The dimension tiles can be used to bring up the Dimension
pop-up as usual, for access to that dimension's levels, Show Attributes and Sort, as
well as the Show and Hide tabs.

Unlike the Pivot Table/Chart worksheet, the tiled view can have at most one
dimension on the row or y-axis. Also, the column or x-axis is fixed and cannot be
changed. In terms of the tiled view, this axis is also called the "tile axis." In Figure 15-2,
the tile (column) axis is shown in the red box. No other dimension tile can be moved to
or away from the tile axis.

Figure 15-2 Tile Axis
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| FF 2018 Summer Casual Tops 01|
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The single dimension in the row axis of the tiled view is also called the "tiled
dimension."

Each tile represents a tiled dimension position combined with the page and row
positions. Each tile displays the values for visible attributes for the tiled dimension
position. If measures are visible, each measure's label and value are shown in the tile.
Figure 15-3 shows an example of a tiled view. The product and measure dimensions
are in the tile axis, and each tile shows the product name as a tile title (for example,
210083 Basic Vee and 210092 Burnout Top). Several measures are displayed for each
tile (WP Include in Shopping List, WP Style Status, WP Buy Qty, and WP # of Colors).
The row dimension (Cluster) shows the clusters vertically along the page.
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Figure 15-3 Tile View Example
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Displaying, Filtering, and Ordering Tiles in a Row

On the tiled view, every row contains a number of tiles. If there are more tiles in a row
than can fit on a single line, the extra tiles are wrapped onto lines below the first. This

can be seen for the items in Cluster B in Figure 15-3. There is no set limit to how many
tiles can be shown in a row.

Factors Affecting Which Tiles are Displayed in a Row

The actual tiles shown in a row are controlled by the following:

Any position filtering in effect

-+

v A

B3 Product Measure

)
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{eesy
4
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0 WP Buy Oty
5 WP # of Colors
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' {
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0 WP Buy Oty
5 WP # of Colors

X

The settings in the Show and Hide tab in the Dimension pop-up

A Position Query Definition (PQD) in effect for that worksheet

The underlying Boolean measure that filters which tiles are shown on the tiled
view. This Boolean measure is part of the definition of the tiled view and is what is
updated when tiles are dragged and dropped from one worksheet onto another.

Dragging and dropping a tile updates the underlying Boolean measure directly, and
changes are reflected immediately on the tiled view.

In addition, there are a number of ways to affect which tiles are shown via edits to the
underlying Boolean measure (either directly or indirectly), including:

Changing a value using a check box in a tile

Removing a tile (by clicking the x in the tile's upper right hand corner)

Changing a value using an edit in a pivot table or chart
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»  Fill, clear, cut, and paste
= Refreshing the workbook

These edits also cause the tiled view to be updated immediately. This occurs regardless
of the user operation causing the edit or the view that was edited.

The effects of each of the above factors are cumulative. For example, a tile hidden via
position filtering will not show up even if it is visible per the Show and Hide tab in the
Dimension pop-up. In addition, because some of the filtering listed above can apply to
individual rows on the worksheet, the filtering can vary between rows.

The Ordering of Tiles in a Row

The order in which the tiles are displayed is controlled by two factors. The first factor
is the underlying ordering of the dimension itself. This does not change from row to
row in a tiled view, and if the tiled view is represented as a pivot table, this ordering
will be the same as the order of the items in the column. This ordering is the same for
all rows in a tiled view. As with the pivot table, this ordering can be modified by using
the Show Attributes and Sort tab of the Dimension pop-up.

However, the ordering of the tiles can be temporarily changed by just dragging and
dropping. A dropped tile appears in the row of tiles where it is dropped. This is
temporary. The dropped tiles are sorted into their regular place whenever the
worksheet is calculated, saved, or the row is scrolled off screen by a new fetch.

How Rows are Arranged

The rows shown in the tiled view are determined by the dimension in the row edge.
The rows can be scrolled vertically as usual. The dimension can also be formatted as
usual. Multiple levels of this dimension can be displayed in either block or outline
mode. When multiple levels are shown, the page and row positions for the aggregated
levels will use aggregated values for both filtering and displaying measure values
within the tile.

If no dimension is shown in the row edge, then all positions are displayed in a single
large row, as shown in the Available Styles worksheet in Figure 15-1. Figure 154
shows this situation in detail.
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Figure 15-4 Auvailable Styles Worksheet
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Scrolling and Viewing Tiles in Each Worksheet Row

In general, there are more tiles (positions) in a row than space available for display.
This is addressed in several ways in the tiled view.

The first way is that each row can be adjusted to show more than one row of tiles.This
can be seen in Figure 15-3, where the Cluster B position shows two rows of tiles within
a single row of the worksheet.

Figure 15-5 shows the View Port Controls that can be used to control the number of
tile rows.This mini-toolbar is displayed for each row on the worksheet.

Figure 15-5 View Port Controls
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= Remove Row: Removes a display row. Disabled if only one display row is visible.

= Add Row: Displays another display row for a given logical row. If the screen
width is such that it displays five tiles in a single row, clicking this button will
display another row, creating a worksheet row that now displays two rows of five
tiles. The number of rows that can be added is limited by the Maximum Display
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Rows setting (for example, 10). This button is disabled if the last tile in the row is
already visible.

= Expand Row: Displays all rows in a vertically scrolling View Port. Other rows in
the view are not visible when a row is expanded in this way.

= Back to Multi-Row View: This control is only accessible when a row has been
expanded.

In conjunction with the number of tile rows that are displayed per worksheet row,
each worksheet row can be scrolled individually. If the worksheet row is in multi-row
mode, then a horizontal scrollbar is used. Otherwise, a vertical scrollbar is used.

Scrolling and Paging Within a Worksheet Row

The ordering and filtering of tiles within a tile row need not be the same from one row
to the next. Each worksheet row has its own scrolling and paging controls that apply
only to that individual row. Figure 15-6 shows the scrolling and paging controls.

Figure 15-6 Scrolling and Paging Controls
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= Show First: Displays the first chunk of tiles and puts the first tile in the first
position of the first display row. Disabled if the first tile is currently visible.

= Show Previous: Displays the previous chunk of tiles x display rows. Disabled if
the first tile is currently visible.

= Show Next: Displays the next chunk of tiles x display rows. Disabled if the last tile
is currently visible.

= Show Last: Displays last chunk of tiles and puts the last tile in the last position of
the last display row. Disabled if the last tile is currently visible.

If the worksheet row contains more than about two dozen tiles, or if there are more
than a half dozen rows displayed, seeing all of the contents of a row or the contents of
adjacent rows becomes difficult. In either case, the per-row scrolling and paging
controls are less useful.

In this case, there is another option. A special Expanded Row user interface allows
users to focus on a single worksheet row that is laid out in tile rows. A more typical
vertical scrollbar is available for continuous scrolling of tile rows. Figure 15-7 shows
this feature. In this example, the row Cluster B has been expanded. The other rows are
no longer visible.
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Figure 15-7 Expanded Row
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The Collapse Expanded Row button (boxed in red) restores the original multi-row

view.

Tiles

The content of each tile is based on the visible attributes followed by the visible
measures. There is no requirement that images be displayed. Figure 15-8 and
Figure 15-9 provides some examples of tiles.

Figure 15-8 Tile Example
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Attributes

Measures

Figure 15-9 Additional Tile Example
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A tile displays the values of the visible attributes for the level of the tile dimension
position, one per line, in order.

The visible attributes and their order may be specified in ConfigTools via the Window
Formatting tab in the Worksheet tool, and they may be altered by the Show Attributes
tab of the Dimension pop-up. At least one attribute is included here. If all attributes
are hidden, the label is shown. There is no requirement that images be included.

If the label attribute is shown, it is displayed in the header of the tile. Attribute labels
are not displayed in the tile (but may be available via hover). The attribute values are
formatted and styled as they would be in a pivot table header.

The tile displays the label and value of each visible measure, one per line, in order
below the attributes. There is no requirement that any measures be displayed.

Visible measures are configured via Measure Profiles in the ConfigTools Worksheet
tool, just like they are for pivot tables. The user may use the Dimension pop-up on the
Measure dimension to switch between measure profiles, show or hide individual
measures, create new measure profiles, and so on.

The measure labels are styled as they are in pivot table headers (Measure
Styles/Headers). The measure cells are formatted and styled as they are in pivot table
cells. This includes Measure Styles/Cells, Number, Date/Time, Exception Format, and
Real Time Alerts.

If the cell is read-only or locked, that will be indicated here. If the cell is editable in a
pivot table, it will be editable here as well.

Practical Limitations

Tiles are meant to be compact, summary objects that can be dragged and dropped. A
tile has limited space, and the physical size of the screen and its resolution set a
practical limit on how large a given tile can be. The attribute and measure display tries
to make effective use of the available space, but compromises are made and the end
user cannot control the sizing of individual cells. In some cases, values or labels may
be clipped or all the attributes and measures in a tile of reasonable size may not be
visible.
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Resizing a Tile

A tile can be resized by dragging the lower right hand corner of the tile. This changes
the size of all tiles for this level of a worksheet row. There is a limit to how large you
can make a tile; this can be controlled by the administrator. Figure 15-10 shows the
location of the resize control boxed in red.

Figure 15-10 Resizing a Tile

2100%4 Graphic Studded... =

) §

WP Include in [«

WP Style Statu
WP Buy Qty i}
WP # of Colors 5

Tile Formatting

In addition to formatting the attribute and measure content of the tile, formatting can
be applied to the tile itself. This is done by using the formatting of the tile measure's
cell as styles for the tile. The tile's background color is taken from the cell's background
color. If possible, the tile's border color is taken from the cell's text color. As an
example, Figure 15-11 shows formatting applied to a specific tile and a specific
measure. The tile formatting is based on the WP Style Status measure being New, and
the measure is when WP # of Colors is less than 6.

Figure 15-11 Formatting a Tile

210081 Pattern W Neck ... 3 | |210084 Fitted Princess... X

The tile measure does not have to be one of the visible measures shown in the tile
content for this to work. It just has to be designated as the tile measure in a tiled view.
If the tile measure is the target measure of a Real Time Alert, the alert measure is
evaluated and used to determine the styles and hover information.
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Format Dialog Change

The Format Dialog filters measures by what is visible in the selected view(s). For this
purposes the tile measure for the tiled view must always be included so that the
formatting can be set. Figure 15-12 shows the Format Dialog.

Figure 15-12 Format Dialog Box

Format [ ]

| Measure Styles | Number ‘ Date/Time | Exceptions ‘ Alert Styles | Dimension Styles ‘

4 Filter measures

Name

coitaia Type Al v |V!s:h§e in Available Styles v I\la
4 Apply measure format
Measure WP Include in Shopping LI w Textcolor || RS a!ignmi.i‘ti v
Background 5 . :
View All color xample
Ao [#, WP Include in Shopping List Font style v

1 VP Pice Tier

WP Shopping List Inclusion Status

WP Style Status
Close

In the above example, the WP Include in Shopping List measure is available for the
Available Styles even though it is not a visible measure in that view. It is included
because it is the tile measure for that worksheet.

Editing Measures in a Tile

Editing a measure cell in a tile is much the same as editing a measure cell in a pivot
table. The changes can be reverted, undone, and so on.

Dragging and Dropping

In order to drag an item, you just click at the top of a tile and start dragging. You can
make a multi-tile selection by clicking on the first tile, then ctrl-clicking to add others.
Once you have a multi-tile selection, you can drag the whole selection.

Dragged items can be dropped onto a tile row or on a row on the row edge. Fusion
Client adds the dropped tiles to the worksheet rows, provided it makes sense. That is,
the ability to drag and drop must be enabled in the configuration. The initial setup
includes specifying a source worksheet and a destination worksheet, as well as what
information moves from the source to the destination as part of the drag and drop
action. Dropped items are not automatically added. Fusion Client checks to make sure
that the information dragged from the source makes sense in the context of the
destination, that protection processing and locks are respected, base and aggregated
states are editable, and so on.

If the drop is permitted, several things can occur. The underlying Boolean measure
gets updated. This has the usual effect of an edited cell value. The new value is shown
in any views in which it is visible, it can trigger an exception format formatting
change, have protection processing effects, and so on. If the destination tile is already
present, the drop will have no effect.

Note that it is possible that some dropped tiles may be hidden due to Show/Hide,
Position Filtering, or PQD filtering. The dropped tile may also not be visible because of
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the layout of the screen and the limited number of tiles that can be shown at one time.
This does not cause the drop to be rejected. If the drop is rejected, an error message
will be displayed.

In a tiled view, you can drag items in the destination worksheet at will. All this does is
temporarily adjust the ordering of the tiles (see The Ordering of Tiles in a Row).

Miscellaneous Features Supported by the Tiled View

The Pivot Table/Chart worksheet supports a wide variety of operations on both the
view and the workbook. In many cases, the tiled view supports the same operations,
adjusted for the different selection model. Some features do not translate well to the
tiled view, and are not included. Table 15-1 lists support for various features found in
the Pivot Table/Chart worksheet.

Table 15-1 Features Supported by the Tiled View

Feature Supported Comments
Copy/Rename View Yes
Insert Measures Yes

Page Edge Synchronization  Yes

PQDs and Auto PQDs Yes

View /Manage Images Yes

Clear and Fill Partial Selected items must be visible. No Quick
Fill

Cut, Copy, and Paste Partial Selected items must be visible.

Detail Pop-ups Partial The context menu for launching a detail
pop-up is available on either a position or a
cell (only).

Lock Cell and Lock Measure Partial The measure or cell to be locked must be
visible on one of the tiles.

Position Filtering Partial Filtering using a selection of tiles represents
only the positions used in any of the
intersections of the underlying selected
tiles.

Simple Sort Partial

Workbook Transitions Partial Tiled views are supported as a target for
Master/Detail transitions. They are
supported as a source for Master Detail
transitions if the tiles are visible and
selected. They are supported as a source for
Detail Pop-up transitions via the context
menu.

Batch Alerts No

Level Splitting No

Print & Export No

Real Time Alerts No Tiles and tile content may be formatted by

Real Time Alerts, including hover
information. Filtering and Alert Navigation
are not supported.
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Print and Export

You can use the print and export functionality to export data in the current slice of a
view to Microsoft Excel or a delimited file and print it.

Additionally, you can adjust the page setup options before printing and exporting the
data. These print settings are persisted in the Fusion Client for the selected view.

Note: The exact way the print and export functions operate may
depend on the browser being used for the Fusion Client. The
description below is based on the behavior in Internet Explorer. You
may need to change the configuration settings in other browsers (such
as Firefox or Google Chrome) before files can be printed or exported.

The page setup, print, and export options are located in the File menu.

Figure 16—-1 Page Setup, Print, and Export Options

Save
Save As...
Rename...

ﬁw Commit

[ commit Status. ..

Page Setup...
Bprint...
@ Export...
R Refresh Ctrl+R

In addition, print and export icons are located in the toolbar. In both, an Excel
spreadsheet is produced for output.

Figure 16-2 Print and Export Icons

¥ Commit status: Never Committed iy | & £ & ﬂ|v F

Page Setup

The page setup option is available in the File menu, as shown in Figure 16-3.
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Figure 16-3 Page Setup Option in the File Menu

k Edit v \View v For
E Save
Save As...
Rename...
@ Commit
(G Commit Status...

| Page Setup...

&, print...
@ Export...
R Refresh Cirl+R

The Page Setup dialog box (Figure 16—4) contains five tabs: Page, Margins,
Header/Footer, Sheet, and Page Breaks.

Figure 16-4 Page Setup Dialog Box

Page Setup Mm

View |Sales by Type [v]

Page Margins Header Footer Sheet Page Breaks
Orientation @ Portrait L
O Landscape A
Scaling & Adjust to: 100 él %% normal size
(OFitto: 1 :I pages(s) wide by 1 :I tall

QK Cancel

Page settings are applied per view. The View drop-down list contains a list of views of
the current workbook. By default, the displayed view is selected. Selecting the view in
the View drop-down sets the view in all tabs of this dialog box.

The settings created in the Page Setup dialog box are passed to Microsoft Excel and
used when printing the data.

The five Page Setup tabs are described in the next sections.

Page Tab

Use the Page tab to specify the page orientation and scaling.

16-2 Oracle Retail Predictive Application Server User Guide for the Fusion Client



Page Setup

Figure 16-5 Page Setup Dialog Box: Page Tab

Page Setup
View |Sales by Type [i]

Page Maragins

Orientation @ Portrait
& Landscape

Scaling ® Adjust to:

() Fit o

Header Footer

Sheet

100 §| %% normal size

1 %! pages(s) wide by

Page Breaks

=i

QK Cancel

Margin Tab
Use the Margin tab to specify the page margins.
Figure 16-6 Page Setup Dialog Box: Margin Tab
Page Setup <]
View |Sales by Type [1]
Page Margins Header [Footer Sheet Page Breaks
Top: 1 §|
Left: 0.5 3 Right: 0.5 3
Bottom: 1 §|
QK Cancel
Header/Footer

Use the Header/Footer tab to apply headers and footers.
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Figure 16-7 Page Setup Dialog Box: Header/Footer Tab

Page Setup B
Vigw |Sales by Type [v]
Page Margins Header/Footer Sheet Page Breaks

Apply Header | Mone [V]

Header Preview

Custom Header...

Apply Footer | None [V]

Footer Preview

Custom Footer...

QK Cancel

Sheet

Use the Sheet tab to define row and column headers, print gridlines, and page order.
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Figure 16-8 Page Setup Dialog Box: Sheet Tab

Page Setup L)
Wigw |Sales by Type [1]

Page Margins Header Footer Sheet Page Breaks

Print Gridlines

Repeat row headers @ Every page
) Only leftmost page(s)

Repeat column headers ) Every page
(") Only topmost page(s)

Page Order (&) Down, then over %

(") Over, then down

QK Cancel

Page Breaks

Use the Page Breaks tab to specify how the rows and columns break across pages.
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Figure 16-9 Page Setup Dialog Box: Page Breaks Tab

Page Setup "
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Page Margins Header [Footer Sheet Page Breaks
Break rows on (") MNone Level [Mone [
® Product
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oK Cancel

After you have used the Page Setup dialog box to define how the view appears on a
page, you can print or export the page.

Export

You can use the Export functionality to export a slice to a text file or to Microsoft Excel.
These options are described in the following sections.

Note: Before exporting a view, ensure that the Internet Explorer
automatic prompting for file downloads security setting for
downloads is set to Disable.

If you are using other browsers, you may need to adjust specific
settings in those browsers in order to get the Save dialog box to
appear during the export process for text or Excel files.

Export to a Text File

When a slice is exported to a text file, the data is exported row by row, with each item
of data separated by a specified delimiter. This means the page setup options are not
required.

1. Select the Export option from the File menu.
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Figure 16-10 Export Option

Edit » View ~

Save
Save As. .

Rename. ..

Commit Status. .

Fage Setup...

B, Print .

If you have edited the view, a warning message appears, asking if you want to
calculate the workbook, revert the cells, or cancel the export.

Figure 16-11 Edited Cells Warning Message

Warning o

. There are edited cells in the workbook. Would you like to
£ calculate the workbook, revert the edited cells or cancel
the operation?

Calculate | Rewvert | Cancel |

= Click Calculate to calculate the workbook and open the File Download dialog
box.

»  Click Revert to revert the edited cells and open the File Download dialog box.
= Click Cancel to cancel the operation.

2. The Export dialog box appears.

Print and Export 16-7



Export

Figure 16-12 Export Dialog Box: Text

Export
Wikt Cover Cazel
Expon To CrExcel
(5 Tewt
Exporl DAz Been oo ator CommmE v
Format orrmatied
Type i RawDats  DESCHRNONS [ Labels
Read-only
el il t A elup Oolions
; age Margins HeadenFooter Shest Age al
Orientation Fortrait
Landscaps
Sialing Adjust 1o 100 5 % normal size
Ll | % pagesis)wide by 11 tail
0K  Cancel

Set the Export To radio button to Text. This specifies that the output is to be in text
format. It also ensures that options such as Separator and Descriptions are
available for selection and not grayed out. The lower part of the dialog box (used
for exporting to Excel spreadsheets) is grayed out and unavailable).

Select the following options:
= View: Choose the view that you want to export.

= Export Format Type: Choose As Seen or Raw Data. (The Formatted option is
not available when you are exporting to a text file.)

— Choose As Seen if you want the data to be exported as it appears in the
Fusion Client.

— Choose Raw Data if you want the exported data in the text file to appear
with no number formatting.

For instance, if you have entered 12588.687 and the number formatting is
configured to have a scale of 1, a precision of 2, the separator turned on, and a
prefix of $, the number appears as $12,588.69 in the pivot table. This number

appears in the text file in the following ways, depending on the exported
format type:

— As Seen: $12588.69
— Raw: 12588.687
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Note: Data types other than integer and float are not supported. If a
view contains columns with data types other than integer and float,
the data is exported as it appears in the Fusion Client. If a worksheet
contains a mix of columns with integer or float data types with other
data types, the exported file contains the appropriate formatting for
the supported data types based on the options selected during the
export. Data in the columns of the unsupported data types appears as

it is seen in the Fusion Client.

Date or any type of picklists are exported as a string.

= Separator: Choose Comma, Tab, Space, or Other (Please specify). The default

separator is Comma.

— If you choose Other (Please Specify), you must enter a character in the

text box. This character will act as the separator.

Figure 16-13 Separator: Others Option

Separator Other (Please spedify) v :

= Descriptions: Choose either Labels or Names to be displayed as a header in

the exported data. The default is Labels.

Note: The Apply Page Setup Options and Read-only options are

not applicable to text file exports.

3. C(lick OK.

4. The File Download dialog box appears. You can choose to either Open the text file

or Save it to a location on your computer.

Figure 16-14 File Download Dialog Box

File Download X

Do you want to open or save this file?

I"_"j Mame: null. bt
= Type: TextDocument
From: localhost

Open ]’ Save ]| Cancel |

ham your computer. f you do not trust the source, do not open or

lgl While files from the Intemet can be useful, some files can potentially
save this file. What 's the rsk?

5. If you chose Open, the text file opens. If you chose Save, you can open the file

from the location you saved it.
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Figure 16-15 Data in Text File

B null[1].txt - Notepad
File Edit Format View Help

vMen's cCasualwear_grick & mortar,2/13/2010,2/20/2010,2/27/2010,3/¢
.00,wp sales C,42,169.09,39,252.73,36,641.82,41,605.45,52,972.73,
,0.0 %,0.0 %,0.0 %,0.0 %,0.0 %,0.0 %,0.0 %,0.0 %,0.0 %,0.0 %,0.0
00,64,020.00,62,637.27,55,505.45,63,365.45,61,775.45,61,429. 09, 6¢
00,0.00,0.00,0.00,0.00,0,00,0.00,0.00,0.00,0.00,0.00,0.00,0.00,0.
.00,0.00,wp EOP Inv AUC,18.88,18.86,18.58,18.35,18.49,18.55,18.5:
18.22,16.36,17.37,18.07,18.19,18.33,17.97,18.79,18.03,17.04,18.41

Export to Excel

You can export data to Microsoft Excel using two options. You can use the Export
option in the File menu to set export options before exporting. Or, you can use the
Export icon in the toolbar to bypass the export options and export the slice directly to
Excel.

Note: The export functionality is certified with Microsoft Excel 2003
and 2007.

Note: After exporting a worksheet to Excel, the Export to Excel
dialog may not automatically dismiss. You can click Cancel to dismiss
the dialog and continue with your work.

Option 1: Export Option in the File Menu

To export the slice to Microsoft Excel with the Export option in the File menu,
complete the following steps:

1. Select the view that you want to export.

2. Select the Export option from the File menu.

Figure 16-16 Export Option

Edit ~ VMiew ~  Form

Save
Save As...

Rename...

Commit Status...
Page Setup...

&y Print...

% Export... [}

& Refresh Ctrl+R

If you have edited the view, a warning message appears, asking if you want to
calculate the workbook, revert the cells, or cancel the operation.
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Figure 16-17 Edited Cells Warning

Warning >4

. There are edited cells in the workbook. Would you like to
£ calculate the workbook, revert the edited cells or cancel
the operation?

Calculate | Revert | Cancel |

s Clicking Calculate calculates the workbook and opens the File Download
dialog box.

s Clicking Revert reverts the edited cells and opens the File Download dialog.
s Clicking Cancel cancels the operation.

3. The Export dialog box appears.

Figure 16-18 Export Dialog Box: Excel

Export
View Review History by A | ¥
® Excel
Export To Text
® AsSeen Separator v
Export Format Type Formatted
Raw Data Descriptions v
Read-only
Export Images ¥ Size Default v Cell Width px Cell Height px Custom

#| Apply Page Setup Options

Page | Margins | Header/Footer | Sheet | Page Breaks
. . ® Portrait B
Orientation Landscape

- . X
Scaling f’—}ittlJthl;tlo. 100 A~ % normal size

1 ~ pages(s) wide by 1 ~ tall

OK Cancel

Set the Export To radio button to Excel. This grays out some options associated
with exporting to a text file. It also enables the Apply Page Setup Options check
box.

Select the following options:
= View: Choose the view that you want to export.
= Export Format Type: Choose As Seen, Formatted, or Raw Data.

— Choose As Seen if you want the data to be exported as it appears in the
Fusion Client.

—  Choose Formatted if you want the data to be exported to Excel in raw
format (meaning that the Fusion Client formatting has been removed) and
then have the Excel-based formatting automatically applied within Excel.
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Only the formatting selected in the Fusion Client is applied in Excel. After
the data is exported, you can apply more formatting within Excel.

— Choose Raw Data if you want the exported data in Excel to appear with
no number formatting.

For example, if you have entered 12588.687 and the number formatting is
configured to have a scale of 1, a precision of 2, the separator turned on, and a
prefix of $, the number appears as $12,588.69 in the pivot table. This number
appears in Excel in the following ways, depending on the exported format
type:

- As Seen: $12588.69

— Formatted: $12,588.69 (the raw number, 12588.687, is formatted in Excel to
display as $12588.69)

— Raw: 12588.687

Note: Data types other than integer and float are not supported. If a
view contains columns with data types other than integer and float,
the data is exported as it appears in the Fusion Client. If a worksheet
contains a mix of columns with integer or float data types with other
data types, the exported file contains the appropriate formatting for
the supported data types based on the options selected during the
export. Data in the columns of the unsupported data types appears as
it is seen in the Fusion Client.

Date or any type of picklists are exported as a string.

Boolean data types are exported with formatting compatible with
Excel.

When you use the formatted option and use a scale factor of anything
besides 1000, the value in Excel is displayed as the raw formatted
value, not the scaled formatted value. For percentages, a scale factor of
.01 displays as a percent in Excel.

Note: The Separator and Descriptions options are not applicable to
Microsoft Excel exports.

4. By default, the Export Images check box is checked. This allows any images that
are included in the pivot table to be exported, along with other data.

Select the desired size of the exported images from the Size drop-down menu.
The two available values are Default, which exports a thumbnail image, and
Large, which exports a full-sized image. The image size associated with the
Default option and the Large option can be changed by the administrator.

The default values are set for both the cell width and the cell height. If you
check the Custom check box, you can specify a custom size within the bounds
set by the administrator for the image cells in Excel.

When you uncheck the Export Images check box, Fusion will export the label
associated with a specific image rather than the image itself.

Image export is not available when you select the Text option from the Export
To radio buttons.
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5. If the Apply Page Setup Options check box has been selected, the tabs concerning
page setup will be enabled. Options include Page, Margins, Header/Footer, Sheet
and Page Breaks. These options function in an identical manner to those accessed
by the Page Setup option on the File menu. For more information, see Page Setup.

Read-only: Select this check box if you want the exported data to be read-only.
This prevents the data from being updated when opened in Microsoft Excel.

6. Click OK.

7. The File Download dialog box appears. You can choose to either Open the
Microsoft Excel file or Save it to a location on your computer.

Figure 16-19 Export Dialog Box

File Download X

Do you want to open or save this file?

@ j Name: null.xls
1l Type: Microsoft Excel Worksheet

From: localhost

Open ll Save l| Cancel |

|--"‘~| ‘While files from the Intemet can be useful, some files can potentially
@ harm your computer. i you do not trust the source, do not open or
= save this file. What s the risk?

8. If you chose Open, Microsoft Excel opens and the slice appears in a spreadsheet. If
you chose Save, you can open the file from the location you saved it.

Print and Export 16-13



Export

Figure 16-20 Slice in Microsoft Excel

A B C D E
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2 | J | Color
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a
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Note: Exporting images to Excel requires Microsoft Excel 2007 or
later (.xIsx instead of .xIs).

Also note that, while common image formats are supported with the
export to Excel functionality, only a single frame of an animated .gif
file is exported. (That is, the file is no longer animated.)

Option 2: Export Icon in the Toolbar

The global toolbar icon for Export, shown in Figure 16-21, bypasses the Export dialog
box and exports the data to Excel using the default export options. By default, the
images are exported to Excel.

To export the slice to Microsoft Excel with the Export icon in the toolbar, complete the
following steps:

1. Select the view that you want to export.

2. Click the Export icon in the toolbar.

Figure 16-21 Export Icon

¥ Commit status: Never Committed g | & & & ) |'—' =)
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If you have edited the view, a warning message appears, asking if you want to
calculate the workbook, revert the cells, or cancel the operation.

Figure 16-22 Edited Cells Warning

Warning 2]

. There are edited cells in the workbook. Would you like to
& calculate the workbook, revert the edited cells or cancel
the operation?

Calculate | Revert | Cancel |

s Clicking Calculate calculates the workbook and opens the File Download
dialog box.

»  Clicking Revert reverts the edited cells and opens the File Download dialog
box.

s Clicking Cancel cancels the operation.

3. The File Download dialog box appears. You can choose to either Open the
Microsoft Excel file or Save it to a location on your computer.

Figure 16-23 File Download Dialog Box

File Download El

Do you want to open or save this file?

@ j Name: null.xls
IHL Type: Microsoft Excel Worksheet

From: localhost

Open ]l Save ]| Cancel |

ham your computer. f you do not trust the source, do not open or

|® While files from the Intemet can be useful, some files can potentially
L
= save this file. What s the risk?

4. If you choose Open, Microsoft Excel opens and the slice appears in a spreadsheet.
If you choose Save, you can open the file from the location where you saved it.
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Figure 16-24 Slice in Microsoft Excel
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Print

You can print data to an Excel spreadsheet by use the Print option in the File menu or
on the toolbar.

The print functionality is similar to the export functionality, except that the print
functionality always applies the page setup options before exporting to Microsoft
Excel.

Print also differs from export because the exported data is always read-only and as a
result the cells in the spreadsheet are protected against changes. If required, cell
protection can be removed using Excel functionality to enable the spreadsheet to be
edited.

Note: This example is based on using Internet Explorer.

If you are using other browsers, you may need to adjust specific
settings in those browsers so that the Print functionality operates as
specified below.

Option 1: Print Option in the File Menu

To print the slice with the Print option in the File menu, complete the following steps:
1. Select the view that you want to print.

2. Select the Print option from the File menu.
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Figure 16-25 Print Option
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If you have edited the view, a warning message appears, asking if you want to
calculate the workbook, revert the cells, or cancel the operation.

Figure 16-26 Edited Cells Warning

Warning >4

. There are edited cells in the workbook. Would you like to
£ calculate the workbook, revert the edited cells or cancel
the operation?

Calculate | Revert | Cancel |

s Click Calculate to calculate the workbook and open the File Download dialog

box.

»  Click Revert to revert the edited cells and open the File Download dialog box.

s Click Cancel to cancel the operation.

3. The Print dialog box appears. Select the view you want to print.

Figure 16-27 Print Dialog Box
Prriint
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Cancel
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4. ltis possible to make changes to the page set-up options using the Page, Margins,
Header/Footer, Sheet or Page Breaks tabs. For more information, see Page Setup.

5. Click OK.
6. The File Download dialog box appears. You can choose to either Open the

Microsoft Excel file or Save it to a location on your computer.

Figure 16-28 File Download Dialog Box

File Download E

Do you want to open or save this file?

@ j Name: null.xls
1l Type: Microsoft Excel Worksheet

From: localhost

Open ll Save l| Cancel |

harm your computer. i you do not trust the source, do not open or

|g) ‘While files from the Intemet can be useful, some files can potentially
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7. If you chose Open, Microsoft Excel opens and the slice appears in a spreadsheet. If
you chose Save, you can open the file from the location where you saved it.

Figure 16-29 Slice in Microsoft Excel
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From Microsoft Excel, click the Print option in the main menu.
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Figure 16-30 Print Icon in Microsoft Excel

‘ Print 3

Option 2: Print Icon in the Toolbar

To print the slice with the Print icon in the toolbar, complete the following steps:

1. Select the view that you want to export.

2. Click the Print icon in the toolbar.

Figure 16-31 Print Icon

¥ Commit status: Never Committed §p | & & & ra‘|v' =

If you have edited the view, a warning message appears, asking if you want to
calculate the workbook, revert the cells, or cancel the operation.

Figure 16-32 Edited Cells Warning

Warning >4

. There are edited cells in the workbook. Would you like to
£ calculate the workbook, revert the edited cells or cancel
the operation?

Calculate | Revert | Cancel |

s Clicking Calculate calculates the workbook and opens the File Download
dialog box.

»  Clicking Revert reverts the edited cells and opens the File Download dialog
box.

s Clicking Cancel cancels the operation.

3. The File Download dialog box appears. You can choose to either Open the
Microsoft Excel file or Save it to a location on your computer.

Figure 16-33 Export Dialog Box

File Download X

Do you want to open or save this file?

@ j Name: null.xls
1l Type: Microsoft Excel Worksheet

From: localhost

Open ll Save l| Cancel |

| | ‘While files from the Intemet can be useful, some files can potentially
@ harm your computer. i you do not trust the source, do not open or
= save this file. What s the risk?

4. If you chose Open, Microsoft Excel opens and the slice appears in a spreadsheet. If
you chose Save, you can open the file from the location you saved it.
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Figure 16-34 Slice in Microsoft Excel
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From Microsoft Excel, click the Print icon.

Figure 16-35 Print Icon in Microsoft Excel
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16-20 Oracle Retail Predictive Application Server User Guide for the Fusion Client



17

Special RPAS Fusion Client Features

This chapter describes special RPAS Fusion Client features that you can use. The
following sections are included:

= Batch Alerts

= Real Time Alerts

= Extended Measures
= Replicate Selections

s Creating a Consumer Decision Tree

Overview of Alerts

Retailers routinely deal with very large volumes of data. To help you to manage the
inevitable problems that occur, two forms of alerts are provided. These can help you to
focus directly on the areas of the plan that need corrective action.

Batch Alerts

Batch alerts are run at a regular time interval by a scheduling tool (for example on a
daily basis). They provide a method for a retailer to set up a systematic framework to
identify data that falls outside of specific parameters.

Real Time Alerts

Real time alerts are calculated and updated when the workbook is opened. They can
then be manually updated by users. Data outside of specified parameters is
highlighted. After you have modified the data to a suitable value, click Calculate to
clear the alert. This lets you systematically work through and clear a particular set of
problems.

Configuring Batch and Real Time Alerts

The defaults for both batch and real time alerts are configured in the RPAS
Configuration Module. This configuration can be done by users with access to the
configuration tools and the alertmgr utility. They are not accessible by standard users.
Standard users can only modify the visual appearance and priorities of real time alerts
for workbooks or workbook templates to suit their personal preferences.

Batch Alerts

Batch alerts are based on business rules that notify users about retail events such as
open to buy opportunities, stock outages, sales performance against plan, margin
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opportunities, and many others. The home page includes a Batch Manager Alert
option, allowing users to create new workbooks to deal with the batch alerts.

Figure 17-1 Batch Alert Manager on the Home Page
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I} Click this icon to open the last workbook you worked on for the task.

5  Click this icon to view the list of workbooks that already exist for the task.
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With a combined taskflow, batch alerts can be displayed from multiple solutions. Only
a global domain environment is required to show the tree-based master/locals
breakdown. The results can be filtered by Solution or Solution and Domain.

A batch alert for a global domain environment has a master line that can be expanded
to show lines for each accessible local domain. The master line shows the -sumAlerts
count, and each local domain its respective -findAlerts count. For simple domains, or
for a global domain in which the user only has access to a single local domain, a single
line per batch alert appears with the -find Alerts count.

Batch alerts are set up by identifying a business measure as the foundation and then
creating the alert by using a mathematical rule. A facility behind the scene finds the
areas of a plan that fall outside the thresholds that is declared within the batch alert
rules. This creates an alert that is flagged to the user through the Batch Alert Manager
feature.

You can configure batch alerts to automatically run on a defined schedule using the
alertmgr utility. Each time that Batch Alert Manager is run, it shows you all the alert
conditions that were identified during the last execution. For more information about
alertmgr, see the Oracle Retail Predictive Application Server Administration Guide for the
Fusion Client.

In the RPAS Fusion Client, Batch Alert Manager provides two methods for viewing the
measures associated with identified alerts, loading batch alerts in a new workbook and
inserting batch alerts in an existing one. For more information, see "Building a
Workbook Using Batch Alerts" and Inserting a Batch Alert in an Existing Workbook.

The following scenario describes how the batch alert manager displays records:

1. The batch alert manager table shows the master record at the top and local domain
records as the children in a tree structure. However, if a user runs findAlert in the
local domain, but forgets to run findAlert or sumAlert on the master domain, the
Fusion Client only receives records for local domains and will not be able to build
a master and child type structure since there is no master record. In this case, the
UI shows local domain records that are not grouped under the master domain (no
tree structure).
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2. A user may have already run findAlert or sumAlert over the master domain, but
there is still a chance that the total of the local domains is not the value shown for
the master domain, because a later run may have been for just a single local
domain.

3. Hit counts may include hits from positions the user does not have position level
security access to; those hits are not visible in any workbook user builds.

4. The hit count on the master record may not add up to the sum of the local domain
records if the user does not have access to one or more local domains.

You can also use the Batch Alert Manager window to keep track of alerts that have
been resolved. See Resolving Batch Alerts for more information.

Show Members with Batch Alert

When you use the active batch alert, the positions of the dimensions that are contained
in the base intersection of the alert measure can be filtered to display only the positions
that have alerts.

You can right-click a dimension on which an alert is based and select the Show
members with batch alert option to display only the positions for which an alert
condition is triggered.

Note: The Fusion Client displays this option on all dimensions when
the workbook has alert hits. When you select the Show members with
batch alert option for a dimension that is not part of the alert measure,
the view does not change.

For example, if you have an batch alert that is based at SKU/store/week, you can
right-click the Product, Location, or Calendar dimension when they are on the X, Y, or
Z axis and select the Show members with batch alert option. This displays all
positions that have alerts for that dimension. This option is also available on the Page
Edge tool.

Show/Open the Alert Manager Window

You can access the Alert Manager from the Home page (Figure 17-1) or from the View
menu (Figure 17-2).

Note: If there are no alerts of either type in the workbook, the Alert
Manager window and the alert options in the View menu will not

appear.

Special RPAS Fusion Client Features 17-3



Batch Alerts

Figure 17-2 Alert Options - View Menu
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Building a Workbook Using Batch Alerts

If no workbooks are currently open, you may pick a batch alert from the Alert
Manager list to load and have the system automatically construct a workbook that
contains that alert's measure and any other measures that you want to display. Use this
workbook to examine the actual measure values involved in the generation of the
batch alert, so that you can make decisions about what needs to be done next.

To build an alert manager workbook using batch alerts, complete the following steps:

1. Inthe Alert Manager dialog box, select the alert that you want to see. Selecting a
batch alert enables the New Workbook option.

2. Click New Workbook.

Figure 17-3 Alert Manager, New Workbook Icon

~| Manage Alerts

New Workbook:

Alert Mame

Regular Sales Alert

3. The Workbook Wizard dialog box opens. Select any optional alerts you want to
include in the workbook and click Next.
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Figure 17-4 Alert Manager Workbook Wizard: Additional Alerts

Workbook Wizard

Flease select optional alerts.

] mone

Cancel Previous Mext | Finish

4. Select the workbook template type and click Next.

Figure 17-5 Alert Manager Workbook Wizard: Workbook Template

Workbook Wizard

Flease select & workbook template type.

|Z]sales Planning

Cancel Previous Mext Einish

Note: If the workbook template for the workbook the user is
building contains real time alerts, the real time alerts will be
incorporated into the new workbook. This lets the user to see
complementary batch and real time alerts.
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5. The hierarchies shown in this step are related to the workbook you select. In the
top section, select the hierarchies you want to range. This means that only the
positions in this hierarchy that trigger the alert are available for selection in the
workbook wizard. In the bottom section, select the hierarchies that you do not
want to see in the workbook. Click Next.

Figure 17-6 Alert Manager Workbook Wizard: Range and Hide

Workbook Wizard ]

Please select hierarchies to range.

El Mone

Q Location
El Product
5 calendar

Pleage select hierarchies to hide.

E None

El Location
& Product
El Calendar

Cancel Previous ‘ Mext | Einish |

6. The workbook wizard steps from this point on depend on the workbook you
selected. For each step, select the positions you want to see in each dimension. At
the last step, click Finish.
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Figure 17-7 Batch Alert Manager Workbook Wizard: Position Selection
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7. The Alert Worksheet Selection dialog box opens. Select the view (worksheet) you
want the alert to appear in. If you do not select a view, Alert Manager
automatically selects one with the appropriate base intersection.

Note: The Alert Manager Selection dialog box does not have a cancel
button. Once you click the Finish button on the Alert Manager
Workbook Wizard, you can no longer change the selected positions
and can only select the worksheet from the list provided and click OK.

Figure 17-8 Alert Worksheet Selection

Alert Worksheet Selection

Alert Names Waorksheet Mames/Intersection

Regular Sales Alert :
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Alert will be added to the selected worksheet.
QK

If you select a view that has a base intersection below the base intersection of the
alert, a message appears that states the base intersections do not match and an
additional view is created.

The workbook opens.

Inserting a Batch Alert in an Existing Workbook

If you have an open workbook already displayed, you can use the Alert Manager to
insert a batch alert measure into that workbook. This lets you view multiple alert
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measures simultaneously and address alert-related issues without building a new
workbook for each.

To insert a batch alert in an existing workbook, complete the following steps:

1. In the open workbook, select the Manage Alerts option in the View menu.

Figure 17-9 Alert Options - View Menu
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2. The Alert Manager dialog box for batch alerts opens. Select the batch alert you
want to insert in the open workbook and click Insert Alert. (Insert Alert is grayed
out until a batch alert is selected.)

Figure 17-10 Alert Manager Dialog Box for Batch Alerts
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The workbook refreshes and the alert measure is inserted.

3. Close the dialog box using the Close icon or Cancel.
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The Alert Manager dialog box closes, and the alert measure is visible in the workbook.

Finding Batch Alerts

In the view, the batch alert appears and behaves like a read-only Boolean measure.
Positions that have triggered the alert have selected check boxes.

If you have more than one batch alert (or a combination of batch and real time alerts)
in the workbook, use the Select Alert icon to choose the alert type that you want to
work with. Use the Find Next and Find Previous alert icons (Figure 17-11) to scroll
through all instances of that alert in the workbook. If the next or previous alert is not
visible in the view, the view refreshes or scrolls to make it visible.

Figure 17-11 Select Batch Alert and Find Next and Previous Batch Alerts Icons
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Note: You can use the alert controls to determine whether to work
with batch alerts or real time alerts. If you opt to work with batch
alerts, you can use the controls to step forward or back through those
alerts. If you opt to work with real time alerts, you can use the controls
on those.

Resolving Batch Alerts

After you have reviewed the alert instances and made any necessary changes to the
data, you can mark the batch alert as resolved in the Alert Manager dialog box.

To resolve a batch alert, check the Resolved check box for that alert (Figure 17-12).
Checking the resolved check box does not change the data in the workbook or clear
the instances of that alert. It serves only as a visual cue that you have addressed the
alert.

Real time alerts can be considered resolved when their hit count falls to zero in the
workbook.

Figure 17-12 Resolving a Batch Alert
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Real Time Alerts

Real time alerts are interactive alerts that are displayed when you open a workbook or
view. The alerts are then updated each time you edit data and click Calculate.

Configuring Real Time Alerts

Note: For a detailed explanation of how to configure Real Time
Alerts, see the RPAS Configuration Tools User Guide.

Real Time Alerts are configured in the RPAS Configuration Module, which is normally
only accessible by Administrators. This section gives a brief overview of how these
alerts are configured. It is intended to give some background information for users
with access to the Fusion Client only.

Alert Definition

Real Time Alerts are configured on workbook templates and appear in workbooks
built using those templates. An alert definition specifies a number of conditions, each
with styles and a message, that the alert can detect and display. Alerts hits are
determined by a designated alert measure, which uses a rule to calculate a condition
identifier representing each hit at a designated alert intersection. These hits are then
displayed on the cells of a designated target measure at that same intersection. The
alert definition also contains a priority that is used when multiple alerts are raised on
the same target measure cells.

Alert Measure

The alert measure is calculated by a rule that detects the conditions for the alert. For
example, an alert measure FcstAlert may be computed by the following rule:

FcstAlert = if (FestQty <300, "tooLow", if (FcstQty >600, "tooHigh",""))

In this example, tooLow and tooHigh are condition identifiers, which the alert
definition would associate with a style and a message. The alert measure does not
have to be visible in any views.

Target Measure

The alert definition specifies a target measure on which the hits appear. This may be a
measure used in the alert measure's rule, for example FestQty above, but does not
have to be. When an alert measure computes a condition for a cell, the corresponding
target measure cell represents the alert hit and is formatted (and navigated to)
accordingly.

The target measure cells must be visible at the alert intersection for hits to be shown.
The target measure can be the same as the alert measure, if desired. The same measure
may be used as the target for a number of different alerts. In the case of colliding hits,
the alert's priority is used to determine which alert formats the cell, but the cell will be
navigated to for any of the alerts present.

Condition Definitions

For each condition that can be produced by the alert measure's rule, a style, label, and
message is defined. You can modify the styles via Format/Alert Styles. The styles are
used to format target measure cells with the condition, and the message is displayed
as part of the tooltip information that appears when you mouse over hit cells.
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Working with Real Time Alerts

When you open a worksheet, the real time alert hits are calculated and displayed.
They are refreshed every time you click Calculate or invoke operations such as Save
and Custom Menu Executions or as part of the Commit process.

Alerts on the Toolbar
The toolbar contains an alerts icon. The number beside the icon shows the number of

hits for the currently active real time alert for the entire workbook.

Figure 17-13 Toolbar - Current Alerts
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Click on the up or down arrows to move to the next or previous real time alert hit
relative to the currently selected cell in the pivot table.

Click on the exclamation mark to bring up a detailed list for both forms of alert.

Figure 17-14 Toolbar - Outstanding Alerts
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Batch Alerts: I
® Out Of Range (28) I
Problem SKL (28)

Too Low (28) I
If only one form of alert has active alerts, only that form of alert is displayed. For
example, if there are no current batch alerts, this list only displays real time alert hits.

Select a specific type of alert to select that type of alert hit in the worksheet. You can
then step through those alerts using the Find Next Alert or Find Previous Alert
options on the toolbar.

Navigating to Alerts Using the View Menu
The View menu has Find Next, Find Previous, and Select Active Alert controls:
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Figure 17-15 View Menu - Select Alert Options
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Find Next and Find Previous Alert

These options work in the same way as the options on the toolbar. Select them to move
to the next or to the previous alert. These controls are disabled when navigation is not
possible, given the count or layout of the view(s).

Select Active Alert

This option works in the same way as the option on the toolbar. Select a specific type
of alert to select that type of alert in the work sheet. You can then step through those
alerts using the Find Next Alert or Find Previous Alert options.

Other Alert Options on the View Menu

Several other options are available on the View menu.

Allow Users to Find Alerts to Cross Views

This option is only active when a real time alert is selected. You can toggled it on or off
by clicking it. If it is active, it will display a check mark.
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Figure 17-16 View Menu - Cross View Alerts Option
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This options affects the behavior of the navigation controls. If you select it, real time
alert navigation will move to the next or previous worksheet view in the current task
when all real time alert hits have been exhausted in the current view. Otherwise,
navigation is restricted to the current worksheet view.

Filter by Alert

This option is only available for real time alerts. If Filter by Alert is selected, the
current view will be filtered to only display the active real time alerts of the current
type. Select it from the View menu.

Figure 17-17 View Menu - Apply by Alert

Format « > Commit status: Modified g

-

i GoTo pregation & Spre

t Synichronize Page Edae 'Ealendar Locatio
| Automatically Evaluate Position Queries ﬁ -| 0102 STRASE
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t d ol s
@ Manage Images... yF
i

. Attributes " 0010 Leather Loafk
Manage Alerts. .. 00011 Leather Loaft
* Find Mext Alert 00012 Leather Loaf
Find Previous Alert 00013 Leather Loaft
c Select Active Alert + 00014 Leather Loafe
Allow Find Alerts To Cross Views 00015 Leather Loaf
Apply Filter By Alert 00016 Leather Loaf
Remove Filter By Alert 017 | eather | nafe

| Active Real Time Alert: Overflow lﬁ

EDTlIe Vertically
%‘I’lle Horizontally
E5 e

00019 Leather Loaf
T
When applied, the rows, columns and pages in the worksheet view are restricted to

those with the currently selected real time alert. These rows are not dynamically
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updated. The same rows, columns and pages remain visible after a calculation changes
the data.

Figure 17-18 Worksheet View Before Applying Filters

~| Aggregation & Spreading w & g A
igzz| M F| EH Measure
[2zzms]- B Location| Product
.|
Blau | & | [Fod. - & 4 B Ece A W
ramp ravgd damr
0102 STRASBOURG 10000010 Leather Loafer -Black 6 B 10,00 654,00  01/31/2013
10000011 Leather Loafer - Black 6.5 B 6554.00 511.00  02/28/2013
10000012 Leather Loafer - Black 7B 123.00 935.00  01/31/2013
10000013 Leather Loafer - Black 7,58 3453.00 864.00 01312013
0156 LIVERPOOL 10000010 Leather Loafer - Black 6 B 54.00 6.00 02/23(2013
10000011 Leather Loafer - Black 6.5B 134.00 754.00  01/31/2013
10000012 Leather Loafer - Black 7B 342.00 89.00 01/31/2013
10000013 Leather Loafer - Black 7.5B 755.00 650,00  02/28/2013
0180 05LO 10000010 Leather Loafer - Black 6 B 387.00 53200 01/31/2013
10000011 Leather Loafer - Black 6,58 32.00 279.00 03012013
10000012 Leather Loafer - Black 7B 224.00 756,00 02f18/2013
10000013 Leather Loafer - Black 7.5B 7754.00 322.00  01/31/2013

Figure 17-19 Worksheet View After Applying Filters

~| Aggregation & Spreading - b A
B Calendar E] Measure
2/12/2005 |= :‘@ Location |  Product
|
Bl il | & | [Fd.. > & & | [Ecan A o
ramp ravgd damr
0102 STRASBOURG 10000011 Leather Loafer -Black 6.5B 6554.00 511.00  02/28/2013
10000013 Leather Loafer - Black 7.58 3453.00 864.00  01/31/2013
0150 O5LO 10000013 Leather Loafer - Black 7.58 7754.00 322.00  01/31f2013

Remove the filter by selecting the Remove Filter by Alert option on the View menu.

Reapplying an Alert Filter

After editing the data to address problems associated with a number of alerts, you can
use the Calculate option. Once the results are recalculated, some real time alerts will
being cleared. In addition, other real time alerts may be generated.
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Since the number, type, and position of the alerts may be changed by the calculation,
you can remove the filter to see all rows in the worksheet. All rows become visible,
including alerts of different types.

Reapply Filter By Alert is available in the View menu. If you select it, the same alert
that was used previously will be reapplied. Alternatively, you can select a different
type of alert from the global toolbar. In this case, you will see the Apply Filter By Alert
option.

Figure 17-20 View Menu - Reapply Filter by Alert Option
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" Find Mext Alert D012 Leather Loafer -
Find Previous Alert 00013 Leather Loafer -

c Select Active Alert b 00014 Leather Loafer -
Allow Find Alerts To Cross Views 00015 Leather Loafer -
Reapply Filter By Alert 00016 Leather Loafer -

b Tl el Hear | far
| Active Real Tirme Alert: Problem Item

Remove Filter By Alert

DD'ﬁIe Vertically
E=7ile Horizontally
ESTie

00019 Leather Loafer -
e

Customizing Alert Appearance

Each real time alert is preconfigured with a specific appearance. These styles are set up
in the Configuration Module. You can modify them using the Alert Styles option in
the Format menu.The settings are saved with the current workbook.Use Save Format
so that the modified styles can be used in other workbooks or by other users.

Figure 17-21 Format Menu - Alert Styles Option

Measure Styles. ..
MNumber...
DatefTime...
Exceptions...

Alert Styles...
Dimension Styles. ..
Save Format b

Delete Format 2

This brings up the Format dialog box opened to the Alert Styles tab.
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Figure 17-22 Format Dialog Box - Alert Styles Tab

Format L]
Maan e Shyles Mumber DateTme Excephans Alert Styles Demensaon Styles
~| Mlert Styles
Resl T | probiem Item [=) Text eolor [[l= Font style | Bold [=l

- Example

Clear |  Apaly |

You can customize the appearance of the alerts.

= Real Time Alert automatically sets the options visible in the Condition drop-down
list.

= Condition customizes the appearance of the Condition drop-down list. All
conditions can be set to the same appearance, or individual conditions may be set
to different appearances.

= The visual appearance can be specified from a combination of text color,
background color, and font style. The result is shown as an example.

Three buttons are available:
= Apply saves the current settings.
»  Clear removes the settings so the real time alert reverts to an unformatted style.

s Close closes the dialog box.

Saving the Alert Styles

You can save the modified real time alert appearances in three forms: For Just Me, For
My Group, or For Everyone. Specify the save option using the Save Format option on
the Format menu. These take effect the next time you create a new workbook from the
workbook template that the modified real time alert appearances have been saved
back to.

Setting the Alert Priorities

A specific measure (such as Gross Margins or Forecast Quantities) may be the subject
of more than one real time alert. The order of precedence can be set for cases where
multiple alerts occur. Do this by selecting the Manage Alerts option from the View
menu.
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Figure 17-23 View Menu - Manage Alerts Option
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This brings up the Manage Alerts dialog box.

Figure 17-24 Manage Alerts Dialog Box

jS==s 5 1 e ) "2 A L L e LOBMRE: -] = =
Manage Alerts
(] new workbosk
Aert Nome |ert Tyme [Category | coutlasof | Resolved |Meas
Cut Of Range Batch rpas 31 Nov 13, 2012 4:59:52 PM il
Toa Low Batch pas 13 Mow 13, 2012 4:59:52 PM I
Problem SKU Batch pas 18 Hov 13, 2012 4:59:52 PM &
Problem Item Res Time 7 O
Diata Issue Real Time 17 O
Margn Alest Real Time [] ¥
Dietad Issue Real Tene 196243 O
Ovesfiow Real Time 1965 O
W G taveme 1 =

Click on any figure in the Priorities column to bring up the Prioritize dialog box.
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Figure 17-25 Prioritize Dialog Box

Prioritize the alerts that can format measure GM:
Margin Alert
Detail 1

K4 M

OK Cancel

This shows all real time alerts for a specific measure. Change the priority by
highlighting an alert and using the up or down arrows. Click OK to close the dialog
box and return to the Manage Alerts dialog box. Click the Close button to close this
dialog box.

Working with Real Time Alerts

This section explains how to work with real time alerts.
Saved Real Time Alert Counts

The Open Workbook dialog box lists the number of real time alerts for each available
workbook. Mouse over the number to bring up a tool tip that contains further details.

Figure 17-26 Open Workbook Dialog Box

Open Warkbook
View » | JEfename 3 Delete Find.. @& 4@
Pl Task Hame Cwmer Group Crmaer Mod Date =W Created Date ALCEES Alert Count |Boman Name
L Aderunistator 4 o
813 Apgregation & Sprea Adminstrator
w4 L
fme
8t plan

Real Time Alerts in the Workbook

Real time alerts in the workbook are shown by highlighted cells. The highlighting
consists of a combination of text color, background color, and font style. Mouse over a
specific cell to bring up a tooltip specifying the nature of the alert.
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Figure 17-27 Example of Color-Coded Cells and Tooltip

RegSis PromoSis Foet Qty Days Hist

10000010 Leather Loafer 23.23 0.00 25.00 52

10000011 Leather Loafer - 45.00 33z.00 [NEEGG 52

10000012 Leather Loafer 211.00 0.00 22.00 112

10000013 Leather Loafer 99 44 0.00 9.00 113

10000014 Leather Loafer 653.23 62.00 72.00 History Alert: Mot enough history
10000015 Leather Loafer 554.10 o.00 [NEEEGG] - Forecast Alert Quantity too low
10000016 Leather Loafer 32.00 0.00 8g ™

10000017 Leather Loafer 0.00 01 6 g2

10000018 Leather Loafer 142.00 43.00 25.00 52

10000019 Leather Loafer 32.00 0.00 0.00 52

10000020 Leather Loafer 44.00 o.00 [EEEGE 52
10000021 Leather Loafer 100.30 o.00 [NEEEGE 52
10000022 Leather Loafer 5421.00 0.00 25.00 52
10000023 Leather Loafer 0.00 0.00 3.00 52

The appearance of the cells are set to default values in the configuration module, but
you can customize the appearance using Customizing Alert Appearance. If a cell has
multiple real time alerts, the order in which they appear is set in the configuration
Module. Only the first alert is visible. You can customize the order using Setting the
Alert Priorities.

Where a view has large numbers of rows, you can filter the view so that only rows,
columns, and pages with alerts show, using Other Alert Options on the View Menu.

You can then systematically work to clear the real time alerts in the view by:

= Navigating to a specific real time alert and identifying its nature from its
appearance or from the tool tip.

»  Editing the value of any cell referenced by the rule to calculate the alert.
s Clicking Calculate to update the view.

= When you click calculate, if an appropriate value has been entered into the cell, the
alert should clear.

You can then periodically commit the changes to save them back to the
multidimensional database.

Extended Measures

You can use an extended measure to define, view, and edit a measure as a proportion
or percentage of another measure for a parent that is up one or more levels. These
measure relationships are also referred to as participation measures. These measures
can be defined in the RPAS Fusion Client in a view or preconfigured in the RPAS
Configuration Tools. For more information about preconfigured measures, see the
Oracle Retail Predictive Application Server Configuration Tools User Guide.

This functionality is commonly used to define measures that are percentage
participations of sales measures. Typically, these measures are defined as:

= Absolute Percent of Parent: A percentage of a fixed level (such as class) so that the
participation of each item to the class can be viewed and manipulated.

= Relative Percent of Parent: A percentage to the next level shown in any dimension
(such as Product).

= Ranking: A value that indicates the relative order of positions in either ascending
or descending order.
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s Cumulative Sum: A sequence of partial sums of a given sequence, based on an
ascending or descending rank.

s Cumulative Percent: A sequence of partial sums of a given sequence, based on an
ascending or descending rank expressed as a percentage to the total.

Note: Extended measures can be defined only on measures that have
Total as their default aggregate method.

When the percentage of the extended measure is changed, values of
the underlying measure change to reflect the newly set percentage.

Multiple extended measures can be defined for the same underlying
measure; however, only one extended measure or the underlying
measure can be edited before calculation. All other versions are
protected.

Smart editing is not allowed in the extended measure.
Extended measures cannot be based on split dimensions.

The value of an extended measure is a fraction between zero and one.
If desired, you must format the measure to be displayed as a
percentage.

For extended measures contributions in instances with very small
values (such as 0.000001) in the cell, those values are considered to be
0.0 when the extended measurescontribution is determined.

For Ranking, Cumulative Sum, and Cumulative Percent, the extended
measures are read only.

The following sections describe the extended measures features.

Absolute Percent of Parent

The absolute percent of parent type of absolute percent of parent measures allows you
to explicitly define the parent levels that are used to calculate the percentage at all
child levels.

As shown in Figure 17-28, an absolute percent of parent measure has been created for
the Weekly Sales - Regular measure with a defined parent at the Fiscal Half level of the
Calendar dimension. Therefore, this measure shows what percentage of the Season 4
half that each week is.

Figure 17-28 Absolute Extended Measure

« | Filter Product Wi A

(i catendsr
{ £

180 Measure |
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To create an absolute extended measure, complete the following steps:
1. Right-click the measure for which you want to create an extended measure.

2. The right-click context menu opens. Select the Extended measure... as shown in
Figure 17-29.

Figure 17-29 Create Extended Measure Option

% Selection Options r
| Measure Status..,
Hide Selected Member(s)
Show and Hide. ..
Extended Measure 3
Cuk Chrl+i
Copy Cri4-C
Paste Chrl+y

Lock

Attributes v
I:};J:! Lewvel splitting 3
Find...

Forrnak k

3. C(lick Create.

4. The Create Extended Measure dialog box opens (Figure 17-30). If you right-clicked
a valid measure (one that has Total as its aggregation) in Step 1, then that measure
appears in the Measure list. If not, then you must select a valid measure from the
list.

Figure 17-30 Create Extended Measure Dialog Box

Create Extended measure

Label | Weekly Sales - Regular

*Type (@ Relative Percent of Parent

= Absolute Percent of Parent E
¥ Ranking <
= Cumulative Sum 1

; Cumulative Percent

* Measure | Weekly Sales - Regular

* Dimension | Calendar

* apply To | Filter Product x|

Create Cancel
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5. In the Create Percent-of-Extended Measure dialog box, change the Type to
Absolute Percent of Parent. The dialog box refreshes and displays drop-down
lists for all the dimensions (Figure 17-31). These lists contain the levels that are
available for that dimension. These levels are defined by the intersection of the
measure.

Select the level at which you want to compare the child levels.

Figure 17-31 Create Extended Measure - Absolute
Create Extended measure
*Label | 'Weekly Sales - Regular %6 to Half

*Type ) Relative Percent of Parent
(@) Absolute Percent of Parent
® Ranking
(™) Cumulative Sum

() Cumulative Percent
*Measure | Weekly Sales - Regular El
Calendar | Fiscal Half El
Location El
Product [=]

* Apply To | Filter Product |

Create Cancel

6. When finished defining the parent levels, click Create. The view refreshes and the
new extended measure appears (Figure 17-32).

Figure 17-32 Absolute Extended Measure

! Filter Product > bov oA
BN locstion| Product] »HT :jﬁ Calendar |

|BYW\I|IE-5IEJK 1L 558 Water =

50 Measure
.

Baw e ~ -39 micmanedg

10/6/2006 | 10/13/2006 = 10/20/2006 | 10/27/2006 | 11/3/2006.  11/10/200

‘\_‘\'ge_kfv _S-afée_s - Qeg«s&y _______ QEN0.00 1250000 123000.00 FE000.00 93355.73 QEE5E.
Weekiy Sales - Regidar % to Half 3% 3% 0% 6% 3% g
Weekly Sales - Clearance 0.00 0.00 0.00 0.00 Q.00 .
‘Weekly Sales - Promo 0.00 0.80 0.00 2,00 .00 .

As shown in Figure 17-32, a new extended measure has been created for the Weekly
Sales - Regular measure with a defined parent at the Fiscal Half level of the Calendar
dimension.

The measure shows what percentage of the Season 4 half that each week is. For
example, the Weekly Sales - Regular for week 10/6/2006 are 8 percent of the entire
Season 4 half of the 2006 fiscal year.
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Relative

The relative percent of parent type of extended measure calculates the value for a
given level, which is the percentage that level is of the immediate parent level
displayed in the view. This type can only be set for a single dimension.

To create a relative percent of parent measure, complete the following steps:
1. Right-click the measure for which you want to create an extended measure.

2. The right-click context menu opens. Select the Extended measure... as shown in
Figure 17-33.

Figure 17-33 Create Extended Measure Option

% Selection Options r
| Measure Status..,
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3. C(lick Create.

4. The Create Extended Measure dialog box opens (Figure 17-34). If you right-clicked
a valid measure (one that has Total as its aggregation) in Step 1, then that measure
appears in the Measure list. If not, then you must select a valid measure from the
list.

Special RPAS Fusion Client Features 17-23



Extended Measures

Figure 17-34 Create Extended Measure Dialog Box
Create Extended measure
*Label |Wweekly Sales - Regular % of Calent

*Type (@) Relative Percent of Parent
® Absolute Percent of Parent
® Ranking
() Cumulative Sum

® Cumulative Percent
*Measure | Weekly Sales - Reqular El

* Dimension | Calendar [=]

= Apply To | Filter Product |

Create Cancel

5. In the Create Extended Measure dialog box, select the dimension for which you
want to set the parent level.

6. Click Create. The view refreshes and the new extended measure appears.

Figure 17-35 Relative Extended Measure

| Filter Product * + ¥
Locaton| Product T £ Calendar
* r
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e w e -3 ¢ mila=A AR
7
ic ] W IFY 2005
[Calerai] 7 £
Fraons |V Quirter 4,
FY 2008

Wiy Sales - Fegulsr 100203 L2003
Wieekly Sales - Feguiar % of Calendar
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Nipidy Shied - Profs

As shown in Figure 17-35, a new extended measure has been created for the Weekly
Sales - Regular measure with a defined dimension of Calendar. Because a dimension is
defined and not a specific level of a dimension, the extended measure data shown is
relative. This means that the percentage shown is compared to the next level shown in
the view.

For example, the Weekly Sales - Regular % of Calendar measure for week 10/6/2006
makes up 24 percent of the next level shown, which is October, FY 2006. Accordingly,
October makes up 32 percent of all [Quarter 4, FY 2006]. No percentage is shown for
all [Calendar] because it is the highest level in the workbook.
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Comparing Absolute and Relative Percent of Parent Measures

The difference between an absolute percent of parent measure and a relative one is
that the parent level for absolute is specified by the user. The parent level for relative is
not specified. It is the next parent level shown in the view.

Figure 17-36 Comparing Absolute and Relative Percent of Parent Measures

~| Sales by Type * 4 oy oA

B location| Product s T :Iﬁ Calendar

[Barcelona | =[4 X 6X 1L Still Water |« Ef Measure
|

= e ~ o @ mMEsEEA W
7 FY2006 |
W Season 4, FY |
" October
10/5/2006 | 10/13/2006
Weekly Sales - Regular 1220125.15 1220125.15 374553.... 95586.00  93689.00
Absolute —|Weekly Sales -Regular % Fiscal Half [ NNNRNREREB} 1% 8% 8%
Relative —|weekly Sales - Regular % Calendar 100% 100% 3% 26% 26%
Weekly Sales - Clearance 0.00 0.00 0.00 0.00 0.00
Weekly Sales - Promo 0.00 0.00 0.00 0.00 0.00
ra 3]

As shown in Figure 17-36, there is an Absolute and Relative Percent of Parent measure
created on the source measure of Weekly Sales - Regular. The absolute measure
(Weekly Sales - Regular % to Half) compares the children levels to the static level of
Fiscal Half.

The relative extended measure (Weekly Sales - Regular % of Calendar) displays the
percent of the children position to the next higher position displayed in the view.

Since the absolute extended measure specifies Fiscal Half as the parent level, the other
level shown in the view, Month, is compared to Half. For instance, week 10/6/2006 is
8 percent of the Season 4. October is 32 percent of the Season 4. Because Fiscal Half is
the specified parent, it does not show what percentage of FY2006 it is.

However, the relative extended measure only specifies the Calendar dimension as the
parent. This means that any parent level shown in the view can act as the parent.
Therefore, week 10/6/2006 is 24 percent of its immediate parent level, which is month
October. October is 32 percent of its immediately displayed parent level, which is
Season 4. Finally, Season 4 is 100 percent of its immediately displayed parent level,
FY2006. The relationship of month to quarter (the configured parent of the month
level) is not displayed since quarter is not displayed in the view.

If the month level of the Calendar dimension were hidden in this view, then the
relative extended measure would look more like the absolute one since the
immediately displayed parent level for week would be Fiscal Half, which is the
specified absolute parent. This is illustrated in Figure 17-37.
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Figure 17-37 Comparing Absolute and Relative Extended Measures at Half
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Creating a Ranking Measure

A ranking extended measure is used to create a measure that indicates the relative
order of positions in either ascending (Low to High) or descending order (High to
Low). You can also display rankings at only the base level or at all visible levels.

Note: These ranking measures are read-only measures and cannot be
edited.

To create a ranking measure, complete the following steps:
1. Right-click the measure for which you want to create an extended measure.

2. The right-click context menu opens. Select the Extended measure... as shown in
Figure 17-38.

Figure 17-38 Create Extended Measure Option
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3. C(lick Create.

4. The Create Extended Measure dialog box opens (Figure 17-39). If you right-clicked
a valid measure (one that has Total as its aggregation) in Step 1, then that measure
appears in the Measure list. If not, then you must select a valid measure from the
list.
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Figure 17-39 Create Extended Measure Dialog Box
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In the Create Extended Measure dialog box, select Ranking as the type of extended
measure.

Enter a label for the new ranking extended measure. The Measure selection
changes to the list only numerical (real or integer) source measures. It defaults to
the measure selected in the right-click operation.

Select the dimension in which to rank the source measure.
Select the rank from Low to High or High to Low.
Select the position ranking display, either Only base level or All visible levels.

s When Only base level is selected, the ranks are displayed for positions at base
level only. The rank values for positions at higher levels would be empty. This
is the default.

s When All visible levels is selected, the rank is displayed for positions at all
visible levels except the All level.

Select views to display the extended measure. Only worksheet views that have the
selected measure are listed. By default, the current worksheet view is selected.

Click Create. The view refreshes and the new extended measure appears next to
the source measure when the source measure is visible. If it is not visible, the
ranking measure is hidden as well.
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Figure 17-40 Ranking Extended Measure

v|Cover Case 1
ER  Location >y
[0102 STRASEGURG]-
BEEn | frd. -3 % SEsmANE Q@ @B
F2005 Fi2
Cover ECP Sales Sales Rank | Cover  EOP 53
W all [Product] 8160.00 24950000.00 F4280000.0C 0.00 0,00
W Antigue 323.00 038000.00 2964000.00 1 0.00 0.00
10000064 Carpenter Jeans - Antique 68.00 20800000 62400000 2 0.00 0,00
10000093 Cargo Jeans - Antigue 65.00 208000.00 62400000 2 0.00 0.00
10000290 5 pocket capri - Antique 51.00 156000.00 46800000 1 0.00 0.00
10000641 S Pocket Frayved Jeans - Antique 68,00 208000.00  624000,00 2 0.00 0,00
10000654 Loose Fit Jean - Antique 68.00 208000.00 62400000 2 0.00 0.00
W Black 620,00 2020000,00 &240000,00 3 0.00 0,00
10000009 Leather Loafer - Black 153.00 468000.00  1404000.00 gl 0.00 0.00
10000022 Leather Lace-up - Black 119.00 36400000 109200000 8 0.00 0.00
10000043 Kangaroo Pocket Sweater - Black 68.00 20800000 62400000 4 000 0.00
10000064 Carpenter Jeans - Black 68.00 208000.00 62400000 4 0.00 0.00
10000123 Chunky Shrunken Sweater - Black 62.00 20200000 624000.00 4 000 0.00
10000260 Men's Pocket Tees - Black 68.00 202000.00 62400000 4 0.00 0.00
10000334 Ladies cashrmere jersey - Black 51.00 156000.00 46200000 2 0.00 0.00
10000390 S pocket capri - Black 51.00 156000.00 46800000 2 0.00 0.00
10000540 T-Shirt - Black 34.00 104000.00  312000.00 1 0.00 0.00
'| 7 Blue 340,00 1040000.00 3120000.00 2 0.00 0,00
10000129 Mickey Print Gitls T-shirt - Blue 85.00 260000.00 72000000 E] 0.00 0.00 :|
10000190 Mickey Print Shorts - Blus 85.00 26000000  F720000,00 5] 0.00 0,00
10000260 Men's Pocket Tees - Elue 65.00 20800000 62400000 4 0.00 0.00
100002632 Blues Clues Baby BElue Longjohn - Blue 51.00 156000.00  468000.00 3 000 0.00
10000271 Blues clues slippers - Blug 17.00 5200000 158000.00 1 000 000
10000540 T-Shirt - Blue 34.00 10400000 312000.00 2 [0.00 0.00

Creating a Cumulative Sum

A cumulative sum extended measure is used to create a measure that indicates the
source measure in ascending or descending order.

Note: These cumulative sum measures are read-only measures and
cannot be edited.

To create a cumulative sum measure, complete the following steps:
1. Right-click the measure for which you want to create an extended measure.

2. The right-click context menu opens. Select the Extended measure... as shown in
Figure 17-41.
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Figure 17-41 Create Extended Measure Option

% Selection Options k
1 Measure Status..,

Hide Selected Member(s)

Show and Hide. ..

Extended Measure 3
Cut Chrl+
Copy Chrl4+C
Paste Chrl+y

Lock.

[x¥2) Attributes 3
CiaLevel splitting b
Find...

Farrnak ¥

3. Click Create.

4. The Create Extended Measure dialog box opens (Figure 17-42). If you right-clicked
a valid measure (one that has Total as its aggregation) in Step 1, then that measure
appears in the Measure list. If not, then you must select a valid measure from the
list.

Figure 17-42 Create Extended Measure Dialog Box

Create Extended measure

*Label | Weekly Sales - Regular

“Type @ Relative Percent of Parent

= Absolute Percent of Parent E
¥ Ranking 1
= Cumulative Sum e

, Cumulative Percent
= Measure | Weekly Sales - Regular

* Dimension | Calendar

* Apply To | Filter Product B

Create Cancel

5. In the Create Extended Measure dialog box, select Cumulative Sum as the type of
extended measure.

6. Enter a label for the new cumulative sum extended measure. The Measure
selection changes to the list only numerical (real or integer) source measures. It
defaults to the measure selected in the right-click operation.
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7. Click Create. The view refreshes and the new extended measure appears next to
the source measure when the source measure is visible.

Figure 17-43 Cumulative Sum Extended Measure

~| Cover Case 1
R Calendar| Product| ¢ 3
|1,’2f2IZIlD = 10000029 Carpenter Jeans - Antique & |-
Blm@ i | & | [Fnd. -3 ¢ mBcsm @MW
Cover EOP | Sales Cumulative Sales | Sales Rank
7 all [Location] 000 0.00  355.00
W 33 FRAMNCE 0.00 000 145,00 355,00 3
0102 STRASBOURG 0.00 0.00 10.00 15.00 2
0295 BORDEALIK 0.00 0.00 10.00 25,00 2
0557 TOLULCLISE 0.00 0.00 25.00 65,00 =]
0593 NICE 0.00 0.00 35.00 100.00 ]
0711 MARSEILLES 0.00 0.00 5,00 5.00 1
0804 LyioN 0.00 0.00 15.00 40,00 4
0959 PARIS 0.00 0.00 45.00 145.00 7
W 34 SPAIN 0.00 0.00 00,00 0,00 1
0594 BARCELOMA 0.00 0.00 G0.00 90,00 2
1001 BARCELOMA 0.00 0.00 20,00 30,00 1
W 44 ENGLAMND 0.00 000 12000 210.00 2
0156 LIVERPOOL 0.00 0.00 20,00 20.00 1
0160 MAMCHESTER 0.00 0.00 40.00 20,00 3
0242 BIRMIMGHSM 0.00 0.00 40.00 120,00 3
0297 LOMDOMN 0.00 0.00 20.00 40,00 1

Creating a Cumulative Percent

A cumulative percent extended measure is used to create a sequence of partial sums of
a given sequence based on an ascending or descending rank expressed as a percentage
to the total.

Note: These cumulative percent measures are read-only measures
and cannot be edited.

To create a cumulative percent measure, complete the following steps:
1. Right-click the measure for which you want to create an extended measure.

2. The right-click context menu opens. Select the Extended measure... as shown in
Figure 17-44.
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Figure 17-44 Create Extended Measure Option

% Selection Options k
1 Measure Status..,

Hide Selected Member(s)

Show and Hide. ..
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3. Click Create.

4. The Create Extended Measure dialog box opens (Figure 17-34). If you right-clicked
a valid measure (one that has Total as its aggregation) in Step 1, then that measure
appears in the Measure list. If not, then you must select a valid measure from the
list.

Figure 17-45 Create Extended Measure Dialog Box

Create Extended measure

*Label | Weekly Sales - Regular

“Type @ Relative Percent of Parent

= Absolute Percent of Parent E
¥ Ranking 1
= Cumulative Sum e

, Cumulative Percent
= Measure | Weekly Sales - Regular

* Dimension | Calendar

* Apply To | Filter Product B

Create Cancel

5. In the Create Extended Measure dialog box, select Cumulative Percent as the type
of extended measure.

6. Enter a label for the new cumulative percent extended measure. The Measure
selection changes to the list only numerical (real or integer) source measures. It
defaults to the measure selected in the right-click operation.
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7. Click Create. The view refreshes and the new extended measure appears next to
the source measure when the source measure is visible.

Figure 17-46 Cumulative Percent Extended Measure

~| Cover Case 1
R Calendar| Product| ¢ 3
|1,’2f2IZIlD = 10000029 Carpenter Jeans - Antique & |-
Blm@ i | & | [Fnd. -3 ¢ mBcsm @MW
Cover EOP | Sales Cumulative Sales | Sales Rank
7 all [Location] 000 0.00  355.00
W 33 FRAMNCE 0.00 000 145,00 100,00 % 3
0102 STRASBOURG 0.00 0.00 10.00 5.00% 2
0295 BORDEALIK 0.00 0.00 10.00 11.33% 2
0557 TOLULCLISE 0.00 0.00 25.00 27.86% =]
0593 NICE 0.00 0.00 35.00 63.19% ]
0711 MARSEILLES 0.00 0.00 5,00 1.20% 1
0804 LyioN 0.00 0.00 15.00 21.46% 4
0959 PARIS 0.00 0.00 45.00 100,00 % 7
W 34 SPAIN 0.00 0.00 90,00 13.74% 1
0594 BARCELOMA 0.00 0.00 G0.00 100.00% 2
1001 BARCELOMA 0.00 0.00 20,00 29.00% 1
W 44 ENGLAMND 0.00 000 12000 32.06% 2
0156 LIVERPOOL 0.00 0.00 20,00 7.660% 1
0160 MAMCHESTER 0.00 0.00 40.00 44,90 9% 3
0242 BIRMIMGHSM 0.00 0.00 40.00 100,00 % 3
0297 LOMDOMN 0.00 0.00 20.00 15.39% 1

Select All

You can select all cells in the current slice by using the Select All option. This is useful
if you need to select all instances within a large view.

The Select All option is located in the toolbar as well as in the right-click context menu.
Figure 17-47 Select All Option in Toolbar

B Ecom
[E5 select Al IT

eplicate Row Selections

i

Figure 17-48 Select All Option in Right-Click Context Menu

7 FY2006 |
" Season 4, FY

10/5/2006 | 10/13/2006
1971196 16 171795 16 _ggeas M 9REST, 00
Weekly Sales - Req: g Selection Options Ff select Al | 8%
Sales Revenue Measure Status. .. e 3%
Sales Revenue 0.00 0.00
\Weekly Sales -pron  Hide Selectzd Member(s) 0.00 0.00

Show and Hide. ..

To select all cells in the current slice, use one of the following methods:

Select All: Method 1

1. Click the Selection Options icon in the toolbar.
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2. From the drop-down list, click Select All.

All the cells in the current slice are selected.

Select All: Method 2

1. Right-click a cell in the view.
2. The right-click context menu opens. Click Selection Options.
3. From the drop-down list, click Select All.

All the cells in the current slice are selected.

Replicate Selections

In the RPAS Fusion Client, you can select all instances of a particular level at once with
the Replicate Selections feature. This is useful if you need to select all instances within
a large view.

To select instances using the Replicate Selections feature, complete the following steps:

1. Select an instance of the particular level for which you want to select all instances.
You can select a single cell or an entire row or column.

Figure 17-49 Replicating Selections
~| Sales by Type + ¢

-

El Measure P j@ Calendar |
[Weskly Sakes - Regulr [ Bl Product| Location

—a |

Bl | & | [Frd. ~ 3 ¢ mMEswm @ >
W FY2008
W Season 4, FY

10/5/2006 | 10/13/2008
4% 6X 1L Still Water | Barcelona 1220135.15 1220125,15 95686.00 98689.00 |
Pariz 0.00 0.00 0.00 0.00 (=

Rio de Janeiro 0.00 0.00 0.00 0.00

5 pocket capri - Anti Barcelona 0.00 0.00 0.00 0.00

Paris 0.00 0.00 0.00 0.00

Rio de Janeiro 0.00 0.00 0.00 0.00

5 packet capri - Antid Barcelona 0,00 0,00 0.00 0.00

Paris 0.00 0.00 0.00 0.00

Rio de Janeiro 0.00 0.00 0.00 0.00

5 pocket capri - Antid Barcelona 0.00 0.00 0.00 0.00

Paris 0.00 0.00 0.00 0.00

Rio de Janeiro 0,00 0,00 0.00 0.00

5 pocket capri - Band Barcelona 0.00 0.00 0.00 0.00

Paris 0.00 0.00 0.00 0.00

Rio de Janeiro 0.00 0.00 0.00 0.00

5 pocket capri - Bang Barcelona 0.00 0.00 0.00 0.00
Paris 0.00 0.00 0.00 0.00 [V

[< ] I | [ )]

2. Click the Selection Options icon in the toolbar. Or, right-click the measure and
from the right-click context menu select Selection Options. Then, click Replicate
[Row/Column] Selections.
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Figure 17-50 Replicate Selections Option

| sales by Type > o A
ER Measure P EB cCalendar
Weekhy Sales - Regular | [« B Product| Location
.|
Bam e M. -3¢ DEomnda
W FY2006
W Season 4, FY
10/6/2006 | 10/13/2008 | 10/20/
4% 6X 1L Stll Water s
Paris Levels v 10,00 0.00 0.
Ria de Jan1 [EJ selection Options v | B8 select Al
5 pocket capri - Antid Barcelona =
Paris ® Block View FEReplicate Row Selections
Rio de Jane Qutline View F.DD 0.00 0.

3. The view refreshes and all instances of the chosen level are selected.

Figure 17-51 Replicated Selections in the View

| Sales by Type > by A
E] Measure PRy Bl calendar
[Weskhy Sales - Reguler [ BA  Product| Location
k|
Blaw & . ~§ ¢ BEsmAEd
7 FY2008
W Season 4, FY
10/6/2006 | 10/13/2006 | 1020
4% 6% 1L still Water | Barcelona -~
Paris 0.00 0.00 0.00 0.00 =
Rio de Janeiro 0.00 0.00 0.00 0.00
5 pocket capri - Antq Barcelona |INNGI00! FNGIGE NG00 IGe0) e
Paris 0.00 0.00 0.00 0.00
Rio de Janeiro 0.00 0.00 0.00 0.00
5 pocket capri - Antiq Barcelona |NNGID0! FNNNGI0E NNGI00) oea) e
Paris 0.00 0.00 0.00 0.00
Rio de Janeiro 0.00 0.00 0.00 0.00
5 pocket capri - Anti Barcelona |00 FONNGI0E NG00 o) e
Paris 0.00 0.00 0.00 0.00
Rio de Janeiro 0.00 0.00 0.00 0.00
5 pocket capri -Band Barcelona |GGG [NG:0) MNo:a0 GG . |
%] I ] (2]

Using Replicate Selections to Copy and Paste

Complete the following steps to copy an instance of a particular level and paste it to all
other instances of that level:

1. Right-click an instance of the particular level for which you want to copy and
paste to all other instances.You can select a single cell or an entire row or column.

2. The right-click context menu opens. Select the Copy option.
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Figure 17-52 Using Replicate Selections to Copy and Paste

~| Sales by Type

+ 2

I's

Bl Measure

> ¥

[vresky S - Rl 1]
Bla u | &

Find...
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-~ % & @ Ecam A ol
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E:;r:lon( Hide Selected Member(s) Egg Egg E
RiodeJa  Show and Hide... 0.00 0.00 0.
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Rio de Ja B Level spitting , | 0.00 0.00 0.
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Barcelona 0.00 0.00 0.00 0.00 D.M

<] 1 (]

3.

Select the same instance again. Either click the Selection Options icon in the

toolbar, or right-click and select Selection Options from the right-click context
menu. Then, click Replicate [Row/Column] Selections.

Figure 17-53 Replicate Selections Option

~| Sales by Type
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4. The view refreshes and all instances of the chosen level are selected.
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Figure 17-54 Replicated Selections in the View

~| Sales by Type - by A
E] Measure P B3 Calendar
Weekhy Sales - Regular | |- BA Product| Lecation
_a |
Blawm & . -3 & SEcsmAEd
WV FY2006
% Season 4, FY
10/6/2006 | 10/13/2006 | 10/20
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Paris 0.00 0.00 0.00 0.00 =
Rio de Janeiro 0,00 0,00 0,00 0,00
5 pocket capri - Antq Barcelona | INNGIE0! FNGIGE NG00 e e
Paris 0.00 0.00 0.00 0.00
Rio de Janeiro 0.00 0.00 0.00 0.00
5 pocket capri - Antq Barcelona |INNGI00! FNGIGE NG00 IGe0) e
Paris 0.00 0,00 0,00 0,00
Rio de Janeiro 0.00 0.00 0.00 0.00
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5. With all the instances of that particular level highlighted, select the Paste option in
the Edit menu.

The view refreshes, and all the selected instances contain the copied information.

Figure 17-55 Replicated Selections

~| Sales by Type * b o A
B Measure P B2 calendar
Weekly Sales - Regular | |- Ef Product| Location
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Bai o <. -3 & BEsmHd
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% Season 4, FY
10/6/2006 | 10/13/2006 | 10/20
4% 6X 1L 5till Water | Barcelona ~
Paris 0,00 0,00 0,00 0,00 =
Rio de Janeira 0.00 0.00 0.00 0.00
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5 pocket capri - Antid Barcelona |\ E220325/45 220325015 95686100 [\ Sae55100| WNSH
Paris 0,00 0,00 0,00 0,00
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Using Replicate Selections for the Chart View

Complete the following steps to use the replicate selection function to create a
particular chart view.

1. Select an instance of the particular level for which you want to select all instances
to show in a chart view. You can select a single cell or an entire row or column.
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2. Click the Selection Options icon from the toolbar. Or, right-click and select
Selection Options from the right-click context menu. Then click Replicate
[Row/Column] Selections.

Figure 17-56 Replicate Selections Option

~| Sales by Type - 4 g A
Measure M BB calendar
[Weekhy Sales - Regular [ |- EA Product| Location
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Bl i | & | [Frd. & @ mEcam & W
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3. The view refreshes and all instances of the chosen level are selected.

Figure 17-57 Replicated Selections in the View
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W Season 4, FY
10/6/2006 | 10/13/2006 | 10/
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Paris 0.00 0.00 0.00 0.00 ;
Rio de Janeiro 0.00 0.00 0.00 0.00 N |
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Paris 0.00 0.00 0.00 0.00
Rio de Janeiro 0,00 0,00 0,00 0,00
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4. With all the instances of that particular level highlighted, click the Switch to Chart
View icon.

Figure 17-58 Switch to Chart View Icon

~| Sales by Type

El Measure P
[y sl -

Em E || [Fnd... -

WV FY2006

4X 6X 1L Stil Water I Barcelona 1220125.15
The chart view opens. Only the selected instances are shown in the chart. In

Figure 17-59, the chart only shows data for the Brick & Mortar because those were the
selected instances.
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Figure 17-59 Replicated Selections in Chart View
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Creating a Consumer Decision Tree

The RPAS Fusion Client includes functionality to create Consumer Decision Trees.
Instead of viewing data within a pivot table, you access a hierarchy viewer, also called
a Consumer Decision Tree Editor, in which you can create positions in a tree structure
of an hierarchy.

The Consumer Decision Tree represents an ordered decision flow for a consumer of a
certain category of product made prior to buying the product. The Consumer Decision
Tree is an unbalanced tree where each decision point represents an attribute value.
Consumer Decision Trees are used to aggregate data in the product dimension and are
displayed as an alternate hierarchy in the product dimension within the pivot table.

Accessing the Consumer Decision Tree Editor Workbook

To access the Consumer Decision Tree Editor, you must be logged into a solution that
has a task configured as a Consumer Decision Tree editor. To access the editor, the
process is the same as it is to build or open any workbook. The only difference is in
using the editor.

Navigating Page Edge
The Page Edge component displays in the Consumer Decision Tree Editor and shows
the dimensions that make up a Consumer Decision Tree. Keeping the page edge lets
you access the Consumer Decision Tree in a sequential and ordered way by paging
through the various Consumer Decision Tree positions.

Figure 17-60 Page Edge in Consumer Decision Tree Editor Workbook Window
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Creating a New Consumer Decision Tree

After accessing a task that is configured to be a Consumer Decision Tree Editor task,
you can create a new Consumer Decision Tree.

To create Consumer Decision Tree:

1. Select New CDT from the context menu while on a File Node. The New CDT
window displays.

2. Enter a label for the new version.

Figure 17-61 New CDT window

New CDT o B

Create | Cancel

3. C(lick Create.

4. Continue to edit and build the Consumer Decision Tree.

Consumer Decision Tree Editor View

The Consumer Decision Tree editor is within the framework of the Fusion Client
workbook page, but many of the workbook functions do not apply to the Consumer
Decision Tree. The available commands from the Consumer Decision Tree editor view
are shown in Figure 17-62 and Table 17-1:

Figure 17-62 Consumer Decision Tree Editor Layout Window
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Table 177-1 Consumer Decision Tree Commands

File Menu Edit Menu View Menu Global Toolbar
Save Add Child Go To Save
Save As Edit Commit
Rename Copy Branch Commit Status
Commit Paste Branch Taskflow Navigation-Previous
Revert Delete and Next Step
Delete Branch
Adding Nodes to the Tree

The Consumer Decision Tree tree displays the root node representing the pre-selected
highest node of the Consumer Decision Tree.

Figure 17-63 New Consumer Decision Tree Editor Category Window

1. Click Add Child to add a child node to the branch. A pop-up is displayed.

17-40 Oracle Retail Predictive Application Server User Guide for the Fusion Client



Creating a Consumer Decision Tree

Figure 17-64 Add CDT Node Window

Add CDT Node 8

Aftribute v
Atbribute Yalues .

Create separate branch per value

2. Select an attribute from the Attribute drop-down list.
3. Select a value from the Attribute Value drop-down list.

4. Select the Create separate branch per value, if applicable. When you select more
than one of the attribute values, this field create a separate node for every attribute
value selected.

Note: A node can be created by selecting one or more attribute
values. If multiple attribute values are chosen, and the check box to
create a separate branch is not selected, one node that represents
multiple attribute values is created.

If one branch is created for all values of an attribute, select all attribute
values and only one node will appear with the attribute value of ALL.

If all the attribute values for an attribute are used, either by creating
one node or separate nodes, a child cannot be added to the node, and
the Add Child is disabled. Creating a node with ALL does not
associate the specific attribute values with the node. Instead, it
encompasses any attribute value.

5. Click OK.

Editing Nodes

Editing is allowed on all nodes as long as there are additional attribute values
available. The selections from the node being edited are preselected in the dialog. The
attribute cannot be changed, so the attribute drop-down is disabled. Any attribute
values that are in use by other siblings are not displayed in the list.

Deleting Nodes
Nodes can be deleted from the tree. There are two options for deleting: Delete and
Delete Branch.

Selecting Delete deletes the selected node. Delete is available for any leaf node (a node
without any children). It is also available for a non-leaf node that represents all the
attributes for an attribute value: the children under this node move under the parent.

Selecting Delete Branch deletes the entire branch of nodes under the selected node, but
not the selected node itself.

Copying and Pasting in Consumer Decision Tree Editor

Copy and Paste functionality is provided to copy nodes from one branch to another.
Copy Branch is enabled when a node is selected that has children. The Copy Branch
function copies the full branch of children of the selected node, but not the selected
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node itself. Paste Branch is enabled when a branch has been copied and the selected
node is a leaf node.

Viewing a Consumer Decision Tree

The Consumer Decision Trees have the potential to become large and occupy more
space than the screen real estate allows for. The hierarchy viewer component used to
display the Consumer Decision Tree provides several features to assist in viewing the
Consumer Decision Tree effectively.

Expanding and Collapsing the Nodes or Branches

One way to limit the amount of space taken up by the Consumer Decision Tree is to
collapse branches of the tree. For any node that has children, a small triangle appears
at the bottom of the box for that node. Mouse over the triangle to enlarge it and
display an option to collapse that node if it is expanded and expand the node if it is
collapsed.

Moving the Tree

If the entire Consumer Decision Tree is not visible on one screen, the Consumer
Decision Tree can be moved to make other parts of the tree visible. The view can be
moved by either clicking and dragging or by using the panning controls in the control
bar for the hierarchy viewer.

Figure 17-65 Pan Control Tool
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Zooming the Tree

The hierarchy viewer provides some controls for zooming in and out to allow more or
less of the tree to be in view at a time. Zooming out shrinks the size of the nodes that
may make them difficult to read.
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Figure 17-66 Zoom Control Tool

Copying and Pasting Consumer Decision Trees in the Consumer Decision Tree Explorer

The easiest way to copy Consumer Decision Trees as a whole is to use the Consumer
Decision Tree explorer as it provides quick access to any Consumer Decision Tree.
Quick copying is aided by the Consumer Decision Tree explorer's right-click menu and
selecting Copy, which copies the selected node.

To paste, select one more node to copy to, again using either the right-click menu or
the menu item under Edit.

Group Pasting

The Consumer Decision Tree Explorer offers group pasting functionality. Select a
directory node as the target of a paste, and all children of that directory node are
pasted with a copy of the stored Consumer Decision Tree.

Multi-Select Pasting The Consumer Decision Tree explorer lets you select multiple nodes
in order to paste with a single Consumer Decision Tree copy.

SKU Counts and Weights in the Consumer Decision Tree

The nodes in the Consumer Decision Tree contain two items of information that give
the user information. These are SKU Count and Weight.

Figure 17-67 Example CDT with SKU Counts and Weights
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SKU Counts

For each node, the SKU count is the number of SKUs that match the attribute common
to that node and its parent.
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Figure 17-68 Example of SKU Counts
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In the above example, the Segment has an attribute of Decaffeinated and 24 SKUs
match that attribute. The SubCategory levels have attributes of Ground and Instant,
which are matched by 8 and 3 SKUs, respectively. Other attributes may be possible at
the SubCategory level, such as Whole Bean and Flavored. If these attributes are not
included in the CDT, the total number of SKUs at the SubCategory level will be less
than that of their parent Segment node.

The SKU count for a a parent node is always greater than or equal to the SKU counts
of its children.

SKU Weights

SKU weights measure the relative importance of each node. They are normally
calculated in another application and imported into the CDT. A typical way of
calculating the weight is as the total sales of items represented in the node as a
percentage of the total sales of items in the category. This value may change,
depending on the time period, trade area, and customer segment for which the CDT
has been defined.

For example, if a specific node had 10,247 sales from a total of 93,284 sales in the
category, it would be assigned a weight of 0.11.

The XML Button
The XML button enables a CDT to be imported in the form of an XML file. The XML

file has an attribute that enables the imported CDT to be set to Read Only. This can be
used to ensure that externally generated CDTs are not edited after import.

However, copying from one CDT to another is allowed in some circumstances. In that
case, imported values are cleared.

Effect of Editing on CDT

If the CDT is edited, for example by deleting or cutting and pasting nodes, the SKU
count for each node will be recalculated and re-displayed. However, cutting and
pasting a note invalidates any calculations of the weights associated with each node.
As these calculations cannot be carried out by the CDT editor, the weights are
removed from the entire tree.

Saving a Consumer Decision Tree

Save and Save As functions are available for any Consumer Decision Tree Editor
Workbook. Overall, the Consumer Decision Tree workbook save process behaves
exactly the same way as any other workbook save does, despite the difference in
appearance.
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Committing a Consumer Decision Tree

Editing and saving a Consumer Decision Tree can occur before it is committed. When
a Consumer Decision Tree is finalized and ready to publish, click Commit.

Printing a Consumer Decision Tree

Printing is not supported from the Consumer Decision Tree, but printing the tree does
work in Internet Explorer 8, as long as the tree is visible in one page view, by using the
browser's print function.
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Available Menu Shortcuts

Some of the commonly used menu items can have shortcut keys assigned. The
shortcuts will appear in the menu alongside the command they have been associated
with. The user can then use those shortcut keys as an alternative to manually selecting
items from the menu.

The list of menu items that have shortcuts is pre-configured. Additional shortcuts
cannot be created for menu items outside of this list. Neither should entries be deleted
as they are referenced by the software. The only thing that can be modified is the
combination of keystrokes assigned to each menu item.

Note: The browser also has shortcuts. Care must be taken that the
key combinations used for the menu do not duplicate the key
combinations used for the browser.

The default settings are defined in rpasBundle.properties as follows:
s Copy
menu.edit.copy.accelerator=control C
s Cut
menu.edit.cut.accelerator=control X
= Find
Setting = menu.edit.find.accelerator=control F
s Paste
menu.edit.paste.accelerator=control V
=  Undo
Setting = menu.edit.undo.accelerator=control Z
s New Tab???
menu.edit.calculate.accelerator=control T
s Search Backwards???

menu.edit.refresh.accelerator=control R

Available Menu Shortcuts A-1
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